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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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Chapter 1

Using Network Node Manager
NNMi enables you to quickly detect, isolate, and troubleshoot abnormal network behavior. Using
NNMi, you can also record what has been done to date to troubleshoot or resolve a problem.

The following table describes some of the ways that NNMi assists in making your job easier and
the help topics that would bemost valuable for accomplishing those tasks.

Task Help Topic

Rapidly detect, isolate, and correct
the problem

"Monitoring Devices for Problems" (on page 264) and
"Investigate and Diagnose Problems" (on page 347)

Annotate information for future
diagnosis

"Accessing Device Details" (on page 45)

Look for historical information to
proactively monitor the network

"Monitoring Incidents for Problems" (on page 298)

View an inventory of what is being
managed

"Learning Your Network Inventory" (on page 25)

Change your password "Change Your Password" (on page 19)

Check NNMi health "Checking the Status of NNMi" (on page 449)

Node and Incident Access
NNMi enables an NNMi administrator to limit visibility and control to parts of the network for some
or all operators. Tenants are the top-level organization to which a node belongs.

Security Groups enable and NNMi administrator to group objects that require the same access
level.

Security GroupMapping controls (through User Groups) which User Accounts can access a node
and its hosted objects, such as an interface. Each node is associated with only one Security Group
and Tenant.

Note: Users see only thosemembers of an object group (for example, NodeGroup or Router
Redundancy Group) for which they have access. If a user cannot access any nodes in the
group, the group is not visible to that user.

If your NNMi administrator has configured Security Groups to limit node access, then as a network
operator you can view a node and its associated incidents only if one of the User Groups to which
you belongs is asociated with that node's Security Group.

Note: If a node is deleted, only an NNMi administrator can view the incidents associated with that
node.
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Tip: Select Help→ System Information to view the User Account, NNMi Role1, and User
Groups for the current NNMi session.

Change Your Password
Note: This feature is disabled for all users with anObject Access Privilege of Object Guest.

If NNMi is not configured to access a directory service for user names and passwords, NNMi users
can change their NNMi password at any time using File→Change Password.

To change your NNMi password:

1. Select File→Change Password.

2. In theOld Password attribute, type your current password.

3. In theNew Password attribute, type your new password.

4. In theConfirm Password attribute, retype your new password.

5. Click OK.

1Determined by your membership in one of four special NNMi User Groups. This membership
determines what you can see and do within the NNMi console.
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NNMi's Global Network Management Feature (NNMi
Advanced)

(NNMi Advanced ) The NNMi Global Network Management feature enables multiple NNMi
management servers to work together while managing different geographic areas of your network.
Each NNMi management server discovers andmonitors a portion of the network. Specific NNMi
management servers can be designated as Global Manager to display combined Node object data.

(NNMi Advanced) There aremany benefits to using the NNMi Global Network Management
feature:

l Provides safe and secure communication amongmultiple NNMi management servers.

l Provides a central big-picture view of your corporate-wide network on the Global Manager for 24-
hour/7-days-per-week coverage.

l Enables management of nodes that are configured with address translation protocols to provide
their public address (resulting in overlapping addresses domains). An NNMi Regional Manager
is required for each address domain configured with following protocols:

n Static Network Address Translation (NAT)

n Dynamic Network Address Translation (NAT)

n Dynamic Port Address Translation (PAT/NAPT)

l Easy to set up:
n Each Regional Manager administrator specifies all Node object data or a specific NodeGroup

for participation at the Global Manager level.

n EachGlobal Manager administrator specifies which Regional Managers are permitted to
contribute information.
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l Automatically combines topology frommultiple NNMi management servers on the Global
Manager, but keeps management responsibilities separate. (No duplication, the responsible
NNMi Management server is clearly identified per Node.)

l Generates andmanages Incidents independently on each server (generated within the context
of topology available on each server).

l Regional Manager administrators can configure specific SNMP traps or NNM 6.x/7.x Events to
be forwarded from Regional Managers to Global Managers.

(NNMi Advanced - Global Network Management feature) TheGlobal Manager and the Regional
Manager maintain separate sets of data. Conclusions about each Node are derived from the
available data and can sometimes be different. Regional Managers forward the results of each
Spiral Discovery cycle to the Global Manager. The Regional Manager can have a NodeGroup filter
configured to limit the amount of data that is forwarded to the Global Manager. Filters are usually
unnecessary for Global Network Management. Do not filter out nodes that are important for
connectivity in your network environment to ensure NNMi has the data needed for accurate root
cause analysis.

l TheGlobal Manager might know information about why a connection from one site to another is
down, but the Regional Manager just knows that the router connected to that remote site has an
interface that is down. UseActions→Regional Manager Console to see the other
perspective.

l When troubleshooting a Node on theGlobal Manager, you can useActions→Open from
Regional Manager to see the latest Node information on the Regional Manager.

After Global Network Management is set up in your network environment:

l To determine if your NNMi management server is a Global Manager or a Regional Manager, see
"Is the Global Network Management Feature Enabled (NNMi Advanced)?" (on page 21).

l To determine which Nodes aremonitored by each NNMi management server, see "View the
NNMi Management Servers' Domain List (NNMi Advanced)" (on page 22).

l To determine which Incidents were forwarded to the Global Manager, see "Monitor Incidents in a
Global Network Management Environment (NNMi Advanced)" (on page 332) .

Is the Global Network Management Feature Enabled (NNMi
Advanced)?

(NNMi Advanced ) The NNMi Global Network Management feature enables multiple NNMi
management servers to work together while managing different geographic areas of your network.
See "NNMi's Global Network Management Feature (NNMi Advanced)" (on page 20) for more
information.

l Is your NNMi management server a Global Manager that displays information from other NNMi
management servers (Regional Managers)? Click here to find out:

a. Open the NNMi console.

b. Select Help→ System Information.

c. Do you see aGlobal Network Management tab?

d. If yes, on theGlobal Network Management tab, do you see aRegional Managers
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Reporting to this Global Manager section?

o If yes, this NNMi management server is functioning as aGlobal Manager.

o If no, this NNMi management server is not a Global Manager.

The NNMi administrators in your network environment determine which NNMi management
server functions as aGlobal Manager.

l Is your NNMi management server a Regional Manager that contributes data to one or more
Global Managers? Click here to find out:

a. Open the NNMi console.

b. Select Help→ System Information.

c. Do you see aGlobal Network Management tab?

d. If yes, in theGlobal Network Management tab, do you see theReporting to Global
Managers section?

o If yes, this NNMi management server is functioning as a Regional Manager.

o If no, this NNMi management server is not a Regional Manager.

Tomake this NNMi management server a Regional Manager, the NNMi administrator for some
other NNMi management server must create a Global Network Management connection to this
NNMi management server.

View the NNMi Management Servers' Domain List (NNMi
Advanced)

(NNMi Advanced - Global Network Management feature) If your NNMi management server is a
Global Manager, you can see network information frommultiple NNMi management servers. You
can easily determine which list of nodes each NNMi management server is discovering and
monitoring.

To display the list of nodes assigned to each NNMi management server, use one of the
following methods:

Navigate to theNodes by Management Server view.
1. Open the NNMi console on the Global Manager (NNMi management server).

2. From the workspace navigation panel, select the Inventoryworkspace.

3. Select theNodes by Management Server view.

4. Click the drop-down filter in the view to display a list of all NNMi management servers in your
Global Network Management environment.

Local = The NNMi management server you are currently signed into.

<name> = The name your NNMi administrator assigned to a Regional Manager (NNMi
management server). If you see a <name> value, it means that you are currently
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signed into a Global Manager, and other NNMi management servers report to this
NNMi management server.

See "Nodes by Management Server View (Inventory)" (on page 35) for more information about this
view.

Navigate to theNodes view.
1. Open the NNMi console on the Global Manager (NNMi management server).

2. From the workspace navigation panel, select the Inventoryworkspace.

3. Select theNodes view.

4. At the far right of the view, click theNNMi Management Server column heading to sort the
view by the responsible NNMi management server's name:

Local = The NNMi management server you are currently signed into.

<name> = The name your NNMi administrator assigned to a Regional Manager (NNMi
management server). If you see a <name> value, it means that you are currently
signed into a Global Manager, and other NNMi management servers report to this
NNMi management server.

5. Scroll up or down through the rows in this view to locate the entire list of devices being
managed by each NNMi management server.

See "Nodes View (Inventory)" (on page 26) for more information about this view.
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Accessing NNM 6.x and 7.x Features
Your NNMi administrator might configure NNMi so that you are able to view incidents that are being
forwarded from anNNM 6.x or 7.x management station.

If your NNMi administrator has configured any NNM 6.x or 7.x management stations, you are able
to view this information using the Inventoryworkspace. TheManagement Stations (6.x/7.x) view
in the Inventoryworkspace is useful for identifying all of the NNM 6.x or 7.x management stations
that might be forwarding incidents to your NNMi incident views. See "Management Stations View
(6.x/7.x) (Inventory)" (on page 43) for more information.

If an NNM 6.x or 7.x management station has been configured, you are also able to access the
following NNM 6.x or 7.x features from the NNMi Actionsmenu:

Note: You can only use the 6.x/7.x ovw action if ovw is running on the NNM 6.x/7.x management
station.

From Incident Views

l Actions→ 6.x/7.x Neighbor View

l Actions→ 6.x/7.x Details

l Actions→ 6.x/7.x ovw

Tip: You can right-click any object in a table or map view to access theActionsmenu.

FromManagement Station Views

l Actions→ 6.x/7.x Home Base

l Actions→ 6.x/7.x ovw

l Actions→ 6.x/7.x Launcher

l Actions→ SNMP Viewer

l Actions→Alarms

Note: You can only access NNM 6.x/7.x features by selecting incidents generated from
NNM 6.x/7.x events.
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Chapter 4

Learning Your Network Inventory
After NNMi discovers your network (or rediscovers it on a regular basis), you have several options
for exploring up-to-date information about what was discovered:

Within any table view, you can quickly view a few additional properties of your network devices. To
do so, click the row representing a network object. NNMi provides Analysis Pane information at a
glance for object attributes.

Forms are a way to gain amore in depth understanding of a particular object instance. To view the
form for the object's attributes, from a table view, double-click the row that contains the object
information. The form containing the information for the object's attributes appears.

You can also access another form from the current one for any related objects. Related objects in a
form appear as lookup fields. Each  Lookup field includes a drop-down list that lets you open
the form for that object.

You can filter views using pre-defined NodeGroups and Interface Groups . Select a filter by using

the drop-down filter selection. See "Filter Views by Node or
Interface Group" (on page 25) for more information about filters.

In the form for that object, you can view or edit the information for the selected object as described
inWorking with Objects.

TheViews with Inventory Lists section in Views Provided by NNMi provides a short description
of each Inventory view.

Filter Views by Node or Interface Group
Whenmonitoring your network, youmight be interested in only viewing information for a particular
set of nodes or interfaces. Your network administrator can group sets of nodes or interfaces into
node or interface groups. An example of a NodeGroup could be all important Cisco routers, or all
routers in a particular building. As another example, all interfaces used for Voice-Over-IP might be
grouped together in an Interface Group.

NodeGroup filters are available for: 

l Node views

l Interface views

l IP address views

l Incident views

Note: NodeGroup filters are not available for the NNM 6.x/7.x Events view.

Interface Group filters are available for:

l Interface views

l IP Address views
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l Card views

l NodeComponent views

To filter a view by Node or Interface Group:

1. Navigate to the view of interest.

a. From the workspace navigation panel, select the workspace that contains the view you
want to use; for example, Inventory.

b. Select the view of interest; for example, Interfaces.

2. In the group selector drop-down list, select the NodeGroup
or Interface Group you want to use as a filter.

When using NodeGroup or Interface Group filters, note the following:

l By default, table views are not filtered by Node or Interface Group.

l If a view can be filtered by both NodeGroup and Interface Group, the selection box lists the
NodeGroups first, followed by the Interface Groups. Each list appears in alphabetical order.

l When the filter is applied, the view automatically refreshes to show the appropriate set of
objects.

l If you set a NodeGroup or Interface Group filter, NNMi combines the group filter with any other
filters using the AND Boolean operator.

l To clear the group filter, return the selection value to "<Set node group filter>" or "<Set node or
interface group filter>".

Nodes View (Inventory)
Tip: See "Node Form" (on page 48) for more details about the node attributes that appear in this

view's column headings.

The Nodes view is useful for identifying all of the nodes beingmanaged by NNMi.

For each node displayed, you can identify its overall status (for example, Normal,Warning,
Minor,Major, Critical, orUnknown), device category (for example, Switch), name, hostname,
management address, system location (the current value of the sysLocationMIB variable), device
profile, whether the SNMP agent is enabled or not, date indicating the last time the node status was
modified, which NNMi management server is responsible for this node, and any notes included for
the node.

To display the Nodes view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theNodes view.

Node views are useful for quickly identifying items described in the following table.

Use Description

View all problem nodes Sort the view by Status so that you can be quickly alerted

Uses for Nodes Views
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Use Description

to existing and potential problems.

View all device types being
managed

Sort the view by theDevice Profile attribute.

Identify whether the problem can be
isolated to a particular area of your
network

Sort the view by System Location. This is the current
value of the sysLocationMIB variable.

View address and subnet
information associated with a
selected node to better determine
the scope of the problem

From theNodes view, open theNode form. Select the
Addresses tab.

Access amap view of a selected
node and its surrounding topology

Select the node of interest and use theActionsmenu
from themain toolbar to select either the Layer 2 or Layer
3 Neighbor View. See Using Table Views for more
information

View the statuses of interfaces in
the node

If a node is not completely down, youmight want to see
which interfaces are down for the selected node. To do
so, open theNode form and select the Interfaces tab.

The number of devices that are
served by this node.

Select the node you want and access the Layer 2 or Layer
3 Neighbor View using theActionsmenu.

View the status of all of the nodes
that have been grouped together in a
nodes group; for example, all of your
important Cisco routers.

Your NNMi administrator can create NodeGroups. These
groups might contain only the nodes important to you.
See Filter Information in a Table View for more
information.

(NNMi Advanced - Global Network
Management feature) If your NNMi
management server is a Global
Manager, identify which nodes are
managed by each Regional
Manager.

See "NNMi's Global Network Management Feature
(NNMi Advanced)" (on page 20) for more information.
Sort the Node view using the NNMi Management Server
column (at the far right of the view).

Local = The NNMi management server you are currently
signed into.

<name> = The name your NNMi administrator assigned
to a Regional Manager (NNMi management
server). If you see a <name> value, it means
that you are currently signed into a Global
Manager, and other NNMi management servers
report to this NNMi management server.

Uses for Nodes Views, continued

Related Topics:

Using Table Views

"Node Form" (on page 48)

Export Table Information
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Interfaces View (Inventory)
Tip: See "Interface Form" (on page 114) for more details about the interface attributes that appear in

this view's column headings.

The Interfaces view is useful for identifying the network interfaces managed by NNMi.

For each interface displayed in the view, you can identify the interface’s overall status (for example,
Normal,Warning,Minor,Major, Critical, orUnknown), its administrative (AS) and operational
(OS) status, associated node Name value (Hosted On Node), the interface name, interface type,
interface speed, input speed, output speed, the date the interface information was last changed, its
description, the ifAlias value, and any notes included for the interface.

To display the Interfaces view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select the Interfaces view.

If you see several blank columns for an interface in a table view, note the following:

n The interfacemight be in a non-SNMP node.

For interfaces on non-SNMP nodes, note the following: 

o The interface index (ifIndex) value is always set to 0 (zero).

o The interface type (ifType) is set toOther.

o The interface Name (ifName), if none is available, is set toPseudo Interface.

Note: ForPseudo Interface, NNMi attempts to obtain additional information using a
variety of discovery protocols (see the list of Topology Source protocols in Layer 2
Connection Form).

o If the interface hosts an IP address, the interface Alias (ifAlias) is set to the IP
address. Otherwise, the interface Alias (ifAlias) is set with information from
neighboring SNMP devices.

o NNMi obtains theMAC address if the IP address can be resolved using ARP cache.

n The interfacemight be a Nortel private interface.

For Nortel SNMP interfaces, note the following: 

o The interface index (ifIndex) value is set according the Nortel privateMIB.

o NNMi tries to collect theMAC address and interface name using Nortel's privateMIBs.

n (NNMi Advanced) The interfacemight be an IPv-6 interface.

A small number of IPv6 devices do not support the standard RFC 2863 IF-MIB for IPv6
interfaces. In this case, NNMi uses theRFC 2465 IPv6-MIB. When this happens, note the
following:

o Interface index (ifIndex) and description (ifDescr) are set according to the RFC
2465 IPv6MIB.

o Interface type (ifType) is set to Other (no specific type is available).
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o Interface Name (ifName), Alias (ifAlias), and Speed (ifSpeed) are blank (not
available).

o NNMi monitors the Status of this interface, but Performancemetrics are not available.

When an IP Address has the Interface Name (ifName) attribute set to blank, NNMi
constructs an alternate string for the IP Address's In Interface attribute (Other
[<ifIndex_value>]).

Interface views are useful for quickly identifying items described in the following table.

Use Description

View all network interfaces per node Sort the view by Hosted On Node. This is the
current value in NNMi’s database for the Name
attribute of the host device.

Determine the health of each of the
managed interfaces

Sort the view by theStatus attribute.

Access amap view of the network
interface and its surrounding topology.

Select the interface of interest and use theActions
menu to select either the Layer 2 or Layer 3 Neighbor
view. See Using Table Views for more information.

View the status of all of the interfaces
that have been grouped together in a
node or an interfaces group; for example,
all of the interfaces on the important
Cisco routers or all of the Voice-Over-IP
interfaces within your network.

Your NNMi administrator can create nodes and
interface groups. These groups might include only
those nodes or interfaces important to you. Now you
can filter the interfaces view by a node or an interface
group. See "Filter Views by Node or Interface Group"
(on page 25) for more information.

Uses for Interfaces Views

Related Topics:

Using Table Views

"Interface Form" (on page 114)

Export Table Information

IP Addresses View (Inventory)
Tip: See "IP Address Form" (on page 153) for more information about the IP address attributes that

appear in this view's column headings.

The IP Addresses view is useful for identifying all of the IP addresses beingmanaged by NNMi.

For each IP address displayed, you can identify its status, state, IP address, interface name (In
Interface), associated node Name value (Hosted On Node), the subnet prefix (In Subnet) and
prefix length (PL), and any notes included for the IP address.

To display the IP Addresses view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select the IP Addresses view.

The IP Address view is useful for quickly identifying items described in the following table.
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Use Description

View all IP addresses per node Sort the view onHosted On Node attribute.

View the addresses per
interface

Sort the view on the Interface name (In Interface) attribute.

View the addresses per subnet Sort the view on the subnet (In Subnet) attribute.

View the subnet information for
a selected IP address

To access a subnet from this view:

1. Select the IP address of interest.

2. Open the IP Address form

3. Navigate to the In Subnet attribute. Click the
 Lookup icon and select  Open to access the IP
Subnet form.

View the status of all of the
addresses for the nodes that
have been grouped together in a
nodes group; for example, all of
your important Cisco routers.

Your NNMi administrator can create node or interface groups.
These groups might include only those nodes or interfaces
important to you. Now you can filter the addresses view by a
node or interface group. See "Filter Views by Node or Interface
Group" (on page 25) for more information.

Uses for the IP Addresses View

Related Topics:

Use Table Views

"IP Address Form" (on page 153)

Export Table Information

SNMP Agents View
Tip: See "SNMP Agent Form" (on page 94) for more details about the SNMP Agent attributes that

appear in this view's column headings.

TheNon-Normal SNMP Agents view in theMonitoringworkspace is useful for identifying all of
the SNMP Agents that have a state that is other than Normal.

To display the Non-Normal Node SNMP Agents view:

1. In theWorkspaces navigation pane, select theMonitoringworkspace.

2. Select theNon-Normal SNMP Agents view.

For each SNMP Agent displayed in the view, you can identify the SNMP Agent Status, the Agent
SNMP State, the Agent ICMP State, theManagement Address ICMP Response Time, the
Management Address ICMP Response Time Baseline, the associated node Name value (Hosted
On Node), the IP address NNMi uses to communicate with this SNMP agent (Management
Address), the date and time the Status was last modified, the version of the SNMP protocol in use,
whether the SNMP agent is set up for SNMP communication in the network environment (Agent
Enabled), the User Datagram Protocol port configuration for this SNMP agent (UDP Port), the time
that NNMi waits for a response to an SNMP query before reissuing the request, and themaximum
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number of retries that NNMi issues for an SNMP query before determining the query result to be
"unresponsive", the SNMP Proxy address, and the SNMP Proxy port.

Note: If you have Administrator Role, the SNMP Agents view also displays the Read Community
String.

Related Topics

Use Table Views

Export Table Information

IP Subnets View (Inventory)
Tip: See "IP Subnet Form" (on page 160) for more details about the IP subnet attributes that appear

in this view's column headings.

The IP Subnets view is useful for identifying all of the networks within your management domain.

For each IP subnet displayed, you can identify its name, the subnet prefix (In Subnet) and prefix
length (PL), the date and time its status was last changed, and any notes included for the subnet.

To display the IP Subnets view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select the IP Subnets view.

The IP Subnets view is useful for quickly identifying items described in the following table.

Use Description

Determine all nodes within
a subnet

Use the Layer 3 Neighbor view to easily see the number of problem
nodes within a subnet.

Browse for large and small
subnets

Scan theName column to view the list of available subnets.

Uses for the Subnets View

You can identify empty subnets by opening the form for a selected subnet and viewing the IP
addresses table.

Related Topics:

Use Table Views

"IP Subnet Form" (on page 160)

Export Table Information

VLANs View (Inventory)
A virtual local area network (VLAN) is a logical network within a physical network. The VLAN
creates a reduced broadcast domain. Participating devices can physically reside in different
segments of a LAN. After the VLAN is established, the participating devices behave "as if" they
were all connected to one LAN. For example, switches within the same layer 2 switching fabric
(switches that hear one another and do not have layer 3 routers between them) can be in a VLAN
(identified by theVLAN Identifier value, the VLAN Id).
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Several VLANs can co-exist within a network. Devices can participate in multiple VLANs. And
trunk ports can participate in multiple VLANs.

There are several types of VLANs. NNMi supports switch port VLANs.

Note: NNMi does not currently support protocol-based VLANs andMAC-based VLANs.

VLANs that reside in separate broadcast domains can have identical names. And one VLAN can
havemultiple names. For example, two switches participate in the same VLAN (VLAN Id=10), but
the VLAN name is different on each switch. Those switches are nonetheless still participating in the
same VLAN.

Tip: To sort the VLANs view and group all devices in a particular VLAN together, click theVLAN Id
column heading.

To display the VLAN view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theVLANs view.

Note: NNMi ignores VLAN-1 because that is the default VLAN Identifier, but NNMi discovers
any higher numbered VLANs.

3. Use the VLAN view to quickly identify all of the switch port VLANs configured in your network
environment:

The table displays a row for each VLAN member and columns for the following:

n Global VLAN Name

VLAN connections are determined by a common VLAN Id. The name assigned to that
VLAN can be designated by each participating Node's configuration settings for that
VLAN Id. Therefore, NNMi chooses a VLAN name for this value (from potentially many
names for the same VLAN ID). NNMi uses the lowest sort-order name from all available
names designated by member Nodes.

n VLAN Id (identifier value)

n Member Node Count

n Member Node[Interface] ( hostname[Interface Name])

Tip: If your VLAN view contains two or more VLANs with the same name, those VLANs exist
in separate broadcast domains.

Related Topics:

"VLAN Form" (on page 162)

Export Table Information

Cards View
Tip: See "Card Form" (on page 164)  for more details about the Card attributes that appear in this

view's column headings.
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The Card view is useful for identifying all of the Cards hosted on the nodes that are stored in the
NNMi database. To view the Cards per node, sort the Card view by theHosted On Node attribute.

See Use Table Views for more information about sorting, filtering, and hiding attribute columns
within a view.

To display the Cards view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theCards view.

For each Card displayed in this view, you can identify the Card Status, Administrative State,
Operational State, Name of the Node in which the card resides (Hosted OnNode), the date and
time the Status was last modififed, the Card Name, model, Type (hardware-type designator), Serial
Number, Firmware Version, Software Version, Index, Physical Index, Hosted on Card (name of the
card, if any, in which the selected card is attached), Redundant Group, if any, in which the card
participates, and a Description, and any Notes for the Card.

To see the incidents related to a Card:

1. Double-click the row representing a Card. The "Card Form" (on page 164) displays all details
about the selected Card.

2. Navigate to the Incidents tab to see the incidents associated with the selected Card.

Related Topics

Use Table Views

Export Table Information

Ports View
Tip: See "Port Form" (on page 177)  for more details about the Port attributes that appear in this

view's column headings.

The Ports view is useful for identifying all of the Ports hosted on the nodes that are stored in the
NNMi database. To view the Ports per node, sort the Ports view by theHosted On Node attribute.

See Use Table Views for more information about sorting, filtering, and hiding attribute columns
within a view.

To display the Ports view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select thePorts view.

For each Port displayed in this view, you can identify the name of the Node in which the Card
resides (Hosted OnNode), the Port Name, index number, Type (hardware-type designator), Speed,
Configured Duplex Setting, if any, the Card on which the Port resides, and the interface to which
the Port is associated.

Related Topics

Use Table Views

Export Table Information
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Node Components View
Tip: See "Node Component Form" (on page 67)  for more details about the Node Component

attributes that appear in this view's column headings.

The Node Components view is useful for identifying all of the Node Components that NNMi
monitors on the nodes including the following:

l Fan

l Power Supply

l Temperature

l Voltage

See Use Table Views for more information about sorting, filtering, and hiding attribute columns
within a view.

To display the Node Components view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theNode Components view.

For each Node Component displayed in this view, you can identify the Node Component Status,
Name, type (for example Fan), the associated hostname (Hosted OnNode), and the date and time
the Status was last modified.

Related Topics

Use Table Views

Export Table Information

Layer 2 Connections View (Inventory)
Tip: See "Layer 2 Connection Form" (on page 179) for more details about the Layer 2 Connection
attributes that appear in this view's column headings. 

The Layer 2 Connections view is useful for identifying all of the connections beingmanaged by
NNMi. Sorting this view by Topology Source lets you easily identify all user added connections.

For each connection displayed in the view, you can identify the status, name, the data source or
protocol (Topology Source) used to create the connection (for exampleCDP orUSER), the date
and time the connection was last modified, and any notes related to the connection.

To display the Layer 2 Connections view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select the Layer 2 Connections view.

Related Topics

Export Table Information
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Nodes by Management Server View (Inventory)
Tip: See "Node Form" (on page 48) for more details about the node attributes that appear in this
view's column headings.

(NNMi Advanced) TheGlobal Network Management feature enables multiple NNMi management
servers to share the workload in your network environment. See "NNMi's Global Network
Management Feature (NNMi Advanced)" (on page 20) for more information about this feature.

If the Global Network Management feature is enabled in your environment, and your NNMi
management server is a Global Manager, theNodes by Management Server view provides a filter
to show which nodes each NNMi management server is responsible for discovering andmonitoring:

Local = The NNMi management server you are currently signed into.

<name> = The name your NNMi administrator assigned to a Regional Manager (NNMi
management server). If you see a <name> value, it means that you are currently signed
into a Global Manager, and other NNMi management servers report to this NNMi
management server.

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the
filter value. Here is an example of a Quick Filter list:

Note: If you filter your view using additional filters, such as NodeGroups, NNMi uses the
AND operator to combine the filters you have selected. See Filter a Table View for more
information.

To display the Nodes by Management Server view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theNodes by Management Server view.

3. Click the filter drop-down and choose the name of the NNMi management server that has the
list of Nodes you want to view.

For each node displayed, you can identify its overall status (for example, Normal,Warning,
Minor,Major, Critical, orUnknown), device category, name, hostname, management address,
system location (the current value of the sysLocationMIB variable), device profile, date indicating
the last time the node status was modified, and any notes included for the node.

Related Topics

Use Table Views

Filter a Table View

Export Table Information

Nodes (All Attributes) View (Inventory)
Tip: See "Node Form" (on page 48) for more details about the node attributes that appear in this

view's column headings.
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The Nodes (All Attributes) view enables you to create a customized view of nodes. This view
includes most of the attributes available for the node so that you can decide which aremost
important for you to display. See Use Table Views for more information about sorting, filtering, and
hiding attributes within a view.

To display the Nodes (All Attributes) view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theNodes (All Attributes) view.

The Nodes (All Attributes) view includes the node's overall status (for example, Normal,Warning,
Minor,Major, Critical, orUnknown), device category (DC), name, fully-qualified hostname
(including the domain name, if available), management address, system location (the current value
of the sysLocationMIB variable), device profile, whether the SNNP agent is enabled, the date
indicating the last time the node status was modified, any notes that exist for the node, its system
name, system contact name, a system description, which NNMi management server is
responsible for this node, the system object ID (MIB-II sysObjectID), the device vendor, the device
family, the name of its SNMP agent, the SNMP protocol version, the Agent SNMP  state, the Agent
ICMP state, the date the node's state was last modified, the Tenant and Security Group assigned
to the node, its discovery state, time of the last discovery cycle, the creation date, and the date and
time the node was last modified.

See "Nodes View (Inventory)" (on page 26) for more information about ways to use a node view.

Related Topics:

Use Table Views

Export Table Information

Interfaces (All Attributes) View (Inventory)
Tip: See "Interface Form" (on page 114) for more details about the interface attributes that appear in

this view's column headings.

The Interfaces (All Attributes) view lets you choose the columns of interface information, to better
meet your needs. For example, youmight want to filter the view to display only the interfaces
related to a particular set of devices.

This view includes most of the attributes available for the incident so that you can decide which are
most important for you to display. See Use Table Views for more information about sorting, filtering,
and hiding attributes within a view.

For each interface displayed, you can view its status, its administrative state and operational state,
the associated hostname (Hosted OnNode), its interface name, type, speed, description, the value
of its alias, the date and time the status was last modified, the name of the Layer 2 Connection
associated with the interface, any notes related to the interface, its direct management mode, its
nodemanagement mode, the physical address, the interface index, the creation date, and the date
and time the interface was last modified.

To display the Interfaces (All Attributes) view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select the Interfaces (All Attributes) view.

If you see several blank columns for an interface in a table view, note the following:
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n The interfacemight be in a non-SNMP node.

For interfaces on non-SNMP nodes, note the following: 

o The interface index (ifIndex) value is always set to 0 (zero).

o The interface type (ifType) is set toOther.

o The interface Name (ifName), if none is available, is set toPseudo Interface.

Note: ForPseudo Interface, NNMi attempts to obtain additional information using a
variety of discovery protocols (see the list of Topology Source protocols in Layer 2
Connection Form).

o If the interface hosts an IP address, the interface Alias (ifAlias) is set to the IP
address. Otherwise, the interface Alias (ifAlias) is set with information from
neighboring SNMP devices.

o NNMi obtains theMAC address if the IP address can be resolved using ARP cache.

n The interfacemight be a Nortel private interface.

For Nortel SNMP interfaces, note the following: 

o The interface index (ifIndex) value is set according the Nortel privateMIB.

o NNMi tries to collect theMAC address and interface name using Nortel's privateMIBs.

n (NNMi Advanced) The interfacemight be an IPv-6 interface.

A small number of IPv6 devices do not support the standard RFC 2863 IF-MIB for IPv6
interfaces. In this case, NNMi uses theRFC 2465 IPv6-MIB. When this happens, note the
following:

o Interface index (ifIndex) and description (ifDescr) are set according to the RFC
2465 IPv6MIB.

o Interface type (ifType) is set to Other (no specific type is available).

o Interface Name (ifName), Alias (ifAlias), and Speed (ifSpeed) are blank (not
available).

o NNMi monitors the Status of this interface, but Performancemetrics are not available.

When an IP Address has the Interface Name (ifName) attribute set to blank, NNMi
constructs an alternate string for the IP Address's In Interface attribute (Other
[<ifIndex_value>]).

Related Topics:

Use Table Views

Filter a Table View

Export Table Information

IP Addresses (All Attributes) View (Inventory)
Tip: See "IP Address Form" (on page 153) for more details about the IP address attributes that

appear in this view's column headings.

HP Network NodeManager i Software (9.21)Page 37 of 454



Online Help: Help for Operators
Chapter 4: Learning Your Network Inventory

The Custom IP Addresses view displays most IP address attribute columns. Sort and filter this IP
address view tomeet your needs, if the out-of-the-box views provided by NNMi don't provide
exactly what you want.

See Use Table Views) for more information about sorting, filtering, and hiding attribute columns
within a view.

To display the IP Addresses (All Attributes) view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select the IP Addresses (All Attributes) view.

For each address displayed in the view, you can identify the status, state, address, the name of the
interface (In Interface), associated node Name value (Hosted On Node), the subnet in which the
address is contained, the subnet prefix length (PL), the date the address status was last modified
(Status Last Modified), any notes that exist for the IP address, its direct management mode, date
the state of the address was last modified (State Last Modified), date the address was created,
date the address was last modified.

Related Topics

Use Table Views

Export Table Information

MIB Variables View
Tip: See "MIB Variable Form" (on page 361) for more details about theMIB Variable attributes that

appear in this view's column headings.

TheMIB Variables view displays all of theMIB variables currently available in NNMi.

Note: Your NNMi administrator might choose to load additional MIBs. Check this view periodically
to view the latest list of MIB variables available.

See Use Table Views for more information about sorting, filtering, and hiding attribute columns
within a view.

To display the MIB Variables view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theMIB Variables view.

For eachMIB variable displayed in this view, you can identify theMIB variable's numeric OID
(Object Identifier), Name, Syntax and textual OID.

Related Topics

Use Table Views

Export Table Information

MIB Notifications View
Tip: See "MIB Notification Form" (on page 39) for more details about theMIB Notification attributes

that appear in this view's column headings.
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TheMIB Notifications view displays the SNMP trap information that is defined by the associated
MIB.

Note: Your NNMi administrator might choose to load additional MIBs. Check this view periodically
to view the latest list of MIB Notifications available.

See Use Table Views for more information about sorting, filtering, and hiding attribute columns
within a view.

To display the MIB Notifications view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theMIB Notifications view.

For eachMIB Notication displayed in this view, you can identify theMIB variable's numeric OID
(Object Identifier), Name, MIB, and textual OID, as well as the Type, Severity, Category, and State
information for the SNMP trap.

Related Topics

Use Table Views

Export Table Information

MIB Notification Form
TheMIB Notification form enables you to view the SNMP trap information, if any, that is defined by
the selectedMIB.

Note: If you are an Administrator, you can also access theMIB Notification form from the
Loaded MIBs option in theConfiguration workspace. SeeMIB Notification Form (for
Adminstrators) for more information.

For information about each tab:

To view the MIB Notification information for a selected MIB:

1. From the workspace navigation panel, select the Inventoryworkspace.

2. SelectMIB Notifications.

3. Double-click the row of interest.

4. View the Basics information for the selectedMIB Notification (see theMIB Notification Basic
Attributes table).

Attribute Description

Name The Name value that is stored in theMIB definition for the selectedMIB
notification. In the following example, linkDown is the Name of theMIB variable :

linkDown NOTIFICATION-TYPE
OBJECTS { ifIndex, ifAdminStatus, ifOperStatus }
STATUS current
DESCRIPTION
"A linkDown trap signifies that the SNMP entity, acting in

MIB Notification Basic Attributes
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Attribute Description

an agent role, has detected that the ifOperStatus object
for
one of its communication links is about to enter the down
state from some other state (but not from the notPresent
state). This other state is indicated by the included

value
of ifOperStatus."
::= { snmpTraps 3 }

OID
(Numeric)

The numeric representation of the OID (Object Identification) value for the selected
MIB notification.

OID (Text) The textual representation of the OID for the selectedMIB variable.

MIB The name value that is stored at the beginning of theMIB definitions to identify the
MIB. In the following example, IF-MIB is the name of theMIB:

IF-MIB DEFINITIONS ::= BEGIN

Description SNMP Trap Description that is stored in theMIB.

Type Optional. SNMP Trap --#TYPE value that is stored in theMIB.

Summary Optional. The-- #SUMMARY value that is stored in theMIB for the SNMP Trap.

Arguments Optional. Number of arguments for the SNMP Trap.

Severity Optional. The --#SEVERITY value that is stored in theMIB for the SNMP Trap.

Generic Optional. The --#GENERIC value that is stored in theMIB for the SNMP Trap.

Category Optional. The --#CATEGORY value that is stored in theMIB for the SNMP Trap.

Source ID Optional. The --#SOURCE ID  value that is stored in theMIB for the SNMP Trap.

State Optional. The --#STATE value that is stored in theMIB for the SNMP Trap.

MIB Notification Basic Attributes, continued

Card Redundancy Groups View (Inventory)
Tip: See "Card Redundancy Group Form" (on page 210)  for more details about the attributes that

appear in this view's column headings.

The Card Redundancy Groups view is useful for identifying the names of the groups that provide
redundancy protection against card failure.

See Use Table Views for more information about sorting, filtering, and hiding attribute columns
within a view.

To display the Card Redundancy Groups view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theCard Redundancy Groups View view.
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For each Card Redundancy Group displayed in this view, you can identify the Card Redundancy
Group Status, Name, and the date and time the Status was last modified.

To see the incidents related to a Card Redundancy Group:

1. Double-click the row representing a Card Redundancy Group. The "Card Redundancy Group
Form" (on page 210) displays all details about the selected Card Redundancy Group.

2. Navigate to the Incidents tab to see the incidents associated with the selected Card
Redundancy Group.

To view the members that belong to this group:

1. Double-click the row representing a Card Redundancy Group. The "Card Redundancy Group
Form" (on page 210) displays all details about the selected Card Redundancy Group.

2. Navigate to theRedundant Cards tab.

Each Card that belongs to the selected Card Redundancy Group is listed.

Related Topics

Use Table Views

Export Table Information

Router Redundancy Group View (Inventory) (NNMi
Advanced)

Your network administrator might have set up groups of redundant routers to help ensure that
information packets reach their intended destination. Use the Router Redundancy Group view to
see all of the available groups of redundant routers in your network.

Tip: See "Router Redundancy Group Form (NNMi Advanced)" (on page 214) for more details about
the Router Redundancy Group attributes that appear in this view's column headings.

To display the Router Redundancy Group view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theRouter Redundancy Group view.

For each Router Redundancy Group displayed in the view, you can identify the Router Redundancy
Group status, Router Redundancy Group Name, the Router Redundancy Group protocol (for
example, HSRP), and the date the Router Redundancy Group Status was last modified.

To see the incidents related to a Router Redundancy Group:

1. Double-click the row representing a Router Redundancy Group. The "Router Redundancy
Group Form (NNMi Advanced)" (on page 214) displays all details about the selected Router
Redundancy Group.

2. Navigate to the Incidents tab to see the incidents associated with the selected Router
Redundancy Group.

To view the members that belong to this group:

1. Double-click the row representing the Router Redundancy Groupmembers you want to see.

2. Navigate to theRouter Redundancy Members tab.
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Each node that belongs to the selected Router Redundancy Group is listed. You also see
which interface is assigned to the Router Redundancy Group within each node.

Related Topics

Use Table Views

Export Table Information

Router Redundancy Group Members View (Inventory) (NNMi
Advanced)

Your network administrator might have set up groups of redundant routers to help ensure that
information packets reach their intended destination. Use the Router Redundancy GroupMembers
view to see all of themembers of a group of redundant routers in your network.

Tip: See "Router Redundancy Member Form (NNMi Advanced)" (on page 216) for more details
about the Router Redundancy GroupMember attributes that appear in this view's column
headings.

To display the Router Redundancy Group Member view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theRouter Redundancy Group Members view.

For each Router Redundancy GroupMember displayed in the view, you can identify the Router
Redundancy GroupMember Current State, its Previous State, the Router Redundancy Group
Name, the hostname on which the Router Redundancy GroupMember resides, the interface that is
being used by the router to participate in the Router Redundancy Group (Redundancy Inteface), the
IP Address used to exchange the configured Router Redundancy Protocol messages between
routers in the Router Redundancy Group (Primary IP), the number used to rank the Router
Redundancy Members (Priority), the date and time the Router Redundancy Member State was last
modified, and whether the Router Redundancy GroupMember owns the Virtual IP Address for the
Router Redundancy Group (for example, VRRP1 protocol).

Related Topics

Use Table Views

Export Table Information

Node Groups View (Inventory)
Tip: See "NodeGroup Form" (on page 228) for more details about the NodeGroup attributes that

appear in this view's column headings

When checking your network inventory, youmight be interested in only viewing information for a
particular set of nodes. Your network administrator can group sets of nodes into node groups. An
example node group could be all important Cisco routers, or all routers in a particular building. See
About Node and Interface Groups for more information about how your administrator sets up node
groups. See "Filter Views by Node or Interface Group" (on page 25) for more information about
filtering views using node groups.

1Virtual Router Redundancy Protocol
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Note: Your NNMi administrator can remove the Nodes Group view from the NNMi console. If you
are an NNMi administrator, see the "NNMi Console" chapter of the HP Network Node
Manager i Software Deployment Reference for more information.

To display the Node Groups view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theNode Groups view.

3. To display the definition for a particular NodeGroup filter, double-click the row representing a
NodeGroup. The "NodeGroup Form" (on page 228) displays all details about the selected
NodeGroup.

For each node group displayed in the view, you can identify the node group status, name, whether
the node group appears in the filter list for node and interface views, whether the node group is
available as a filter in the NNM iSPI Performance software, and any notes about the node group.

Related Topics

Export Table Information

Interface Group View (Inventory)
Tip: See "Interface Group Form" (on page 236) for more details about the Interface Group attributes

that appear in this view's column headings.

When checking your network inventory, youmight be interested in only viewing information for a
particular set of interfaces. Your network administrator can group sets of interfaces into interface
groups. See About Node and Interface Groups for more information about how your administrator
sets up interface groups. See "Filter Views by Node or Interface Group" (on page 25) for more
information about filtering views using interface groups.

To display the Interface Group view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select the Interface Group view.

3. To display the definition for a particular Interface Group filter, double-click the row representing
an Interface Group. The "Interface Form" (on page 114) displays all details about the selected
InterfacedGroup.

For each interface group displayed in the view, you can identify the interface group name, whether
the interface group appears in the filter list for interface views, whether the interface group is
available as a filter in the NNM iSPI Performance software, and any notes about the interface
group.

Related Topics

Export Table Information

Management Stations View (6.x/7.x) (Inventory)
Your NNMi administrator might configure NNMi so that you are able to view incidents that are being
forwarded from either an NNM 6.x or 7.x management station. If your NNMi administrator
configured any NNM 6.x/7.x management stations to forward incidents, you are able to view this
information using the Inventoryworkspace.

HP Network NodeManager i Software (9.21)Page 43 of 454



Online Help: Help for Operators
Chapter 4: Learning Your Network Inventory

TheManagement Stations (6.x/7.x) view is useful for identifying all of the NNM 6.x or 7.x
management stations that might be forwarding incidents to your NNMi incident views, as well as
directly accessing the NNM 6.x/7.x management station.

Note: If an NNM 6.x or 7.x management station has been configured, you are also able to access
the following NNM 6.x or 7.x features from the NNMi Actionsmenu: Home Base, ovw,
Launcher, and Alarms. See "Accessing NNM 6.x and 7.x Features" (on page 24) for more
information.

To view attribute information for any NNM 6.x or 7.x management stations that have been
configured:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select theManagement Stations (6.x/7.x) view.

For eachmanagement station displayed, you can identify its name, the version of NNM 6.x or 7.x
that is running on that machine, the IP address for themachine, the OpenView Application Server
(ovas) port number, theWeb server port number, and a description of themanagement station that
was provided by your NNMi administrator.

Related Topics

Export Table Information

MPLS WAN Clouds (RAMS) (NNMi Advanced)
Tip: SeeMPLSWAN Cloud (RAMS) form for more details about the attributes that appear in this

view's column headings.

NNMi Advanced. TheMPLSWAN Connections view provides information about the Layer 3
connectivity between your network and any MPLS networks (for example, an Internet Service
Provider MPLS network).

Note:EachMPLS network is represented in the associated topology map by anMPLSWAN
Cloud.

Information displayed in theMPLSWAN Clouds (RAMS) view includes the name and Autonomous
System Number assigned to theMPLS Cloud as well as the number of Customer Edge (CE)
routers associated with theMPLSWAN Cloud.

Related Topics:

Use Table Views

Export Table Information
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Accessing Device Details
NNMi provides forms that help you easily view all details associated with amanaged object, such
as a node, SNMP agent, interface, address, subnet, or connection.

NNMi also provides an Analysis Pane that displays related information about an object. NNMi
performs the appropriate analysis on the object and determines the related information to display.
See "Use the Analysis Pane " (on page 348) for more information.

From a table view, to view all details associated with an object:
1. From the workspace navigation panel, select a workspace containing a view of the object of

interest.

2. Select a view that contains the specific object (for example, Inventoryworkspace, Nodes
view).

3. Double-click the row representing an object.

4. The form displays, containing details of all information related to the object.

5. View or edit the details of the selected object:

n "Node Form" (on page 48)

n "SNMP Agent Form" (on page 94)

n "Interface Form" (on page 114)

n "IP Address Form" (on page 153)

n "SNMP Agent Form" (on page 94)

n "IP Subnet Form" (on page 160)

n "VLAN Form" (on page 162)

n "Card Form" (on page 164)

n "Port Form" (on page 177)

n "Node Component Form" (on page 67)

n "Layer 2 Connection Form" (on page 179)

n "MIB Variable Form" (on page 361)

n "MIB Notification Form" (on page 39)

n "Card Redundancy Group Form" (on page 210)

n "Router Redundancy Group Form (NNMi Advanced)" (on page 214)

n "Router Redundancy Member Form (NNMi Advanced)" (on page 216)

n "NodeGroup Form" (on page 228)

n "Interface Group Form" (on page 236)
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Tip: A form is also available for incidents, see "Incident Form" (on page 300).

Note: The SNMP Agent form is also accessed from the Node form. The Port form is also accessed
from the VLAN form.

From a map view, to view all details associated with an object:
1. Display amap using the Topology Maps or Troubleshooting workspace, or theActions→

menu.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Note: If themap requires a starting node before it displays, enter the name or
IP Address for the starting node you want to use.

2. After themap displays, select the object and click the  Open icon in themenu bar.

3. The form displays, containing details of all information related to the object.

4. View or edit the details of the selected object.

To access the Analysis Pane from a table view:

1. Select the workspace of interest (for example, Inventory).

2. Select the view that contains the object of interest (for example, theNodes view).

3. Select the row that contains the object of interest.

4. NNMi displays detailed information at the bottom of the view in the Analysis Pane.

To access the Analysis Pane in a map view:

1. Select the workspace of interest (for example, Topology Maps).

2. Select amap view (for example, select Routers).

Note: If themap requires a starting node before it opens, enter the name or
IP Address for the starting node you want to use.

3. Click themap object of interest.

4. NNMi displays detailed information at the bottom of the view in the Analysis Pane.

To access the Analysis Pane in a form:

l Click the form's toolbar Show Analysis icon to display information about the current form's
top-level object in the Analysis Pane.

Note: Show Analysis always displays the top-level object's information.

l Click a row in a table on one of the form's tabs to display detailed information about the selected
object in the Analysis Pane.

NNMi displays detailed information at the bottom of the form in the Analysis Pane. SeeWorking
with Objects for more information about forms.

Note the following: 
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l Look for one of the following at the bottom of the display area:

Open the Analysis Pane if necessary by clicking the expand button.

l Place your mouse cursor over the title bar to display the ↕ symbol, then resize as necessary.

l The Analysis Pane remains blank until an object is selected.

l If you select multiple objects or clear a selection, NNMi retains the Analysis Pane's contents.

l If you change views, NNMi clears the Analysis Pane.

l Click any Refresh icon in the Analysis Pane to update a subset of displayed information.

l NNMi automatically refreshes the entire Analysis Pane's contents when you save a form.

l TheGauges tab shows real-time SNMP gauges to display State Poller and Custom Poller
SNMP data.

n These gauges are displayed for Nodes, Interfaces, Custom Node Collections, and for Node
Components of type CPU, Memory, Buffers, or Backplane.

n NNMi displays a gauge for each significant MIB Object Identifier (OID) that the node or
interface supports, up to the default maximum of 24.

Tip: If you are an NNMi administrator, for information about using the nms-
ui.properties file to change this default, see the "NNMi Console" chapter in theHP
Network NodeManager i Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

n Each gauge displays the current OID value, using the default refresh rate of 15 seconds. (If
you are an NNMi administrator, for information about using the nms-ui.properties file to
change this default, see the "NNMi Console" chapter of theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.)

n The value range displayed indicates the OID minimum andmaximum values that NNMi has
encountered.

n For any gauge that tracks percentage values, NNMi uses a red line to indicate where the OID
value is near 100 percent.

n There is not a one-to-onematch between theOIDs used to analyzemonitoring thresholds and
those displayed in the Analysis Pane. For example, the Analysis Panemight display aCisco
Memory Pool OID value that does not match the value used to calculate whether the
Memory UtilizationMonitored Attribute threshold is reached or exceeded. This is because
some thresholdmetrics require more complex calculations than a single OID allows. 

Tip: If a gauge label appears to be a duplicate value, mouse over the label to view the
more complete tooltip name that appears. (If you are an NNMi administrator, to change
the gauge title from the NNMi component name to the SNMP MIB variable name, see the
"Maintaining NNMi" chapter of theHP Network NodeManager i Software Deployment
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Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.)

n To launch an SNMP LineGraph for the selectedmetric, click the icon that appears at the
bottom of each gauge.

n To select and copy the tooltip information, double-click the gauge. NNMi opens a text window
that enables you to select and copy the tooltip information.

Related Topics:

Using Table Views

UsingMap Views

Node Form
The Node form provides details about the selected node. It also provides details about the
interfaces, the IP addresses, the ports, the VLAN ports, the SUMP agent, the device profile, and
the incidents associated with this node.

If your role permits, you can use this form tomodify theManagement Mode for a node (for example
to indicate it will be temporarily out of service) or add notes to communicate information about this
node to your team.

For information about each tab:

Attribute Description

Name The dynamically generated name assigned to this device.

The NNMi administrator configures how NNMi populates this attribute through
two configuration settings: (1) TheNode Name Resolution attributes in
Discovery Configuration (full or short DNS name, full or short sysName,
IP address). (2) The Namemight be converted to all uppercase or all lowercase
(depending on how the NNMi administrator configured settings in the nms-
topology.properties file). See the "Modifying NNMi Normalization
Properties" section of theHP Network NodeManager i Software Deployment
Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

This name is used in table views andmaps.

Hostname The fully-qualified hostname currently stored in the NNMi database for this device
(according to any hostname resolution strategy currently in use in your network
environment; for example, DNS). 

NNMi follows a set of rules to dynamically generate the value stored in the NNMi
database for each Node's Hostname. Click here for details.

Note: If DNS is the source of the Node's Hostname, the actual Hostname

Basic Attributes
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Attribute Description

might be converted to all uppercase or all lowercase before it is added to the
NNMi database (depending on how the NNMi administrator configured
settings in the nms-topology.properties file). See the "Modifying
NNMi Normalization Properties" section of theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

l If the Node supports SNMP, NNMi requests the Hostname using the IP
Address of the associated SNMP agent (theManagement Address attribute
value on the Node form).

When the NNMi administrator chooses Enable SNMP Address
Rediscovery in the Communication Configuration:

n If the SNMP Agent does not respond, NNMi checks for another
Management Address to request the Hostname, and the Hostname could
change.

n If the SNMP Agent associated with the node changes, theManagement
Address and Hostname could change.

When the NNMi administrator disables Enable SNMP Address
Rediscovery in the Communication Configuration:

n If the SNMP Agent does not respond, NNMi uses the previously gathered
Management Address attribute value to request the Hostname.

n If the SNMP Agent associated with the node changes, NNMi uses the
previously gatheredManagement Address attribute value to request the
Hostname.

l If the Node does not support SNMP, noManagement Address is available.
NNMi requests a Hostname starting with the lowest IP Address associated
with the node (a Discovery Seed value or an IP address value gathered from a
neighboring device). NNMi uses the first Hostname provided. The Hostname
might change during a future discovery cycle.

Management
Address

IP address NNMi uses to communicate with this node through SNMP. This is the
IP address of the device's SNMP agent.

TIP: The NNMi administrator can specify an address (Communication
Configurations workspace, Specific Node Settings tab), or NNMi can
dynamically select one.

When NNMi first discovers a node, the seed address (provided by the NNMi
administrator) or discovered address (for non-seeded nodes) becomes the initial
Management Address of the node. After NNMi builds an inventory of all IP
addresses associated with the node, NNMi follows a set of rules to determine
which address is the best choice as the node's Management Address. Click here
for details.

Basic Attributes, continued
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Attribute Description

Note: With NNMi Advanced, the NNMi administrator specifies whether NNMi
prefers IPv4 or IPv6 addresses when selecting theManagement Address.
See Configure Default SNMP, Management Address, and ICMP Settings.

1. NNMi ignores the following addresses when determining whichManagement
Address is most appropriate:

n Any address of an administratively-down interface.

n Any address that is virtual (for example, VRRP1).

n Any IPv4Anycast Rendezvous Point IP Address2 or IPv6 Anycast
address.

n Any address in the reserved loopback network range. IPv4 uses 127/24
(127.*.*.*) and IPv6 uses ::1.

n Any IPv6 link-local address3.

2. If the NNMi Administrator specifies Enable SNMP Address Rediscovery in
Communication Configuration, NNMi prefers the last-knownManagement
Address (if any).

3. If theManagement Address does not respond and the NNMi Administrator
specifies Enable SNMP Address Rediscovery in Communication
Configuration, NNMi uses the Communication Configuration settings for
Management Address Selection. The NNMi Administrators chooses the
order in which NNMi checks the following:

n Seed IP / Management IP - If the NNMi Administrator configures a Seed,
NNMi uses the Seed address (either a specified IP address or the DNS
address associated with a specified hostname) only during initial
Discovery. NNMi then requests the current Management Address (the
address from which the node's SNMP Agent responds) and uses that IP
address for all communication after initial discovery.

n Lowest Loopback - If a node supports multiple loopback address4,
NNMi queries each loopback addresses, starting with the lowest number.

Basic Attributes, continued

1Virtual Router Redundancy Protocol
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network
configurations.
3A non-routable IPv6 unicast address only used for communication with other nodes on the same
link (LAN or VLAN). Link local addresses cannot be used for communication that must be
forwarded through a router. IPv6 auto-configuration automatically assigns a unique link local
address in the fe80::/10 address space to each IPv6-enabled interface on a system.
4The address associated with the loopback interface. The loopback interface is a virtual interface
on a device that provides a route for internal communication. Many vendors provide a specially
configured loopback for management purposes. Exact details of how loopbacks are configured
varies by vendor andmodel. See each device's documentation for details. NNMi identifies these
loopback addresses by using ifType Number 24, softwareloopback from the IANA ifType-MIB.
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Attribute Description

NNMi uses the loopback address with the lowest number from which the
SNMP agent responds (for example, 10.16.42.197 is a lower number than
10.16.197.42).

n Highest Loopback - If a node supports multiple loopback address1,
NNMi queries each loopback addresses, starting with the highest number.
NNMi uses the loopback address with the highest number from which the
SNMP agent responds.

n InterfaceMatching - The NNMi Administrator chooses which interface
MIB variable NNMi queries to detect changes. NNMi can use the
followingMIB-II attribute values: ifIndex, ifName, ifDescr,
ifAlias, or a combination of these (ifName or ifDescr, ifName or
ifDescr or ifAlias).

4. If no response, NNMi queries any remaining IP addresses in the node's IP
address inventory, starting with the lowest number. NNMi uses the address
with the lowest number from which the SNMP agent responds.

5. If no response, NNMi checks for any Mapped Address configured for one of
the currently known addresses (see theMapped Address column in the
Custom IP Addresses view).

Note: The address represents a static Network Address Translation
(NAT) pair's external IP address from the internal/external IP address
pair. NNMi Administrators configure these pairs using the Overlapping
IP Address Mapping form. NNMi uses this list of addresses starting with
IPv4 from low to high, then IPv6 from low to high.

6. If no response, NNMi might be configured to repeat the sequence using
SNMPv1, SNMPv2c, or SNMPv3 in the order specified by the NNMi
administrator (Communication Configurations SNMP Minimum Security
Level settings).

7. When all else fails, NNMi retains the last knownManagement Address (if
any) and automatically changes the State of that SNMP Agent object to
Critical.

This process is repeated during each Spiral Discovery cycle, and the
Management Address can change. For example, NNMi's inventory of addresses
for the node expands, or the current Management Address does not respond to
SNMP queries due to network problems or node reconfiguration. The NNMi
administrator can prevent changes to themanagement address using the

Basic Attributes, continued

1The address associated with the loopback interface. The loopback interface is a virtual interface
on a device that provides a route for internal communication. Many vendors provide a specially
configured loopback for management purposes. Exact details of how loopbacks are configured
varies by vendor andmodel. See each device's documentation for details. NNMi identifies these
loopback addresses by using ifType Number 24, softwareloopback from the IANA ifType-MIB.
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Attribute Description

Communication Configurations Enable SNMP Address Rediscovery orPreferred
Management Address setting.

If this field shows unexpected results:

l Use theActions→ Polling→Configuration Poll command to gather the
most current information about this node.

Tip: You can right-click any object in a table or map view to access the
Actionsmenu.

l Check with your NNMi administrator. The NNMi administrator can configure a
specific management address for this node in the Communication
Configuration settings.

Note: If the device does not support SNMP, this field is empty.

Status Overall status for the current node. NNMi follows the ISO standard for status
classification. See the "Node Form: Status Tab" (on page 85) for more
information. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

The status of all IP addresses and the SNMP Agent associated with this node
contribute to node status. For information about how the current status was
determined, see the Conclusions tab. Status reflects themost serious
outstanding conclusion. See "Watch Status Colors" (on page 274) for more
information about possible status values.

Note: The icons are displayed only in table views.

Node
Management
Mode

Indicates whether the current node is beingmanaged. This field also lets you
specify whether a node is temporarily out of service. Possible values are:

Managed – Indicates the node is managed by NNMi.

Not Managed – Indicates the node is intentionally not managed. For
example, the nodemight not be accessible because it is in a private network.

Basic Attributes, continued
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Attribute Description

NNMi does not update discovery information or monitor these nodes.

Out of Service – Indicates a node is unavailable because it is out of service.
NNMi does not update discovery information or monitor these nodes.

This attribute is useful for notifying NNMi when a device has been temporarily out
of service, or should never bemanaged.

(NNMi Advanced - Global Network Management feature) Any change to the
Node's Management Mode setting is immediately sent from aRegional Manager
(NNMi management server) to the Global Manager. (Changes toManagement
Mode for other objects are sent during the next Spiral Discovery cycle on the
Regional Manager.)

Note: If the NNMi Security configuration permits, you can change this setting
usingActions→Management Mode. To change theManagement Mode
back toManaged for the selected Node object and change the
Management Mode back toManaged or Inherited for all associated
interfaces and addresses, use theActions→Management Mode→
Managed (Reset All).

Device
Profile

Name of the device profile that determines how devices of this type aremanaged
and the icon and background shape displayed onmaps.

Click the  Lookup icon and select  Open to display the "Device Profile
Form" (on page 108) for more information.

Tenant Tenants enable NNMi administrators to partition a network across multiple
customers.

A Tenant is the top-level organization to which a Node belongs.

NNMi administrators can use this drop-down to change the Tenant assignment
for a Node, or use the  Lookup icon and select  New to create a new
Tenant. Use caution when changing the Tenant assignment, see Change Tenant
Assignment for a Node.

Devices that belong to the Default Tenant can have Layer 2 Connections to any
device in any Tenant. Devices within any Tenant other thanDefault Tenant can
have Layer 2 Connections only to devices within the same Tenant or the Default
Tenant.

Security
Group

Security GroupMappings specify which User Groups have access a node. NNMi
users see only those nodes assigned to their Security GroupMapping. You see a
node and its associated incidents only if one of the User Groups to which you
belong is mapped to that node's Security Group.

NNMi administrators assign each node to a Security Group. Each node is
associated with only one Security Group. An NNMi administrator can use this
attribute to change the Security Group for a node.

Note: This attribute displays after the NNMi administrator defines more than one

Basic Attributes, continued
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Attribute Description

Security Group.

NNMi
Management
Server

(NNMi Advanced) This attribute only appears if the Global Network Management
feature is enabled and you are using aGlobal Manager. See "NNMi's Global
Network Management Feature (NNMi Advanced)" (on page 20) for more
information.

Local = The NNMi management server you are currently signed into.

<name> = The name your NNMi administrator assigned to a Regional Manager
(NNMi management server). If you see a <name> value, it means that
you are currently signed into a Global Manager, and other NNMi
management servers report to this NNMi management server.

Basic Attributes, continued

Attribute Description

Agent Enabled Indicates whether this SNMP agent is set up for SNMP communication
in your network environment.

Agent SNMP State Indicates whether the SNMP Agent assigned to this node is available
and how NNMi is using SNMP to interact with this SNMP Agent.
Possible values are:

Normal – Indicates that the agent responds to SNMP queries.

Not Responding – Indicates that the SNMP agent does not
respond to SNMP queries.

Not Polled – Indicates that this SNMP Agent's address is
intentionally not polled, based on current Monitoring Configuration
settings, current Communication Configuration settings, or because
the parent Node is set to Not Managed or Out of Service. The SNMP
Agent’s address might or might not have an associated polling
policy.

No Polling Policy– Indicates that this SNMP Agent's address is
being polled, but no polling policy exists in any Monitoring
Configuration settings for this monitored attribute.

Unset – Currently not used by NNMi.

Note: State is determined by the State Poller Service. The current state
contributes towards the status calculation for the node. See the
Status tab for more information.

Management Address
ICMP State

Indicates whether NNMi is communicating with themanagement
address. Possible values are:

Responding – Indicates that themanagement address is being
polled and is responding to an ICMP ping.

SNMP Agent State Attributes
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Attribute Description

Not Responding – Indicates that themanagement address is being
polled, but is not responding to an ICMP ping.

The following values indicate NNMi encountered trouble while trying to
gather the required data:

No Polling Policy - No polling policy exists in Monitoring
Configuration settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled,
based on current Monitoring Configuration settings, current
Communication Configuration settings, current polling policies, or
because the parent Node is set to Not Managed or Out of Service

Unavailable - Unable to determine the State. For example, the
ICMP poll returned a value outside the range of possible values or
returned a null value.

Unset – Currently not used by NNMi.

Note: NNMi's State Poller determines the State. The current state
contributes towards the status calculation for the SNMP Agent.

See the "SNMP Agent Form: Status Tab" (on page 101) tab for more
information.

Management Address
ICMP Response
Time

Note: Enable Management Address ICMP Pollingmust be selected.
See "Interface Form: Performance Tab (HP Network Node
Manager iSPI Performance for Metrics Software)" (on page 135)
for more information.

Indicates the State of the ICMP response time between the
management station and the selected node. Possible values are:

Unavailable - Unable to determine the State. For example, the
ICMP poll returned a value outside the range of possible values or
returned a null value.

Nominal - Indicates the ICMP response time was between 0 and
the configured High Value.

High - Indicates a higher than configured ICMP response time
between themanagement station and the selected node.

Management Address
ICMP Response
Time Baseline

HP Network NodeManager iSPI Performance for Metrics Software
only.

Note: Enable Node Component Performance Pollingmust be
selected. See "Interface Form: Performance Tab (HP Network
NodeManager iSPI Performance for Metrics Software)" (on page
135) for more information.

SNMP Agent State Attributes, continued
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Attribute Description

Indicates the ICMP response time between themanagement station and
the selected node is abnormal based on the computed baseline.
Possible values are:

Abnormal Range – Indicates State Poller has collected values
outside the normal range when compared to the baseline data
collected for themanagement address response time.

Normal Range - Indicates State Poller collected values within the
normal range when compared to the baseline data collected for the
management address response time.

State Last Modified The date and time when the State value was last modified.

Notes (NNMi Advanced - Global Network Management feature) The text you
enter here is not sent from aRegional Manager (NNMi management
server) to the Global Manager. NNMi administrators for the Global
Manager can add notes that are stored in the NNMi database on the
Global Manager.

Provided for network operators to use for any additional notes required to
further explain the node. Informationmight include why the node is
important, if applicable, or to what customer, department, or service the
node is related. Additional informationmight include where the nodes is
located, who is responsible for it, and its serial number. Youmight also
track maintenance history using this attribute.

Type amaximum of 1024 characters. Alpha-numeric, spaces, and
special characters (~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Note: You can sort your node table views based on this value.
Therefore, youmight want to include keywords for this attribute
value.

SNMP Agent State Attributes, continued

Node Form: General Tab
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

Attribute Description

System
Name

TheMIB II sysName value returned from the device's SNMP agent. This attribute
is set by the device administrator.

If sysName is part of the strategy used to populate the node Name attribute value,
NNMi avoids populating the NNMi database with multiple devices having the same
manufacturer's default name by following a set of rules. Click here for details.

For each device type, NNMi has a Device Profile that includes a record of the

SNMP Values
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Attribute Description

manufacturer's default sysName. Other settings within the Device Profile can
change the way NNMi determines sysName values.

To view the Device Profile associated with this node, locate the Device Profile
attribute in the Basics section of the Node form, and click the   Lookup icon.
Your NNMi administrator canmake changes to a Device Profile, if necessary.

System
Contact

Optional MIB-II sysContact value. This attribute is set by the device administrator.
It usually includes the contact person for themanaged node as well as information
about how to contact this person.

System
Location

Optional MIB sysLocation value for the physical location of the current node. For
example, Building K, 3rd floor. This attribute is set by the device administrator.

System
Object ID

MIB-II sysObjectID value provided by the vendor. This value identifies the device
vendor, type, andmodel. For example, all Cisco 6509 devices have the same
system object ID.

System
Description

Optional MIB-II sysDescr value for the device description. This attribute is set by
the device administrator.

SNMP
Agent

Name used to identify the SNMP agent. This name is the hostname of the node (as
stored in the NNMi database). NNMi chooses the hostname of the parent node
according to the criteria specified by your NNMi administrator (see Hostname
attribute information).

Click the  Lookup icon and select  Open to display the "SNMP Agent Form"
(on page 94) for more information.

SNMP Values, continued

Attribute Description

Discovery
State

Current discovery status for the node. Possible values are:

Newly Created – Indicates the node's hostname and associated IP addresses are
in the NNMi database, but NNMi needs to collect more information before
determining state, status, and connectivity to other devices in your network
environment.

Discovery Completed – Indicates that NNMi collected all of the required
information about the node.

Rediscovery in Process – Indicates NNMi is updating information about the node.

Last
Completed

Time of the last discovery cycle.

Discovery Attribute

Node Form: IP Addresses Tab
The "Node Form" (on page 48) provides details about the selected node.

NNMi Advanced. This table could include all associated IPv4 addresses and IPv6 addresses.
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For information about each tab:

Attribute Description

IP
Addresses

Table view of the IP addresses associated with the selected node. You can use this
table to determine the status, state, address, interface, and subnet for each address
associated with the selected node.

Double-click the row representing an IP address. The "IP Address Form" (on page
153) displays all details about the selected IP address.

IP Addresses Table

Node Form: Interfaces Tab
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

Attribute Description

Interfaces Table view of all of the interfaces associated with the current node. You can use this
table to determine the status, administrative state, operational state, name, type,
interface speed, and Layer 2 Connection for each interface associated with the
selected node.

Double-click the row representing an interface. The "Interface Form" (on page 114)
displays all details about the selected interface.

Interfaces Table

Node Form: Cards Tab
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

Attribute Description

Cards Table view of all of the cards associated with the current node.

Double-click the row representing a Card. The "Card Form" (on page 164) displays all
details about the selected Card.

Cards Table

Node Form: Ports Tab
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

Attribute Description

Ports Table view of all of the ports associated with the selected node. Use this table to
access information about each port associated with the selected node.

Ports Table
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Attribute Description

Double-click the row representing a port. The "Port Form" (on page 177) displays all
details about the selected port.

Ports Table, continued

Node Form: VLAN Ports Tab
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

(NNMi Advanced - Global Network Management feature) Theremight be slight differences between
the VLAN information shown on Regional Managers andGlobal Managers, because the VLAN
calculations use Layer 2 Connections data.

Attribute Description

VLAN
Ports

Table view of all of the VLAN ports associated with the current node. Use this table to
determine all port and VLAN combinations associated with this node.

Double-click the row representing a VLAN port. The "VLAN Port Form" (on page 59)
displays all details about the selected VLAN port.

VLAN Ports Table

VLAN Port Form

The VLAN Port form provides details about the VLAN port you selected on the Node or Interface
form. The following table describes the fields included on the VLAN Port form.

Attribute Description

Local
VLAN
Name

VLAN connections are determined by a common VLAN Id. The name assigned to that
VLAN can be designated by each participating Node/Interface's configuration
settings for that VLAN Id.

Local VLAN Name = the VLAN name assigned by the configuration settings on the
currently selected Node/Interface.

Tip: If you see an attribute namedGlobal VLAN name = NNMi uses the lowest sort-
order name from all available names designated by member Nodes assigned to
that VLAN.

VLAN Id The identification value for the current VLAN. This value is taken directly from the
MIB file provided by the Vendor.

Click the  Lookup icon and select  Show Analysis or  Open to display more
information about the VLAN.

Port
Name

The port name consists of <Card-number / Port-number>.

Click the  Lookup icon and select  Show Analysis or  Open to display more
information about the VLAN.

Basic Attributes
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Related Topics:

"Node Form" (on page 48)

"Interface Form" (on page 114)

"VLAN Form" (on page 162)

Node Form: Router Redundancy Group Tab (NNMi Advanced)
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

Attribute Description

Router
Redundancy

Table view of all of the Router Redundancy Groups associated with the current
Node. Use this table to determine all Router Redundancy Groups to which the
current Node belongs.

Double-click the row representing a Router Redundancy Group. The "Router
Redundancy Group Form (NNMi Advanced)" (on page 214) displays all details
about the selected Router Redundancy Group.

Router Redundancy Table

Node Form: Capabilities Tab
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

The Node Form: Capabilities Tab displays a table view of any capabilities added to the node
object by NNMi or an external application. Capabilities enable NNMi and application programmers
to providemore information about a node than is initially stored in the NNMi database.

For example, NNMi Advanced uses the capability com.hp.nnm.capability.rrp.hsrp
when a node is amember of anHSRP1 group.

Note: Because the values are generated by NNMi or an external application, Capability values
cannot bemodified.

(NNMi Advanced - Global Network Management feature) Any Capability values added by an NNM
iSPI are available on the Global Manager only if that iSPI is also running on theGlobal Manager.

Attribute Description

Capability Table of all of the capabilities associated with the selected Node. Use this table to
access information about each Capability.

Double-click the row representing a Node Capability to open the "Node Capability
Form" (on page 64) and view more information.

For more information, see "Node Capabilities Provided by NNMi" (on page 61).

Capabilities Table

1Hot Standby Router Protocol
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Node Capabilities Provided by NNMi

The "Node Form: Capabilities Tab" (on page 60) displays a table of any Capabilities added to a
particular node object. Capabilities enable NNMi and application programmers to providemore
information about a node than what is initially stored in the NNMi database. For more information,
click any of the following:

l Basic Node Capability Attribute Values

l NodeComponent Capability Attribute Values that are assigned to Nodes (*)

These Node Capabilities assist in determining Node Component metrics. See "Node Form:
Node Component Tab" (on page 66) for more information about health metrics.

l Card Capability Attribute Values that are assigned to Nodes (*)

l NNMi Advanced: Router Redundancy Protocol Capability Attribute Values

l NNMi Advanced: VMware ESX/ESXi Host and Virtual Machine Capability Attribute Values

External applications can also add Capabilities.

The CISCO-STACK-MIB is associated with multiple Capabilities because NNMi uses the CISCO-
STACK-MIB for both card andmetrics data.

KEY: com.hp.<product>.capability.<content>.<vendor/org>.<MIB/feature>

Any Capability provided by NNMi begins with the prefix com.hp.nnm.capability.

<product> = Either NNMi or the NNM iSPI providing this capability.

<content> = card, ipaddr (address), iface (interface), lag (Link Aggregation1 interface), node,
rrp (Router Redundancy), or metric (Node Sensor, Component Health, Component and
DeviceMetrics).

<vendor/org> = Standards organization or vendor defining theMIB or feature associated with the
capability.

<MIB/feature> = What this capability measures.

Note: The following tables show a few examples of the Capabilities provided by NNMi.

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Unique Key Capability Description

com.hp.nnm.capability.node.ipforwarding IP
Forwarding
(Layer 3)

Value that indicates
NNMi identified the
selected node as a router
that forwards Layer 3
data. NNMi evaluates
SNMP MIB-II
sysServices and other
clues to determine this
value and set the symbols
in map views. The NNMi
administrator can override
this value using the
Device Profile form,
Force Device attribute
(see "Device Profile
Form" (on page 108)).

com.hp.nnm.capability.node.lanswitching LAN
Switching
(Layer 2)

Value that indicates
NNMi identified the
selected node as a switch
for Layer 2 data. NNMi
evaluates SNMP MIB-II
sysServices and other
clues to determine this
value and set the symbols
in map views. The NNMi
administrator can override
this value using the
Device Profile form,
Force Device attribute
(see "Device Profile
Form" (on page 108)).

Basic Node Capability Attribute Values

Unique Key Capability
Descrip-
tion

com.hp.nnm-
.capability.rams.node.ramsmplswancenode

MPLS WAN CE N-
ode

(NNMi
Advanced)
The node
supports
HP Router
Analytics
Man-
agement
System
(RAMS)
andMPLS
WAN.

Node Component Capability Attribute Values that are assigned to Nodes
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Unique Key Capability Description

com.hp.nnm.capability.card.ietf.entity IETF
Entity

NNMi discovers but
cannot monitor using
the Internet
Engineering Task
Force (IETF)
ENTITY-MIB.

com.hp.nnm.capability.card.ietf.entitystate IETF
Entity
State

The node supports
cardmonitoring
using the Internet
Engineering Task
Force (IETF)
ENTITY-STATE-
MIB.

Card Capability Attribute Values that are assigned to Nodes

Unique Key Capability Description

com.hp.nnm.capability.rrp.vrrp VRRP NNMi Advanced. The node is a
member of a Virtual Router
Redundancy Protocol (VRRP)group.

NNMi Advanced: Router Redundancy Protocol Capability Attribute Values

Unique Key Capability Description

com.hp.nnm.capability.node.VM Virtual
Machine

NNMi
Advanced.
The node is a
virtual
machine
being hosted
on a VMware
ESX/ESXi
server.
Nodes with
this capability
become a
member of
the Node
Group named
Virtual
Machines.

com.hp.nnm.capability.node.hypervisor.vmware.ESX VMware
ESX Host

NNMi
Advanced. A
VMware

NNMi Advanced: VMware ESX/ESXi Host and Virtual Machine Capability Attribute
Values
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Unique Key Capability Description

ESX/ESXi
server that is
hosting
virtual
machines.
Nodes with
this capability
become a
member of
the Node
Group named
VMware ESX
Hosts.

NNMi Advanced: VMware ESX/ESXi Host and Virtual Machine Capability Attribute
Values, continued

Node Capability Form

This form describes a capability added to the node object by NNMi or an external application.
Capabilities enable NNMi and application programmers to providemore information about a node
than what is initially stored in the NNMi database.

For example, NNMi Advanced uses the capability com.hp.nnm.capability.rrp.hsrp to
identify when a node is amember of anHSRP1 group.

Note: Because the values are generated by NNMi or an external application, Capability values
cannot bemodified.

(NNMi Advanced - Global Network Management feature) Any Capability values added by an NNM
iSPI are available on the Global Manager only if that iSPI is also running on theGlobal Manager.

Attribute Description

Capability Label used to identify the Capability that was added to the node object.

"Node Form: Capabilities Tab" (on page 60) shows a list of all available Capabilities
for that node.

For more information, see "Node Capabilities Provided by NNMi" (on page 61).

Unique
Key

Used as a unique identifier for the Capability. Any capability provided by NNMi
begins with the prefix com.hp.nnm.capability.

For more information, see "Node Capabilities Provided by NNMi" (on page 61).

Node Capability Attributes

1Hot Standby Router Protocol
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Node Form: Custom Attributes Tab
Custom Attributes enable an NNMi administrator to add information to the Node object . Custom
Attributes can also be set by external applications that have been integrated with NNMi.

The Node Form: Custom Attributes Tab displays a table view of any Custom Attributes that have
been added to the selected node. For example, your NNMi administrator might have addedSerial
Number as another attribute for the nodes in your network.

Note: If your role permits, you can edit a Custom Attribute. Only users assigned to the NNMi
Administrator role can add a Custom Attribute.

For information about each tab:

(NNMi Advanced - Global Network Management feature) Custom Attribute values are not sent from
aRegional Manager (NNMi management server) to the Global Manager. NNMi administrators for
the Global Manager can configure Custom Attribute values that are stored in the NNMi database on
theGlobal Manager.

Attribute Description

Name Name used to identify the Custom Attribute.

Value The actual value for the Custom Attribute for the selected node. For example, the
value for theSerial Number attributemight be: UHF536697J3. For more information,
see "Node Custom Attributes Form" (on page 65).

Custom Attributes Table

Node Custom Attributes Form

Custom Attributes enable an NNMi administrator to add information to a node object. For example,
your NNMi administrator might have addedSerial Number as another attribute for the nodes in
your network. Custom Attributes can also be set by external applications that have been integrated
with NNMi.

The Custom Attributes form displays the Name and Value for each of the Custom Attributes that
were added to the node object. Each of these attributes is described in the table below.

(NNMi Advanced - Global Network Management feature) Custom Attribute values are not sent from
aRegional Manager (NNMi management server) to the Global Manager. NNMi administrators for
the Global Manager can configure Custom Attribute values that are stored in the NNMi database on
theGlobal Manager.

Attribute Description

Name Name used to identify the Custom Attribute. This name appears in the table view on
the Custom Attributes tab in Node forms.

Value Value assigned to the Custom Attribute for the selected node. For example, the value
for theSerial Number attributemight be: UHF536697J3.. For more information, see
"Node Form: Custom Attributes Tab" (on page 65).

Basics Attributes
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Node Form: Node Groups Tab
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

Attribute Description

Node
Groups

Table view of all NodeGroups to which this node belongs.

Double-click the row representing a NodeGroup. The "NodeGroup Form" (on page
228) displays all details about the selected NodeGroup.

Node Groups Table

Node Form: Node Component Tab
The "Node Form" (on page 48) provides details about the selected node.

The Node Form: Node Component tab displays information about node health related to the
following fault metrics:

l Fan

l Power Supply

l Temperature

l Voltage

(HP Network NodeManager iSPI Performance for Metrics Software) If the HP Network Node
Manager iSPI Performance for Metrics Software software is installed and configured within your
environment, the Node Form: Node Component tab also displays information about node health
related to the following performancemetrics:

l CPU utilization

l Memory utilization

l Buffer utilization

l Buffer miss rate

l Buffer failure rate

For information about each tab:

Attribute Description

Node
Components

Table view of the health metrics associated with the current node. You can use
this table to determine the Status, Name, and Type for each Node Component
metric associated with the selected node.

Double-click the row representing a Node Component. The "Node Component
Form" (on page 67) displays all details about the selected Node Component.

Node Component Table
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Node Component Form

This form describes the fault and performancemetrics used tomonitor Node Components. NNMi
obtains fault metrics from the node's MIB files. The NNMi administrator can set threshold values for
only the performance health metrics displayed.

Fault metrics include the following:

Note: The NNMi administrator cannot set threshold values for fault metrics.

l Fan

l Power Supply

l Temperature

l Voltage

(HP Network NodeManager iSPI Performance for Metrics Software) The following performance
metrics require an HP Network NodeManager iSPI Performance for Metrics Software license:

Note: The NNMi administrator can set threshold values for performancemetrics.

l CPU utilization

l Memory utilization

l Buffer utilization

l Buffer failures

l Buffer misses

For information about each tab:

Attribute Description

Status Overall status for the current node. NNMi follows the ISO standard for status
classification. See the "Node Component Form: Status Tab " (on page 73) for
more information. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

For information about how the current status was determined, see the

Basic Attributes
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Attribute Description

Conclusions tab. Status reflects themost serious outstanding conclusion. See
"Watch Status Colors" (on page 274) for more information about possible status
values.

Note: The icons are displayed only in table views.

Name Name of the node component that has the health attribute beingmeasured, For
example, NNMi measures fault metrics for Fan, Power Supply, Temperature, and
Voltage node components.

(HP Network NodeManager iSPI Performance for Metrics Software) If licensed
and installed, HP Network NodeManager iSPI Performance for Metrics Software
alsomeasures performancemetrics for CPU, memory, and buffer utilization, as
well as for buffer failures andmisses.

When possible, NNMi obtains the Name value for the node component from the
associatedMIB file. The number of MIBs available and subsequently the number
of health attributes that aremeasured for each node component vary. For
example, if the node component is of type Buffer, up to fiveMIBs that contain
information about the Buffer component are available (Small, Medium, Large, Big,
and Huge). NNMi collects information from eachMIB that is available and lists a
node component Name value for each. For example, If all fiveMIBs are available,
you see the following node components listed in the Node Component table:
Small Buffers, Medium Buffers, Large Buffers, Big Buffers, and Huge Buffers.

Note: If the associatedMIB file does not provide a name value, NNMi uses the
value contained in the Type attribute.

Type Identifies the aspect of node health that is beingmonitored. Possible values
include:

l Fan

l Power Supply

l Temperature

l Voltage

(HP Network NodeManager iSPI Performance for Metrics Software) The
following performance types require an HP Network NodeManager iSPI
Performance for Metrics Software license:

l CPU utilization

l Memory utilization

l Buffer utilization

l Buffer failures

l Buffer misses

Management Indicates whether the current node is beingmanaged. This field also lets you

Basic Attributes, continued
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Attribute Description

Mode specify whether a node is temporarily out of service. Possible values are:

Managed – Indicates the node is managed by NNMi.

Not Managed – Indicates the node is intentionally not managed. For
example, the nodemight not be accessible because it is in a private network.
NNMi does not update discovery information or monitor these nodes.

Out of Service – Indicates a node is unavailable because it is out of service.
NNMi does not update discovery information or monitor these nodes.

This attribute is useful for notifying NNMi when a device has been temporarily out
of service, or should never bemanaged.

Note: If the Security configuration permits, you can change this setting using
Actions→Management Mode.

Tip: You can right-click any object in a table or map view to access the
Actionsmenu.

Direct
Management
Mode

Indicates whether the current node component is beingmanaged. This attribute is
set by the administrator and specifies whether a node component should be
managed or whether a node component is temporarily out of service. Possible
values are:

Inherited – Used to indicate that the node component should inherit the
Management Mode from the node in which it resides.

Not Managed – Used to indicate that NNMi does not discover or monitor the
node component.

Out of Service – Used to indicate a node component is unavailable because
it is out of service. NNMi does not discover or monitor these node
components.

This attribute is useful for notifying NNMi when a node component, such as a fan,
is temporarily out of service, or should never bemanaged.

Note: If you change the Direct Management Mode usingActions→
Management Mode, NNMi updates the calculatedManagement Mode on
the form. If youmanually set the Direct Management Mode and then Save
your changes, theManagement Mode value is not updated until you refresh
the form.

Hosted On
Node

Node on which the health metric is beingmeasured. This is the current value in
NNMi’s database for the Name attribute of the host device. The value could be a
DNS name, aMIB-II sysName, or an address (depending on how your NNMi
administrator configured the discovery process).

Basic Attributes, continued
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Node Component Form: Monitored Attributes Tab

The "Node Component Form" (on page 67) provides details about themonitored attributes for the
current node.  

For information about each tab:

Description

Table view of the Name and State of eachmonitored attribute associated with the selected Node
Component. Use this view to determine the State of themonitored attributes for the selected
node.

Double-click the row representing aMonitored Attribute. The "Node Component Monitored
Attribute Form" (on page 70) displays all details about the selectedMonitored Attribute.

Attributes Table

Node Component Monitored Attribute Form

TheMonitored Attribute form displays information about the attribute selected on the Attribute tab of
the "Node Component Form" (on page 67).

Fault metrics are available for the following Node Components:

l Fan

l Power Supply

l Temperature

l Voltage

NNMi obtains fault metric information from the associatedMIB.

(HP Network NodeManager iSPI Performance for Metrics Software) If the HP Network Node
Manager iSPI Performance for Metrics Software software is installed and configured within your
environment, the Node Form: Node Component tab also displays information about node health
related to the following performancemetrics. The NNMi administrator sets the threshold for node
components related to performancemetrics:

l Backplane

l Buffer

l CPU 

l Disk space

l Memory

Attribute Description

Name Name used to identify the attribute beingmonitored.

The number of attributes available vary depending on the number of MIBs available

Basics Attributes
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Attribute Description

for the current node component. See "Node Component Form" (on page 67) for more
information.

The Name of each health attribute identifies the attribute beingmeasured as well as
the type of MIB used to gather this information. For example, whenmonitoring
CPU utilization, NNMi uses values measured for 1-minute, 5-minute, and 5-second
intervals. Each of these values might be available from an old, standard, or most
recent (revised) MIB file. The following example health attribute names indicate the
CPU measurement interval as well as the fact that the information was collected from
themost recent (revised) MIB:

l CPU Revised 1Minute

l CPU Revised 5Minute

l CPU Revised 5 Second

Unique
Key

Used as a unique identifier for the Node Health Monitored Attribute. Any Node Health
Monitored Attribute provided by NNMi begins with the prefix com.hp.nms.

State Normalized value used to indicate the State of the attribute of the selected node.
Possible values are listed below.

Note: The NNMi State Poller interprets and normalizes the State value returned for
themonitored attribute to handle the differences between vendor-specific
nodes.

Normal - Indicates there are no known problems related to the associated object.

Warning - Indicates theremight be a problem related to the associated object.

Minor - Indicates NNMi has detected problems related to the associated object
that require further investigation.

Major - Indicates NNMi detected problems that could precede a critical situation.

Critical - Indicates NNMi detected problems that require immediate attention.

The following values indicate NNMi could not gather the required data:

Agent Error – Indicates an SNMP error was returned in response to an SNMP
query to this agent.

No Polling Policy - Indicates the object is being polled, but no polling policy
exists in Monitoring Configuration settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled, based on
current Monitoring Configuration settings, current Communication Configuration
settings, or because the parent Node is set to Not Managed or Out of Service.
This object attributemight or might not have an associated polling policy.

Unavailable - Unable to determine the State. For example, the SNMP agent

Basics Attributes, continued
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Attribute Description

returned a value outside the range of possible values or returned a null value.

Unset – Currently not used by NNMi.

Note: State is determined by the State Poller Service. Only the Fan and Power
Supply Node Components' States contribute towards the status calculation for
the node. See the Status tab for more information.

(HP Network NodeManager iSPI Performance for Metrics Software) Additional
States for performancemetrics include the following (Warning andCritical states
are not used for performancemetrics):

Abnormal Range – Indicates State Poller has collected values outside the
normal range when compared to the baseline data collected for the current object.

Normal - Indicates there are no known problems related to the associated object.

Normal Range - Indicates State Poller collected values within the normal range
when compared to the baseline data collected for the current object.

High - The High threshold was crossed.

Low - The Low threshold was crossed.

None - The threshold value returned is zero.

Last
Modified

Themost recent date and time when the State of this Monitored Attribute changed.

Basics Attributes, continued

Node Component Form: Incidents Tab

Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in
the incident view's column headings.

The "Node Component Form" (on page 67) provides details about themonitored attributes for the
selected node.

For information about each tab:

Description

Table view of the incidents associated with the selectedmonitored attribute. These incidents are
sorted by creation time so that you can view the incidents in chronological order. Use this view to
determine which incidents are still open for themonitored attribute.

Double-click the row representing an incident. The "Incident Form" (on page 300) displays all
details about the selected incident.

Incidents Table
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Node Component Form: Status Tab

The "Node Component Form" (on page 67) provides details about the selected health metric for the
current node. 

For information about each tab:

Attribute
Description

Status Overall status for the current node. NNMi follows the ISO standard for status
classification. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

Note: Your NNMi administrator might have disabled polling of Node Component
using theMonitoring Configuration workspace.

The status of the health metric associated with this node contributes to the node's
overall status. For information about how the current status was determined, see the
"Node Component Form: Conclusions Tab" (on page 74). Status reflects themost
serious outstanding conclusion. See "Watch Status Colors" (on page 274) for more
information about possible status values.

Note: The icons are displayed only in table views.

Status
Last
Modified

Date and time indicating when the status was last set.

Overall Status

Attribute
Description

Status
History

List of the last 30 changes in the status for the node component. This view is useful
for obtaining a summary of the node component status so that you can better
determine any patterns in behavior and activity.

Status History Table

HP Network NodeManager i Software (9.21)Page 73 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute
Description

Double-click the row representing a Status History. The Status History form displays
all details about the selected Status.

Status History Table, continued

Node Component Form: Conclusions Tab

The "Node Component Form" (on page 67) provides details about the selected health metric for the
current node.

For information about each tab:

Attribute Description

Outstanding
Status
Con-
clusions

The dynamically generated list of summary statuses of themonitored attribute
that contributed to the current overall status of the selected node. Status is set by
the Causal Engine.

Each Conclusion listed is outstanding and contributes to the current overall
Status.

This view is useful for obtaining a quick summary of the problem description for
the current monitored attribute that led up to the node component's most current
Status.

The status value is correlated based on themost critical conclusions.

Double-click the row representing a Status Conclusion. The Status Conclusion
form displays all details about the selected Status Conclusion.

The following table describes the possible Conclusions that might appear for a
node object.

Note: A Y in the Incident? column indicates that the Conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description Status
Inci-
dent?

BackplaneOutOfRangeOrMalfunctioning The
backplane
monitored
attributes
are outside
of the
threshold
range
configured

Crit-
ical

Y

Outstanding Status Conclusion Values
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Attribute Description

Conclusion Description Status
Inci-
dent?

for the
device.

BufferOutOfRangeOrMalfunctioning The buffer
pool
monitored
attributes
are outside
of the
threshold
range
configured
for the
device. This
incident
indicates
the buffer
pool is
exhausted
or cannot
meet the
demand.

Crit-
ical

Y

CpuOutOfRangeOrMalfunctioning Any of the
following
utilization
averages is
above the
threshold
range
configured
for the
device:

l CPU 5
second
util-
ization

l CPU 1
minute
util-
ization

l CPU 5

Crit-
ical

Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

minute
util-
ization

DiskOutOfRangeOrMalfunctioning The disk
monitored
attributes
are outside
of the
threshold
range
configured
for the
device.

Crit-
ical

Y

FanOutOfRangeOrMalfunctioning The fan
monitored
attributes
are outside
of the
threshold
range
configured
for the
device.

Crit-
ical

Y

MemoryOutOfRangeOrMalfunctioning The Source
Node's
memory
pool is
outside of
the
threshold
range
configured
for the
device.

This
incident
indicates
thememory
pool is
exhausted

Crit-
ical

Y

Outstanding Status Conclusion Values, continued

HP Network NodeManager i Software (9.21)Page 76 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute Description

Conclusion Description Status
Inci-
dent?

or cannot
meet the
demand for
use.

Pow-
erSupplyOutOfRangeOrMalfunctioning

A power
supply’s
monitored
attributes
are outside
of the
threshold
range
configured
for the
device.

Crit-
ical

Y

TemperatureOutOfRangeOrMalfunctioning The
specified
temperature
sensor on
the Source
Node is
outside of
the
threshold
range
configured
for the
device.

Crit-
ical

Y

VoltageOutOfRangeOrMalfunctioning The
specified
voltage on
one of the
Source
Node's
power
supplies is
outside of
the
threshold
configured
for the

Crit-
ical

Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

device.

Warning Status Conclusions

Conclusion Description Status Incident?

BackplaneAbnormal The backplane utilization is
abnormal based on the computed
baseline.

Warning Y

BufferAbnormal The buffer utilization is abnormal
based on the computed baseline.

Warning Y

CpuAbnormal The CPU utilization is abnormal
based on the computed baseline
for one of the following:

l CPU 5 second utilization

l CPU 1minute utilization

l CPU 5minute utilization

Warning Y

DiskAbnormal The disk space utilization is
abnormal based on the computed
baseline.

Warning Y

MemoryAbnormal Thememory utilization is
abnormal based on the computed
baseline.

Warning Y

Normal Status Conclusions

Conclusion Description Status Incident?

BackplaneInRangeAndFunctioning The backplane
monitored
attributes are
within the
threshold range
configured for the
device.

Normal N

BackplaneNormal The backplane
utilization is
normal based on
the computed

Normal N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

baseline.

BufferInRangeAndFunctioning The buffer pool is
operating within
the threshold
range configured
for the device.

Normal N

BufferNormal The buffer
utilization is
normal based on
the computed
baseline.

Normal N

CpuInRangeAndFunctioning All of the
following
utilization
averages are
within the
threshold range
configured for the
device:

l CPU 5
second
utilization

l CPU 1minute
utilization

l CPU 5minute
utilization

Normal N

CpuNormal The CPU
utilization is
normal based on
the computed
baseline for the
following:

l CPU 5
second
utilization

l CPU 1minute
utilization

l CPU 5minute

Normal N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

utilization

DiskInRangeAndFunctioning The disk
monitored
attributes are
within the
threshold range
configured for the
device.

Normal N

DiskNormal The disk space
utilization is
normal based on
the computed
baseline.

Normal N

FanInRangeAndFunctioning The specified fan
monitored
attributes are
within the
threshold range
configured for the
device.

Normal N

MemoryInRangeAndFunctioning The specified
memory pool is
operating within
the threshold
range configured
for the device.

Normal N

MemoryNormal Thememory
utilization is
normal based on
the computed
baseline.

Normal N

PowerSupplyInRangeAndFunctioning A power supply’s
monitored
attributes are
within the
threshold range
configured for the
device.

Normal N

TemperatureInRangeAndFunctioning The specified Normal N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

temperature
sensor on the
Source Node is
within the
threshold range
configured for the
device.

VoltageInRangeAndFunctioning The specified
voltage on one of
the Source
Node's power
supplies is within
the threshold
range configured
for the device.

Normal N

Outstanding Status Conclusion Values, continued

Node Component Form: Registration Tab

The "Node Component Form" (on page 67) provides details about the selected Node Component.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes

Node Form: Custom Polled Instances Tab
Tip: The "Custom Polled Instance Form" (on page 201) provides details about the selected Polled

Instance.

For information about each tab:
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(NNMi Advanced - Global Network Management feature) Any Custom Polled Instances are not
sent from aRegional Manager (NNMi management server) to the Global Manager. From theGlobal
Manager, useActions→Open from Regional Manager to see the list of Custom Polled
Instances on the Regional Manager.

Attribute Description

Node Name of the topology node from which the Custom Poller Policy information is
being collected. This is the current value in the NNMi database for the Name
attribute of the node. The value could be a DNS name, aMIB-II sysName, or an
address (depending on how your NNMi administrator configured the discovery
process).

State The State of the Custom Polled Instance as determined by any Thresholds (High
State / Low State value) or ComparisonMaps (StateMapping = the NNMi
administrator assigns a State value for each possible Polled Instance value)
configured for the current Custom Poller Collection's MIB Expression.

Possible State values for aPolled Instance (Threshold = High State/Low State; or
ComparisonMap = StateMapping) are:

Normal 

Warning

Minor

Major

Critical

Note: Themost severe Threshold High State or Low State value or Comparison
MapStateMapping value returned from the Polled Instances for a Custom
Node Collection becomes the Custom Node Collection Status.

MIB Variable Represents theMIB Expression that NNMi polls according to configuration
settings. Additional information associated with theMIB Variable includes the
MIB Expression Name and any Threshold settings configured for the Custom
Poller Collection.

Click the Lookup icon and select  Show Analysis or  Open to display
more information about theMIB Variable.

See "MIB Variable Form" (on page 361) for more information about theMIB
Variable attribute.

MIB
Instance

This attribute contains themultiple filtered instances for theMIB Expression.
Each instance value identifies a row in theMIB table.

Note: If a MIB Expression includes mulitple MIB Variables that havemultiple
instances, each instance value that is valid across all MIB Variables for a
node is listed here. If NNMi is unable to find the same instance for all MIB
Variables in the expression, a Polled Instance is not created. This is
because NNMi cannot correctly evaluate aMIB Expression with missing

Basics Attributes
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Attribute Description

values. If Polled Instances are not created as expected, check the Custom
Node Collection view for Discovery State and Discovery State Information
values.

Last State
Change
Value

The value from theMIB Expression that caused the State to change.

Note: A value of null indicates that a value was unavailable or an error occurred
while evaluating theMIB Expression.

State Last
Modified

The date and time the Polled Instance was last modified.

Basics Attributes, continued

Node Form: Diagnostics Tab (NNM iSPI NET)
(HP Network NodeManager iSPI Network Engineering Toolset Software) The "Node Form" (on
page 48) provides details about the selected node.

When you access the Node Form: Diagnostics Tab, you can view the history of all the HP Network
NodeManager iSPI Network Engineering Toolset Software Diagnostic reports that have been run
for this Node. Diagnostics are sets of automated commands specific to one or more device types,
including Cisco routers and switches, Cisco switch/routers, and Nortel switches.

To generate a new instance of these Diagnostics reports, click Actions→Run Diagnostics
(iSPI NET only).

Tip: You can right-click any object in a table or map view to access theActionsmenu.

For information about each tab:

(NNMi Advanced - Global Network Management feature) Any NNM iSPI Diagnostics Flows are not
sent from aRegional Manager (NNMi management server) to the Global Manager. From theGlobal
Manager, useActions→Open from Regional Manager to see the list of NNM iSPI Diagnostics
Flows on the Regional Manager.

Attribute Description

Node
Diagnostic
Results

Table view of the Node Diagnostic Results associated with the selected node. You
can use this table to determine the start time, definition, status, report name, and
last update time for each Node Diagnostic Result associated with the selected
node.

Double-click the row representing a Node Diagnostic Result . The "Node
Diagnostic Results Form (Flow RunResult) (NNM iSPI NET )" (on page 83)
displays all details about the selected Node Diagnostic Result.

Diagnostics Table

Node Diagnostic Results Form (Flow Run Result) (NNM iSPI NET )

HP Network NodeManager iSPI Network Engineering Toolset Software automatically prepares
diagnostic reports about the source node when certain incidents are generated and when using
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Actions→Run Diagnostics (iSPI NET only). This form shows details about the currently
selected diagnostic report instance.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Note: Because the values on this form are generated by NNM iSPI NET, these attribute values
cannot bemodified.

(NNMi Advanced - Global Network Management feature) Any NNM iSPI Diagnostics Flows are not
sent from aRegional Manager (NNMi management server) to the Global Manager. From theGlobal
Manager, useActions→Open from Regional Manager to see the list of NNM iSPI Diagnostics
Flows on the Regional Manager.

See "Node Form: Diagnostics Tab (NNM iSPI NET)" (on page 83) for more information.

Attribute Description

Start Time Date and time NNM iSPI NET created this instance of the Diagnostics report. NNM
iSPI NET uses the locale of the client and the date and time from the NNMi
management server.

Definition The name of the NNM iSPI NET Diagnostics report definition.

Status The current status of this NNM iSPI NET Diagnostics report. Possible values
include:

New - The Diagnostic is in the queue, but is not yet running

In Progress -The Diagnostic has been submitted and is not finished running

Completed - The Diagnostic has finished running

Not Submitted - An error condition prevented the Diagnostic from being submitted

Timed Out - NNMi was unable to submit or run the Diagnostic due to a time out
error. The time out limit for submitting a Diagnostic is one hour. The time out
limit for running a Diagnostic is four hours.

Example error conditions include the following:

l The number of Diagnostics in the queuemight prevent NNMI from submitting the
Diagnostic.

l A configuration error, such as an incorrect user name or password, might prevent
NNMi from accessing the required Operations Orchestration server.

Contact your NNMi administrator for Diagnostic log file information.

Report Click this link to open the actual report. NNM iSPI NET uses this text string to
display the selected instance of the diagnostics report in a browser window.

Note: Youmight be prompted to provide a user name and password to access the
Operations Orchestration software. See theNNM iSPI NET Planning and
Installation Guide for more information.

Diagnostics Table
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Attribute Description

Lifecycle
State

Incident Lifecycle State of the target Incident.

If the incident's Lifecycle Statematches the value specified here, the Diagnostic
runs.

The Diagnostic automatically runs on each applicable Source Node in the specified
NodeGroup if the incident has the Lifecycle State currently configured in this
attribute of the Diagnostic (Flow Definition - set of automated commands).

Last
Update
Time

Date and time NNM iSPI NET last updated this instance of the Diagnostics report.
NNM iSPI NET uses the locale of the client and the date and time from the NNMi
management server.

Diagnostics Table, continued

Node Form: Incidents Tab
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in

the incident table view's column headings.

The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

Description

Table view of the incidents associated with the selected node. These incidents are sorted by
creation time so that you can view the incidents in chronological order. Use this view to
determine which incidents are still open for the selected node.

Double-click the row representing an incident. The "Incident Form" (on page 300) displays all
details about the selected incident.

Incidents Table

Node Form: Status Tab
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

Attribute
Description

Status Overall status for the current node. NNMi follows the ISO standard for status
classification. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

Overall Status
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Attribute
Description

  Warning

  Minor

  Major

Critical

The status of all IP addresses and the SNMP Agent associated with this node, and
well as interface health contribute to node status. For information about how the
current status was determined, see the "Node Form: Conclusions Tab" (on page 87).
Status reflects themost serious outstanding conclusion. See "Watch Status Colors"
(on page 274) for more information about possible status values.

Your NNMi administrator might configure Custom Poller so that the Status of a
Custom Node Collection effects the topology node's Status. Click here to view the
effect of a Custom Node Collection's Status on the topology node's Status. See
About Custom Poller for more information.

The effect of a Custom Node Collection's Status on the topology node's Status is
determined as follows:

l If at least one Custom Collection Node's Status is Critical, the topology node
Conclusion Status is Critical.

l If at least one Custom Collection Node's Status is Major, but none are Critical, the
topology node Conclusion Status is Major.

l If at least one Custom Collection Node's Status is Minor, but none are Critical or
Major, the topology node Conclusion Status is Minor.

l At least one Custom Collection Node's Status is Warning, but none are Critical,
Major, or Minor, the topology node Conclusion Status is Warning.

l If the Status of all Custom Collection Nodes are Normal, the topology node
Conclusion Status is Normal.

Note: The icons are displayed only in table views.

Status
Last
Modified

Date and time indicating when the status was last set.

Overall Status, continued

Attribute
Description

Status
History

List of up to the last 30 changes in status for the selected node. This view is useful for
obtaining a summary of the node status so that you can better determine any patterns
in node behavior and activity.

Double-click the row representing a Status History. The Status History form displays
all details about the selected Status.

Status History Table
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Node Form: Conclusions Tab
The "Node Form" (on page 48) provides details about the selected node.

All relevant Conclusions are shown in the table on this tab. Themost severe Status in the current
group of conclusions becomes the overall Node status. SomeNode conclusions for routers can
propagate to relevant Router Redundancy Groups:

For information about each tab:

Attribute Description

Out-
standing
Status
Con-
clusions

The dynamically generated list of summary statuses of the node that contributed to
the current overall Status of the selected node. Status is set by the Causal Engine.

Each Conclusion listed is still outstanding and applies to the current overall Status.

This view is useful for obtaining a quick summary of the Status and problem
description for the current node's interfaces that led up to the node's most current
Status.

The Status value is correlated based on themost critical Conclusions.

Double-click the row representing a Conclusion. The Conclusion form displays all
details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for a node
object.

Note: A Y in the Incident? column indicates that the Conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description Status Incident?

CustomPollingOnNodeCritical At least one Custom
Polled Instance
associated with the
physical node has a
Status of Critical.

Critical N

NodeDown The NNMi Causal Engine
has determined the node
is down based on the
following analysis:

l 100% of the addresses
assigned to this node
are unreachable

l The SNMP agent
installed on this

Critical Y

Outstanding Status Conclusion Values
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Attribute Description

Conclusion Description Status Incident?

machine is not
responding

l NNMi is
communicating with at
least two of the
neighboring devices.

NodeOrConnectionDown A node is not responding
to an ICMP or SNMP
query. It also indicates
that NNMi is
communicating with only
one neighbor. Therefore,
NNMi cannot determine
whether the node or the
connection is down.

Critical Y

NonSNMPNodeUnresponsive A non-SNMP node is
unresponsive. Reasons
for this include: 1) The
node is down, or 2) An
undiscovered device in
the path between the
node and the NNMi
management server is
down.

Critical Y

Major Status Conclusions

Conclusion Description Status Incident?

CustomPollingOnNodeMajor At least one Custom Polled
Instance associated with
the physical node has a
Status of Major.

Major N

NodeWithBadBackplane At least one of the
monitored attributes for the
backplane on the node is
outside of the threshold
range set on the device.

Major N

NodeWithBadFan At least one of the
monitored attributes for a
fan on the node is outside of

Major N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

the threshold range set on
the device.

NodeWithBadMemory At least onememory pool
on the node is outside the
threshold range configured
for the device. This incident
indicates thememory pool
is exhausted or cannot meet
the demand for use.

Major N

NodeWithBadPowerSupply At least one of the power
supply’s monitored
attributes on the node is
outside of the threshold
range set on the device.

Major N

Minor Status Conclusions

Conclusion
Descrip-
tion

Statu-
s

Inci-
dent?

AllUnresponsiveAddressesInNode None of the
addresses
associated
with the
selected
node
respond to
ICMP ping.

Minor N

CardsDownInNode At least
one card in
the node
has an
Operational
State of
Down.

Minor N

CardsUndeterminedStateInNode At least
one card in
the node
has an
Operational
State of

Minor N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion
Descrip-
tion

Statu-
s

Inci-
dent?

Other.This
state
indicates
the card is
not
functioning.
For
example,
the card
has a bad
loop
problem.

CustomPollingOnNodeMinor At least
one
Custom
Polled
Instance
associated
with the
physical
node has a
Status of
Minor.

Minor N

InterfacesDownInNode At least
one
interface
contained
in the node
has an
Operational
State of
Down.

Minor N

SNMPAgentPingUnresponsiveInNode The
man-
agement
address on
the node is
not
responding
to ICMP.

Minor N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion
Descrip-
tion

Statu-
s

Inci-
dent?

SomeIn-
terfacesOutsideThresholdBoundariesInNode

At least
one
interface on
the node
has a
threshold
outside the
range
specified
for the
device.

Minor N

SomeUnresponsiveAddressesInNode At least
one, but not
all
addresses,
in the node
are not
responding
to ICMP.

Minor N

UnresponsiveAgentInNode The SNMP
Agent
associated
with this
node is not
responding
to SNMP
requests.

Minor N

Warning Status Conclusions

Conclusion Description Status Incident?

CrgMalfunctionInNode A Card Redundancy
Group in the node has a
Status other than
Normal.

Warning N

CustomPollingOnNodeWarning At least one Custom
Polled Instance
associated with the
physical node has a
Status of Warning.

Warning N

Outstanding Status Conclusion Values, continued
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Attribute Description

Unknown Status Conclusions

Conclusion Description Status Incident?

NodeUnmanageable The node cannot be reached
because NNMi has determined
that the node on which it depends
to route its traffic is down. This
condition is known as “in the
shadow”.

Note: The status of any node “in
the shadow” of a node that
is down is always Unknown
and the conclusion on each
of the nodes in the shadow
is NodeUnmanageable.

Unknown N

Normal Status Conclusions

Conclusion Description Status
Inci-
dent?

All-
Inter-
facesWithinThresholdBoundariesInNode

All of the
interfaces
within the
selected
node are
within the
allowable
threshold
range
configured
by the
admin-
istrator.

Nor-
mal

N

AllResponsiveAddressesInNode All of the
addresses
associated
with the
selected
node
respond to
ICMP ping.

Nor-
mal

N

CardsUpInNode All cards in
the node

Nor-
mal

N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

have an
Operational
State of Up.

CrgNormalInNode All Card
Redundancy
Groups in
the node are
functioning
properly.

Nor-
mal

N

CustomPollingOnNodeNormal All Custom
Polled
Instances
associated
with the
physical
node have a
Status of
Normal.

Nor-
mal

N

InterfacesUpInNode All
interfaces in
the node
have an
Operational
State of Up.

Nor-
mal

N

NodeUp The node
and its
components
are
functioning
properly.

Nor-
mal

N

ResponsiveAgentInNode The node’s
SNMP
Agent is
responding.

Nor-
mal

N

Multiple Node conclusions can appear for the same node object. For example, if a
node is functioning properly and it has monitored addresses, interfaces, at least one
card, and a card redundancy group, you would see these conclusions together:

l SNMPAgentResponding

Outstanding Status Conclusion Values, continued
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Attribute Description

l AllResponsiveAddressesInNode

l InterfacesUpInNode

l CardsUpInNode

l CrgNormalInNode

Outstanding Status Conclusion Values, continued

Node Form: Registration Tab
The "Node Form" (on page 48) provides details about the selected node.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes

SNMP Agent Form
The SNMP Agent form provides details about the SNMP Agent assigned to the currently selected
node. This form is useful when you want to view more details about the SNMP Agent, including the
agent's status. You can also use the form to determine all of the attributes in the NNMi database
associated with the SNMP Agent.

For information about each tab:

Attribute Description

Name Name used to identify the SNMP agent. This name is the hostname of
the node (as stored in the NNMi database). NNMi chooses the
hostname of the parent node according to the criteria specified by your
NNMi administrator.

NNMi follows a set of rules to dynamically generate the value stored in
the NNMi database for each Node's Hostname. Click here for details.

Basic Attributes
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Attribute Description

Note: If DNS is the source of the Node's Hostname, the actual
Hostnamemight be converted to all uppercase or all lowercase
before it is added to the NNMi database (depending on how the
NNMi administrator configured settings in the nms-
topology.properties file). See the "Modifying NNMi
Normalization Properties" section of theHP Network Node
Manager i Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

l If the Node supports SNMP, NNMi requests the Hostname using the
IP Address of the associated SNMP agent (theManagement
Address attribute value on the Node form).

When the NNMi administrator chooses Enable SNMP Address
Rediscovery in the Communication Configuration:

n If the SNMP Agent does not respond, NNMi checks for another
Management Address to request the Hostname, and the
Hostname could change.

n If the SNMP Agent associated with the node changes, the
Management Address and Hostname could change.

When the NNMi administrator disables Enable SNMP Address
Rediscovery in the Communication Configuration:

n If the SNMP Agent does not respond, NNMi uses the previously
gatheredManagement Address attribute value to request the
Hostname.

n If the SNMP Agent associated with the node changes, NNMi uses
the previously gatheredManagement Address attribute value to
request the Hostname.

l If the Node does not support SNMP, noManagement Address is
available. NNMi requests a Hostname starting with the lowest IP
Address associated with the node (a Discovery Seed value or an IP
address value gathered from a neighboring device). NNMi uses the
first Hostname provided. The Hostnamemight change during a future
discovery cycle.

Management Address IP address NNMi uses to communicate with this SNMP agent.

The NNMi administrator can specify an address (Communication
Configurations workspace, Specific Node settings tab), or NNMi can
dynamically select one. Click here for details.

Note: With NNMi Advanced, the NNMi administrator specifies whether
NNMi prefers IPv4 or IPv6 addresses when selecting the
Management Address. See Configure Default SNMP,
Management Address, and ICMP Settings.

Basic Attributes, continued
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Attribute Description

1. NNMi ignores the following addresses when determining which
Management Address is most appropriate:

n Any address of an administratively-down interface.

n Any address that is virtual (for example, VRRP1).

n Any IPv4Anycast Rendezvous Point IP Address2 or IPv6
Anycast address.

n Any address in the reserved loopback network range. IPv4 uses
127/24 (127.*.*.*) and IPv6 uses ::1.

n Any IPv6 link-local address3.

2. If the NNMi Administrator specifies Enable SNMP Address
Rediscovery in Communication Configuration, NNMi prefers the
last-knownManagement Address (if any).

3. If theManagement Address does not respond and the NNMi
Administrator specifies Enable SNMP Address Rediscovery in
Communication Configuration, NNMi uses the Communication
Configuration settings forManagement Address Selection. The
NNMi Administrators chooses the order in which NNMi checks the
following:

n Seed IP / Management IP - If the NNMi Administrator configures
a Seed, NNMi uses the Seed address (either a specified IP
address or the DNS address associated with a specified
hostname) only during initial Discovery. NNMi then requests the
current Management Address (the address from which the
node's SNMP Agent responds) and uses that IP address for all
communication after initial discovery.

n Lowest Loopback - If a node supports multiple loopback
address4, NNMi queries each loopback addresses, starting with
the lowest number. NNMi uses the loopback address with the
lowest number from which the SNMP agent responds (for

Basic Attributes, continued

1Virtual Router Redundancy Protocol
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network
configurations.
3A non-routable IPv6 unicast address only used for communication with other nodes on the same
link (LAN or VLAN). Link local addresses cannot be used for communication that must be
forwarded through a router. IPv6 auto-configuration automatically assigns a unique link local
address in the fe80::/10 address space to each IPv6-enabled interface on a system.
4The address associated with the loopback interface. The loopback interface is a virtual interface
on a device that provides a route for internal communication. Many vendors provide a specially
configured loopback for management purposes. Exact details of how loopbacks are configured
varies by vendor andmodel. See each device's documentation for details. NNMi identifies these
loopback addresses by using ifType Number 24, softwareloopback from the IANA ifType-MIB.

HP Network NodeManager i Software (9.21)Page 96 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute Description

example, 10.16.42.197 is a lower number than 10.16.197.42).

n Highest Loopback - If a node supports multiple loopback
address1, NNMi queries each loopback addresses, starting with
the highest number. NNMi uses the loopback address with the
highest number from which the SNMP agent responds.

n InterfaceMatching - The NNMi Administrator chooses which
interfaceMIB variable NNMi queries to detect changes. NNMi
can use the followingMIB-II attribute values: ifIndex,
ifName, ifDescr, ifAlias, or a combination of these
(ifName or ifDescr, ifName or ifDescr or ifAlias).

4. If no response, NNMi queries any remaining IP addresses in the
node's IP address inventory, starting with the lowest number. NNMi
uses the address with the lowest number from which the
SNMP agent responds.

5. If no response, NNMi checks for any Mapped Address configured
for one of the currently known addresses (see theMapped Address
column in the Custom IP Addresses view).

Note: The address represents a static Network Address
Translation (NAT) pair's external IP address from the
internal/external IP address pair. NNMi Administrators
configure these pairs using the Overlapping IP Address
Mapping form. NNMi uses this list of addresses starting with
IPv4 from low to high, then IPv6 from low to high.

6. If no response, NNMi might be configured to repeat the sequence
using SNMPv1, SNMPv2c, or SNMPv3 in the order specified by
the NNMi administrator (Communication Configurations SNMP
Minimum Security Level settings).

7. When all else fails, NNMi retains the last knownManagement
Address (if any) and automatically changes the State of that SNMP
Agent object to Critical.

This process is repeated during each Spiral Discovery cycle, and the
Management Address can change. For example, NNMi's inventory of
addresses for the node expands, or the current Management Address
does not respond to SNMP queries due to network problems or node
reconfiguration. The NNMi administrator can prevent changes to the

Basic Attributes, continued

1The address associated with the loopback interface. The loopback interface is a virtual interface
on a device that provides a route for internal communication. Many vendors provide a specially
configured loopback for management purposes. Exact details of how loopbacks are configured
varies by vendor andmodel. See each device's documentation for details. NNMi identifies these
loopback addresses by using ifType Number 24, softwareloopback from the IANA ifType-MIB.
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Attribute Description

management address using the Communication Configurations Enable
SNMP Address Rediscovery orPreferredManagement Address setting.

Protocol Version Version of the SNMP protocol in use. NNMi supports versions
SNMPv1, SNMPv2c, and SNMPv3.

Read Community
String

The read community string value that was discovered for the selected
SNMP agent.

Note: The read community string is an SNMPv1 or SNMPv2c
password. The actual read community string is only visible if you
are assigned to the Administrator role.

Agent Enabled Indicates whether this SNMP agent is set up for SNMP communication
in your network environment.

UDP Port User Datagram Protocol port configuration for this SNMP agent.

Default 161. Port NNMi is instructed to use when contacting this
SNMP agent to collect SNMP data. Both the Discovery Process and the
State Poller Service use this setting.

SNMP Proxy
Address

Prerequisite: The NNMi administrator must specify one or more SNMP
Proxy Servers in the NNMi Communication Configuration settings.

The IP address of the server that is acting as the SNMP Proxy Server
for this SNMP agent. Your NNMi administrator might have set up one or
more SNMP Proxy Servers to enable communication with nodes that
otherwisemight be unreachable. For example, when a node to be
managed is behind a firewall. The SNMP Proxy Server enables NNMi to
manage these nodes in the sameway as nodes that provide
SNMP access directly.

SNMP Proxy Port Prerequisite: The NNMi administrator must specify one or more SNMP
Proxy Servers in the NNMi Communication Configuration settings.

The port number on the server that is acting as the SNMP Proxy Server
for this SNMP Agent. See SNMP Proxy Address (previous attribute) for
more information.

SNMP Timeout (Seconds:Milliseconds) Time that NNMi waits for a response to an
SNMP query before reissuing the request.

SNMP Retries Maximum number of retries that NNMi issues for an SNMP query before
determining the query result to be "unresponsive". Zeromeans no
retries.

SNMP Agent State Attributes

Agent SNMP  State Indicates whether the SNMP agent is available and how NNMi is using
SNMP to interact with this SNMP agent. Possible values are:

Basic Attributes, continued
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Attribute Description

Normal – Indicates that the agent responds to SNMP queries.

Not Responding – Indicates that the SNMP agent does not
respond to SNMP queries.

Not Polled – Indicates that this SNMP Agent's address is
intentionally not polled, based on current Monitoring Configuration
settings, current Communication Configuration settings, or because
the parent Node is set to Not Managed or Out of Service. The SNMP
Agent’s address might or might not have an associated polling
policy.

No Polling Policy– Indicates that this SNMP Agent's address is
being polled, but no polling policy exists in any Monitoring
Configuration settings for this monitored attribute.

Unset – Currently not used by NNMi.

Note: NNMi's State Poller sets this state. The current state contributes
towards the status calculation for the agent. See "SNMP Agent
Form: Status Tab" (on page 101) for more information.

Management Address
ICMP State Indicates whether NNMi is communicating with themanagement

address. Possible values are:

Responding – Indicates that themanagement address is being
polled and is responding to an ICMP ping.

Not Responding – Indicates that themanagement address is being
polled, but is not responding to an ICMP ping.

The following values indicate NNMi encountered trouble while trying to
gather the required data:

No Polling Policy - No polling policy exists in Monitoring
Configuration settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled,
based on current Monitoring Configuration settings, current
Communication Configuration settings, current polling policies, or
because the parent Node is set to Not Managed or Out of Service

Unavailable - Unable to determine the State. For example, the
ICMP poll returned a value outside the range of possible values or
returned a null value.

Unset – Currently not used by NNMi.

Note: NNMi's State Poller determines the State. The current state
contributes towards the status calculation for the SNMP Agent.

Basic Attributes, continued
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Attribute Description

See the "SNMP Agent Form: Status Tab" (on page 101) tab for more
information.

Management Address
Response Time State

Note: Enable Management Address ICMP Pollingmust be
selected. See "Interface Form: Performance Tab (HP Network Node
Manager iSPI Performance for Metrics Software)" (on page 135) for
more information.

Indicates the State of the ICMP response time between the
management station and the selected node. Possible values are:

Unavailable - Unable to determine the State. For example, the
ICMP poll returned a value outside the range of possible values or
returned a null value.

Nominal - Indicates the ICMP response time was between 0 and
the configured High Value.

High - Indicates a higher than configured ICMP response time
between themanagement station and the selected node.

Management Address
Response Time
Baseline

 HP Network NodeManager iSPI Performance for Metrics Software
only.

Note: Enable Node Component Performance Pollingmust be
selected. See "Interface Form: Performance Tab (HP Network
NodeManager iSPI Performance for Metrics Software)" (on page
135) for more information.

Indicates the ICMP response time between themanagement station and
the selected node is abnormal based on the computed baseline.
Possible values are:

  Abnormal Range – Indicates State Poller has collected values
outside the normal range when compared to the baseline data
collected for themanagement address response time.

Normal Range - Indicates State Poller collected values within the
normal range when compared to the baseline data collected for the
management address response time.

State Last Modified The date and time when the State value was last modified.

Hosted OnNode Node on which the SNMP Agent resides. This is the current value in
NNMi’s database for the Name attribute of the host device. The value
could be a DNS name, aMIB-II sysName, or an address (depending on
how your NNMi administrator configured the discovery process).

Click the Lookup icon and select  Show Analysis or Open to
display more information about the node.

Basic Attributes, continued
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SNMP Agent Form: Status Tab

The "SNMP Agent Form" (on page 94) provides details about the SNMP Agent of the selected node
or interface.

For information about each tab:

Attribute Description

Status Overall status for the current SNMP agent. NNMi follows the ISO standard for status
classification. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

For information about how the current status was determined, see "SNMP Agent
Form: Conclusions Tab" (on page 101). Status reflects themost serious outstanding
conclusion.

Status
Last
Modified

Date and time indicating when the Status was last set.

Status

Attribute
Description

Status
History

List of the last 30 changes in the status for the SNMP agent. This view is useful for
obtaining a summary of the SNMP agent status so that you can better determine any
patterns in behavior and activity.

Double-click the row representing a Status History. The Status History form displays
all details about the selected Status.

Status History Table

SNMP Agent Form: Conclusions Tab

The "SNMP Agent Form" (on page 94) provides details about the SNMP Agent of the selected node
or interface.

For information about each tab:
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Attribute Description

Out-
standing
Status
Con-
clusions

The dynamically generated list of summary statuses for the SNMP agent that
contributed to the current overall Status of the selected SNMP agent. Status is set
by the Causal Engine.

Each Conclusion listed is still outstanding and applies to the current overall Status.

This view is useful for obtaining a quick summary of how the Status of SNMP
Agent in the node contributes to the current Status of the SNMP Agent.

The Status value is correlated based on themost critical Conclusions.

Double-click the row representing a Conclusion. The Conclusion form displays all
details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for an
SNMP Agent object.

Note: A Y in the Incident? column indicates that the Conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description Status Incident?

SNMPAgentNotResponding The SNMP agent is not
responding to SNMP
queries on the selected
node.

Critical Y

Minor Status Conclusions

Conclusion Description Status Incident?

SNMPAgentPingNotResponding The address associated
with this SNMP Agent
is not responding to
ping.

Minor N

Warning Status Conclusions

Conclusion
Descrip-
tion Status

Inci-
dent?

Man-
age-
mentAddressICMPResponseTimeAbnormal

Indicates
there is an
abnormal
Internet
Control
Message
Protocol

Warn-
ing

Y

Outstanding Status Conclusion Values
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Attribute Description

Conclusion
Descrip-
tion Status

Inci-
dent?

(ICMP)
response
time from
the NNMi
man-
agement
server to
the
selected
node.

ICMP
messages
are
typically
used for
diagnostic
or routing
purposes
for
deter-
mining
whether a
host or
router
could not
be
reached.

The
incident is
generated
when
NNMi
detects a
higher or
lower value
than the
baseline
ICMP
response
time
between

Outstanding Status Conclusion Values, continued

HP Network NodeManager i Software (9.21)Page 103 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute Description

Conclusion
Descrip-
tion Status

Inci-
dent?

the NNMi
man-
agement
server and
the
selected
node.

Man-
agementAddressICMPResponseTimeHigh

Indicates a
high
Internet
Control
Message
Protocol
(ICMP)
response
time from
the
man-
agement
station to
the
selected
node.

ICMP
messages
are
typically
used for
diagnostic
or routing
purposes
for
deter-
mining
whether a
host or
router
could not
be
reached.

Warn-
ing

Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion
Descrip-
tion Status

Inci-
dent?

The
incident is
generated
when
NNMi
detects a
higher than
configured
ICMP
response
time
between
the NNMi
man-
agement
server and
the
selected
node.

Normal Status Conclusions

Conclusion
Descrip-
tion

Statu-
s

Inci-
dent?

Man-
age-
mentAddressICMPResponseTimeNominal

Indicates
that the
Internet
Control
Message
Protocol
(ICMP)
response
time from
the
man-
agement
station to
the selected
node is
within the
threshold
range set by

Nor-
mal

N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion
Descrip-
tion

Statu-
s

Inci-
dent?

the
admin-
istrator.

ICMP
messages
are typically
used for
diagnostic
or routing
purposes
for
determining
whether a
host or
router could
not be
reached.

the
admin-
istrator.

Man-
agementAddressICMPResponseTimeNormal

Indicates l
Internet
Control
Message
Protocol
(ICMP)
response
time from
the NNMi
man-
agement
server to
the selected
node is
within the
baseline set
by the
admin-
istrator.

ICMP

Nor-
mal

N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion
Descrip-
tion

Statu-
s

Inci-
dent?

messages
are typically
used for
diagnostic
or routing
purposes
for
determining
whether a
host or
router could
not be
reached.

SNMPAgentPingResponding The
address
associated
with this
SNMP
Agent is
responding
to ping.

Nor-
mal

N

SNMPAgentResponding The SNMP
Agent is
responding
to SNMP
requests.

Nor-
mal

N

Outstanding Status Conclusion Values, continued

SNMP Agent Form: Incidents Tab

The "SNMP Agent Form" (on page 94) provides details about the SNMP Agent of the selected node
or interface.

For information about each tab:

Attribute Description

Associated
Incidents

Table view of the incidents associated with the selected SNMP agent. These
incidents are sorted by creation time so that you can view the incidents in
chronological order. Use this view to determine which incidents are still open for the
selected SNMP agent.

Double-click the row representing an incident. The "Incident Form" (on page 300)
displays all details about the selected incident.

Incidents Table
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SNMP Agent Form: Registration Tab

The "SNMP Agent Form" (on page 94) provides details about the SNMP Agent of the selected node
or interface.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes

Device Profile Form
According to industry standards (MIB-II), each combination of vendor, device type, andmodel
number is assigned a unique SNMP system object ID (sysObjectID). For example, all Cisco
6500 series switches have the same sysObjectID prefix: .1.3.6.1.4.1.9.* See the Basic
Attributes.

NNMi uses the Advanced Settings tomake decisions about how devices are discovered and
depicted on the NNMi maps.

Tip: Each "Node Form" (on page 48) has a link to the appropriate Device Profile form.

Attribute Description

Device
Model

Devicemodel name or number designator, determined by the vendor.

SNMP
Object ID

MIB-II sysObjectID number issued for this device type. These numbers are
unique across all vendors.

Description The description, based on information from theMIB-II sysDescr string provided
by the vendor.

Maximum length is 255 characters: alpha-numeric, spaces, and special characters
(~ ! @ # $ % ̂  & * ( ) _+ -)

Device
Family

Device family name provided by the vendor; for example Cisco Catalyst 6500
Series Switches or HP AdvanceStack Routers.

Basic Attributes
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Attribute Description

Click the  Lookup icon to access the "Device Family Form" (on page 112) for
more details.

Device
Vendor

Name of the vendor that manufactures the device.

Click the  Lookup icon to access the "Device Vendor Form" (on page 113) for
more details.

Device
Category

The value of this attribute determines which background shape NNMi uses for the
map icon representing devices of this type. See "About Map Symbols" for more
information about the possible values.

Click the  Lookup icon to access the "Device Category Form" (on page 114)
for more details.

OUI Organizationally unique identifier. The first three octets of theMAC address for the
device that identify the device's vendor.

Author Indicates who created or last modified the device profile.

See Author form for important information.

Caution: If the Author attribute value is HP Network Node Manager, any
changes are at risk of being overwritten in the future.

Click the  Lookup icon and select Show Analysis to display details about
the currently selected Author, select  Quick Find to access the list of existing
Author values, or click   New to create one.

Basic Attributes , continued

Attribute Description

Use of SNMP SysName for Node Name Resolution

Never Use
sysName

If  enabled, Spiral Discovery does not use aMIB-II sysName value for the Name
attribute for discovered Nodes of this type. If sysName is part of the current node
Name strategy, NNMi uses the next designated node Name choice in the strategy
established by your NNMi administrator.

If  disabled, MIB-II sysName can potentially be used as the Name attribute
value for nodes of this type.

Do not Use
sysName
Starting
With

The vendor's default sysName text string, fromMIB-II sysName.

If the SNMP agent responds to a sysName request with a value that matches or
starts with the entry in this field (case-sensitive), Spiral Discovery ignores the
sysName and considers sysName to be unset. As a result, NNMi instead tries to
find a DNS name or IP address for this node (according to the strategy established
by your NNMi administrator).

For example, when an SNMP agent responds with a default sysName, NNMi's

Advanced Settings Tab
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Attribute Description

maps might display multiple icons with the same name (one for every device of that
type in your environment that responded to an SNMP query with the default
sysName). Usually, the device administrator changes the default sysName value
to somethingmoremeaningful, so this problem is avoided.

Device Behaviors

Force
Device

This attribute enables the NNMi administrator to override the IP Forwarding (Layer
3) and LAN Switching (Layer 2) Capability settings provided by Spiral Discovery
(displayed on the "Node Form: Capabilities Tab" (on page 60)).

Note the following:

l The Force Device attribute does not affect default membership for the Node
Groups provided by NNMi. For example, the Force to router settings does not
add the Node to the Routers NodeGroup. NNMi uses the Device Category to
determine NodeGroupmembership for the NodeGroups it provides.

l The Force Device setting does not affect the background shapes displayed on
an NNMi map. NNMi uses the Device Category specified in the Device Profile
to determine themap background shapes displayed.

The following table describes the possible Force Device settings and subsequent
behavior:

Setting Behavior

Do not
force

Ignores the Force Device setting.

Force to
router

l Adds the IP Forwarding (Layer 3) Capability to the Node

l Displays the device in Layer 3 Neighbor View maps

l Checks the Router Redundancy Protocol configuration for
information about the Node

Force to
switch

Adds the LAN Switching (Layer 2) Capability to the Node

Force to
end node

l Removes either of the following Capabilities if they are
configured on the Node:

n IP Forwarding (Layer 3)

n LAN Switching (Layer 2)

l Ignores this Node during Auto-Discovery unless you select
"Discover Any SNMP Device" or include the Node’s System
Object ID in the Auto-Discovery Rule.

Force Device Settings and Behavior

Advanced Settings Tab , continued
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Attribute Description

Setting Behavior

Force to
switch
and router

l Adds the IP Forwarding (Layer 3) Capability to the Node

l Adds the LAN Switching (Layer 2) Capability to the Node

l Displays the Node in Layer 3 Neighbor View maps

l Checks the Router Redundancy Protocol configuration for
information about the Node

Force Device Settings and Behavior, continued

AnNNMi administrator might want to use this attribute to override the IP
Forwarding (Layer 3) and LAN Switching (Layer 2) capabilities setting for the device
under the following circumstances:

l The sysServices setting in MIB-II that is used to determine the IP Forwarding
(Layer 3) and LAN Switching (Layer 2) capability during discovery is not
accurate due to a firmware defect on the device.

l The device serves as a router, switch, or switch and router and the NNMi
administrator wants to force the device to be treated as only one of the
following: 1) a router, 2) a switch, or 3) a switch and router.

l The device serves as a virtual router, but should not bemanaged as a router.

Setting the Force Device attribute to Force to end node enables the NNMi
administrator to configure Spiral Discovery to ignore this device (unless the
device is within the Default Tenant and an Auto-Discovery Rule is configured to
"Discover Any SNMP Device" or configured to include thematching System
Object ID).

Interface
Reindexing
Type

Your NNMi administrator chooses which interfaceMIB variable the NNMi State
Poller queries to detect interface changes. NNMi can use the followingMIB-II
attribute values: ifIndex, ifName, ifDescr, ifAlias, or a combination of
these (ifName or ifDescr, ifName or ifDescr or ifAlias). See the General
Interface Attributes (SNMP Values) in "Interface Form: General Tab" (on page 120)
for information about these four MIB-II attributes that are available to use for this
setting.

If you are an Administrator, see Detect Interface Changes for more information.

Prefer
LLDP

A network device's interfaces can be configured with proprietary Layer 2 discovery
protocols, instead of or in addition to the industry standard LLDP (see the list of
Topology Source protocols in Layer 2 Connection Form).

By default, NNMi checks the interface for standard LLDP and vendor-specific
IEEE 802 Layer 2 protocol. NNMi uses data from both protocols to calculate the
Layer 2 Connection, but by default prefers the data provided through LLDP.

Note: Forwarding Database (FDB) information can cause NNMi to establish

Advanced Settings Tab , continued
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wrong Layer 2 Connections in the following cases:

l When the FDB is configured as cache and contains obsolete data.

l In network environments with hardware from a variety of vendors, when
each vendor generates different and sometimes conflicting FDB data.

Optional: NNMi administrators can configure Spiral Discovery to ignore the
FDB data from one NodeGroup when calculating Layer 2 Connections (the
FDB data is still included in other calculations).

(NNMi Advanced - Global Network Management feature) NNMi must read the
Forwarding Database (FDB) tables from Ethernet switches within the network
before accurate communication paths between these network devices can be
calculated. Because the FDB data is involved, NNMi can produce different
results on a Regional Manager as opposed to the Global Manager.

If NNMi discovers more than one IEEE 802 Layer 2 protocol being used by a
particular device's interface, the Device Profile's setting controls NNMi's protocol
preference:

Prefer LLDP = Enabled: NNMi gives priority to the LLDP data.

Prefer LLDP = Disabled: NNMi gives priority to the vendor-specific IEEE 802
Layer 2 protocol data.

Tip: If NNMi detects incorrect neighbors,make sure that the interfaces at both ends
of the Layer 2 Connection are using the same configuration for Layer 2
discovery protocol. For more information, see Troubleshooting Layer 2
Connections.

Advanced Settings Tab , continued

Device Family Form

The Device Family attribute value indicates the family name assigned by the vendor when the
device was manufactured; for example, the Cisco Catalyst 6500 Series Switches.

l NNMi monitoring behavior can be configured differently for each family.

l Membership in a NodeGroup can be determined by device family.

This form is accessed from the "Device Profile Form" (on page 108).

Attribute Description

Label Device family name. For example, Cisco Catalyst 6500 Series Switches or HP
AdvanceStack Routers.

Maximum length is 255 characters. Alpha-numeric, spaces, and underline
characters are permitted.

Device Family Definition
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Unique Key The required unique identifier that is important when exporting and importing
device profile information within NNMi.

The valuemust be unique. One possible strategy is to use the Java name space
convention. For example:

com.<your_company_name>.nnm.device_
profile.family.<family_label>

Maximum length is 80 characters. Alpha-numeric characters and periods are
permitted. Spaces are not permitted.

Management
URL

Optional. The URL to the device's management page (provided by the vendor).
This page is used to provide configuration information for the device and is
usually organized by device family.

Icon Displays the icon that is associated with the Device Family.

If you are an NNMi administrator, you can customize the icon. See Customize
Device Profile Icons for more information.

Device Family Definition , continued

Device Vendor Form

The Device Vendor attribute value indicates the name of themanufacturer of this device type; for
example, HP or Cisco. 

l NNMi monitoring behavior can be configured differently for each vendor.

l Membership in a NodeGroup can be determined by device vendor.

This form is accessed from the "Device Profile Form" (on page 108).

Attribute Description

Label Vendor name.

Maximum length is 255 characters. Alpha-numeric, spaces, and underline characters
are permitted.

Unique
Key

The required unique identifier that is important when exporting and importing device
profile information within NNMi.

The valuemust be unique. One possible strategy is to use the Java name space
convention. For example:

com.<your_company_name>.nnm.device_profile.vendor.<vendor_
label>

Maximum length is 80 characters. Alpha-numeric characters and periods are
permitted. Spaces are not permitted.

Icon Displays the icon that is associated with the Device Vendor.

Device Vendor Definition
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If you are an NNMi administrator, you can customize the icon. See Customize
Device Profile Icons for more information.

Device Vendor Definition , continued

Device Category Form

The Device Category attribute value indicates the category of this device; for example, router,
switch, or printer. This attribute:

l In Map views, determines which background shape NNMi uses for the icon representing
devices of this type.

l In table views, the category value can be used when sorting/filtering the Category column.

l During discovery, NNMi behavior changes based on the device category. For example, routers
and switches are discovered by default.

l NNMi monitoring behavior can be configured differently for each category.

l Membership in a NodeGroup can be determined by device category.

This form is accessed from the "Device Profile Form" (on page 108).

Attribute Description

Label Category name.

Maximum length 255 is characters. Alpha-numeric, spaces, and underline characters
are permitted.

Unique
Key

The required unique identifier that is important when exporting and importing device
profile information within NNMi.

The valuemust be unique. One possible strategy is to use the Java name space
convention. For example:

com.<your_company_name>.nnm.device_
profile.category.<category_label>

Maximum length is 80 characters. Alpha-numeric characters and periods are
permitted. Spaces are not permitted.

Icon Displays the icon that is associated with the Device Category.

If you are an NNMi administrator, you can customize the icon. See Customize
Device Profile Icons for more information.

Device Category Definition

Interface Form
The Interface form provides details about the network interface selected. From this form you can
access more details about the parent node, addresses, current network connection, and incidents
associated with this interface.
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If your role permits, you can use this form tomodify theManagement Mode for an interface (for
example to indicate it will be temporarily out of service) or add notes to communicate information
about this interface to your team.

If you see several blank columns for an interface in a table view, note the following:

l The interfacemight be in a non-SNMP node.

For interfaces on non-SNMP nodes, note the following: 

n The interface index (ifIndex) value is always set to 0 (zero).

n The interface type (ifType) is set toOther.

n The interface Name (ifName), if none is available, is set toPseudo Interface.

Note: ForPseudo Interface, NNMi attempts to obtain additional information using a
variety of discovery protocols (see the list of Topology Source protocols in Layer 2
Connection Form).

n If the interface hosts an IP address, the interface Alias (ifAlias) is set to the IP address.
Otherwise, the interface Alias (ifAlias) is set with information from neighboring SNMP
devices.

n NNMi obtains theMAC address if the IP address can be resolved using ARP cache.

l The interfacemight be a Nortel private interface.

For Nortel SNMP interfaces, note the following: 

n The interface index (ifIndex) value is set according the Nortel privateMIB.

n NNMi tries to collect theMAC address and interface name using Nortel's privateMIBs.

l (NNMi Advanced) The interfacemight be an IPv-6 interface.

A small number of IPv6 devices do not support the standard RFC 2863 IF-MIB for IPv6
interfaces. In this case, NNMi uses theRFC 2465 IPv6-MIB. When this happens, note the
following:

n Interface index (ifIndex) and description (ifDescr) are set according to the RFC 2465
IPv6MIB.

n Interface type (ifType) is set to Other (no specific type is available).

n Interface Name (ifName), Alias (ifAlias), and Speed (ifSpeed) are blank (not available).

n NNMi monitors the Status of this interface, but Performancemetrics are not available.

When an IP Address has the Interface Name (ifName) attribute set to blank, NNMi constructs
an alternate string for the IP Address's In Interface attribute (Other[<ifIndex_value>]).

For information about each tab:

Attribute Description

Name Themost accurate interface name available to the initial discovery process. First
choice is the IF MIB ifName value. Second choice is the ifAlias value. Third

Basic Attributes
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choice is a combination of the ifType[ifIndex] value (for example,
ethernetCsmacd[17]).

Status Overall status for the current interface. NNMi follows the ISO standard for status
classification. See the "Interface Form: Status Tab" (on page 137) for more
information. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

Interface status is derived from SNMP polling results for ifAdminStatus and
IfOperStatus, as well as from any conclusions. Status reflects themost serious
outstanding conclusion. See the "Interface Form: Conclusions Tab" (on page
138) for information about how the current status was determined. See "Watch
Status Colors" (on page 274) for more information about possible status values.

Note: The icons are displayed only in table views.

Management
Mode

The calculatedManagement Mode for the interface. This value should reflect the
management mode assigned to the node in which the selected interface resides.
For example, if the node's management mode is Managed, and the Direct
Management Mode of the interface is Inherited, the interfaceManagement Mode
value is Managed.

(NNMi Advanced - Global Network Management feature) Any change to this
Management Mode setting is sent from aRegional Manager to the Global
Manager during the next Spiral Discovery cycle on the Regional Manager.

Note: If the NNMi Security configuration permits, you can change this setting
usingActions→Management Mode.

Tip: You can right-click any object in a table or map view to access the
Actionsmenu.

Direct
Management
Mode

Indicates whether the current interface is beingmanaged. This attribute is set by
the administrator and specifies whether an interface should bemanaged or
whether an interface is temporarily out of service. Possible values are:

Basic Attributes, continued
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Inherited – Used to indicate that the interface should inherit theManagement
Mode from the node in which it resides.

Not Managed – Used to indicate that NNMi does not discover or monitor the
interface. For example, the interfacemight not be accessible because it is in
a private network.

Out of Service – Used to indicate an interface is unavailable because it is out
of service. NNMi does not discover or monitor these interfaces.

This attribute is useful for notifying NNMi when an interface is temporarily out of
service, or should never bemanaged.

Note: If you change the Direct Management Mode usingActions→
Management Mode, NNMi updates the calculatedManagement Mode on
the form. If youmanually set the Direct Management Mode and then Save
your changes, theManagement Mode value is not updated until you refresh
the form.

Hosted On
Node

node in which the interface resides. This is the current value in the NNMi
database for the Name attribute of the host device. The value could be a DNS
name, aMIB-II sysName, or an address (depending on how your NNMi
administrator configured the discovery process).

Click the  Lookup icon and select  Show Analysis or  Open to display
more information about the node.

Physical
Address

The interface address at the physical layer, also known as theMAC address.
This is the globally unique serial number assigned to each interface at the factory.

Layer 2
Connection

Used to indicate whether the selected interface is part of a Layer 2 Connection. If
the interface is part of a connection, use this attribute to access information about
its Layer 2 Connection and the neighboring device. Click here for instructions.

1. Navigate to the Layer 2 Connection attribute. Click the Lookup icon,
and select  Open.

2. In the Layer 2 Connection form, locate the Interfaces tab.

3. Double-click the row representing the other interface participating in this
connection.

4. In the Interface form, locate theHosted On Node attribute.

5. The Node form contains all known information about the neighboring node.

Basic Attributes, continued

Attribute Description

Administrative
State

Either the current MIB-II ifAdminStatus value (set by the device's administrator)
or a value calculated by the State Poller Service. The current Administrative
State contributes towards the status calculation for this interface. See the

Interface State Attributes
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"Interface Form: Status Tab" (on page 137) for more information.

Possible values are:

Up – The SNMP agent responded with an ifAdminStatus value of Up. The
interface is ready to pass packets of data.

Down – The SNMP agent responded with an ifAdminStatus value of Down.

Testing – The SNMP agent responded that the interface is in test mode.

Other – The SNMP agent responded with a value for ifAdminStatus that is
not recognized.

The following values indicate NNMi could not gather the required data:

Agent Error – Indicates an SNMP error was returned in response to an
SNMP query to this agent.

No Polling Policy - Indicates the object is being polled, but no polling policy
exists in Monitoring Configuration settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled, based on
current Monitoring Configuration settings, current Communication
Configuration settings, or because the parent Node is set to Not Managed or
Out of Service. This object attributemight or might not have an associated
polling policy.

Unavailable - Unable to determine the State. For example, the SNMP agent
returned a value outside the range of possible values or returned a null value.

Unset – Currently not used by NNMi.

Operational
State

Either the current MIB-II ifOperStatus value or a value calculated by the State
Poller Service. The current Operational State contributes towards the status
calculation for this interface. See the "Interface Form: Status Tab" (on page 137)
for more information.

Possible values are:

Up – The SNMP agent responded that the interface is operationally up,
ready to receive and send network traffic.

Down – The SNMP agent responded that the interface is operationally
down.

Dormant – Indicates the SNMP agent responded that the interface is in a
"pending” state, waiting for some external event.

Lower Layer Down – Indicates the interface is down due to the state of
lower-level interfaces.

Interface State Attributes, continued

HP Network NodeManager i Software (9.21)Page 118 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute Description

Minor Fault – The interface is still functional, but the SNMP agent reported
aminor concern. Check the device, itself, for more details.

Not Present – Indicates that the interface is missing some hardware
component.

Other – The SNMP agent responded with a value for ifOperStatus that is not
recognized.

Testing – The SNMP agent responded that the interface is in test mode.

Unknown – The SNMP agent responded with an ifOperStatus value of
Unknown.

The following values indicate NNMi could not gather the required data:

Agent Error – Indicates an SNMP error was returned in response to an
SNMP query to this agent.

No Polling Policy - Indicates the object is being polled, but no polling policy
exists in Monitoring Configuration settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled, based on
current Monitoring Configuration settings, current Communication
Configuration settings, or because the parent Node is set to Not Managed or
Out of Service. This object attributemight or might not have an associated
polling policy.

Unavailable - Unable to determine the State. For example, the SNMP agent
returned a value outside the range of possible values or returned a null value.

Unset – Currently not used by NNMi.

State Last
Modified

(NNMi Advanced - Global Network Management feature) The text you enter
here is not sent from aRegional Manager (NNMi management server) to the
Global Manager. NNMi administrators for the Global Manager can add notes
that are stored in the NNMi database on theGlobal Manager.

The date and time when the Administrative State, Operational State, or both
were last modified.

Notes Provided for network operators to use for any additional notes required to further
explain the interface. Informationmight include to what service or customer the
interface is connected.

Type amaximum of 1024 characters. Alpha-numeric, spaces, and special
characters (~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Note: You can sort your interface table views based on this value. Therefore,
youmight want to include keywords for this attribute value.

Interface State Attributes, continued
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Interface Form: General Tab
The "Interface Form" (on page 114) provides details about the selected network interface.

For information about each tab:

Attribute Description

ifName Optional InterfaceMIB variable for ifName assigned to the interface by the vendor. If
no IfName value is provided, SNMP uses the ifType+ifIndex which is dynamically
configured and can change. This name is not guaranteed to be unique or consistent
across reboots.

iIfAlias Optional InterfaceMIB variable for ifAlias assigned to the interface. This value is set
by the device administrator. An ifAlias could be useful if the interface vendor did not
provide an ifName value.

ifDescr Optional InterfaceMIB variable for ifDescr for the interface. This attribute is set by the
device administrator. 

ifIndex InterfaceMIB variable for the row number in the interface table (ifTable) for this
interface. The row number can change. If you are an Administrator, see Accurately
Detect Interface Changes for more information.

Note: Interfaces on non-SNMP nodes have an ifIndex value of 0 (zero).

ifSpeed InterfaceMIB variable for the interface’s bandwidth in bits per second. Depending on
the device vendor, this valuemight indicate current speed or potential speed.

ifType InterfaceMIB variable for the physical link protocol type of the interface. Possible
values include: Ethernet and frameRelay.

Note: Interfaces on non-SNMP nodes have an ifType value of other.

Input
Speed

(HP Network NodeManager iSPI Performance for Metrics Software) If the HP
Network NodeManager iSPI Performance for Metrics Software software is installed
and configured within your environment, you can type an integer value to override the
input speed value returned by the device's SNMP agent. Indicate the speed this
interface is capable of receiving data in bits per second.

For example, youmight want to override the Input Speed value for the following
reason:

Sometimes the value returned by the device's SNMP agent is not accurate or causes
problems when HP Network NodeManager iSPI Performance for Metrics Software
calculates performancemonitoring. For example, the input speedmight be restricted
due to circumstances in your environment, or bandwidth controls might limit the
connection speed regardless of what the physical connection is capable of (such as
within aWAN).

Note: (NNMi Advanced - Global Network Management) If you change this value for
an Interfacemonitored by a Regional Manager, NNMi forwards the updated
information to the Global Manager at the next Discovery Interval.

General SNMP Values
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If you are an NNMi administrator, you can set input speeds for multiple interfaces
using the nnmsetiospeed.ovpl command. Also see "Maintaining NNMi" in the HP
Network NodeManager i Software Deployment Reference for more information.

Output
Speed

(HP Network NodeManager iSPI Performance for Metrics Software) If the HP
Network NodeManager iSPI Performance for Metrics Software software is installed
and configured within your environment, you can type an integer value to override the
output speed value returned by the device's SNMP agent. Indicate the speed this
interface is capable of transmitting data in bits per second.

For example, youmight want to override the Output Speed value for the following
reason:

Sometimes the value returned by the device's SNMP agent is not accurate or causes
problems when HP Network NodeManager iSPI Performance for Metrics Software
calculates performancemonitoring. For example, the output speedmight be restricted
due to circumstances in your environment, or bandwidth controls might limit the
connection speed regardless of what the physical connection is capable of (such as
within aWAN).

Note: (NNMi Advanced - Global Network Management) If you change this value for
an Interfacemonitored by a Regional Manager, NNMi forwards the updated
information to the Global Manager at the next Discovery Interval.

If you are an NNMi administrator, you can set output speeds for multiple interfaces
using the nnmsetiospeed.ovpl command. Also see "Maintaining NNMi" in theHP
Network NodeManager i Software Deployment Reference for more information.

General SNMP Values, continued

Interface Form: IP Addresses Tab
The "Interface Form" (on page 114) provides details about the selected network interface.

For information about each tab:

Attribute Description

IP
Address

Table view of the IP addresses associated with the selected interface. You can use
this table to determine the state and address for each IP address.

Double-click the row representing an IP address. The "IP Address Form" (on page
153) displays all details about the selected IP address.

IP Addresses Table

Interface Form: VLAN Ports Tab
The "Interface Form" (on page 114) provides details about the selected network interface.

For information about each tab:

(NNMi Advanced - Global Network Management feature) Theremight be slight differences between
the VLAN information shown on Regional Managers andGlobal Managers, because the VLAN
calculations use Layer 2 Connections data.
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Attribute
Description

VLAN
Ports

Table view of all of the VLAN ports associated with the current interface. Use this
table to determine all port and VLAN combinations associated with this interface.

Double-click the row representing a VLAN port. The "VLAN Port Form" (on page 59)
displays all details about the selected VLAN port.

VLAN Ports Table

Interface Form: Link Aggregation Tab (NNMi Advanced)
The "Interface Form" (on page 114) provides details about the selected network interface.

For more information about each tab:

The Interface Form: Link Aggregation Tab appears if the selected interface uses a Link
Aggregation1 protocol.

The selected object's role in the Link Aggregation determines the contents of the tab:

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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l Aggregation Member, click here for details.

Attribute Description

Link
Aggregation
Protocol

The Link Aggregation1 Protocol currently in use. These protocols allow
network administrators to configure a set of interfaces on a switch as one
Aggregator Interface, creating an Aggregator Layer 2 Connection to another
device usingmultiple interfaces in parallel to increase bandwidth, increase the
speed at which data travels, and increase redundancy:

Text Represents This Protocol

Cisco Port Aggregation
Protocol

Cisco Systems Port Aggregation Protocol
(pagp)

Nortel Multi-Link Trunking Nortel Multi-Link Trunk technology (mlt)

Split MLT Split Multi-Link Trunk: configuration
technology (splitMlt)

Inter-Switch Trunk MLT Split Multi-Link Trunk: inter-switch trunk
(istMlt)

802.3ad Link Aggregation
Control Protocol

IEEE 802.3ad Link Aggregation Control
protocol (LACP)

Static/Manual Configured Link
Aggregation

Static/Manual Configured Link
Aggregation

Unknown Protocol Link
Aggregation

unknown

Note: It is possible for a Layer 2 Connection to connect sets of
Aggregator/Member Interfaces that are configured using different Link
Aggregation protocols. In that case, this attribute value contains multiple
protocols separated with a slash (/).

Aggregator Name of the Aggregator that contains the selected participating Aggregation
Member:

n Aggregator Interface - represents multiple member interfaces

n Aggregator Layer 2 Connection - thick line on the Layer 2 Neighbor View
map represents multiple member Layer 2 Connections

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

See Layer 2 Neighbor View MapObjects for more information.

Click the Lookup icon, and choose Open to open the form for the
Aggregator.

l Aggregator (representingmultiple members), click here for details.

Attribute Description

Link
Aggregation
Protocol

The Link Aggregation1 Protocol currently in use. These protocols allow
network administrators to configure a set of interfaces on a switch as one
Aggregator Interface, creating an Aggregator Layer 2 Connection to another
device usingmultiple interfaces in parallel to increase bandwidth, increase the
speed at which data travels, and increase redundancy:

Text Represents This Protocol

Cisco Port Aggregation
Protocol

Cisco Systems Port Aggregation Protocol
(pagp)

Nortel Multi-Link Trunking Nortel Multi-Link Trunk technology (mlt)

Split MLT Split Multi-Link Trunk: configuration
technology (splitMlt)

Inter-Switch Trunk MLT Split Multi-Link Trunk: inter-switch trunk
(istMlt)

802.3ad Link Aggregation
Control Protocol

IEEE 802.3ad Link Aggregation Control
protocol (LACP)

Static/Manual Configured Link
Aggregation

Static/Manual Configured Link
Aggregation

Unknown Protocol Link
Aggregation

unknown

Note: It is possible for a Layer 2 Connection to connect sets of
Aggregator/Member Interfaces that are configured using different Link
Aggregation protocols. In that case, this attribute value contains multiple
protocols separated with a slash (/).

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

Available
Bandwidth

Sum of the interface Input Speed attribute values of theMember Interfaces that
have aMIB-II ifOperStatus that is not Down. If the sum of the interface Output
Speed attribute values is different, NNMi displays separate Available Input
Bandwidth and Available Output Bandwidth attributes.

Maximum
Bandwidth

Sum of the interface Input Speed attribute values of theMember Interfaces,
regardless of MIB-II ifOperStatus . If the sum of the interface Output Speed
attribute values is different, NNMi displays separateMaximum Input
Bandwidth andMaximumOutput Bandwidth attributes.

Available
Bandwidth
Percentage

Percentage value computed using Available Bandwidth divided by the
Maximum Bandwidth.

Members Table view of the AggregationMembers.

For more information, double-click the row representing an Aggregation
Member:

n The "Interface Form" (on page 114) displays all details about the selected
Interface.

n The "Layer 2 Connection Form" (on page 179) displays all details about the
selected Layer 2 Connection.

Interface Form: Capabilities Tab
The "Interface Form" (on page 114) provides details about the selected interface.

For information about each tab:

The Interface Form: Capabilities Tab displays a table view of any capabilities added to the interface
object by NNMi or an external application. Capabilities enable NNMi and application programmers
to providemore information about an interface than is initially stored in the NNMi database.

For example, NNMi uses the capability feature to identify interfaces for which NNMi can obtain only
limited information. Examples of these interfaces include Nortel interfaces as well as any interface
on a non-SNMP node. To help identify these interfaces, NNMi assigns the interface the capability
of com.hp.nnm.capability.iface.private.

Note: Because the values are generated by NNMi or an external application, Capability values
cannot bemodified.

(NNMi Advanced - Global Network Management feature) Any Capability values added by an NNM
iSPI are available on the Global Manager only if that iSPI is also running on theGlobal Manager.

Attribute Description

Capability Table of all of the capabilities associated with the selected Interface. Use this table
to access information about each Capability.

Capabilities Table
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Attribute Description

Double-click the row representing a Capability. The "Interface Capability Form" (on
page 133) displays all details about the selected Capability.

For more information, see "Interface Capabilities Provided by NNMi" (on page 126).

Capabilities Table, continued

Interface Capabilities Provided by NNMi

The "Interface Form: Capabilities Tab" (on page 125) displays a table of any capabilities added to a
particular interface object. Capabilities enable NNMi and application programmers to providemore
information about an interface than what is initially stored in the NNMi database.

External applications can also add capabilities.

KEY: com.hp.<product>.capability.<content>.<vendor/org>.<MIB/feature>

Any Capability provided by NNMi begins with the prefix com.hp.nnm.capability.

<product> = Either NNMi or the NNM iSPI providing this capability.

<content> = card, ipaddr (address), iface (interface), lag (Link Aggregation1 interface), node,
rrp (Router Redundancy), or metric (Node Sensor, Component Health, Component and
DeviceMetrics).

<vendor/org> = Standards organization or vendor defining theMIB or feature associated with the
capability.

<MIB/feature> = What this capability measures.

Note: The following tables show a few examples of the Capabilities provided by NNMi.

Unique Key
Capabil-
ity Description

com.hp.nnm.capability.iface.private Private Indicates the interface
was discovered in
either a non-SNMP
node or a Nortel node.
Private interfaces are
not monitored for
Status.

Interface Capability Attribute Values

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Unique Key
Capabil-
ity Description

For interfaces on non-
SNMP nodes, note the
following: 

l The interface index
(ifIndex) value is
always set to 0
(zero).

l The interface type
(ifType) is set to
Other.

l The interface Name
(ifName), if none
is available, is set
toPseudo
Interface.

Note: For
Pseudo
Interface,
NNMi
attempts to
obtain
additional
information
using a variety
of discovery
protocols (see
the list of
Topology
Source
protocols in
Layer 2
Connection
Form).

l If the interface
hosts an
IP address, the
interface Alias
(ifAlias) is set to
the IP address.
Otherwise, the
interface Alias
(ifAlias) is set

Interface Capability Attribute Values, continued
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Unique Key
Capabil-
ity Description

with information
from neighboring
SNMP devices.

l NNMi obtains the
MAC address if the
IP address can be
resolved using
ARP cache.

For Nortel SNMP
interfaces, note the
following: 

l The interface index
(ifIndex) value is
set according the
Nortel privateMIB.

l NNMi tries to
collect theMAC
address and
interface name
using Nortel's
privateMIBs.

com.hp.nnm.capability.iface.ietf.DS1 DS1
Interface
Metrics

Interface that supports
the DS1 (T1) MIB for
gathering performance
data. This data is used
by HP Network Node
Manager iSPI
Performance for
Metrics Software.

com.hp.nnm.capability.iface.ietf.DS3 DS3
Interface
Metrics

Interface that supports
the DS3 (T3) MIB for
gathering performance
data. This data is used
by HP Network Node
Manager iSPI
Performance for
Metrics Software.

com.hp.nnm-
.capability.iface.ietf.ETHERLIKE

EtherLike
Interface
Metrics

Interface that supports
the EtherlikeMIB for
gathering performance
data. NNMi uses this

Interface Capability Attribute Values, continued
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Unique Key
Capabil-
ity Description

MIB tomonitor LAN
errors. This data is
used by HP Network
NodeManager iSPI
Performance for
Metrics Software.

com.hp.nnm-
.capability.iface.ietf.IEEE80211

IEEE
802.11
Interface
Metrics

Interface that supports
the IEEE 802.11
InterfaceMetrics MIB.
NNMi canmonitor for
WLAN metrics. This
data is used by HP
Network Node
Manager iSPI
Performance for
Metrics Software.

com.hp.nnm.capability.iface.ietf.NON-
DEFAULT-CONTEXT-RFC1213

RFC 1213
Interface
from Non-
default
Context

Indicates the
following:

l NNMi discovered
the interface from
the RFC1213MIB.

l The interface has a
context other than
default.

Note:

l NNMi collects
context values
using the
vacmCon-
textTable in
the SNMP-
VIEW-
BASED-ACM-
MIB defined in
RFC2575.

l NNMi does not
monitor
interfaces
under a non-
default
context.

Interface Capability Attribute Values, continued

HP Network NodeManager i Software (9.21)Page 129 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Unique Key
Capabil-
ity Description

com.hp.nnm.capability.iface.PE PE
Interface

Indicates that the
interface is serving as
a Provider Edge (PE1).
NNMi's Subnet
Connection Rules use
this information.

com.hp.nnm.capability.iface.ietf.SONET SONET
Interface
Metrics

Interface that supports
the SONET-MIB
interval monitoring
metrics. This
capability determines
membership in the
SONET interface
group. This data is
used by HP Network
NodeManager iSPI
Performance for
Metrics Software.

com.hp.nnm.capability.iface.ietf.SONET-
PATH

SDH
Interface
Metrics

Interface that supports
the SONET-PATH-
MIB metrics. This data
is used by HP
Network Node
Manager iSPI
Performance for
Metrics Software.

Interface Capability Attribute Values, continued

Unique Key Capability Description

com.hp.nnm.capability.iface.ipv6.rfc2465 RFC2465-
IPv6-
Interface

(NNMi Advanced.)
Indicates the interface is
an IPv6 interface,
discovered using only
the RFC 2465 IPv6-MIB
and not the standard
RFC 2863 IF-MIB.

A small number of IPv6
devices do not support
the standard RFC 2863

NNMi Advanced. IPv6

1Provider Edge router. The Internet Service Provider's router that receives your data on the path to
your data's final desination. The Customer Edge (CE) router in your network connects to this PE.
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Unique Key Capability Description

IF-MIB for IPv6
interfaces. In this case,
NNMi uses theRFC
2465 IPv6-MIB. When
this happens, note the
following:

l Interface index
(ifIndex) and
description
(ifDescr) are set
according to the RFC
2465 IPv6MIB.

l Interface type
(ifType) is set to
Other (no specific
type is available).

l Interface Name
(ifName), Alias
(ifAlias), and
Speed (ifSpeed) are
blank (not available).

l NNMi monitors the
Status of this
interface, but
Performancemetrics
are not available.

When an IP Address has
the Interface Name
(ifName) attribute set to
blank, NNMi constructs
an alternate string for the
IP Address's In
Interface attribute
(Other[<ifIndex_
value>]).

NNMi Advanced. IPv6, continued

HP Network NodeManager i Software (9.21)Page 131 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

NNMi Advanced. The capabilities in the following table identify how the interface is participating in
a Link Aggregation1.

Unique Key Capability Description

com.hp.nnm.capability.lag.aggregator Aggregator
Interface

Indicates the interface
represents a collection of
participating interfaces at one
end of an Aggregator Layer 2
Connection.

See Layer 2 Neighbor View
MapObjects for more
information.

com.hp.nnm.capability.lag.member Aggregation
Member

Indicates the interface is a
physical interface that is a
member of an Aggregator
Interface.

See Layer 2 Neighbor View
MapObjects for more
information.

NNMi Advanced. Link Aggregation Interface Capabilities: Roles

NNMi Advanced. The capabilities in the following table are used when Link Aggregation2 protocol
is available.

Unique Key Capability Description

com.hp.nnm.capability.lag.protocol.lacp 802.3ad Link
Aggregation
Control
Protocol

Indicates an
interface using the
IEEE 802.3ad Link
Aggregation

NNMi Advanced. Link Aggregation Interface Capabilities: Protocols 

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
2Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Unique Key Capability Description

Control protocol
(LACP).

com.hp.nnm.capability.lag.protocol.static Static/Manual
Configured
Link
Aggregation

Indicates the
device has been
configured with
Static/Manual
Configured Link
Aggregation
(static).

com.hp.nnm.capability.lag.protocol.unknown Unknown
Protocol Link
Aggregation

Indicates the
hosting interface is
amember of Link
Aggregation with
unknown protocol.

NNMi Advanced. Link Aggregation Interface Capabilities: Protocols , continued

Interface Capability Form

This form describes a capability added to the interface object by NNMi or an external application.
Capabilities enable NNMi and application programmers to providemore information about a card
than what is initially stored in the NNMi database.

For example, NNMi uses the capability feature to identify interfaces for which NNMi can obtain only
limited information. Examples of these interfaces include Nortel interfaces as well as any interface
on a non-SNMP node. To help identify these interfaces, NNMi assigns the interface the capability
of com.hp.nnm.capability.iface.private.

Note: Because the values are generated by NNMi or an external application, Capability values
cannot bemodified. 

(NNMi Advanced - Global Network Management feature) Any Capability values added by an NNM
iSPI are available on the Global Manager only if that iSPI is also running on theGlobal Manager.

Attribute Description

Capability Label used to identify the Capability that was added to the interface object.

"Interface Form: Capabilities Tab" (on page 125) shows a list of all available
Capabilities for that interface.

For more information, see "Interface Capabilities Provided by NNMi" (on page 126).

Unique
Key

Used as a unique identifier for the Capability. Any capability provided by NNMi
begins with the prefix com.hp.nnm.capability.

For more information, see "Interface Capabilities Provided by NNMi" (on page 126).

Interface Capability Attributes
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Interface Form: Custom Attributes Tab
Custom Attributes enable an NNMi administrator to add information to the Interface object. 
Custom Attributes can also be set by external applications that have been integrated with NNMi.

The Interface Form: Custom Attributes Tab displays a table view of any Custom Attributes that
have been added to the interface object. For example, your NNMi administrator might have added
Role as another attribute for the interfaces in your network.

Note: If your role permits, you can edit a Custom Attribute. Only users assigned to the NNMi
Administrator role can add a Custom Attribute.

(NNMi Advanced - Global Network Management feature) Custom Attribute values are not sent from
aRegional Manager (NNMi management server) to the Global Manager. NNMi administrators for
the Global Manager can configure Custom Attribute values that are stored in the NNMi database on
theGlobal Manager.

Attribute Description

Name Name used to identify the Custom Attribute. This name appears in the table view on
the Custom Attributes tab in Interface forms.

Value The actual value for the Custom Attribute for the selected interface. For example, the
value forRolemight be WAN interface to the London office. For more information,
see "Interface Custom Attributes Form" (on page 134).

Custom Attributes Table

Interface Custom Attributes Form

Custom Attributes enable an NNMi administrator to add information to the interface object . For
example, your NNMi administrator might have added Role as another attribute for the interfaces in
your network. Custom Attributes can also be set by external applications that have been integrated
with NNMi.

The Custom Attributes form displays the Name and Value for each of the Custom Attributes that
were added to the interface object. Each of these attributes is described in the table below.

(NNMi Advanced - Global Network Management feature) Custom Attribute values are not sent from
aRegional Manager (NNMi management server) to the Global Manager. NNMi administrators for
the Global Manager can configure Custom Attribute values that are stored in the NNMi database on
theGlobal Manager.

Attribute Description

Name Name used to identify the Custom Attribute. This name appears in the table view on
the Custom Attributes tab in the Interface forms.

Value Value assigned to the Custom Attribute for the selected interface object. For
example, the value forRolemight be WAN interface to the London office.

Basics Attributes

Interface Form: Interface Groups Tab
The "Interface Form" (on page 114) provides details about the selected network interface.
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For information about each tab:

Attribute
Description

Interface
Groups

Table view of Interface Groups to which the selected interface belongs. Interface
groups are based on specific characteristics of interfaces.

Double-click the row representing an Interface Group. The "Interface Group Form" (on
page 236) displays all details about the selected Interface Group.

Interface Groups Membership Table

Interface Form: Performance Tab (HP Network Node Manager iSPI
Performance for Metrics Software)

The "Interface Form" (on page 114) provides details about the selected network interface.

Tip: This information is also visible in theMonitoring workspace, Interface Performance view.

For information about each tab:

The Performance tab displays data if the HP Network NodeManager iSPI Performance for Metrics
Software software is installed and configured within your environment. The NNMi administrator can
configure an optional high/low threshold.

The icons on the Performance tab indicate the value of themost recent interface performance
states: 

High - The High
threshold was
crossed.

Nominal -
Measured within
healthy range. (Or no
thresholds are being
monitored.)

Low - The Low
threshold was
crossed.

None - The value
returned was zero.

Abnormal Range - This interface is abnormal based on the
computed baseline for the specified threshold.

Agent Error - The SNMP agent responded with an error, rather than
a value.

Not Polled - This interface is intentionally not polled. Possible
reasons are: PerformanceMonitoring is not enabled, because of current
Communication Configuration settings in NNMi, or because the parent
Node or Interface is set to Not Managed or Out of Service.

Normal Range - This interface is normal based on the computed
baseline for the specified threshold.

Unavailable - State Poller is unable to compute the performance
state or the computed value is outside of the valid range (for
example: f0.00 - 100.00).

Tip: NNMi can generate incidents based on threshold results

HP Network NodeManager i Software (9.21)Page 135 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute Description

Input
Utilization

The total number of incoming octets traversing the interface as a percentage of the
total possible number of octets (based on the ifSpeed value). From Interface to
Interface, the exact MIB variables queried vary based on interface speed and
whether the system supports the high speed counters for interfaces.

Tip: Sometimes the value returned by the device's SNMP agent is not accurate and
causes problems when NNMi calculates input utilization. NNMi lets you
manually override the ifSpeed provided by the SNMP agent for this interface.
See Input Speed.

Input
Utilization
Baseline

The computed baseline for the input utilization on the interface. This range is based
on the interface speed and the reported change in the number of input bytes on the
interface.

Output
Utilization

The total number of outbound octets traversing the interface as a percentage of the
total possible number of octets (based on the ifSpeed value). From Interface to
Interface, the exact MIB variables queried vary based on interface speed and
whether the system supports the high speed counters for interfaces.

Tip: Sometimes the value returned by the device's SNMP agent is not accurate and
causes problems when NNMi calculates output utilization. NNMi lets you
manually override the output speed provided by the SNMP agent for this
interface. SeeOutput Speed.

Output
Utilization
Baseline

The computed baseline for the output utilization on the interface. This range is based
on the interface speed, and the reported change in the number of output bytes on the
interface.

Input
Error
Rate

Rate based on the reported change in the number of input packets on the interface
and the packet error count. What constitutes an error is system specific, but likely
includes such issues as bad packet checksums, incorrect header information, and
runt packets.

Output
Error
Rate

Rate based on the reported change in the number of output packets on the interface
and the packet error count. What constitutes an error is system specific, but likely
includes such issues as collisions and buffer errors.

Input
Discard
Rate

Rate based on the reported change in the number of input packets on the interface
and the discarded packet count. Packets might be discarded because of a variety of
issues, including receive buffer overflows, congestion, or system specific issues.

Output
Discard
Rate

Rate based on the reported change in the number of output packets on the interface
and the discarded packet count. Packets might be discarded because of a variety of
issues, including transmission buffer overflows, congestion, or system specific
issues.

FCS LAN
Error
Rate

Local Area Network. FrameCheck Sequence (FCS) error rate on the interface. The
error rate is based on the number of frames that were received with a bad checksum
(CRC value).

Performance Results Table (HP Network Node Manager iSPI Performance for
Metrics Software)
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Attribute Description

FCS
WLAN
Error
Rate

Wireless Local Area Network. FrameCheck Sequence (FCS) error rate on the
interface. The error rate is based on the number of frames that were received with a
bad checksum (CRC value).

Input
Queue
Drops

The number of input queue drops on the interface. This range is based on the number
of packets dropped because of a full queue.

Output
Queue
Drops

The number of output queue drops on the interface. This number is based on the
number of packets dropped because of a full queue.

Performance Results Table (HP Network Node Manager iSPI Performance for Met-
rics Software), continued

Interface Form: Incidents Tab
The "Interface Form" (on page 114) provides details about the selected network interface.

For information about each tab:

Attribute Description

Associated
Incidents

Table view of the incidents associated with the selected interface. These incidents
are sorted by creation time so that you can view the incidents in chronological
order. Use this view to determine which incidents are still open for the selected
interface.

Double-click the row representing an incident. The "Incident Form" (on page 300)
displays all details about the selected incident.

Incidents Table

Interface Form: Status Tab
The "Interface Form" (on page 114) provides details about the selected network interface.

For information about each tab:

Attribute Description

Status Overall status for the current interface. NNMi follows the ISO standard for status
classification. Possible values are:

Note: The icons are displayed only in table views.

  No Status

  Normal

  Disabled

Status Tab
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Attribute Description

  Unknown

  Warning

  Minor

  Major

  Critical

Interface status is derived from SNMP polling results for ifAdminStatus and
IfOperStatus, as well as any conclusions. For information about how the current
status was determined, see the "Interface Form: Conclusions Tab" (on page 138).
Status reflects themost serious outstanding conclusion. See "Watch Status Colors"
(on page 274) for more information about possible status values.

NNMi Advanced. Link Aggregation1: If the Interface is an Aggregator, the Status is
calculated using the combined Status of all AggregationMember Interfaces. For more
information, see"Interface Form: Link Aggregation Tab (NNMi Advanced)" (on page
122) and Status Color for Link Aggregation Objects.

Status
Last
Modified

Date and time indicating when the status was last set.

Status Tab, continued

Attribute
Description

Status
History

List of up to the last 30 changes in the status for the interface. This view is useful for
obtaining a summary of the interface status so that you can better determine any
patterns in behavior and activity.

Double-click the row representing a Status History. The Status History form displays
all details about the selected Status.

Status History Table

Interface Form: Conclusions Tab
The "Interface Form" (on page 114) provides details about the selected network interface.

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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All relevant conclusions are shown in the table on this tab. Themost severe Status in the current
group of conclusions becomes the overall Interface status. Some Interface conclusions propagate
to other object types: 

For information about each tab:

Attribute Description

Outstanding
Status
Con-
clusions

The dynamically generated list of summary statuses of the interface that
contributed to the current overall status of the selected interface. Status is set by
the Causal Engine.

Each Conclusion listed is still outstanding and applies to the current overall
Status.

This view is useful for obtaining a quick summary of the Status and problem
description for the current node’s interfaces that led up to the interface’s most
current Status.

The Status value is correlated based on themost critical Conclusions.

Double-click the row representing a Conclusion. The Conclusion form displays all
details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for an
interface object.

Note: A Y in the Incident? column indicates that the Conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description Status Incident?

AggregatorDown Link Aggregation1: TheOperational
State of the Aggregator Interface is
Down (if monitored), or all of the
AggregationMember Interfaces are
Down. For more information, see
"Interface Form: Link Aggregation Tab
(NNMi Advanced)" (on page 122).

Critical Y

InterfaceDown The interface Operational State is
Down.

Critical Y

Outstanding Status Conclusion Values

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

Major Status Conclusions HP Network Node Manager iSPI Performance for
Metrics Software

Conclusion Description Status Incident?

InterfaceFCSLANErrorRateHigh Local Area
Network.
Indicates a
FrameCheck
Sequence (FCS)
error rate on the
interface has
gone above a
threshold setting.

The error rate is
based on the
number of frames
that were
received with a
bad checksum
(CRC value).
Possible causes
include collisions
at half-duplex, a
duplex
mismatch, bad
hardware (NIC,
cable, or port), or
a connected
device generating
frames with bad
FCS.

Major Y

InterfaceFCSWLANErrorRateHigh Wireless Local
Area Network. A
FrameCheck
Sequence (FCS)
error rate on the
interface has
gone above a
threshold setting.

The error rate is
based on the
number of frames
that were

Major Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

received with a
bad checksum
(CRC value).
Possible causes
include collisions
at half-duplex, a
duplex
mismatch, bad
hardware (NIC,
cable, or port), or
a connected
device generating
frames with bad
FCS.

InterfaceInputDiscardRateHigh The input discard
rate on the
interface has
exceeded a
threshold setting.

This rate is based
on the reported
change in the
number of input
packets on the
interface and the
discarded packet
count.

Major Y

InterfaceInputErrorRateHigh The input error
rate on the
interface has
exceeded a
threshold setting.

This rate is based
on the reported
change in the
number of input
packets on the
interface and the
packet error
count.

Major Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

InterfaceInputQueueDropsRateHigh The number of
input queue drops
on the interface
has exceeded a
threshold setting.

This range is
based on the
number of
packets dropped
because of a full
queue. Possible
causes include
that the number
of packet buffers
allocated to the
interface is
exhausted or has
reached its
maximum
threshold.

Major Y

InterfaceInputUtilizationHigh The input
utilization on the
interface has
exceeded a
threshold setting.

This percentage
is based on the
interface speed
and the reported
change in the
number of input
bytes on the
interface.

Major Y

InterfaceInputUtilizationLow The input
utilization on the
interface is below
a threshold
setting.

This percentage
is based on the

Major Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

interface speed
and the reported
change in the
number of input
bytes on the
interface.

InterfaceInputUtilizationNone The input
utilization for the
interface is zero
(0).

This value is
based on the
interface speed
and the reported
change in the
number of input
bytes on the
interface.

Major Y

InterfaceOutputDiscardRateHigh The output
discard rate on
the interface has
exceeded a
threshold setting.

This rate is based
on the reported
change in the
number of input
packets on the
interface and the
discarded packet
count.

Major Y

InterfaceOutputErrorRateHigh The output error
rate on the
interface has
exceeded a
threshold setting.

This rate is based
on the reported
change in the
number of output

Major Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

packets on the
interface and the
packet error
count.

InterfaceOutputQueueDropsRateHigh The number of
output queue
drops on the
interface has
exceeded a
threshold setting.

This number is
based on the
number of
packets dropped
because of a full
queue.

Major Y

InterfaceOutputUtilizationHigh The output
utilization on the
interface has
exceeded a
threshold setting.

This percentage
is based on the
interface speed
and the reported
change in the
number of output
bytes on the
interface.

Major Y

InterfaceOutputUtilizationLow The output
utilization on the
interface is below
a threshold
setting.

This percentage
is based on the
interface speed
and the reported
change in the
number of output

Major Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

bytes on the
interface.

InterfaceOutputUtilizationNone The output
utilization on the
interface is zero
(0).

This value is
based on the
interface speed
and the reported
change in the
number of output
bytes on the
interface.

Major Y

Minor Status Conclusions

Conclusion Description Status Incident?

AggregatorDegraded Link Aggregation1: One or more
(but not all) AggregationMember
Interfaces that are part of the
Aggregator Interface have an
Operational State of Down. For
more information, see "Interface
Form: Link Aggregation Tab (NNMi
Advanced)" (on page 122).

Minor Y

Warning Status ConclusionsHP Network NodeManager iSPI Performance for
Metrics Software

Conclusion Description Status Incident?

InterfaceInputUtilizationAbnormal The input
utilization on the

Warning Y

Outstanding Status Conclusion Values, continued

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

Conclusion Description Status Incident?

interface is
abnormal based
on the computed
baseline.

This range is
based on the
interface speed
and the reported
change in the
number of input
bytes on the
interface.

interface is
abnormal based
on the computed
baseline.

InterfaceOutputUtilizationAbnormal The output
utilization on the
interface is
abnormal based
on the computed
baseline.

This range is
based on the
interface speed,
and the reported
change in the
number of output
bytes on the
interface.

Warning Y

Disabled Status Conclusions

Conclusion Description Status Incident?

InterfaceDisabled The interface has been explicitly
disabled by the device
administrator.

Disabled Y

Normal Status Conclusions

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

AggregatorUp Link
Aggregation
1: The
Aggregator
Interface and
all
Aggregation
Member
Interfaces
have an
Operational
State of Up.
For more
information,
see "Interface
Form: Link
Aggregation
Tab (NNMi
Advanced)"
(on page 122).

Nor-
mal

N

InterfaceEnabled The interface
has an
Admin-
istrative State
of Up.

Nor-
mal

N

InterfaceFCSLANErrorRateInRange

HP Network NodeManager iSPI
Performance for Metrics Software

The Frame
Check
Sequence
error rate for
the interface
is within the
allowable
range set by

Nor-
mal

N

Outstanding Status Conclusion Values, continued

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

Conclusion Description Status
Inci-
dent?

the
administrator.

InterfaceFCSWLANErrorRateInRange

HP Network NodeManager iSPI
Performance for Metrics Software

The Frame
Check
Sequence
error rate for
the interface
is within the
allowable
range set by
the
administrator.

Nor-
mal

N

InterfaceInputDiscardRateLow

HP Network NodeManager iSPI
Performance for Metrics Software

The input
discard rate
for the
interface is
below the
allowable low
range set by
the
administrator.

Nor-
mal

N

InterfaceInputDiscardRateNominal

HP Network NodeManager iSPI
Performance for Metrics Software

The input
discard rate
for the
interface is
within the
allowable
threshold
range set by
the
administrator.

Nor-
mal

N

InterfaceInputDiscardRateNone

HP Network NodeManager iSPI
Performance for Metrics Software

The input
discard rate
for the
interface is
zero (0) .

Nor-
mal

N

InterfaceInputErrorRateLow

HP Network NodeManager iSPI
Performance for Metrics Software

The input
error rate for
the interface

Nor-
mal

N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

is below the
allowable
threshold
range set by
the
administrator.

InterfaceInputErrorRateNominal

HP Network NodeManager iSPI
Performance for Metrics Software

The input
error rate for
the interface
is within the
allowable
threshold
range set by
the
administrator.

Nor-
mal

N

InterfaceInputErrorRateNone

HP Network NodeManager iSPI
Performance for Metrics Software

The input
error rate for
the interface
is zero (0).

Nor-
mal

N

InterfaceInputQueueDropsRateInRange

HP Network NodeManager iSPI
Performance for Metrics Software

The number
of input queue
drops for the
interface is
within the
allowable
range set by
the
administrator.

Nor-
mal

N

InterfaceInputUtilizationNominal

HP Network NodeManager iSPI
Performance for Metrics Software

The input
utilization for
the interface
is within the
allowable
threshold
range set by
the
administrator.

Nor-
mal

N

InterfaceInputUtilizationNormal

HP Network NodeManager iSPI

The input
utilization on

Nor-
mal

N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

Performance for Metrics Software the interface
is normal
based on the
computed
baseline.

This range is
based on the
interface
speed and the
reported
change in the
number of
input bytes on
the interface.

the interface
is normal
based on the
computed
baseline.

InterfaceOutputDiscardRateLow

HP Network NodeManager iSPI
Performance for Metrics Software

The output
discard rate
for the
interface is
below the
allowable
threshold
range set by
the
administrator.

Nor-
mal

N

InterfaceOutputDiscardRateNominal

HP Network NodeManager iSPI
Performance for Metrics Software

The output
discard rate
for the
interface is
within the
allowable
threshold
range set by
the
administrator.

Nor-
mal

N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

InterfaceOutputDiscardRateNone

HP Network NodeManager iSPI
Performance for Metrics Software

The output
discard rate
for the
interface is
zero (0).

Nor-
mal

N

InterfaceOutputErrorRateLow

HP Network NodeManager iSPI
Performance for Metrics Software

The output
error rate for
the interface
is below the
allowable low
range set by
the
administrator.

Nor-
mal

N

InterfaceOutputErrorRateNominal

HP Network NodeManager iSPI
Performance for Metrics Software

The output
error rate for
the interface
is within the
allowable
threshold
range set by
the
administrator.

Nor-
mal

N

InterfaceOutputErrorRateNone

HP Network NodeManager iSPI
Performance for Metrics Software

The output
error rate for
the interface
is zero (0).

Nor-
mal

N

Inter-
faceOutputQueueDropsRateInRange

HP Network NodeManager iSPI
Performance for Metrics Software

The number
of output
queue drops
for the
interface is
within the
allowable
threshold
range set by
the
administrator.

Nor-
mal

N

InterfaceOutputUtilizationNominal

HP Network NodeManager iSPI

The output
utilization for

Nor-
mal

N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

Performance for Metrics Software the interface
is within the
allowable
threshold
range set by
the
administrator.

InterfaceOutUtilizationNormal

HP Network NodeManager iSPI
Performance for Metrics Software

The output
utilization for
the interface
is within the
allowable
threshold
range set by
the
administrator.

Nor-
mal

N

InterfaceUp The
Operational
State of the
interface is
Up.

Nor-
mal

N

Outstanding Status Conclusion Values, continued

Interface Form: Registration Tab
The "Interface Form" (on page 114) provides details about the selected network interface.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes
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IP Address Form
The IP Address form provides information for the IP address selected. This form is useful for
troubleshooting purposes because you can access additional information about the node, interface,
subnet, and incidents associated with this address.

If your role permits, you can use this form tomodify theManagement Mode for an address (for
example, to indicate it will be temporarily out of service) or add notes to communicate information
about this address to your team.

For information about each tab:

Attribute Description

Address An IP address provided by your NNMi administrator as a discovery seed or an IP
address gathered by Spiral Discovery.

Prefix
Length

The number of significant bits in the subnet prefix associated with this IP
address.

For IPv4 addresses, this value is derived from the subnet mask.

Mapped
Address

If static Network Address Translation (NAT) is part of your network management
domain, your NNMi administrator can configure NNMi to display the NAT internal
IP address (such as private IPv4 address) assigned to the selected external IP
address.

Status Overall status for the current IP address. NNMi follows the ISO standard for
status classification. See "IP Address Form: Status Tab" (on page 156).

Management
Mode

The calculatedManagement Mode for the address used to indicate whether the
current IP address is beingmanaged.

This value should reflect themanagement mode assigned to the node in which
the selected address resides as well as on any associated interfaces. For
example, if the node's management mode is Managed, and theManagement
Mode of the interface is Inherited, theManagement Mode value for the address
is Managed.

(NNMi Advanced - Global Network Management feature) Any change to this
Management Mode setting is sent from aRegional Manager to the Global
Manager during the next Spiral Discovery cycle on the Regional Manager.

Note: If the NNMi Security configuration permits, you can change this setting
usingActions→Management Mode.

Tip: You can right-click any object in a table or map view to access the
Actionsmenu.

Direct
Management
Mode

This attribute is set by the administrator and specifies whether an address should
bemanaged or is temporarily out of service. Possible values are:

Basic Attributes
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Attribute Description

Inherited – Used to indicate that the address should inherit theManagement
Mode from the associated interface, if any. Otherwise the address inherits the
Management Mode of the node in which it resides.

Not Managed – Used to indicate that you do not plan tomanage the address.
For example, the address might not be accessible because it is in a private
network. NNMi does not discover or monitor these addresses.

Out of Service – Used to indicate the address is unavailable because it is out
of service. NNMi does not discover or monitor these addresses.

This attribute is useful for notifying NNMi when an address is been temporarily
out of service, or should never bemanaged.

Note: If you change the Direct Management Mode usingActions→
Management Mode, NNMi updates the calculatedManagement Mode on
the form. If youmanually set the Direct Management Mode and then Save
your changes, theManagement Mode value is not updated until you refresh
the form.

State Indicates whether NNMi is communicating with the IP address. Possible values
are:

Responding – Indicates that the IP address is being polled and is responding
to an ICMP ping.

Not Responding – Indicates that the IP address is being polled, but is not
responding to an ICMP ping.

The following values indicate NNMi encountered trouble while trying to gather the
required data:

No Polling Policy - No polling policy exists in Monitoring Configuration
settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled, based on
current Monitoring Configuration settings, current Communication
Configuration settings, current polling policies, or because the parent Node is
set to Not Managed or Out of Service

Unavailable - Unable to determine the State. For example, the SNMP agent
returned a value outside the range of possible values or returned a null value.

Unset – Currently not used by NNMi.

Note: NNMi's State Poller determines the State. The current state contributes
towards the status calculation for the address. See the Status tab for more
information.

State Last
Modified

The date and time when the State value was last modified.

Basic Attributes, continued
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Attribute Description

In Interface MIB-II ipAddrTable value indicating the interface that owns this IP address. Click
the  Lookup icon and select  Open to display more information about the
interface.

Hosted On
Node

node in which the address resides. This is the current value in NNMi’s database
for the Name attribute of the host device. The value could be a DNS name, a
MIB-II sysName, or an address (depending on how your NNMi administrator
configured the discovery process).

Click the  Lookup icon and select  Show Analysis or  Open to display
more information about the node.

In Subnet Subnet on which the IP address resides. NNMi derives this subnet based on the
IP address and the subnet prefix information. Click the  Lookup icon and
select  Open to display more information about the IP subnet.

Notes (NNMi Advanced - Global Network Management feature) The text you enter here
is not sent from aRegional Manager (NNMi management server) to the Global
Manager. NNMi administrators for the Global Manager can add notes that are
stored in the NNMi database on theGlobal Manager.

Provided for network operators to use for any additional notes required to further
explain the IP address. Informationmight include whether the address is a
backup address. Youmight also use this attribute to track which geographical
groupmight use the address.

Type amaximum of 1024 characters. Alpha-numeric, spaces, and special
characters (~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Note: You can sort your IP address table views based on this value. Therefore,
youmight want to include keywords for this attribute value.

Basic Attributes, continued

IP Address Form: Incidents Tab
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in

the incident view's column headings.

The "IP Address Form" (on page 153) provides details about the selected IP address.

For information about each tab:

Description

Table view of the incidents associated with the selected address. These incidents are sorted by
creation time so that you can view the incidents in chronological order. Use this view to
determine which incidents are still open for the selected address.

Double-click the row representing an incident. The "Incident Form" (on page 300) displays all
details about the selected incident.

Incidents Table
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IP Address Form: Status Tab
The "IP Address Form" (on page 153) provides details about the selected IP address .

For information about each tab:

Attribute Description

Status Overall status for the current IP address. NNMi follows the ISO standard for status
classification. Possible values are:

 No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

IP address status is derived from ICMP ping results, as well as any conclusions. For
information about how the current status was determined, see the "IP Address Form:
Conclusions Tab" (on page 156). Status reflects themost serious outstanding
conclusion. See "Watch Status Colors" (on page 274) for more information about
possible status values.

Note: The icons are displayed only in table views.

Status
Last
Modified

Date and time indicating when the status was last set.

Status of thiis IP Address

Attribute
Description

Status
History

List of up to the last 30 changes in status for the selected IP Address. This view is
useful for obtaining a summary of the IP address status so that you can better
determine any patterns in behavior and activity.

Double-click the row representing a Status History. The Status History form displays
all details about the selected Status.

Status History Table

IP Address Form: Conclusions Tab
The "IP Address Form" (on page 153) provides details about the selected IP address .

HP Network NodeManager i Software (9.21)Page 156 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

All relevant conclusions are shown in the table on this tab. Themost severe Status in the current
group of conclusions becomes the overall IP Address status. Some IP Address conclusions
propagate to other object types: 

For information about each tab:

Attribute Description

Outstanding
Status
Conclusions

The dynamically generated list of summary statuses of the IP address that
contributed to the current overall Status of the selected IP address. Status is set
by the Causal Engine.

Each Conclusion listed is still outstanding and applies to the current overall
Status.

This view is useful for obtaining a quick summary of the Status and problem
description for the current node's IP address that led up to the address' most
current Status.

The Status value is correlated based on themost critical Conclusions.

Double-click the row representing a Conclusion. The Conclusion form displays
all details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for an
IP Address object.

Note: A Y in the Incident? column indicates that the Conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description Status Incident?

AddressNotResponding The address is not responding
to ICMP ping.

Critical Y

Normal Status Conclusions

Conclusion Description Status Incident?

AddressResponding The address responds to ICMP
ping.

Normal N

Outstanding Status Conclusion Values

IP Address Form: Capabilities Tab
The "IP Address Form" (on page 153) provides details about the selected IP address.

For information about each tab:

The IP Address Form: Capabilities tab displays a table view of any capabilities added to the
IP Address object by NNMi or an external application. Capabilities enable NNMi and application
programmers to providemore information about an IP address than is initially stored in the NNMi
database.
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For example, NNMi uses the capability feature to identify an IPv4Anycast Rendezvous Point
IP Address1 or IPv6 Anycast address so it is not polled. NNMi assigns the following capability to
the address: com.hp.nnm.capability.address.anycast.

Note: Because the values are generated by NNMi or an external application, Capability values
cannot bemodified.

(NNMi Advanced - Global Network Management feature) Any Capability values added by an NNM
iSPI are available on the Global Manager only if that iSPI is also running on theGlobal Manager.

Attribute Description

Capability Table of all of the capabilities associated with the selected IP Address. Use this
table to access information about each Capability.

Double-click the row representing a Capability. The "IP Address Capability Form"
(on page 159) displays all details about the selected Capability.

For more information, see "IP Address Capabilities Provided by NNMi" (on page
158).

Capabilities Table

IP Address Capabilities Provided by NNMi

The "IP Address Form: Capabilities Tab" (on page 157) displays a table of any capabilities added to
a particular IP Address object. Capabilities enable NNMi and application programmers to provide
more information about an IP address than what is initially stored in the NNMi database.

External applications can also add capabilities.

KEY: com.hp.<product>.capability.<content>.<vendor/org>.<MIB/feature>

Any Capability provided by NNMi begins with the prefix com.hp.nnm.capability.

<product> = Either NNMi or the NNM iSPI providing this capability.

<content> = card, ipaddr (address), iface (interface), lag (Link Aggregation2 interface), node,
rrp (Router Redundancy), or metric (Node Sensor, Component Health, Component and
DeviceMetrics).

<vendor/org> = Standards organization or vendor defining theMIB or feature associated with the
capability.

<MIB/feature> = What this capability measures.

1Rendezvous Point addresses are loopback addresses used for routers in multi-cast network
configurations.
2Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Note: The following table shows a few examples of the Capabilities provided by NNMi.

Unique Key Capability Description

com.hp.nnm.capability.address.loopback LOOPBACK Used to identify a
loopback address1.

com.hp.nnm.capability.address.anycast ANYCAST Used to identify an
address that is either of
the following:

l IPv4Anycast
Rendezvous Point
IP Address2 that are
loopback addresses
used for routers in
multi-cast network
configurations. These
duplicate IP
addresses are
excluded from
monitoring.

l NNMi Advanced: IPv6
Anycast address.

com.hp.nnm.capability.address.nat NAT
(network
address
translation)

Used tomap one address
space into another
(network masquerading to
protect private networks).

IP Address Capability Attribute Values

IP Address Capability Form

This form describes a capability added to the IP address object by NNMi or an external application.
Capabilities enable NNMi and application programmers to providemore information about an
IP address than what is initially stored in the NNMi database.

For example, NNMi uses the capability feature to identify an IPv4Anycast Rendezvous Point
IP Address3 or IPv6 Anycast address. To exclude these addresses from polling, NNMi assigns
following capability to the address: com.hp.nnm.capability.ipaddr.anycast

1The address associated with the loopback interface. The loopback interface is a virtual interface
on a device that provides a route for internal communication. Many vendors provide a specially
configured loopback for management purposes. Exact details of how loopbacks are configured
varies by vendor andmodel. See each device's documentation for details. NNMi identifies these
loopback addresses by using ifType Number 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network
configurations.
3Rendezvous Point addresses are loopback addresses used for routers in multi-cast network
configurations.
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Note: Because the values are generated by NNMi or an external application, Capability values
cannot bemodified. 

(NNMi Advanced - Global Network Management feature) Any Capability values added by an NNM
iSPI are available on the Global Manager only if that iSPI is also running on theGlobal Manager.

Attribute Description

Capability Label used to identify the Capability that was added to the IP address object.

"IP Address Form: Capabilities Tab" (on page 157) shows a list of all available
Capabilities for that IP address.

For more information, see "IP Address Capabilities Provided by NNMi" (on page
158).

Unique
Key

Used as a unique identifier for the Capability. Any capability provided by NNMi
begins with the prefix com.hp.nnm.capability.

For more information, see "IP Address Capabilities Provided by NNMi" (on page
158).

IP Address Capability Attributes

IP Address Form: Registration Tab
The "IP Address Form" (on page 153) provides details about the selected IP address .

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes

IP Subnet Form
The IP Subnet form provides details about the selected subnet. Each IP Subnet represents an
IP Subnet within a particular Tenant (that IPv4 Subnet definition independently applies to each
Tenant).

If your role permits, you can add notes to communicate information about this subnet to your team.
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For information about each tab:

Attribute Description

Name Subnet in your network. This value is determined by the discovery process
(calculated from IP Addresses and the subnet prefix information).

Prefix The value of the prefix for the current subnet (also known as the subnet address).

Prefix
Length

The number of significant bits in the subnet prefix. This value is used to determine the
size of the subnet.

Tenant Tenants enable NNMi administrators to partition a network across multiple
customers. The NNMi administrator controls the Tenant assignment for each Node.

A Tenant is the top-level organization to which a Node belongs.

Devices that belong to the Default Tenant can have Layer 2 Connections to any
device in any Tenant. Devices within any Tenant other thanDefault Tenant can have
Layer 2 Connections only to devices within the same Tenant or the Default Tenant.

Notes (NNMi Advanced - Global Network Management feature) The text you enter here is
not sent from aRegional Manager (NNMi management server) to the Global Manager.
NNMi administrators for the Global Manager can add notes that are stored in the
NNMi database on theGlobal Manager.

Provided for network operators to use for any additional notes required to further
explain the subnet. Informationmight include its use; for example, point to point for
dialup. Youmight also use this attribute to track which geographical groupmight use
the subnet.

Type amaximum of 1024 characters. Alpha-numeric, spaces, and special characters
(~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Note: You can sort your subnet table views based on this value. Therefore, youmight
want to include keywords for this attribute value.

Basic Attributes

IP Subnet Form: IP Addresses Tab
The "IP Subnet Form" (on page 160) provides details about the selected subnet.

For information about each tab:

Attribute Description

IP
Addresses

Table view of the IP addresses associated with the selected subnet. You can use
this table to determine the state, address, and interface, and parent node for each
address associated with the selected subnet.

Double-click the row representing an IP address. The "IP Address Form" (on page
153) displays all details about the selected IP address.

IP Addresses Table

IP Subnet Form: Registration Tab
The "IP Subnet Form" (on page 160) provides details about the subnet selected.
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For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes

VLAN Form
The VLAN form provides details about the selected virtual local area network, and lists all ports
known to participate in this VLAN.

Note the following:

l A trunk port can participate in multiple VLANs.

l Only the objects to which you have access are visible from the form.

For information about each tab:

(NNMi Advanced - Global Network Management feature) Theremight be slight differences between
the VLAN information shown on Regional Managers andGlobal Managers, because the VLAN
calculations use Layer 2 Connections data.

The following attributes always appear on the VLAN form, whether you access that form from the
VLAN view or from a VLAN Port form's tab.

Attribute Description

Global
VLAN
Name

VLAN connections are determined by a common VLAN Id. The name assigned to that
VLAN can be designated by each participating Node\Interface's configuration
settings for that VLAN Id. Therefore, NNMi chooses a VLAN name for this value
(from potentially many names for the same VLAN Id):

Global VLAN Name = NNMi uses the lowest sort-order name from all available
names designated by member Nodes.

Tip: If you see an attribute named Local VLAN Name = the VLAN name assigned by
the configuration settings on the currently selected Node\Interface.

VLAN Id The identification value for the current VLAN. This value is taken directly from the
MIB file provided by the Vendor.

Basic Attributes
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The following attributes display only when displaying information about a row in the VLAN view.

Attribute Description

Member
Node
[Interface]

hostname[Interface Name]

NNMi selects a representativeMember Node andMember Interface for the current
VLAN. Thesemembers help to distinguish VLANs that use the same identification
number.

NNMi selects theMember Node using the following criteria:

l The node is amember of the VLAN.

l The node has the lexicographically ordered first node hostname.

l The User Group to Security Groupmapping enables the user to view the node.

NNMi selects theMember Interface using the following criteria:

l The interfacemust be on theMember Node.

l The interface is amember of the VLAN.

l The interface has the lexicographically ordered first interface name.

l The User Group to Security Groupmapping enables the user to view the node to
which the interface belongs.

Member
Node
Count

Specifies the number of nodes that belong to the current VLAN.

VLAN Statistics Attributes

Related Topics:

"VLANs View (Inventory)" (on page 31)

VLAN Form: Ports Tab
Note: A trunk port can participate in multiple VLANs.

The "VLAN Form" (on page 162) provides details about the selected VLAN.

Attribute Description

Ports Table view of the ports associated with the selected VLAN. Use this table to access
information about each port associated with the selected VLAN across all member
devices.

Double-click the row representing a Port. The "Port Form" (on page 177) displays all
details about the selected Port.

Ports Associated with this VLAN

Related Topics:

"VLANs View (Inventory)" (on page 31)
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Card Form
The Card form provides details about the Card you selected on the Node form or Inventory: Cards
view. The following table describes the fields included on Basics section of the Card form.

For information about each tab:

Attribute Description

Name The name of the card. Sometimes it’s the descriptive string used by the network
administrator to name the card. For example, SupIII1000SX, Ether10/100TX,
RSM-Mod, and ATM-OC3-Phy.

If the Name value is null, NNMi uses the card Index value (see below).

Hosted on
Node

Node in which the card resides. This is the current value in NNMi’s database for
the Name attribute of the host device. The value could be a DNS name, aMIB-
II sysName, or an address (depending on how your NNMi administrator
configured the discovery process).

Click the  Lookup icon and select Show Analysis or  Open to display
more information about the node.

Status Overall status for the current card. NNMi follows the ISO standard for status
classification. See the "Card Form: Status Tab" (on page 173) for more
information. Possible values are:

  Normal

  Warning

  Minor

  Major

  Critical

  Disabled 

  Unknown

  No Status

Card status is derived from SNMP polling results for Administrative State,
Operational State, and themost serious outstanding conclusion. See the "Card
Form: Conclusions Tab" (on page 175) for information about how the current
status was determined. See "Watch Status Colors" (on page 274) for more
information about possible status values.

Note: The icons are displayed only in table views.

Management
Mode

Indicates whether the current node is beingmanaged. This field also lets you
specify whether a node is temporarily out of service. Possible values are:

Basic Attributes
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Attribute Description

Managed – Indicates the node is managed by NNMi.

Not Managed – Indicates the node is intentionally not managed. For
example, the nodemight not be accessible because it is in a private network.
NNMi does not update discovery information or monitor these nodes.

Out of Service – Indicates a node is unavailable because it is out of service.
NNMi does not update discovery information or monitor these nodes.

This attribute is useful for notifying NNMi when a device has been temporarily out
of service, or should never bemanaged.

(NNMi Advanced - Global Network Management feature) Any change to this
Management Mode setting is sent from aRegional Manager to the Global
Manager during the next Spiral Discovery cycle on the Regional Manager.

Note: If the NNMi Security configuration permits, you can change this setting
usingActions→Management Mode.

Tip: You can right-click any object in a table or map view to access the
Actionsmenu.

Direct
Management
Mode

Indicates whether the current card is beingmanaged. This attribute is set by the
administrator and specifies whether a card should bemanaged or whether a card
is temporarily out of service. Possible values are:

Inherited – Used to indicate that the card should inherit theManagement
Mode from the node in which it resides.

Not Managed – Used to indicate that NNMi does not discover or monitor the
card.

Out of Service – Used to indicate a card is unavailable because it is out of
service. NNMi does not discover or monitor these cards.

This attribute is useful for notifying NNMi when a card is temporarily out of
service, or should never bemanaged.

Note: If you change the Direct Management Mode usingActions→
Management Mode, NNMi updates the calculatedManagement Mode on
the form. If youmanually set the Direct Management Mode and then Save
your changes, theManagement Mode value is not updated until you refresh
the form.

Hosted on
Card

If this card is plugged into another card, the Name of that card is listed here.

Redundant
Group

Indicates whether this card participates in a group of cards that provide
redundancy protection against processor card failure.

Basic Attributes, continued
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Attribute Description

Administrative
State

Either the current card Administrative State value. The NNMi State Poller
interprets and normalizes the State value returned for themonitored attribute to
handle the differences between vendors. The current Administrative State
contributes towards the status calculation for this card. See the "Card Form:
Status Tab" (on page 173) for more information.

Note: If the card's SNMP agent supports only the Internet Engineering Task
Force (IETF) ENTITY-MIB, no state or status information is available.
NNMi sets this state to No Polling Policy and the card status to
  No Status. If you look on the parent "Node Form" (on page 48), you will
see the com.hp.nnm.capability.card.ietf.entity capability in
the list.

Possible values are:

Up – The SNMP agent responded with a card administrative status value of
Up.

Down – The SNMP agent responded with a card administrative status value
of Down.

Other – The SNMP agent responded with a value for card administrative
status that is not recognized.

The following values indicate NNMi could not gather the required data:

Agent Error – Indicates an SNMP error was returned in response to an
SNMP query to this agent.

No Polling Policy - Indicates the object is being polled, but no polling policy
exists in Monitoring Configuration settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled, based on
current Monitoring Configuration settings, current Communication
Configuration settings, or because the parent Node is set to Not Managed or
Out of Service. This object attributemight or might not have an associated
polling policy.

Unavailable - Unable to determine the State. For example, the SNMP agent
returned a value outside the range of possible values or returned a null value.

Unset – Currently not used by NNMi.

Operational
State

The current card Operational State value.  The NNMi State Poller interprets and
normalizes the State value returned for themonitored attribute to handle the
differences between vendors. The current Operational State contributes
towards the status calculation for this card. See the "Card Form: Status Tab"
(on page 173) for more information.

Note: If the card's SNMP agent supports only the Internet Engineering Task
Force (IETF) ENTITY-MIB, no state or status information is available.

Card State Attributes
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Attribute Description

NNMi sets this state to No Polling Policy and the card status to
  No Status. If you look on the parent "Node Form" (on page 48), you will
see the com.hp.nnm.capability.card.ietf.entity capability in
the list.

Possible values are:

Up – The SNMP agent responded that the card is operationally up, ready to
receive and send network traffic.

Disabled – The card's Administrative State is set to Down.

Down – The SNMP agent responded that the card is operationally down.

Dormant – Indicates the card is in a "pending” state, waiting for some
external event.

Minor Fault – Indicates that the card or one of its hardware components is
experiencing a partial failure.

Not Present – Indicates that the cardmodule is not installed or is missing
some hardware component.

Other – The SNMP agent responded with a value for card operational status
that is not recognized.

Testing – The SNMP agent responded that the card is in test mode.

Transient – Indicates the card is in a transient state. For example,
rebooting.

Unknown – The SNMP agent responded with a card operational status
value of unknown.

The following values indicate NNMi could not gather the required data:

Agent Error – Indicates an SNMP error was returned in response to an
SNMP query to this agent.

No Polling Policy - No polling policy exists in Monitoring Configuration
settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled, based on
current Monitoring Configuration settings, current Communication
Configuration settings, current polling policies, or because the parent Node
is set to Not Managed or Out of Service

Unavailable - The SNMP agent responded with a value for card operational
status of Not-Specified, so NNMi is unable to determine the State. Other
possibilites: the SNMP agent returned a value outside the range of possible
values or returned a null value.

Card State Attributes, continued
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Attribute Description

Unset – Currently not used by NNMi.

Current
Standby State

Either the current MIB-II Standby State value or a value the NNMi State Poller
interprets and normalizes to handle differences between vendors. The current
Standby State contributes towards the status calculation for this card. See the
"Card Form: Status Tab" (on page 173) for more information.

Note: If the card's SNMP agent supports only the Internet Engineering Task
Force (IETF) ENTITY-MIB, no state or status information is available.
NNMi sets this state to No Polling Policy and the card status to
  No Status. If you look on the parent "Node Form" (on page 48), you will
see the com.hp.nnm.capability.card.ietf.entity capability in
the list.

Possible values are:

Active - Indicates the card is the active card in the Card Redundancy
Group.

Cold-Standby - Indicates the card is not in use, but is available to take over
the role of the active card after it is initialized.

Hot-Standby - Indicates the card is not in use, but can immediately take
over the role of the active card.

Standby - Indicates the card is a candidate to become the next active card.

Error - Indicates the card cannot take over the role of active or standby card
in the Card Redundancy Group.

Other – The SNMP agent on the card responded with a value for Standby
State of Other or one that is not recognized. 

Transient – Indicates the card is in a transient state. For example,
rebooting.

Unknown - Indicates the card is unable to report Standby State.

The following values indicate NNMi could not gather the required data:

Agent Error – Indicates an SNMP error was returned in response to an
SNMP query to this agent.

No Polling Policy - Indicates the object is being polled, but no polling policy
exists in Monitoring Configuration settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled, based on
current Monitoring Configuration settings, current Communication
Configuration settings, or because the parent Node is set to Not Managed or
Out of Service. This object attributemight or might not have an associated
polling policy.

Card State Attributes, continued
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Attribute Description

Unavailable - Unable to determine the State. For example, the SNMP agent
returned a value outside the range of possible values or returned a null value.

Unset – Currently not used by NNMi.

Previous
Standby State

The Standby State that was determined before the current Standby State. See
Standby State for more information about Standby State and the possible
values.

State Last
Modified

The date and time when any combination of the Stand By State, Administrative
State, andOperational State were last modified.

Card State Attributes, continued

Attribute Description

Notes (NNMi Advanced - Global Network Management feature) The text you enter here is
not sent from aRegional Manager (NNMi management server) to the Global Manager.
NNMi administrators for the Global Manager can add notes that are stored in the
NNMi database on theGlobal Manager.

Provided for network operators to use for any additional information about this card
that you want to communicate to your team.

Type amaximum of 1024 characters. Alpha-numeric, spaces, and special characters
(~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Note: You can sort your Card table views based on this value. Therefore, youmight
want to include keywords for this attribute value.

Notes Attributes

Card Form: General Tab
The "Card Form" (on page 164) provides details about the selected card.

For information about each tab:

Attribute Description

Model
Name

Cardmodel name or number designator, determined by the vendor.

Type The hardware-type designator for the card, determined by the vendor. For example:

l cevCat6kWsSup720Base

l wssup720base(1002)

l cat6k-ws-sup720-base

Serial
Number

Card serial number, determined by the vendor.

General Attributes
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Attribute Description

Firmware
Version

The firmware version or revision for the card, determined by the vendor. For
example, 5.4(2).

Hardware
Version

The hardware version or revision for the card, determined by the vendor. For
example, 3.1.

Software
Version

The software version or revision for the card, determined by the vendor. For
example, 12.2(33)SXI

Index The unique value assigned to each card within a chassis or another card. The value
chosen is always consistent with the Name value assigned to the card's hosted
port. For example, the index of card hosting port Fa5/1 is 5 and the index of card
hosting port J8 is J.

If ENTITY-MIB is the only MIB supported for a particular card, this attribute has the
same value as the Physical Index attribute.

Physical
Index

NNMi gathers this attribute value if the ENTITY-MIB is supported by the card's
vendor.

Description The description assigned to the card by the operating system of the device in which
the card is mounted. Examples:

l WS-X5530 1000BaseSXSupervisor Rev. 1.8

l WS-X5225R 10/100BaseTX Ethernet Rev. 1.1

l HP J4111A 8-port 10/100Base-TX module

General Attributes, continued

Card Form: Ports Tab
The "Card Form" (on page 164) provides details about the selected card.

For information about each tab:

Attribute Description

Ports Table of all of the ports associated with the selected card. Use this table to access
information about each port associated with the selected card.

Double-click the row representing a Port. The "Port Form" (on page 177) displays all
details about the selected Port.

Ports Associated with this Card

Card Form: Daughter Cards Tab
The "Card Form" (on page 164) provides details about the selected card.

For information about each tab:
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Attribute Description

Daughter
Cards

Table of all of the cards that are plugged into the selected card. Use this table to
access information about each daughter card associated with the selected parent
card.

Double-click the row representing a Card. The "Card Form" (on page 164) displays all
details about the selected Card.

Daughter Cards Attached to this Card

Card Form: Capabilities Tab
The "Card Form" (on page 164) provides details about the selected card.

The Card Form: Capabilities tab displays a table of any capabilities added to the card object by
NNMi or an external application. Capabilities enable NNMi and application programmers to provide
more information about a card than is initially stored in the NNMi database.

For information about each tab:

Note: Because the values are generated by NNMi or an external application, Capability values
cannot bemodified.

(NNMi Advanced - Global Network Management feature) Any Capability values added by an NNM
iSPI are available on the Global Manager only if that iSPI is also running on theGlobal Manager.

Attribute Description

Capability Table of all of the capabilities associated with the selected Card. Use this table to
access information about each Capability.

Double-click the row representing a Capability. The "Card Capability Form" (on page
172) displays all details about the selected Capability.

For more information, see "Card Capabilities Provided by NNMi" (on page 171).

Capabilities of this Card

Card Capabilities Provided by NNMi

The "Card Form: Capabilities Tab" (on page 171) displays a table of any capabilities added to a
particular card object. Capabilities enable NNMi and application programmers to providemore
information about a card than what is initially stored in the NNMi database.

External applications can also add capabilities.

KEY: com.hp.<product>.capability.<content>.<vendor/org>.<MIB/feature>

Any Capability provided by NNMi begins with the prefix com.hp.nnm.capability.

<product> = Either NNMi or the NNM iSPI providing this capability.
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<content> = card, ipaddr (address), iface (interface), lag (Link Aggregation1 interface), node,
rrp (Router Redundancy), or metric (Node Sensor, Component Health, Component and
DeviceMetrics).

<vendor/org> = Standards organization or vendor defining theMIB or feature associated with the
capability.

<MIB/feature> = What this capability measures.

Note: The following table shows an example of the Capabilities provided by NNMi.

Unique Key Capability Description

com.hp.nnm.capability.card.fru Field
Replaceable
Unit

Indicates the device is a replaceable
card (Field Replaceable Unit).

Card Capability Attribute Values

Card Capability Form

This form describes a capability added to the card object by NNMi or an external application.
Capabilities enable NNMi and application programmers to providemore information about a card
than what is initially stored in the NNMi database.

Note: Because the values are generated by NNMi or an external application, Capability values
cannot bemodified.

(NNMi Advanced - Global Network Management feature) Any Capability values added by an NNM
iSPI are available on the Global Manager only if that iSPI is also running on theGlobal Manager.

Attribute Description

Capability Label used to identify the Capability that was added to the card object.

"Card Form: Capabilities Tab" (on page 171) shows a list of all available Capabilities
for that card.

For more information, see "Card Capabilities Provided by NNMi" (on page 171).

Unique
Key

Used as a unique identifier for the Capability. Any capability provided by NNMi
begins with the prefix com.hp.nnm.capability.

For more information, see "Card Capabilities Provided by NNMi" (on page 171).

Card Capability Attributes

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Card Form: Incidents Tab
The "Card Form" (on page 164) provides details about the selected card.

For information about each tab:

Attribute Description

Incidents Table of the Incidents associated with the selected card.

These Incidents are sorted by creation time so that you can view the Incidents in
chronological order. Use this table to determine which Incidents are still open for the
selected card.

Double-click the row representing an incident. The "Incident Form" (on page 300)
displays all details about the selected incident.

Tip: See "Incident Form" (on page 300) for more details about the incident attributes
that appear in the incident table's column headings.

Incidents Associated with this Card

Card Form: Status Tab
The "Card Form" (on page 164) provides details about the selected card.

For information about each tab:

Attribute Description

Status Overall status for the current card. NNMi follows the ISO standard for status
classification. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

Card status is derived from SNMP polling results for Administrative State,
Operational State, and themost serious outstanding conclusion. See the "Card
Form: Conclusions Tab" (on page 175) for information about how the current status
was determined. See "Watch Status Colors" (on page 274) for more information about
possible status values.

Note: The icons are displayed only in table views.

Overall Status Attributes
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Attribute Description

Status
Last
Modified

Date and time indicating when the Status was last set.

Overall Status Attributes, continued

Attribute Description

Status
History

Table of up to the last 30 changes in the status for the Card. This table is useful for
obtaining a summary of the Card Status so that you can better determine any patterns
in behavior and activity.

Double-click the row representing a Status History. The "Card Status History Form"
(on page 174) displays all details about the selected Status.

Card Status History Table

Card Status History Form

Card status is derived from SNMP polling results for Administrative State, Operational State, and
themost serious outstanding conclusion. See the "Card Form: Conclusions Tab" (on page 175) for
information about how the current status was determined. See "Watch Status Colors" (on page
274) for more information about possible status values.

Attribute Description

Status Overall status for the current card. NNMi follows the ISO standard for status
classification. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

Card status is derived from SNMP polling results for Administrative State,
Operational State, and themost serious outstanding conclusion.

Note: The icons are displayed only in table views.

Status Last
Modified

Date and time indicating when the status was last set.

Status Attributes
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Card Form: Conclusions Tab
The "Card Form" (on page 164) provides details about the selected card.

For information about each tab:

Attribute Description

Outstanding
Status
Conclusions

The table of dynamically generated summary statuses for the card that
contributed to the current overall Status of the selected card. Status is set by the
Causal Engine1.

Each Conclusion listed is outstanding and contributes to the current overall
Status.

This table is useful for obtaining a quick summary of the problem description for
the current card that led up to the card's most current Status.

Card Status is derived from themost serious outstanding Conclusion and
SNMP polling results for Administrative State andOperational State.

Double-click the row representing a Conclusion. The Conclusion form displays
all details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for a
Card object.

Note: A Y in the Incident? column indicates that the Conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description Status Incident?

CardDown TheOperational State of the selected
card is Down.

Critical Y

Minor Status Conclusions

Conclusion Description Status Incident?

CardDisabled SNMP agent reports that the
Administrative State for the
selected card is Down.

Minor Y

CardUndeterminedState NNMi cannot determine the Minor Y

Outstanding Status Conclusion Values

1The NNMi Causal Engine analyzes the health of your network and provides the ongoing health
status reading for each device. The Causal Engine also extensively evaluates problems and
determines the root cause for you, whenever possible, sending incidents to notify you of problems.
Any incident generated from aCausal Enginemanagement event has anOrigin of NNMi in your
incident views.
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Attribute Description

Conclusion Description Status Incident?

Card's State for one of the
following reasons:

l The SNMP agent
responded with a value for
the card's Operational
Status of Unavailable.

l The SNMP agent returned
a value outside the range
of possible values or
returned a null value.

Card's State for one of the
following reasons:

DaughterCardsDown TheOperational State of at
least one of the associated
daughter cards is Down.

Minor N

Normal Status Conclusions

Conclusion Description Status Incident?

CardEnabled The SNMP agent has determined
the card's Administrative State is
Up.

Normal N

CardUp TheOperational State for the
current card is Up.

Normal N

DaughterCardsUp TheOperational State of all
associated daughter cards is Up.

Normal N

Outstanding Status Conclusion Values, continued

Card Form: RegistrationTab
The "Card Form" (on page 164) provides details about the selected card.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes
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Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes

Port Form
The Port form provides details about the port you selected on the Node form or VLAN form. The
following table describes the fields included on the Port form.

For information about each tab:

Attribute Description

Name The port name consists of <Card-number / Port-number>.

Hosted on
Node

The current value from the Name attribute on the Node form of the node on which
the port resides. This is the current value in NNMi’s database for the Name
attribute of the host device. The value could be a DNS name, aMIB-II sysName, or
an address (depending on how your NNMi administrator configured the discovery
process).

Click the  Lookup icon and select  Show Analysis or  Open to display
more information about the node.

Card The current value from the Name attribute on the Card form of the card to which this
port is assigned.

Click the  Lookup icon and select  Show Analysis or  Open to display
more information about the node.

Type The port-type designator determined by the vendor.

Speed Potential maximum physical speed of the port.

Configured
Duplex
Setting

Set by the administrator of the node. Possible values are:

Value Description

Auto Indicates that Auto-negotiation is set for the configured duplex
setting. Auto-negotiation is an Ethernet procedure in which two
connected devices choose the fastest transmissionmode they both
support.

Half Indicates the port supports half-duplex operations. This means the
port can send information in both directions between two devices,
but in only one direction at a time.

Basic Attributes

Basic Attributes
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Attribute Description

Value Description

Full Indicates the port supports full-duplex operations. This means the
port can send data in both directions simultaneously.

Disagree Indicates the port could not agree on the duplex settings with a port
on the other end of a connection.

Unknown Indicates themanufacturer of this device does not support this
setting.

Basic Attributes, continued

Associated
Interface

The current value from the Name attribute on the Interface form of the interface
using this port. This is the current value in NNMi’s database obtained using the
InterfaceMIB: ifName, ifAlias, or ifType+ifIndex

Click the  Lookup icon and select  Show Analysis or  Open to display
more information about the interface.

ifAlias Optional InterfaceMIB variable for ifAlias assigned to the interface. This value is
set by the device administrator. An ifAlias could be useful if the interface vendor did
not provide an ifName value.

Port Index The unique value assigned to this port within the card.

Basic Attributes, continued

Related Topics:

"Node Form" (on page 48)

"Interface Form" (on page 114)

"Card Form" (on page 164)

Port Form: VLANs Tab
The "Port Form" (on page 177) provides details about the selected port.

For information about each tab:

(NNMi Advanced - Global Network Management feature) Theremight be slight differences between
the VLAN information shown on Regional Managers andGlobal Managers, because the VLAN
calculations use Layer 2 Connections data.

Attribute Description

VLANs Table view of the VLANs to which the selected port belongs. You can use this table to
determine the VLAN ID number and name for each VLAN associated with the

VLANs Attributes
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Attribute Description

selected port.

Double-click the row representing a VLAN. The "VLAN Form" (on page 162) displays
all details about the selected VLAN.

VLANs Attributes, continued

Related Topics:

"Node Form" (on page 48)

"VLAN Form" (on page 162)

Port Form: RegistrationTab
The "Port Form" (on page 177) provides details about the selected port.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes

Layer 2 Connection Form
The Layer 2 Connection form provides details about amanaged connection. These details include
the interfaces that make up the connection, the protocol used to create this connection, and the
current status of the connection. For example, if all interfaces are downwithin a connection, the
connection status is listed as Critical. The NNMi administrator can configure NNMi to automatically
delete Layer 2 Connections when all member Interfaces are down for a specified number of days.

For information about each tab:

Note: Forwarding Database (FDB) information can cause NNMi to establish wrong Layer 2
Connections in the following cases:
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l When the FDB is configured as cache and contains obsolete data.

l In network environments with hardware from a variety of vendors, when each vendor
generates different and sometimes conflicting FDB data.

Optional: NNMi administrators can configure Spiral Discovery to ignore the FDB data from one
NodeGroup when calculating Layer 2 Connections (the FDB data is still included in other
calculations).

(NNMi Advanced - Global Network Management feature) NNMi must read the Forwarding
Database (FDB) tables from Ethernet switches within the network before accurate
communication paths between these network devices can be calculated. Because the FDB
data is involved, NNMi can produce different results on a Regional Manager as opposed to the
Global Manager.

Attribute Description

Name Name that NNMi assigned to the Layer 2 Connection. This name contains the list of
member interface names separated by a comma. Each interface name appears in the
format: Node_Name[Interface_Name].

Status Overall status for the current connection. NNMi follows the ISO standard for status
classification. See the "Layer 2 Connection Form: Status Tab" (on page 183) for more
information. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

For information about how the current status was determined, see the "Layer 2
Connection Form: Conclusions Tab" (on page 184). Status reflects themost serious
outstanding conclusion. See "Watch Status Colors" (on page 274) for more
information about possible status values.

Note: The icons are displayed only in table views.

Topology Indicates the data source used to create this connection.

Basic Attributes
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Attribute Description

Source Note: (NNMi Advanced) Layer 2 Connections using Link Aggregation1 protocols
can connect sets of Interfaces. See "Layer 2 Connection Form: Link
Aggregation Tab (NNMi Advanced)" (on page 191). These Aggregator Layer 2
Connections display as thick lines on NNMi maps.

If you see the icon, NNMi gathered information from Layer 2 of the Open System
Interconnection (OSI) networkingmodel to detect this connection. Layer 2 is the Data
Link layer that encodes and decodes data packets into bits. The Data Link layer has
two sub-layers: TheMedia Access Control (MAC) sub-layer controls how a computer
gains access to data and permission to transmit the data. The Logical Link Control
(LLC) sub-layer controls frame synchronization, flow control, and error checking. The
following are some examples of possible Topology Source values:

CDP - Cisco Discovery Protocol

EDP - ExtremeDiscovery Protocol

EnDP- Enterasys Discovery Protocol (also known as CDP - Cabletron Discovery
Protocol)

FDB - Forwarding Database (also known as AFT - Address Forwarding Table on a
switch)

FDBH - NNMi’s Forwarding Database High Priority indicates a special case was
encountered and NNMi gave priority of FDB over Discovery Protocol information.

FDP - Foundry Discovery Protocol

LLDP - Link Layer Discovery Protocol

NDP - IPv6 Neighbor Discovery Protocol

SONMP - SynOptics Network Management Protocol

ROUTES - indicates NNMi creates the connection from the routing data. NNMi
creates these Layer 2 Connections for unnumbered interfaces. For more information,
see the "NNMi Discovery" chapter of theHP Network NodeManager i Software
Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

SUBNETCONNECTION- Subnet Connection Rule. NNMi applied a special
configurable rule for subnets (only those IPv4 subnets with a prefix length between 28
and 31) to detect this connection. NNMi gathers information from Layer 3 of the Open

Basic Attributes, continued

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

System Interconnection (OSI) networkingmodel to detect this connection. Layer 3 is
the Network layer that provides switching, routing, and logical paths (virtual circuits)
for transmitting data between nodes. The NNMi administrator configures the Subnet
Connection Rules, see "Help for Administrators" for more information. On the NNMi
map, the following icon is in themiddle of the SUBNETCONNECTION line:

.

USER - This connection was configured by your NNMi administrator (using the
Connection Editor). See "Help for Administrators" for more information.

Notes (NNMi Advanced - Global Network Management feature) The text you enter here is
not sent from aRegional Manager (NNMi management server) to the Global
Manager. NNMi administrators for the Global Manager can add notes that are stored
in the NNMi database on theGlobal Manager.

Provided for network operators to use for any additional notes required to further
explain the Layer 2 Connection. Informationmight include when a cable was last
replaced.

Type amaximum of 1024 characters. Alpha-numeric, spaces, and special characters
(~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Basic Attributes, continued

Layer 2 Connection Form: Interfaces Tab
The "Layer 2 Connection Form" (on page 179) provides details about amanaged connection. These
details include the interfaces that make up the connection, the protocol used to create this
connection, and the current status of the connection. For example, if all interfaces are downwithin a
connection, the connection status is listed as Critical.

For information about each tab:

Attribute Description

Interfaces Table view of both of the interfaces that are part of the current connection. You can
use this table to determine the status, administrative state, operational state, name,
type, interface speed, and Layer 2 Connection for each interface associated with the
selected Layer 2 Connection.

Double-click the row representing an interface. The "Interface Form" (on page 114)
displays all details about the selected interface.

Interfaces Table

Layer 2 Connection Form: Incidents Tab
The "Layer 2 Connection Form" (on page 179) provides details about amanaged connection.

For information about each tab:

HP Network NodeManager i Software (9.21)Page 182 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute Description

Associated
Incidents

Table view of the incidents associated with the selected Layer 2 Connection. NNMi
displays only those incidents that have a Family attribute value of Connection.

Tip: To check all Incidents related to the Interface on each end of the connection,
navigate to the "Layer 2 Connection Form: Interfaces Tab" (on page 182) and
open an Interface form. To check all incidents related to the Node, use the
Hosted On Node attribute on the Interface form to open the Node form.

Examples of the incidents that might appear as Associated Incidents for Layer 2
Connections include the following:

l "Connection Down" (on page 390)

l Modified Connection Down

Associated Incidents are sorted by creation time so that you can view the incidents
in chronological order. Use this view to determine which incidents are still open for
the selected connection.

Double-click the row representing an incident. The "Incident Form" (on page 300)
displays all details about the selected incident. Navigate to the "Incident Form:
Correlated Children Tab" (on page 311) and "Incident Form: Correlated Parents
Tab" (on page 311) to check for any correlated incidents that are associated with
the interfaces and nodes on each end of the connection.

Incidents Table

Layer 2 Connection Form: Status Tab
The "Layer 2 Connection Form" (on page 179) provides details about amanaged connection.

For information about each tab:

Attribute
Description

Status Overall status for the current connection. NNMi follows the ISO standard for status
classification. Possible values are:

Note: The icons are displayed only in table views.

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Status Attributes

HP Network NodeManager i Software (9.21)Page 183 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute
Description

Critical

For information about how the current status was determined, see "Layer 2
Connection Form: Conclusions Tab" (on page 184). Status reflects themost serious
outstanding conclusion. See "Watch Status Colors" (on page 274) for more
information about possible status values.

NNMi Advanced. Link Aggregation1: If the Layer 2 Connection is an Aggregator,
the Status is calculated using the combined Status of all AggregationMember Layer 2
Connections. For more information, see "Layer 2 Connection Form: Link Aggregation
Tab (NNMi Advanced)" (on page 191) and Status Color for Aggregator Objects.

Status
Last
Modified

Date and time indicating when the status was last set.

Status Attributes, continued

Attribute
Description

Status
History

List of up to the last 30 changes in status for the selected connection. This view is
useful for obtaining a summary of the connection status so that you can better
determine any patterns in connection behavior and activity.

Double-click the row representing a Status History. The Status History form displays
all details about the selected Status.

Status History Table

Layer 2 Connection Form: Conclusions Tab
The "Layer 2 Connection Form" (on page 179) provides details about amanaged connection.

All relevant conclusions are shown in the table on this tab. Themost severe Status in the current
group of conclusions becomes the overall L2 Connection status. Some L2 Connection conclusions
propagate to other object types: 

For information about each tab:

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

Out-
standing
Status
Con-
clusions

The dynamically generated list of summary statuses of the connection that
contributed to the current overall Status of the selected connection. Status is set by
Causal Engine.

Each Conclusion listed is still outstanding and applies to the current overall Status.

This view is useful for obtaining a quick summary of the Status and problem
description for the current connection that led up to the connection's most current
Status.

The Status value is correlated based on themost critical Conclusion.

Double-click the row representing a Conclusion. The Conclusion form displays all
details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for a
Connection object.

Note: A Y in the Incident? column indicates that the Conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description
Statu-
s

Inci-
dent?

AggregatorLinkDown (NNMi Advanced) Link
Aggregation1: TheOperational
State of all participating
AggregationMember Layer 2
Connections is Down. For more
information, see "Layer 2
Connection Form: Link
Aggregation Tab (NNMi
Advanced)" (on page 191).

Crit-
ical

Y

All-
Con-
nectionThresholdValuesHigh

Each interface in the connection
contains one of the following
Conclusions:

l InterfaceInputUtilizationHigh

Crit-
ical

N

Outstanding Status Conclusion Values

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

Conclusion Description
Statu-
s

Inci-
dent?

l

Inter-
faceOutputUtilizationHigh

l Inter-
faceInputDiscardRateHigh

l Inter-
faceOutputDiscardRateHigh

l InterfaceInputErrorRateHigh

l InterfaceOutputErrorRateHigh

l Inter-
face-
OutputQueueDropsRateHigh

l Inter-
faceIn-
putQueueDropsRateHigh

l Inter-
faceFCSWLANErrorRateHigh

l Inter-
faceFCSLANErrorRateHigh

ConnectionDown Both (or all) ends of a connection
have anOperational State of
Down.

Crit-
ical

Y

Minor Status Conclusions

Conclusion Description
Stat-
us

Inci-
dent?

AggregatorLinkDegraded (NNMi Advanced) Link Min- Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description
Stat-
us

Inci-
dent?

Aggregation1: Some (but not
all) of the participating
AggregationMember Layer 2
Connections have an
Operational State of Down.
For more information, see
"Layer 2 Connection Form:
Link Aggregation Tab (NNMi
Advanced)" (on page
191).Aggregation

or

Con-
nectionWithAtLeastOneDownEP

At least one interface, but not
all interfaces, in the
connection have an
Operational State of Down.

Min-
or

N

Some-
ConnectionThresholdValuesHigh

One interface in the
connection contains one of the
following conclusions:

l

Inter-
faceInputUtilizationHigh

l

Inter-
faceOutputUtilizationHigh

l

Inter-
faceInputDiscardRateHigh

l

Inter-
face-
OutputDiscardRateHigh

l

Min-
or

N

Outstanding Status Conclusion Values, continued

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

Conclusion Description
Stat-
us

Inci-
dent?

Inter-
faceInputErrorRateHigh

l

Inter-
faceOutputErrorRateHigh

l

Inter-
face-
OutputQueueDropsRateHigh

l

Inter-
faceIn-
putQueueDropsRateHigh

l

Inter-
faceFCSWLAN-
ErrorRateHigh

l

Inter-
faceFCSLAN-
ErrorRateHigh

Some-
OrAll-
ConnectionThresholdValuesLow

One Interface in the
connection contains one of the
following conclusions:

l Inter-
faceInputUtilizationLow

l

Inter-
faceOutputUtilizationLow

Min-
or

N

Some-
OrAll-
ConnectionThresholdValuesNone

One interface in the
connection contains one of the
following conclusions:

l Inter-
faceInputUtilizationNone

l Inter-
faceOutputUtilizationNone

Min-
or

N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description
Stat-
us

Inci-
dent?

l

Inter-
faceInputDiscardRateNone

l Inter-
face-
OutputDiscardRateNone

l

Inter-
faceInputErrorRateNone

l Inter-
faceOutputErrorRateNone

Warning Status Conclusions

Conclusion Description Status Incident?

ConnectionPartiallyUnresponsive At least one interface in
a connection has an
Operational State of Up
and at least one
interface's associated
SNMP Agent is not
responding to
SNMP queries.

Warning N

Unknown Status Conclusions

Conclusion Description Status Incident?

ConnectionUnknown All SNMP Agents associated with
all interfaces in the connection are
not responding to SNMP queries.

Unknown N

Disabled Status Conclusions

Conclusion Description Status Incident?

ConnectionDisabled All interfaces in
the connection
have an
Administrative
State of
Disabled.

Disabled N

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status Incident?

ConnectionWithAtLeastOneDisabledEP At least one
interface, but
not all
interfaces, in
the connection
have an
Administrative
State of Down.

Disabled N

Normal Status Conclusions

Conclusion Description Status Incident?

AggregatorLinkUp (NNMi Advanced)
Link
Aggregation1: All
of the participating
Aggregation
Member Layer 2
Connections have
anOperational
State of Up. For
more information,
see "Layer 2
Connection Form:
Link Aggregation
Tab (NNMi
Advanced)" (on
page 191).

Normal N

ConnectionEnabled All interfaces in a
connection have
an Administrative
State of Up.

Normal N

ConnectionUp TheOperational
State of each

Normal N

Outstanding Status Conclusion Values, continued

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.

HP Network NodeManager i Software (9.21)Page 190 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute Description

Conclusion Description Status Incident?

interface in the
connection is Up.

ConnectionWithinThresholdBoundaries All thresholds on
interfaces in the
connection are
functioning within
the threshold
boundaries set on
the device.

Normal N

Outstanding Status Conclusion Values, continued

Layer 2 Connection Form: Link Aggregation Tab (NNMi Advanced)
The "Layer 2 Connection Form" (on page 179) provides details about the selected Layer 2
Connection.

For information about each tab:

The Layer 2 Connection Form: Link Aggregation Tab appears if the selected connection uses a
Link Aggregation1 protocol.

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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The selected object's role in the Link Aggregation determines the contents of the tab:
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l Aggregation Member, click here for details.

Attribute Description

Link
Aggregation
Protocol

The Link Aggregation1 Protocol currently in use. These protocols allow
network administrators to configure a set of interfaces on a switch as one
Aggregator Interface, creating an Aggregator Layer 2 Connection to another
device usingmultiple interfaces in parallel to increase bandwidth, increase the
speed at which data travels, and increase redundancy:

Text Represents This Protocol

Cisco Port Aggregation
Protocol

Cisco Systems Port Aggregation Protocol
(pagp)

Nortel Multi-Link Trunking Nortel Multi-Link Trunk technology (mlt)

Split MLT Split Multi-Link Trunk: configuration
technology (splitMlt)

Inter-Switch Trunk MLT Split Multi-Link Trunk: inter-switch trunk
(istMlt)

802.3ad Link Aggregation
Control Protocol

IEEE 802.3ad Link Aggregation Control
protocol (LACP)

Static/Manual Configured Link
Aggregation

Static/Manual Configured Link
Aggregation

Unknown Protocol Link
Aggregation

unknown

Note: It is possible for a Layer 2 Connection to connect sets of
Aggregator/Member Interfaces that are configured using different Link
Aggregation protocols. In that case, this attribute value contains multiple
protocols separated with a slash (/).

Aggregator Name of the Aggregator that contains the selected participating Aggregation
Member:

n Aggregator Interface - represents multiple member interfaces

n Aggregator Layer 2 Connection - thick line on the Layer 2 Neighbor View
map represents multiple member Layer 2 Connections

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

See Layer 2 Neighbor View MapObjects for more information.

Click the Lookup icon, and choose Open to open the form for the
Aggregator.

l Aggregator (representingmultiple members), click here for details.

Attribute Description

Link
Aggregation
Protocol

The Link Aggregation1 Protocol currently in use. These protocols allow
network administrators to configure a set of interfaces on a switch as one
Aggregator Interface, creating an Aggregator Layer 2 Connection to another
device usingmultiple interfaces in parallel to increase bandwidth, increase the
speed at which data travels, and increase redundancy:

Text Represents This Protocol

Cisco Port Aggregation
Protocol

Cisco Systems Port Aggregation Protocol
(pagp)

Nortel Multi-Link Trunking Nortel Multi-Link Trunk technology (mlt)

Split MLT Split Multi-Link Trunk: configuration
technology (splitMlt)

Inter-Switch Trunk MLT Split Multi-Link Trunk: inter-switch trunk
(istMlt)

802.3ad Link Aggregation
Control Protocol

IEEE 802.3ad Link Aggregation Control
protocol (LACP)

Static/Manual Configured Link
Aggregation

Static/Manual Configured Link
Aggregation

Unknown Protocol Link
Aggregation

unknown

Note: It is possible for a Layer 2 Connection to connect sets of
Aggregator/Member Interfaces that are configured using different Link
Aggregation protocols. In that case, this attribute value contains multiple
protocols separated with a slash (/).

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

Available
Bandwidth

Sum of the interface Input Speed attribute values of theMember Interfaces that
have aMIB-II ifOperStatus that is not Down. If the sum of the interface Output
Speed attribute values is different, NNMi displays separate Available Input
Bandwidth and Available Output Bandwidth attributes.

Maximum
Bandwidth

Sum of the interface Input Speed attribute values of theMember Interfaces,
regardless of MIB-II ifOperStatus . If the sum of the interface Output Speed
attribute values is different, NNMi displays separateMaximum Input
Bandwidth andMaximumOutput Bandwidth attributes.

Available
Bandwidth
Percentage

Percentage value computed using Available Bandwidth divided by the
Maximum Bandwidth.

Members Table view of the AggregationMembers.

For more information, double-click the row representing an Aggregation
Member:

n The "Interface Form" (on page 114) displays all details about the selected
Interface.

n The "Layer 2 Connection Form" (on page 179) displays all details about the
selected Layer 2 Connection.

Layer 2 Connection Form: Registration Tab
The "Layer 2 Connection Form" (on page 179) provides details about amanaged connection.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes
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Custom Node Collections Form
The Custom Node Collections form provides details about the Custom Node Collection you
selected from theMonitoring workspace. A Custom Node Collection identifies a topology node that
has at least one associated Custom Poller Policy. Because a topology node can be associated with
more than one Policy, the same topology nodemight appear in multiple Custom Node Collections.

The following table describes the attributes included on the Custom Node Collection form.

The Custom Node Collections form also provides details about the Status, Conclusions, and
Polled Instances associated with this Custom Poller Node.

For information about each tab:

Attribute Description

Node Name of the topology node from which the Custom Poller Policy information is
being collected. This is the current value in the NNMi database for the Name
attribute of the node. The value could be a DNS name, aMIB-II sysName, or an
address (depending on how your NNMi administrator configured the discovery
process).

Click the Lookup icon and select   Show Analysis or Open to display
more information about the node.

Active
State

The Active State for the associated Custom Collect Policy. Possible values are
described below:

Active - Indicates the Custom Poller Policy is in use.

Note: At the time the Active State attribute is set toActive, NNMi applies the
Custom Poller Policy to the nodes in the specified NodeGroup to determine
which instances should be polled.

Inactive - Indicates the Custom Poller Policy is not in use. NNMi removes all
Polled Instances associated with the Policy.

Suspended - Indicates someone on your team changed this Custom Poller
Policy's Active State to Suspended, or the NNMi administrator disabled
Custom Poller in theGlobal Control settings of Configuration workspace,
Custom Poller Configuration form. NNMi suspends polling and retains the
most recent State value from before the Policy was suspended.

Status Themost severe State value returned from the Custom Poller Polled Instances for
this Custom Node Collection.

Possible values are:

Normal  

Warning

Minor

Basic Attributes
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Attribute Description

Major

Critical

Policy A Policy specifies the NodeGroup and Polling Interval that NNMi should use when
polling the results of theMIB Expression configured for the current Custom Poller
Collection.

If the NNMi Security configuration permits, click the  Lookup icon and select
 Show Analysis or Open to display more information about the current

Custom Poller Node's Policy.

Discovery
State

Indicates the progress toward collecting data associated with this Polled Instance
(discovery using theMIB Expression objects for which you are collecting
information). Possible values include:

Created - NNMi has not yet discovered any data for this new Polled Instance.

In progress - NNMi is currently collecting data for this Polled Instance.

Completed - NNMi gathered the data associated with this Polled Instance and
placed it in the NNMi database.

Unresponsive - The SNMP agent did not respond when NNMi attempted to gather
the data associated with this Polled Instance.

Failed - NNMi is unable to gather the data associated with this Polled Instance.
Look in the Discovery State Information field for details.

Discovery
State Last
Modified

The date and time when the Discovery State value was last modified.

Discovery
State
Information

Indicates any problems contributing to the Discovery State calculation.

Basic Attributes, continued

Related Topics

"About Custom Poller"

Custom Node Collections Form: Incidents Tab
Tip: The "Custom Node Collections Form" (on page 196) provides details about the selected
Custom Node Collection.

For information about each tab:

Description

Table view of the incidents associated with the selected Custom Node Collection. These

Incidents Table
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Description

incidents are sorted by creation time so that you can view the incidents in chronological order.
Use this view to determine which incidents are still open for the selected Custom Node
Collection.

To seemore information about an incident, double-click the row representing an incident. The
"Incident Form" (on page 300) displays all details about the selected incident.

Incidents Table, continued

Custom Node Collections Form: Status Tab
The "Custom Node Collections Form" (on page 196) provides details about the selected Custom
Node Collection.

For information about each tab:

Attribute Description

Status Themost severe value returned from the Polled Instances for this Custom
Node Collection.

Possible values are:

Normal  

Warning

Minor

Major

Critical

Status Last
Modified

Date and time indicating when the status was last set.

Overall Status

Attribute Description

Status
History

List of up to the last 30 changes in status for the selected Custom Node Collection.
This view is useful for obtaining a summary of the Custom Node Collection Status so
that you can better determine any patterns in node behavior and activity.

Double-click a row representing a Status History. The Status History form displays
all details about the selected Status.

Status History Table

Custom Node Collections Form: Conclusions Tab
Tip: The "Custom Node Collections Form" (on page 196) provides details about the selected

Custom Node Collection.

For information about each tab:
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Attribute Description

Outstanding
Status
Conclusions

The dynamically generated list of summary statuses of the Custom Node
Collection that contributed to the current overall Status of the selected Custom
Node Collection.

Each Conclusion listed is still outstanding and applies to the current overall
Status.

This view is useful for obtaining a quick summary of the Status and problem
description that led up to the Custom Node Collection's most current Status.

The Status value is correlated based on themost critical outstanding
Conclusions.

Double-click the row representing a Conclusion. The Conclusion form displays
all details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for a
Custom Node Collection object.

Note: A Y in the Incident? column indicates that the Conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description Status Incident?

CustomPollCritical A Custom Polled Instance
associated with the Custom Poller
Collection is in a Critical State.

Critical Y

Major Status Conclusions

Conclusion Description Status Incident?

CustomPollMajor A Custom Polled Instance
associated with the Custom Poller
Collection is in aMajor State.

Major Y

Minor Status Conclusions

Conclusion Description Status Incident?

CustomPollMinor A Custom Polled Instance
associated with the Custom Poller
Collection is in aMinor State.

Minor Y

Warning Status Conclusions

Conclusion Description Status Incident?

CustomPollWarning A Custom Polled Instance Warning Y

Outstanding Status Conclusion Values
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Attribute Description

Conclusion Description Status Incident?

associated with the Custom
Poller Collection is in aWarning
State.

Normal Status Conclusions

Conclusion Description Status Incident?

CustomPollNormal A Custom Polled Instance
associated with the Custom
Poller Collection is in a Normal
State.

Normal N

Outstanding Status Conclusion Values, continued

Custom Node Collections Form: Polled Instances Tab
Tip: The "Custom Node Collections Form" (on page 196) provides details about the selected
Custom Node Collection.

For more information about Custom Polled Instances, click here.

The first time aMIB Expression is validated with discovery information, the results appear in the
Monitoringworkspace's Custom Polled Instances view.

Each Custom Polled Instance:

l Updates whenever a change in State occurs (defined using Threshold or ComparisonMaps
settings).

l Includes themost recent polled value that caused the State to change.

These results are then used to determine the Status of the associated Custom Node Collection.

For example, you can specify that each time the hrDeviceStatus for a COM (communication)
port returns a value of 5 (down), the State of the Polled Instance becomes Critical, which
automatically affects the Status of the associated Custom Node Collection.

For information about each tab:

Attribute Description

Polled
Instances
List

Information about Custom Poller Policy information being collected.

This table is useful for obtaining a quick summary.

Double-click the row representing a Polled Instance. The "Custom Polled Instance
Form" (on page 201) displays all details about the selected Polled Instance.

Polled Instances Table
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Custom Polled Instance Form

TheCustom Polled Instance1 form provides details about the Custom Polled Instance you
selected from theMonitoringworkspace. The following table describes the attributes included on
the Polled Instance form.

(NNMi Advanced - Global Network Management feature) Any Custom Polled Instances are not
sent from aRegional Manager (NNMi management server) to the Global Manager. From theGlobal
Manager, useActions→Open from Regional Manager to see the list of Custom Polled
Instances on the Regional Manager.

For information about each tab:

Note the following about Custom Polled Instances:

l The first time aMIB Expression is validated with discovery information, the results appear in the
Monitoringworkspace's Custom Polled Instances view.

l Each Custom Polled Instance:

n Updates whenever a change in State occurs (defined using Threshold or ComparisonMaps
settings).

n Includes themost recent polled value that caused the State to change.

l These results are then used to determine the Status of the associated Custom Node Collection.

For example, you can specify that each time the hrDeviceStatus for a COM
(communication) port returns a value of 5 (down), the State of the Polled Instance becomes
Critical, which automatically affects the Status of the associated Custom Node Collection.

Attribute Description

Node Name of the topology node on which the Custom Poller Policy information is being
collected. This is the current value in the NNMi database for the Name attribute of
the node. The value could be a DNS name, aMIB-II sysName, or an address
(depending on how your NNMi administrator configured the discovery process).

Click the  Lookup icon and select  Show Analysis or  Open to display
more information about the topology node.

MIB
Instance

This attribute contains themultiple filtered instances for theMIB Expression. Each
instance value identifies a row in theMIB table.

Note: If a MIB Expression includes mulitple MIB Variables that havemultiple
instances, each instance value that is valid across all MIB Variables for a node

Basic Attributes

1A Custom Polled Instance represents the results of aMIB expression when it is evaluated against
a node. The first time aMIB Expression is validated with discovery information, the results appear
in theMonitoring workspace's Custom Polled Instances view. The Custom Polled Instance is
updated whenever a change in State occurs and includes themost recent polled value that caused
the State to change. These results are then used to determine the Status of the associated Custom
Node Collection.
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Attribute Description

is listed here. If NNMi is unable to find the same instance for all MIB Variables
in the expression, a Polled Instance is not created. This is because NNMi
cannot correctly evaluate aMIB Expression with missing values. If Polled
Instances are not created as expected, check the Custom Node Collection
view for Discovery State and Discovery State Information values.

Filter
Value

The instance of aMIB Variable value after theMIB Filter is applied.

Display
Attribute

TheMIB Variable that contains the values NNMi displays when generating Custom
Polled Instance or Line Graph results.

Note: The NNMi administrator selects this Display Variablewhen configuring the
MIB Expression for a Custom Poller Collection.

Active
State

Specifies whether a Custom Poller Policy is enabled .

Custom
Node
Collection

Name of the associated Custom Node Collection.A Custom Node Collection
identifies a topology node that has at least one associated Custom Poller Policy.
Because a topology node can be associated with more than one Policy, the same
topology nodemight appear in multiple Custom Node Collections.

Click the  Lookup icon and select  Show Analysis or  Open to display
more information about the Custom Node Collection.

See "Custom Node Collections Form" (on page 196) for more information.

Custom
Poller
Policy

Name of the associated Custom Poller Policy. The Custom Poller Policy defines the
NodeGroup from which theMIB information is polled.

Custom
Poller
Collection

Name of the Custom Poller Collection.A Custom Poller Collection defines the
information you want to gather (poll) as well as how you want NNMi to handle the
results.

Click the  Lookup icon and select  Show Analysis or  Open to display
more information about the Custom Poller Collection.

See "Custom Polled Collection Form" (on page 206) for more information.

Status Overall status for the current Custom Polled Instance. NNMi follows the ISO
standard for status classification. See the "Custom Polled Instance Form: Status
Tab" (on page 204) for more information. Possible values are:

  Normal

  Warning

  Minor

  Major

Basic Attributes, continued
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Attribute Description

  Critical

Status reflects themost serious outstanding conclusion. See "Watch Status Colors"
(on page 274) for more information about possible status values.

Note: The icons are displayed only in table views

State The State of the Custom Polled Instance as determined by any Thresholds (High
State / Low State value) or ComparisonMaps (StateMapping = the NNMi
administrator assigns a State value for each possible Polled Instance value)
configured for the current Custom Poller Collection's MIB Expression.

Possible State values for aPolled Instance (Threshold = High State/Low State; or
ComparisonMap = StateMapping) are:

Normal 

Warning

Minor

Major

Critical

Note: Themost severe Threshold High State or Low State value or ComparisonMap
StateMapping value returned from the Polled Instances for a Custom Node
Collection becomes the Custom Node Collection Status.

Last
State
Change
Value

The value from theMIB Expression that most recently caused the State to change.

Note: A value of null indicates that a value was unavailable or an error occurred
while evaluating theMIB Expression.

State
Last
Modified

The date and time the Polled Instance was last modified.

Basic Attributes, continued

Custom Polled Instances Form: Incidents Tab

Tip: The "Custom Polled Instance Form" (on page 201) provides details about the selected Custom
Polled Instance.

The Name of the Source Object for a Custom Polled Instance Incident is the display value that is
determined using the Instance Display Configuration for the associatedMIB Expression.

If the Instance Display Configuration is not set, NNMi identifies the Source Object using the
topology Node Name followed by theMIB Instance value in the format: <node_name> -.<MIB_
instance_value>.

Note: The Name that NNMi uses to identify the Custom Polled Instance Incident’s Source Object
is not stored in the NNMi database as the Custom Polled Instance object Name.

For information about each tab:
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Description

Table view of the incidents associated with the selected Custom Polled Instance. These
incidents are sorted by creation time so that you can view the incidents in chronological order.
Use this view to determine which incident is still open for the selected Custom Polled Instance.

To seemore information about an incident, double-click the row representing an incident. The
"Incident Form" (on page 300) displays all details about the selected incident.

Incidents Table

Custom Polled Instance Form: Status Tab

The "Custom Polled Instance Form" (on page 201) provides details about the selected Custom
Polled Instance.

For information about each tab:

Attribute Description

Status Themost severe value returned from the Custom Polled Instance.

Possible values are:

Normal  

Warning

Minor

Major

Critical

Status Last Modified Date and time indicating when the status was last set.

Overall Status

Attribute Description

Status
History

List of up to the last 30 changes in status for the selected Custom Polled Instance.
This view is useful for obtaining a summary of the Custom Polled Instance Status so
that you can better determine any patterns in node behavior and activity.

Double-click a row representing a Status History. The Status History form displays
all details about the selected Status.

Status History Table

Custom Polled Instance Form: Conclusions Tab

Tip: The "Custom Polled Instance Form" (on page 201) provides details about the selected Custom
Polled Instance.

For information about each tab:

Outstanding Conclusions Table
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Attribute Description

Outstanding
Status
Conclusions

The dynamically generated list of summary statuses of the Custom Polled
Instance that contributed to the current overall Status of the selected Custom
Polled Instance.

Each Conclusion listed is still outstanding and applies to the current overall
Status.

This view is useful for obtaining a quick summary of the Status and problem
description that led up to the Custom Polled Instances most current Status.

The Status value is correlated based on themost critical outstanding
Conclusions.

Double-click the row representing a Conclusion. The Conclusion form displays all
details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for a
Custom Polled Instance object.

Note: A Y in the Incident? column indicates that the Conclusion can result in an
incident. An NNMi administrator can configure whether incidents are
generated. See Configure Basic Settings for a Custom Poller Collection for
more information.

Critical Status Conclusions

Conclusion Description Status Incident?

CustomPolledInstanceCritical A Custom Polled
Instance is in a Critical
State.

Critical Y

Major Status Conclusions

Conclusion Description Status Incident?

CustomPolledInstanceMajor A Custom Polled Instance
is in aMajor State.

Major Y

Minor Status Conclusions

Conclusion Description Status Incident?

CustomPolledInstanceMinor A Custom Polled Instance
is in aMinor State.

Minor Y

Warning Status Conclusions

Conclusion Description Status Incident?

CustomPolledInstanceWarning A Custom Polled
Instance is in a
Warning State.

Warning Y
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Attribute Description

Normal Status Conclusions

Conclusion Description Status Incident?

CustomPolledInstanceNormal A Custom Polled
Instance is in a Normal
State.

Normal N

Custom Polled Collection Form

The NNMi Custom Polling feature enables your NNMi administrator to take a proactive approach to
network management by gathering additional device information using SNMP MIB Expressions.
For example, an NNMi administrator might want NNMi tomonitor the Status of COM
(communication) ports on all of yourWindows servers or determine disk utilization on a specified
group of servers.

A Custom Poller Collection defines the additional SNMP MIB information that NNMi should gather
(Custom Poll) as well as how NNMi reacts to the gathered data.

For information about each tab:

Note: If the Security configuration permits, you can access a ComparisonMap form from the
ComparisonMaps tab.

The following tables describe the attributes included on the Custom Polled Collection form.

Attribute Description

Name The name for the Custom Poller Collection configuration.

 The Custom Poller Collection name appears in any incidents generated as a result
of the collection.

Affect
Node
Status

Used to indicate whether each Polled Instance affects the associated Node's
Status.

The first time aMIB Expression is validated with discovery information, the results
appear in a Polled Instance object. The Polled Instance object is updated whenever
a change in State occurs and includes themost recent polled value that caused the
State to change.

Generate
Incident

Used to indicate whether NNMi generates an incident when a threshold is reached
or exceeded, or when a specifiedMIB value is returned and the resulting State is
other thanNormal.

Export
Custom
Poller
Collection

If enabled , NNMi exports the Custom Poller Collection to a comma-separated
values (CSV) file

If disabled , NNMi does not export the Custom Poller Collection information.

Compress If enabled , NNMi exports the Custom Poller Collection in compressed format

Basics for this Custom Poller Collection
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Attribute Description

Export
File

and appends .gz to the .csv file suffix.

If disabled , NNMi does not compress the CSV file.

Basics for this Custom Poller Collection, continued

Attribute Description

MIB
Expression

MIB Expressions specify additional information that NNMi should poll.

MIB Filter
Variable

TheMIB Filter Variable is theMIB variable that has a value you want to use as a
filter to determine which instances of theMIB expression to Custom Poll.

Variable Attributes

Attribute Description

Threshold
Setting
Type

Time-based threshold settings enable you to determine whether a threshold is
reached for a particular duration of time (for example, the bandwidth utilization for an
interface is above 90 percent for 20 out of 30minutes).

Count-based threshold settings enable you to determine as soon as a threshold is
reached (for example, an interface is dropping data or an Ethernet interface and
getting overloaded).

High
State

The Polled Instance State when NNMi returns a value that exceeds a specified High
Value. Possible values are:

l Normal

l Warning

l Minor

l Major

l Critical

High
Value

Required only for thresholds with a HighState setting.

Value used to define the high threshold. When exceeded, NNMi changes to theHigh
State.

High
Value
Rearm

Applies only for thresholds with a HighState setting.

Value used to define when the Polled Instance is no longer in the High State. The
default value is the High Value.

High
Trigger
Count

Count Threshold Setting Type only

Applies only for thresholds with a HighState setting.

The number of consecutive times the returned valuemust exceed the specified High
Value to transition to the High State. The default value is 1.

Threshold Attributes for a Custom Polled Instance
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Attribute Description

High
Duration Time Threshold Setting Type only.

Applies only for thresholds with a HighState setting.

Designate theminimum timewithin which the valuemust remain in the High range
before the threshold state changes to High and (optionally) an incident is generated.

High
Duration
Window

Time Threshold Setting Type only.

Applies only for thresholds with a HighState setting.

Designate the window of time in which the High Duration criteria must bemet.

Low
State

Value used to define the low threshold. When below this value, NNMi changes to the
Low State.

Low
Value

Required only for thresholds with a Low State setting.

Value used to define the low threshold. Possible values are:

l Normal

l Warning

l Minor

l Major

l Critical

Low
Value
Rearm

Applies only for thresholds with a Low State setting.

The value used to define when the Polled Instance is no longer in the Low State. The
default value is the Low Value.

Low
Trigger
Count

Count Threshold Setting Type only.
Applies only for thresholds with a Low State setting.

The number of consecutive times the returned valuemust exceed the specified Low
Value to transition to the Low State. The default value is 1.

Low
Duration

Time Threshold Setting Type only.
Applies only for thresholds with a Low State setting.

Designate theminimum timewithin which the valuemust remain in the Low range
before the threshold state changes to Low and (optionally) an incident is generated.

Low
Duration
Window

Time Threshold Setting Type only.

Applies only for thresholds with a Low State setting.

Designate the window of time in which the Low Duration criteria must bemet.

Threshold Attributes for a Custom Polled Instance, continued
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Comparison Map Form

Custom Poller enables the NNMi administrator to map the returned value of aMIB Expression to a
Custom Poller Polled Instance State. NNMi uses ComparisonMap values to determine when to
generate an incident, as well as the State of the Polled Instance.

Click here for more information about Polled Instances.

The first time aMIB Expression is validated with discovery information, the results appear in a
Polled Instance object. The Polled Instance object is updated whenever a change in State occurs
and includes themost recent polled value that caused the State to change.

For example, the NNMi administrator might configure a Custom Polled Collection so that the
hrDeviceStatus value of 5 (down) is mapped to aCritical State. This means that NNMi changes
the State of the Polled Collection Instance toCritical each time the hrDeviceStatus returns a value
of 5when polled.

The following tables describe the attributes included on the ComparisonMap form.

Attribute Description

Ordering The order in which the Statemapping (ComparisonMaps) operations should be
performed.

Note: NNMi uses the Ordering value to determine which Statemapping to use.
The lower the number, the higher the priority. For example, 1 is the highest
priority.

Comparison
Operator

Operator used to evaluate the polled value and subsequently determine its State.
For example, the < (less than) Comparison Operator indicates the polled value
returnedmust be less than the Comparison Value to change the Custom Poller
Polled Instance to the state specified using the StateMapping value.

Comparison
Value

The value to which the polled value is compared.

State
Mapping

The State to assign to the Custom Poller Polled Instance when the polled value
meets the comparison criteria. For example, each time the value 3 (warning) is
returned when NNMi polls hrDeviceStatus, you can specify that you want NNMi
to change the State of the Polled Instance toWarning.

Possible State values for aPolled Instance (Threshold = High State/Low State; or
ComparisonMap = StateMapping) are:

Normal 

Warning

Minor

Major

Critical

State Mapping Attributes
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Card Redundancy Group Form
Card Redundancy Groups are configured to provide one-to-one redundancy protection against
processor card failure.

The Card Redundancy Group form provides details about the Card Redundancy Group you
selected. The following table describes the fields included on the Card Redundancy Group form.

For information about each tab:

Attribute Description

Name Name assigned to the Card Redundancy Group. NNMi uses the Node Name
followed by a slash and then the name that is specific to the Device Vendor:

Device
Vendor Naming Convention

Cisco <nodename>/Supervisor Engine Group

Note: Only cards classified as Management Modules are
considered for Card Redundancy Groups.

HP ProCurve <nodename>/Management Module Group

Note: Only cards classified as Management Modules are
considered for Card Redundancy Groups.

Card Redundancy Group Naming Conventions

Status Overall status for the current Card Redundancy Group. NNMi follows the ISO
standard for status classification.

Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

Note: The icons are displayed only in table views.

Status
Last
Modified

The date and time when the Status value was last modified.

Basic Attributes
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Card Redundancy Group Form: Redundant Cards Tab
Card Redundancy Groups are configured to provide redundancy protection against processor card
failures.

The "Card Redundancy Group Form" (on page 210) provides details about the selected Card
Redundancy Group.

For information about each tab:

Attribute Description

Redundant
Cards

Table of all of the cards that aremembers of this Card Redundancy Group. Use this
table to access information about each card associated with the selected Card
Redundancy Group.

Double-click the row representing a Card. The "Card Form" (on page 164) displays
all details about the selected Card.

Note: Only parent cards can bemembers of this group, daughter cards are not
permitted to participate in Card Redundancy Groups.

Redundant Group Member Cards

Card Redundancy Group Form: Incidents Tab
Card Redundancy Groups are configured to provide redundancy protection against processor card
failures.

The "Card Redundancy Group Form" (on page 210) provides details about the selected Card
Redundancy Group.

For information about each tab:

Attribute Description

Incidents Table of the Incidents associated with the selected Card Redundancy Group.

These Incidents are sorted by creation time so that you can view the Incidents in
chronological order. Use this table to determine which Incidents are still open for the
selected Card Redundancy Group.

Double-click the row representing an Incident. The "Incident Form" (on page 300)
displays all details about the selected incident.

Tip: See "Incident Form" (on page 300) for more details about the incident attributes
that appear in the incident table's column headings.

Incidents Associated with Cards in this Redundancy Group

Card Redundancy Group Form: Status Tab
Card Redundancy Groups are configured to provide redundancy protection against processor card
failures.

The "Card Redundancy Group Form" (on page 210) provides details about the selected Card
Redundancy Group.

For information about each tab:
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Attribute Description

Status
History

List of up to the last 30 changes in the status for the Card Redundancy Group. This
table is useful for obtaining a summary of the Card Redundancy Group Status so that
you can better determine any patterns in behavior and activity.

Double-click the row representing a Status History. The "Card Redundancy Group
Status History Form" (on page 212) displays all details about the selected Status.

Card Redundancy Group Status History Table

Card Redundancy Group Status History Form

Card Redundancy Group Status is derived from SNMP polling results for both cards in the Card
Redundancy Group, as well as any conclusions. For information about how the current Status was
determined, see the "Card Redundancy Group Form: Conclusions Tab" (on page 212). Status
reflects themost serious outstanding conclusion. See "Watch Status Colors" (on page 274) for
more information about possible status values.

Attribute Description

Status Overall status for the current Card Redundancy Group. NNMi follows the ISO
standard for status classification. Possible values are:

  No Status

  Normal (one Active card and one Standby card)

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

Note: The icons are displayed only in table views.

Status Last
Modified

Date and time indicating when the Status was last set.

Status Attributes

Card Redundancy Group Form: Conclusions Tab
Card Redundancy Groups are configured to provide redundancy protection against processor card
failures.

The "Card Redundancy Group Form" (on page 210) provides details about the selected Card
Redundancy Group.

For information about each tab:
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Attribute Description

Outstanding
Status
Conclusions

The dynamically generated list of summary statuses for the Card Redundancy
Group that contributed to the current overall Status of the selected Card
Redundancy Group. Status is set by the Causal Engine.

Each Conclusion listed is outstanding and contributes to the current overall
Status.

This table is useful for obtaining a quick summary of the problem description for
the current Card Redundancy Group that led up to the Card Redundancy Group's
most current Status.

The Status value is correlated based on themost critical Conclusions.

Double-click the row representing a Conclusion. The Conclusion form displays all
details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for a
Card Redundancy Group object.

Note: A Y in the Incident? column indicates that the conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description Status Incident?

CrgMultiplePrimary NNMi has identifiedmultiple
Primary Cards (for example, Card
Active) in the Card Redundancy
Group. This typically indicates the
communication between the cards
in the group is malfunctioning.

Critical Y

CrgNoPrimary NNMi is unable to identify a
Primary Card (for example, Card
Active) in the Card Redundancy
Group. This typically indicates one
of the following:

l One card, or both the Primary
and Secondary Cards, are
down.

l NNMi has identified only
Secondary cards (for example
Standby cards) in the group.

l Communication between cards
in the group is malfunctioning.

Critical Y

Warning Status Conclusions

Outstanding Status Conclusion Values
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Attribute Description

Conclusion Description Status Incident?

CrgNoSecondary A Card Redundancy Group does not
have a secondary member. Neither
card has a cardStandbyStatus equal
to Standby. A properly functioning
Card Redundancy Group should
have one operational Primary Card
and one operational Secondary
Card.

Warning Y

Unknown Status Conclusions

Conclusion Description Status Incident?

CrgUnmanagable The SNMP Agent on the node
hosting the Card Redundancy
Group is not responding to
SNMP queries.

Unknown N

Normal Status Conclusions

Conclusion Description Status Incident?

CrgFailback The initial Primary Card is now active. This
conclusion can occur only when a failover
has occurred and then the Card
Redundancy Group has returned to its
previous state.

Normal N

CrgNormal The Card Redundancy Group is operating
normally. It has one card operating as the
Primary Card and the other acting as the
Secondary Card.

Normal N

CrgFailover The Primary Card (for example, Card
Active) has moved from one card to the
other in a Card Redundancy Group. The
Card Redundancy Group is routing
packets properly.

Normal Y

Outstanding Status Conclusion Values, continued

Router Redundancy Group Form (NNMi Advanced)
The Router Redundancy Group Form provides details about the Router Redundancy Group
selected. This form is useful for troubleshooting purposes. You can access information about the
name, status, and Router Redundancy Members (routers) associated with this Router Redundancy
Group.
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Note: All members of a Router Redundancy Groupmust be assigned to the same Tenant
(visible in the Node form's Basic Attributes and in the Tenants column of the Inventory >
Nodes view). The NNMi administrator configures the Tenants.

For information about each tab:

Attribute Description

Name The name assigned to this Router Redundancy Group. This name is the virtual IP
address protected by this group and used by the router that is actively routing
information packets (for example, HSRP Active or VRRPMaster).

Tenant Tenants enable NNMi administrators to partition a network across multiple
customers. The NNMi administrator controls the Tenant assignment for each Node.
All Nodes in the Router Redundancy Groupmust be assigned to the same Tenant.

A Tenant is the top-level organization to which a n=Node belongs.

Status Router Redundancy Group Status reflects themost serious Severity value of the
incidents associated with the Router Redundancy Group. Possible values are:

  Normal

 Warning

  Minor

  Major

  Critical

See "Watch Status Colors" (on page 274) for more information about Severity values.

Note: The icons are displayed only in table views.

Status
Last
Modified

Date and time indicating when the Status was last set.

Protocol The protocol in use for the selected Router Redundancy Group. For example: Virtual
Router Redundancy Protocol (VRRP1) or Hot Standby Router Protocol (HSRP2) .

Group
Number

The group number that was configured for the current Router Redundancy Group.

Number
of
Members

Specifies the number of members that belong to the current Router Redundancy
Group.

Basics Attributes

Related Topics

1Virtual Router Redundancy Protocol
2Hot Standby Router Protocol
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"Router Redundancy Group View (Inventory) (NNMi Advanced)" (on page 41)

"Non-Normal Router Redundancy Group View (NNMi Advanced)" (on page 271)

Router Redundancy Group Form: Router Redundancy Members Tab
(NNMi Advanced)

The "Router Redundancy Group Form (NNMi Advanced)" (on page 214) provides details about the
selected Router Redundancy Group.

Note: All members of a Router Redundancy Groupmust be assigned to the same Tenant
(visible in the Node form's Basic Attributes and in the Tenants column of the Inventory >
Nodes view). The NNMi administrator configures the Tenants.

For information about each tab:

Attribute Description

Router
Redundancy
Members

Table of all of the routers that aremembers of the selected Router Redundancy
Group. The table lists each router's interface that is associated with this Router
Redundancy Group. Use this table to access information about each router.

Double-click the row representing a Router Redundancy Member. The "Router
Redundancy Member Form (NNMi Advanced)" (on page 216) displays all details
about the selected Router Redundancy Member.

Router Redundancy Members in this Router Redundancy Group

Router Redundancy Member Form (NNMi Advanced)

The Router Redundancy Member form provides details about a router in the Router Redundancy
Group.

This form is useful for troubleshooting purposes. You can access information about the router name
and status, as well as conclusions information to assist you in understanding the router's current
state. You can also see the name of each tracked object associated with the router. A tracked
object represents the interface responsible for delivering the outbound information packet that was
originally sent to the current Router Redundancy Member.

For information about each tab:

Attribute Description

Name Name of the selected router and its associated interface that is amember of the
current Router Redundancy Group.

Note: NNMi determines this Name value.

The name includes the fully-qualified DNS hostname assigned to the router and
the Name attribute value that NNMi assigned to the interface.

This name appears in the following format:

<fully qualified hostname assigned to the router>[Interface Name:group_number]

Basics Attributes

HP Network NodeManager i Software (9.21)Page 216 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute Description

For example:  HSRPRouter1.abc.example.com[Se1/1:1]

See "Node Form" (on page 48) for more information about node names. See
"Interface Form" (on page 114) for more information about interface names.

Primary IP The IP Address used to exchangemessages between routers in the Router
Redundancy Group.

Is Owner Boolean attribute used to Indicate whether the selected router owns a Virtual
IP Address (if any) for the Router Redundancy Group. See "Virtual IP Addresses
Form (NNMi Advanced)" (on page 222) for more information.

If the selected router uses a Router Redundancy Protocol that does not support
virtual addresses, the value is set to false.

Priority The configured protocol-specific number that indicates the current rank of the
Router Redundancy Member.

Redundancy
Interface

The interface that is being used by the router to participate in the Router
Redundancy Group.

To find out more information about this Interface:

Click the  Lookup icon and choose one of the following options:

l  Show Analysis to view the Analysis Pane information for the selected
interface. (See "Use the Analysis Pane " (on page 348) for more information
about the Analysis Pane.)

l  Open to open the Interface form.

Hosted on
Node

Name attribute value from the "Node Form" (on page 48) of the selected router
(the Router Redundancy Groupmember).

To find out more information about the Node:

Click the  Lookup icon and choose one of the following options:

l  Show Analysis to view the Analysis Pane information for the selected
interface. (See "Use the Analysis Pane " (on page 348) for more information
about the Analysis Pane.)

l  Open to open the Node form.

Redundancy
Group

Name of the Router Redundancy Group to which the Router Redundancy
Member belongs.

To find out more information about the Router Redundancy Group:

Click the  Lookup icon and choose one of the following options:

l  Show Analysis to view the Analysis Pane information for the selected
interface. (See "Use the Analysis Pane " (on page 348) for more information
about the Analysis Pane.)

Basics Attributes, continued
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Attribute Description

l  Open to open the Router Redundancy Group form.

Current
State

State of the Router Redundancy Member. State values are protocol-specific. For
example:

l Hot Standby Router Protocol (HSRP) States:click here.

Active - Indicates the router is forwarding packets that are sent to the
router redundancy group.

Standby - Indicates the router is a candidate to become the next active
router.

Initial - Indicates HSRP1 is not running. This state occurs when an
interface first comes up.

Learn - Indicates the router has not yet determined the virtual IP address.
This state occurs when the router is waiting to hear from the active router.

Listen - Indicates the router knows the virtual IP address, but it is neither
the active nor standby router. In this state, the router is waiting for a
message from the active and standby routers.

Speak - Indicates the router knows the virtual IP address. In this state, the
router sends periodic messages and is ready to become an active or
standby router.

l Virtual Router Redundancy Protocol (VRRP) States:click here.

Master - Indicates the router is forwarding packets that are sent to the
router redundancy group.

Backup - Indicates the router is a candidate to become the next master
router.

Initialize - Indicates the router is not running VRRP protocol. This state
occurs when an interface first comes up.

The following values indicate NNMi could not gather the required data:

Agent Error – Indicates an SNMP error was returned in response to an
SNMP query to this agent.

No Polling Policy - Indicates the object is being polled, but no polling policy
exists in Monitoring Configuration settings for this monitored attribute.

Not Polled - Indicates that this attribute is intentionally not polled, based on
current Monitoring Configuration settings, current Communication
Configuration settings, or because the parent Node is set to Not Managed or

Basics Attributes, continued

1Hot Standby Router Protocol

HP Network NodeManager i Software (9.21)Page 218 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

Attribute Description

Out of Service. This object attributemight or might not have an associated
polling policy.

Unavailable - Unable to determine the State. For example, the SNMP agent
returned a value outside the range of possible values or returned a null value.

Unset – Currently not used by NNMi.

Other – The SNMP agent responded with a value for theMIB variable used to
determine the Router Redundancy Member State that is not recognized. 

Previous
State

The previous State of the Router Redundancy Member. State values are protocol-
specific. For examples, see Current State.

State Last
Modified

Date and time the Router Redundancy State was last modified.

Basics Attributes, continued

Router Redundancy Member Form: Tracked Objects Tab (NNMi Advanced)

A tracked object is the outbound interface responsible for delivering the outbound information
packet that was originally sent to a selected inbound interface on a router that is part of the Router
Redundancy Group. A Router Redundancy Member can have one or more associated tracked
objects

The "Router Redundancy Member Form (NNMi Advanced)" (on page 216) provides details about
the selected Router Redundancy Member. Each Router Redundancy Member is a router in the
Router Redundancy Group.

For information about each tab: 

See "TrackedObjects Form (NNMi Advanced)" (on page 220) for more information about tracked
objects.

Attribute Description

Name Name of the selected router and its associated interface that is amember of the
current Router Redundancy Group.

Note: NNMi determines this Name value.

The name includes the fully-qualified DNS hostname assigned to the router and the
Name attribute value that NNMi assigned to the interface.

This name appears in the following format:

<fully qualified hostname assigned to the router>[Interface Name]

For example:  HSRPRouter1.abc.example.com[Se1/1]

Note: NNMi determines this Name value. See "Node Form" (on page 48) for more
information about node names. See "Interface Form" (on page 114) for more

Tracked Objects Table
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Attribute Description

information about interface names.

Track
Priority

Number NNMi uses to rank the tracked object whenever a Current State change
occurs. NNMi uses this number indirectly in the calculation to determine the next
Primary member of the Router Redundancy Group.

When a tracked object goes down, the priority of the tracked object (Track Priority) is
subtracted from its Router Redundancy Member Priority value to produce a smaller
member Priority number. If this new Priority number is smaller than one of the other
member Priority numbers, themember with the highest Priority value becomes the
new Primary router in the Router Redundancy Group.

For example, if an interface that has a Track Priority of 20 goes down on a Router
Redundancy Member that has amember Priority of 250:

l The Track Priority (20) is subtracted from its member Priority (250-20=230).

l The new member Priority (230) is then compared to the Priority value of the other
members in the Router Redundancy Group.

l If one of themembers in the Router Redundancy Group has a higher member
Priority, for example, 240, that member becomes the Primary router in the group
(for example, HSRP Active or VRRP Master).

State
Last
Modified

The date and time when the State value was last modified.

Tracked Objects Table, continued

Tracked Objects Form (NNMi Advanced)

Your network administrator might have set up groups of redundant routers to help ensure that
information packets reach their intended destination. A tracked object is the outbound interface
responsible for delivering the outbound information packet that was originally sent to a selected
inbound interface on a router that is part of the Router Redundancy Group. A Router Redundancy
Member can have one or more associated tracked objects.

Attribute Description

Name Name used to identify the selected TrackedObject. The name includes the fully-
qualified DNS name assigned to the Router and the name assigned to its associated
TrackedObject .

Note: NNMi determines this Name value.

The name includes the fully-qualified DNS hostname assigned to the router and the
Name attribute value that NNMi assigned to the interface.

This name appears in the following format:

<fully qualified hostname assigned to the router>[Interface Name]

Basics Attributes
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Attribute Description

For example:  HSRPRouter1.abc.example.com[Se1/1]

See "Node Form" (on page 48) for more information about node names. See
"Interface Form" (on page 114) for more information about interface names.

To find out more information about this interface: 

Click the  Lookup icon and choose one of the following options:

l  Show Analysis to view the Analysis Pane information for the selected Tracked
Object. (See "Use the Analysis Pane " (on page 348) for more information about
the Analysis Pane.

l  Open to open the Interface form.

Track
Priority

Number used to rank the tracked object. This number is used indirectly in the
calculation that determines the next Active or Master member of the Router
Redundancy Group whenever a State change occurs.

When a tracked object goes down, the priority of the tracked object (Track Priority) is
subtracted from its Router Redundancy Member Priority value to produce a smaller
member Priority number. If this new Priority number is smaller than one of the other
member Priority numbers, themember with the highest Priority value becomes the
new Master or Active router in the current Router Redundancy Group.

For example, if an interface that has a Track Priority of 20 goes down on a Router
Redundancy Member that has amember Priority of 250:

l The Track Priority (20) is subtracted from its member Priority (250-20=230).

l The new member Priority (230) is then compared to the Priority value of the other
members in the Router Redundancy Group.

l If one of themembers in the Router Redundancy Group has a higher member
Priority, for example, 240, that member becomes the Active or Master router in the
group.

State
Last
Modified

Date and time the TrackedObject State was last modified.

Basics Attributes, continued

Router Redundancy Group Form: Virtual IP Addresses Tab (NNMi
Advanced)

The "Router Redundancy Group Form (NNMi Advanced)" (on page 214) provides details about the
selected Router Redundancy Group.

For information about each tab:
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Attribute Description

Virtual IP
Addresses

Table view of the virtual IP addresses associated with the selected Router
Redundancy Group. The virtual IP address is the IP address protected by this group
and used by any router that is actively routing information packets (for example,
VRRP Master). For each virtual IP address displayed, you can see the IP address
value.

Double-click the row representing a Virtual IP Address. The "Virtual IP Addresses
Form (NNMi Advanced)" (on page 222) displays all details about the selected
Virtual IP Address.

Virtual IP Addresses Table

Virtual IP Addresses Form (NNMi Advanced)

A virtual IP address is an address protected by the Router Redundancy Group and used by the
router that is actively routing information packed (for example, VRRP Master).

Basic Attributes

Attribute Description

Value IP address value for the virtual IP address.

Virtual IP Addresses

Router Redundancy Group Form: Incidents Tab (NNMi Advanced)
The "Router Redundancy Group Form (NNMi Advanced)" (on page 214) provides details about the
selected Router Redundancy Group.

For information about each tab:

Attribute Description

Incidents Table of the Incidents associated with the selected Router Redundancy Group.

These Incidents are sorted by creation time so that you can view the Incidents in
chronological order. Use this table to determine which Incidents are still open for the
selected Router Redundancy Group.

Double-click the row representing an Incident. The "Incident Form" (on page 300)
displays all details about the selected incident.

Tip: See "Incident Form" (on page 300) for more details about the incident attributes
that appear in the incident table's column headings.

Incidents Associated with this Router Redundancy Group

Router Redundancy Group Form: Status Tab (NNMi Advanced)
The "Router Redundancy Group Form (NNMi Advanced)" (on page 214) provides details about the
selected Router Redundancy Group.

For information about each tab:
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Attribute
Description

Status
History

List of up to the last 30 changes in the status for the Router Redundancy Group. This
table is useful for obtaining a summary of the Router Redundancy status so that you
can better determine any patterns in behavior and activity.

Double-click the row representing a Status History. The "Router Redundancy Group
Status History Form (NNMi Advanced)" (on page 223) displays all details about the
selected Status.

Router Redundancy Group Status History Table

Router Redundancy Group Status History Form (NNMi Advanced)

Router Redundancy Group Status is derived from SNMP polling results, as well as any
conclusions. For information about how the current Status was determined, see the "Router
Redundancy Group Form: Conclusions Tab (NNMi Advanced)" (on page 223). Status reflects the
most serious outstanding conclusion. See "Watch Status Colors" (on page 274) for more
information about possible status values.

Attribute Description

Status Overall status for the current Router Redundancy Group. NNMi follows the ISO
standard for status classification. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

Note: The icons are displayed only in table views.

Status Last
Modified

Date and time indicating when the Status was last set.

Status Attributes

Router Redundancy Group Form: Conclusions Tab (NNMi
Advanced)

The "Router Redundancy Group Form (NNMi Advanced)" (on page 214) provides details about the
selected Router Redundancy Group.

All relevant conclusions are shown in the table on this tab. Themost severe Status in the current
group of conclusions becomes the overall Router Redundancy Group status:

HP Network NodeManager i Software (9.21)Page 223 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

For information about each tab:

Attribute Description

Out-
standing
Status
Con-
clusions

The dynamically generated list of summary statuses for the Router Redundancy
Group that contributed to the current overall Status of the selected Router
Redundancy Group. Status is set by the Causal Engine.

Each Conclusion listed is outstanding and contributes to the current overall
Status.

This table is useful for obtaining a quick summary of the problem description for
the current Router Redundancy Group that led up to the Router Redundancy
Group's most current Status.

The Status value is correlated based on themost critical Conclusions.

Double-click the row representing a Conclusion. The Conclusion form displays all
details about the selected Conclusion.

The following table describes the possible Conclusions that might appear for a
Router Redundancy object.

Note: A Y in the Incident? column indicates that the Conclusion results in an
incident.

Critical Status Conclusions

Conclusion Description Status Incident?

RrgNoPrimary No primary device is identified in a
Router Redundancy Group (for example,
zero routers reporting HSRP Active or
VRRP Master). This incident typically
indicates one of the following:

l Toomany routers are down.

l Protocol-specific communication
between routers in the group is
malfunctioning.

Critical Y

Major Status Conclusions

Conclusion Description Status Incident?

RrgMultiplePrimary Indicates that more than one router
in a Router Redundancy Group is
designated as Primary (for example,
two routers reporting HSRP Active
or VRRP Master). This incident
typically indicates the protocol-
specific communication between

Major Y

Outstanding Status Conclusion Values
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Attribute Description

Conclusion Description Status Incident?

routers in the group is
malfunctioning.

Minor Status Conclusions

Conclusion Description Status Incident?

RrgMultipleSecondary Indicates that more than one
secondary device is identified in a
Router Redundancy Group (for
example, HSRP Standby).

Note: This incident applies
only to Router Redundancy
Groups that allow only one
secondary member.
Typically, the protocol-
specific communication
between routers in the group
is malfunctioning.

Typically, the protocol-specific
communication between routers
in the group is malfunctioning.

Minor Y

RrgNoSecondary Indicates that zero routers in a
Router Redundancy Group are
designated as Secondary (for
example, no router reporting
HSRP Standby or VRRP
Backup).

This incident typically indicates
the following:

l Protocol-specific
communication between
routers in the group is
malfunctioning.

l The group is routing packets
properly because a single
Primary device has been
identified.

Minor Y

Warning Status Conclusions

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

RrgGroup-
ContainsUnmanagedMember

At least one, but
not all SNMP
Agents,
associated with
themember
interfaces are not
responding to
SNMP queries or
are not polled.

Warn-
ing

N

RrgDegraded This incident
occurs only in
Router
Redundancy
Groups with more
than two
members. This
incident typically
indicates the
following:

l The Router
Redundancy
Group has a
Primary and
Secondary
device.

l The remaining
devices in the
group are not
in an expected
protocol-
specific state
(for example,
zero routers
reporting
HSRP Listen
state).

l Typically, the
protocol-
specific
com-

Warn-
ing

Y

Outstanding Status Conclusion Values, continued
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Attribute Description

Conclusion Description Status
Inci-
dent?

munication
between
routers is
mal-
functioning.
However, the
group is
routing
packets
properly.

Unknown Status Conclusions

Conclusion Description Status Incident?

RrgGroupAllMembersUnmanaged The SNMP Agent
associated with all
Router
Redundancy
Groupmember's
interfaces are not
responding to
SNMP queries or
are not polled.

Unknown N

Normal Status Conclusions

Conclusion Description Status Incident?

RrgOnePrimary At least onemember of the Router
Redundancy Group is acting as a
Primary router.

Normal N

Outstanding Status Conclusion Values, continued

Router Redundancy Group Form: Registration Tab (NNMi Advanced)
The "Router Redundancy Group Form (NNMi Advanced)" (on page 214) provides details about a
managed connection.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes
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Attribute Description

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes, continued

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes

Node Group Form
Note: Island NodeGroups are a special kind of NodeGroup that NNMi manages internally.

Therefore, NNMi administrators should not modify Island NodeGroup configurations. NNMi
overrides any user changes the next time NNMi updates the Island NodeGroup discovery
information. See "Help for Administrators" for more information about Island NodeGroups.

Membership in each node group is determined by a number of factors specified on the NodeGroup
form. The NNMi administrator can create andmodify NodeGroup definitions. The NNMi
administrator can also configure NodeGroups as filters for views. NNMi monitors the status of
each NodeGroup over time. NNMi also provides amap of each NodeGroup (Actions→Node
Group Map).

Each NodeGroup definition includes one or more of the following:

l Device Filters (by any combination of category, vendor, family, profile)

l Additional Filters (based on current object attribute values in the NNMi database)

l Additional Nodes (specific nodes identified by case-sensitiveHostname)

l Child NodeGroups nest into this NodeGroup.

For information about each tab:

Tip: Special Actions are available within the NodeGroup view and Interface Group view.

If you are an NNMI administrator, you can create NodeGroups and use NodeGroups in several
ways:

Attribute Description

Name The name of this group (text string specified by the NNMi administrator). This name
is amaximum of 255 characters. Alpha-numeric, spaces, and special characters
(~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Calculate
Status

NNMi Administrators only.

If disabled  , NNMi does not calculate the Status for this NodeGroup. NNMi sets

Node Group Basic Settings
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Attribute Description

the NodeGroup Status value to No Status.

If enabled  , NNMi calculates the NodeGroup Status according to the Status
Configuration settings. See "Configure NodeGroup Status" for more information.

Status Overall status for the specified node group. NNMi follows the ISO standard for status
classification. See the "NodeGroup Form: Status Tab" (on page 235) for more
information.

Add to
View
Filter List

NNMi Administrators only.

If disabled  , this node group does not appear in any node group filter lists for node,
interface, IP address, and incident views.

If enabled  , this node group is available as a filter for all node, interface, IP
address, and incident views.

Notes Optional. If your role permits, enter any information that might be useful to you and
your team.

Type amaximum of 1024 characters. Alpha-numeric, spaces, and special characters
(~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Node Group Basic Settings, continued

Attribute Description

Add to
Filter
List

NNMi Administrators only.

(NNM iSPI Performance) Using this feature is entirely optional. The NNM iSPI
Performance software, such as HP Network NodeManager iSPI Performance for
Metrics Software or HP Network NodeManager iSPI Performance for Traffic
Software, canmonitor your network without any exported filter.

Enable only for groups that are needed as filters in NNM iSPI Performance reports. It
might take up to an hour before the results are visible in the NNM iSPI Performance
reports. Choose wisely because establishing a filter requires significant NNM iSPI
Performance software processing time.

If disabled  , this group is not available as a filter in NNM iSPI Performance reports.

If enabled  , this group appears in the Optional Filters selection panel of the NNM
iSPI Performance reports.

Node Group Settings (NNM iSPI Performance)

Node Group Form: Device Filters Tab (NNMi Administrators only)
Optional: Determine NodeGroupmembers by vendor, family, model, or other device
characteristics such as SNMP object identifiers.

NNMi combines the results of all NodeGroup configuration settings in the followingmanner:

HP Network NodeManager i Software (9.21)Page 229 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

l NNMi first evaluates Device Filters. If any exist, nodes must match at least one specification to
belong to this NodeGroup.

l NNMi then evaluates any Additional Filters. Nodes must also pass all Additional Filters
specifications to belong to this NodeGroup.

l Any Additional Nodes specified are always included in the NodeGroup, regardless of any filters.

l Any Child NodeGroup results are treated the same as Additional Nodes.

The "NodeGroup Form" (on page 228) provides details about the selected node group. 

For information about each tab:

Attribute Description

Device
Filter

Table view of the device category, vendor, product family, or product model filters
associated with the selected node group.

Double-click the row representing the node that has the "Node Device Filter Form
(NNMi Administrators only)" (on page 230) you want to see.

Device-Characteristic Filters Table

Node Device Filter Form (NNMi Administrators only)

Optional: NodeGroup definitions can specify membership using combinations of Device Profile
attributes for device category, vendor, family, and profile. If you providemore than one Node
Device Filter specification for a particular NodeGroup, the NodeGroup includes devices that pass
any one of the Device Filters.

NNMi combines the results of all NodeGroup configuration settings in the followingmanner:

l NNMi first evaluates Device Filters. If any exist, nodes must match at least one specification to
belong to this NodeGroup.

l NNMi then evaluates any Additional Filters. Nodes must also pass all Additional Filters
specifications to belong to this NodeGroup.

l Any Additional Nodes specified are always included in the NodeGroup, regardless of any filters.

l Any Child NodeGroup results are treated the same as Additional Nodes.

Each Node Device Filter specifies one or more criteria that devices must meet to qualify for
inclusion in the NodeGroup (see table below). If more than one criteria, devices must meet all of the
criteria to pass that Node Device Filter and join the NodeGroup.

Attribute Description

Device
Category

Optional: A particular category of devices. The drop-down list displays all available
choices.

Device
Vendor

Optional: A particular vendor. The drop-down list displays all available choices.

Device Optional: A particular family of devices. The drop-down list displays all available

Device Attribute Filters Table
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Attribute Description

Device
Category

Optional: A particular category of devices. The drop-down list displays all available
choices.

Family choices.

Device
Profile

Optional: The text string for DeviceModel from the Device Profile.

Tip: According to industry standards (RFC 1213, MIB-II), each combination of
vendor, category, andmodel is assigned a unique SNMP system object ID
number (sysObjectID). NNMi provides a Device Profile for each of these. The
Device Profile allows you to customize NNMi behavior for specific device
models. If you want to know the actual SNMP system object ID number, use
 Quick Find (see below).

If your role permits, click the  Lookup icon and select one of the options from the
drop-downmenu:

l  Show Analysis to view Analysis Pane information for the currently selected
Device Profile. (See "Use the Analysis Pane " (on page 348) for more information
about the Analysis Pane.)

l  Quick Find to view and select from the list of all existing Device Profiles.

l  Open to display the details of the currently selected Device Profile.

l  New to create a new Device Profile definition.

Device Attribute Filters Table , continued

Node Group Form: Additional Filters Tab (NNMi Administrators only)
Note: The Additional Filters Editor requires that your user name be assigned a role of Administrator.

If you are an NNMi Administrator, see Specify NodeGroup Additional Filters for more
information about how to use the Additional Filters editor.

The Additional Filters tab enables the NNMi administrator to use expressions to refine the
requirements for membership in a NodeGroup.

NNMi combines the results of all NodeGroup configuration settings in the followingmanner:

l NNMi first evaluates Device Filters. If any exist, nodes must match at least one specification to
belong to this NodeGroup.

l NNMi then evaluates any Additional Filters. Nodes must also pass all Additional Filters
specifications to belong to this NodeGroup.

l Any Additional Nodes specified are always included in the NodeGroup, regardless of any filters.

l Any Child NodeGroup results are treated the same as Additional Nodes.

 The "NodeGroup Form" (on page 228) provides details about the selected NodeGroup. 

For information about each tab:

If an NNMi administrator created any Additional Filters for the selected NodeGroup, NNMi displays
the Additional Filters expression.
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Node Group Form: Additional Nodes Tab (NNMi Administrators only)
Optional: Determine NodeGroupmembers by specifying each device hostname (or address when
hostname is not available).

Nodes that are specifically listed are always included in this node group.

The "NodeGroup Form" (on page 228) provides details about the selected node group. 

For information about each tab:

Attribute Description

Node
Hostname

Table view of the case-sensitiveHostnames for the additional nodes added as
members of the selected NodeGroup.

Double-click the row representing the node that has the "Additional Node Form
(NNMi Administrators only)" (on page 232) you want to see.

Specific-Device Filters Table

Additional Node Form (NNMi Administrators only)

Optional: NodeGroup definitions can specify members by case-sensitiveHostname (on the "Node
Group Form: Additional Nodes Tab (NNMi Administrators only)" (on page 232).

Nodes that are specified as Additional Nodes are always included in the NodeGroup.

Tip for Administrators: To addmore than a few additional nodes to the NodeGroup, create a
Custom Attribute for the nodes. Use the Additional Filters tab with the Custom Attribute value
to group the nodes together. See "Node Form: Custom Attributes Tab" (on page 65) and "Node
Custom Attributes Form" (on page 65) for more information.

Attribute Description

Node
Hostname

The current value of the fully-qualified, case-sensitiveHostname attribute as it
appears on the Node form.

NNMi follows a set of rules to dynamically generate the value stored in the NNMi
database for each Node's Hostname. Click here for details.

Note: If DNS is the source of the Node's Hostname, the actual Hostname
might be converted to all uppercase or all lowercase before it is added to the
NNMi database (depending on how the NNMi administrator configured settings
in the nms-topology.properties file). See the "Modifying NNMi
Normalization Properties" section of theHP Network NodeManager i Software
Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

l If the Node supports SNMP, NNMi requests the Hostname using the IP Address
of the associated SNMP agent (theManagement Address attribute value on the
Node form).

Specific Node Group Member
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Attribute Description

When the NNMi administrator chooses Enable SNMP Address Rediscovery
in the Communication Configuration:

n If the SNMP Agent does not respond, NNMi checks for another Management
Address to request the Hostname, and the Hostname could change.

n If the SNMP Agent associated with the node changes, theManagement
Address and Hostname could change.

When the NNMi administrator disables Enable SNMP Address Rediscovery
in the Communication Configuration:

n If the SNMP Agent does not respond, NNMi uses the previously gathered
Management Address attribute value to request the Hostname.

n If the SNMP Agent associated with the node changes, NNMi uses the
previously gatheredManagement Address attribute value to request the
Hostname.

l If the Node does not support SNMP, noManagement Address is available.
NNMi requests a Hostname starting with the lowest IP Address associated with
the node (a Discovery Seed value or an IP address value gathered from a
neighboring device). NNMi uses the first Hostname provided. The Hostname
might change during a future discovery cycle.

See "Access Node Details" (on page 277) and Access More Details (Forms and
Analysis Pane) for a description of the ways to verify node details.

Specific Node Group Member, continued

Node Group Form: Child Node Groups Tab (NNMi Administrators
only)

The "NodeGroup Form" (on page 228) provides details about the selected NodeGroup.

A set of NodeGroups can be hierarchically configured, for example, based on geographical
location. TheParent NodeGroupmight be namedNorth America to represent all of the nodes on
that continent. Additional NodeGroups might exist for each country in which your business offices
reside (for exampleCanada,Mexico andUnited States). Each of these individual NodeGroups
are configured as aChildNodeGroup of theNorth AmericaNodeGroup.

For information about each of the columns displayed in the Child NodeGroups table, see "Node
Group Hierarchy (Child NodeGroup) Form (NNMi Administrators only)" (on page 234).

By default, eachChildNodeGroup is represented by a hexagon symbol that appears with the
other Node objects of theParent NodeGroup in the NodeGroupMap. Child NodeGroup objects
can bemoved and have their locations saved with other Node objects in themap. Unlike other
Node objects, double-clicking a Child NodeGroup object displays amap of the nodes in the Child
NodeGroup rather than the object's form.

Alternatively, an NNMi administrator can configure themap to display all nodes in a Child Node
Group as though its contents are directly in the Parent NodeGroup by setting theExpand Child in
Parent Node Group Map attribute. An NNMi administrator must set this option for each Child
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NodeGroup that should be expanded. See "NodeGroup Hierarchy (Child NodeGroup) Form (NNMi
Administrators only)" (on page 234) for more information.

For information about each tab:

Related Topics

"NodeGroupMaps" (on page 244)

"Navigating within a NodeGroupMap" (on page 246)

"Position Nodes on a NodeGroupMap" (on page 248)

Node Group Hierarchy (Child Node Group) Form (NNMi Administrators only)

Child NodeGroups associate groups of nodes in a hierarchical order. For example, the Parent Node
Groupmight be namedUnited States to represent all of the nodes in the United States. Additional
NodeGroups might exist for each state in which your business offices reside (for example
Colorado andCalifornia). Each of these individual state NodeGroups can be a Child NodeGroup
of theUnited StatesNodeGroup.

The following table describes each of theBasics attributes in theNode Group Hierarchy form.

Attribute Description

Child Node
Group

Indicates the name of a NodeGroup that is below the current NodeGroup in
the hierarchical order. For example, Colorado could be a Child NodeGroup to
a NodeGroup namedUnited States.

Note: This attribute appears as theName column in theChild Node Groups
table view.

Expand Child
in Parent Node
GroupMap

Used to indicate whether all of the nodes contained in a Child NodeGroup are
displayed in the NodeGroupMap as though they were directly contained in the
parent node group.

If enabled, each node in the group appears as a separate node on the Node
GroupMap.

If disabled, a single object represents a Child NodeGroup on the NodeGroup
Map.

Note the following:

l If the current NodeGroup has one or more Child NodeGroups, each Child
NodeGroup is also displayed. Child NodeGroups are indicated using a
hexagon as shown below:

l If any Child NodeGroup is a parent to other Child NodeGroups, those Child
NodeGroups are also displayed on themap as follows:
n If the Child NodeGroup has theExpand Child in Parent Node Group

Map attribute disabled, the Child NodeGroup appears as a hexagon.

Basics Attributes
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Attribute Description

Child Node
Group

Indicates the name of a NodeGroup that is below the current NodeGroup in
the hierarchical order. For example, Colorado could be a Child NodeGroup to
a NodeGroup namedUnited States.

Note: This attribute appears as theName column in theChild Node Groups
table view.

n If any Child NodeGroup has theExpand Child in Parent Node Group
Map attribute enabled, NNMi displays each of the nodes in that Child
NodeGroup.

Note: This attribute appears in theExpand column in theChild Node Groups
table view.

Basics Attributes, continued

Related Topics

"NodeGroupMaps" (on page 244)

"Position Nodes on a NodeGroupMap" (on page 248)

Node Group Form: Status Tab
NNMi calculates the NodeGroup status based on the status of the nodes within the group. NNMi
follows the ISO standard for status classification. Your NNMi administrator chooses a strategy for
calculating NodeGroup Status. Possible strategies are:

l Propagating theMost Severe Status

l Configuring percentage thresholds

By default, NNMi uses the strategy for Propagating theMost Severe Status. NNMi sets the Node
Group status equal to themost severe Status of any node in the NodeGroup.

NNMi can also use the alternative Percentage threshold strategy. NNMi sets the NodeGroup
status according to rules defined by your NNMi Administrator. Whenmore than one Status
percentage exceeds the threshold, NNMi propagates themost severe status. For example using
the settings below, if the percentage of nodes with Warning Status exceeds 30 percent and the
number of nodes with Minor Status exceeds 20 percent, NNMi assigns the NodeGroup a
Status of Minor.

The following list shows an example of using the alternative Percentage strategy:

No Status — The NodeGroup has just been added and NNMi has not yet calculated the
status.

Normal — All nodes in the NodeGroup have a status of Normal or the threshold specified for
this Target Status has not been reached.

Unknown — All nodes within the NodeGroup have a status of Unknown.

Warning — At least 30 percent of the nodes within the NodeGroup have a status ofWarning.

Minor — At least 20 percent of the nodes in the NodeGroup have a Status ofMinor.

Major — At least 10 percent of the nodes within the NodeGroup have a status ofMajor.
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Critical — At least 5 percent of the nodes in the group have a status of Critical.

Note: These example percentages might not match your NNMi Administrator's choices. See "Help
for Administrators" for more information.

The "NodeGroup Form" (on page 228) provides details about the selected NodeGroup.

For information about each tab:

Attribute Description

Status NNMi calculates the NodeGroup status based on the status of the nodes within the
group. Your NNMi administrator chooses a strategy for calculating NodeGroup
Status. Possible strategies are:

l Propagating theMost Severe Status (NNMi default setting)

l Configuring percentage thresholds

Possible status values are as follows. See "Watch Status Colors" (on page 274) for
more information about themeaning of possible status values. The status icons are
displayed in table views. All other locations use status colors (instead of icons):

No Status

Normal

Unknown

Warning

Minor

Major

Critical

Status
Last
Modified

Date and time indicating when the status was last set.

Status Attributes

Attribute Description

Status
History

List of up to the last 30 changes in status for the selected node. This view is useful for
obtaining a summary of the node group status so that you can better determine any
patterns in behavior and activity.

Double-click the row representing a Status History. The Status History form displays
all details about the selected Status.

Status History Table

Interface Group Form
Each interface group can include one or more interface-type specifications (based on industry-
standard IANA ifType-MIB variables). The NNMi administrator can create andmodify interface
group definitions. The NNMi administrator can also configure interface groups as filters in table
views.

The NNMi administrator can create andmodify Interface Group definitions. The NNMi administrator
can also configure Interface Groups as filters for views.
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When determiningmembership in this Interface Group, NNMi combines the results of all Interface
Group configuration settings in the followingmanner:

l NNMi first evaluates ifType Filters. If any exist, interfaces must match at least one specification
to belong to this Interface Group.

l NNMi then evaluates any Additional Filters. Interfaces must also pass all Additional Filters
specifications to belong to this Interface Group.

l If a NodeGroup is specified for this Interface Group, any interface in this groupmust be
contained in a node that is amember of the NodeGroup specified in the Basics section.

For information about each tab:

Tip: Special Actions are available within the NodeGroup and Interface Group views.

If you are an NNMI administrator, you can create Interface Groups and use Interface Groups in
several ways:

Attribute Description

Name The name of this group (text string specified by the NNMi administrator). This name is
amaximum of 255 characters. Alpha-numeric, spaces, and special characters
(~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Add to
View
Filter
List

If disabled  , this interface group does not appear in any interface group filter lists for
interface and IP address views.

If enabled  , this interface group is a filter for all interface and IP address views.

Node
Group

Optional. If configured, the specified NodeGroup serves as a filter for this Interface
Group.

If you specify a NodeGroup, any interface in this groupmust be contained in a node
that matches the specified NodeGroup. For example, an Interface Group configured
for Ethernet-only interfaces could be further refined by associating a NodeGroup
configured for Printers-only. You could then gather data about all printers that contain
Ethernet interfaces.

Notes Optional. If your role permits, enter any information that might be useful to you and
your team.

Type amaximum of 1024 characters. Alpha-numeric, spaces, and special characters
(~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Interface Group Basics

Attribute Description

Add to
Filter
List

(NNM iSPI Performance) Using this feature is entirely optional. The NNM iSPI
Performance software, such as HP Network NodeManager iSPI Performance for
Metrics Software or HP Network NodeManager iSPI Performance for Traffic
Software, canmonitor your network without any exported filter.

Interface Group Settings (NNM iSPI Performance)
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Attribute Description

Enable only for groups that are needed as filters in NNM iSPI Performance reports. It
might take up to an hour before the results are visible in the NNM iSPI Performance
reports. Choose wisely because establishing a filter requires significant NNM iSPI
Performance software processing time.

If disabled  , this group is not available as a filter in NNM iSPI Performance reports.

If enabled  , this group appears in the Optional Filters selection panel of the NNM
iSPI Performance reports.

Interface Group Settings (NNM iSPI Performance), continued

Interface Group Form: ifType Filters Tab
Interface Groupmembers are filtered by industry-standard IANA ifType-MIB variables.

When determiningmembership in this Interface Group, NNMi combines the results of all Interface
Group configuration settings in the followingmanner:

l NNMi first evaluates ifType Filters. If any exist, interfaces must match at least one specification
to belong to this Interface Group.

l NNMi then evaluates any Additional Filters. Interfaces must also pass all Additional Filters
specifications to belong to this Interface Group.

l If a NodeGroup is specified for this Interface Group, any interface in this groupmust be
contained in a node that is amember of the NodeGroup specified in the Basics section.

The "Interface Group Form" (on page 236) provides details about the selected interface group. 

For information about each tab:

Attribute Description

ifType
Filters

Table view of all ifType filters associated with the selected interface group.

If the Security configuration permits, double-click the row representing the ifType
filter to view more details on the "ifType Filter Form" (on page 238).

ifType Filters Table

ifType Filter Form

If the NNMi Security configuration permits access to this form, displays the specification of the
selected interface-type filter. This filter is based on an industry-standard IANA ifType-MIB variable.

Attribute Description

ifType Click the  Lookup icon and select  Open to display the "ifType (Interface Type)
Form" (on page 239) and view more information about the specified IANA ifType-MIB
variable.

ifType Specification
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Attribute Description

If your role permits, you can easily choose from a list of all known industry-standard
IANAifType-MIB variables (as of the time NNMi was released). You can also add a
new value. (For more information, see
http://www.iana.org/assignments/ianaiftype-mib)

ifType Specification, continued

ifType (Interface Type) Form

Displays information about the selected industry-standard IANA ifType-MIB variable.

The NNMi administrator can change these settings.

Attribute Description

ifType Text string. The IANA ifType TEXTUAL-CONVENTION values extracted from the
IANA ifType-MIB. This text string displays as the ifType attribute value in
Interfaces views. (For more information, see
http://www.iana.org/assignments/ianaiftype-mib.)

If your role permits, click the  Lookup icon and select one of the options from
the drop-downmenu:

l  Show Analysis to view Analysis Pane information for the currently selected
ifType. (See "Use the Analysis Pane " (on page 348) for more information
about the Analysis Pane.)

l  Quick Find to view and select from the list of all available ifType values.

l  Open to display the details of the currently selected ifType.

l  New to create a new ifType definition.

Number Industry-standard number assigned to this ifType value.

Description Optional. If your role permits, provide any description that would be useful for
communication purposes within your team.

Type amaximum of 2048 characters. Alpha-numeric, spaces, and special
characters (~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Interface Type Definition

Interface Group Form: Additional Filters Tab
Note:  To createAdditional Filters, your user namemust be assigned to the role of NNMi

Administrator.

Additional Filters enable the NNMi administrator to create expressions that further refine which
interfaces to include in an Interface Group. If an NNMi administrator created any Additional Filters
for the selected Interface Group, NNMi displays the Additional Filters expression. See Specify
Interface Group Additional Filters for information about how to use the Additional Filters Editor or
how to decipher an existing Additional Filters expression.

HP Network NodeManager i Software (9.21)Page 239 of 454



Online Help: Help for Operators
Chapter 5: Accessing Device Details

When determiningmembership in this Interface Group, NNMi combines the results of all Interface
Group configuration settings in the followingmanner:

l NNMi first evaluates ifType Filters. If any exist, interfaces must match at least one specification
to belong to this Interface Group.

l NNMi then evaluates any Additional Filters. Interfaces must also pass all Additional Filters
specifications to belong to this Interface Group.

l If a NodeGroup is specified for this Interface Group, any interface in this groupmust be
contained in a node that is amember of the NodeGroup specified in the Basics section.

 The "Interface Group Form" (on page 236) provides details about the selected Interface Group. 

For information about each tab:

MPLS WAN Cloud (RAMS) Form (NNMi Advanced)
TheMPLSWAN Cloud (RAMS) form provides information for the selectedMPLSWAN Cloud. The
following table describes the fields included on theMPLSWAN Cloud (RAMS) form:

Attributes Description

MPLSWAN Cloud
Name

The name assigned to the discoveredMPLS WAN Cloud.

AS Number The Autonomous System Number assigned to theMPLS WAN Cloud.

CEs The number of Customer Edge (CE) routers associated with the
MPLS WAN Cloud.

Basic Attributes

Related Topics:

"MPLSWAN Cloud (RAMS) Form: MPLSWAN Connections Tab (NNMi Advanced)" (on page
240)

"MPLS WAN CloudMap (NNMi Advanced)" (on page 262)

MPLS WAN Cloud (RAMS) Form: MPLS WAN Connections Tab (NNMi
Advanced)

The "MPLSWAN Cloud Form" provides details about the selectedMPLS VPN Cloud.

Note: The Last Discovered Time is displayed in theMPLS WAN Interface summary. It is the date
and time when the selectedMPLS WAN Cloud was last discovered.
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Attributes Description

CE Status Overall status for the Customer Edge (CE1) router. The possible values
are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

CE Name The name assigned to the CE router.

CE Interface Interface of the CE router participating in theMPLSWAN Cloud.

CE Address The IP address of the CE router.

PE Address The IP address of the Provider Edge (PE2) router.

Protocol The routing protocol used between the CE and the PE router.

Basic Attributes

Related Topics:

"MPLS WAN CloudMap (NNMi Advanced)" (on page 262)

Management Station Form
Management Station configurations are used for a variety of purposes:

l Enable NNM  6.x or 7.x to forward events to NNMi.

l Enable access to NNM  6.x or 7.x features from incidents that were forwarded from
NNM 6.x/7.x. (See "Accessing NNM 6.x and 7.x Features" (on page 24) for more information.)

l Filter incident views by NNM  6.x or 7.x Management Station. 

Name Description

Name The name your team uses to identify this remote NNM 6.x or 7.x

NNM 6.x or 7.x Management Station Attributes

1Customer Edge router. The router in your network that sends data to an Internet Service Provider's
router (the Provider Edge) on the path to the data's final desination.
2Provider Edge router. The Internet Service Provider's router that receives your data on the path to
your data's final desination. The Customer Edge (CE) router in your network connects to this PE.
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Name Description

management station.

NNM Version The version of NNM (6.x or 7.x) in use on this remotemanagement
station.

IP Address The IP address used for communication with this remote NNM 6.x or
7.x management station.

ovas Port (OpenView
Application Server)

The port number used by the OpenView Application Server (ovas) on
this NNM 6.x or 7.x management station.

The port number is usually 7510.

Web Server Port The port number used by the web server on this NNM 6.x or 7.x
management station:

l For NNM 7.x management stations on all operating systems, the
port number is usually 3443.

l For NNM 6.x management stations running UNIX, the port is
usually 3443.

l For NNM 6.x management stations runningWindows systems, it is
usually 80.

Description Optional. Notes your NNMi administrator added about this NNM 6.x or
7.x management station.

Maximum length is 255 characters. Alpha-numeric, spaces, and
special characters (~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

NNM 6.x or 7.x Management Station Attributes , continued
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Viewing Maps (Network Connectivity)
NNMi provides several views that display maps of device connections within your network. You
can access these views in the Troubleshooting workspace or by using theActionsmenu. These
views include:

l Layer 2 Neighbor View

l Layer 3 Neighbor View

l Path View

l "NodeGroupMaps" (on page 244)

Tip: You can right-click any object in a table or map view to access theActionsmenu.

TheOSI initiative identified seven layers for communication and computer network protocol design.
The Layer 21 and Layer 32 Neighbor Views display data according to the Open Systems
Interconnection (OSI) model.

The Path view combines real-time data about both Layer 2 and Layer 3 information.

On themaps, the lines between devices indicate the connections.

In Layer 2 Neighbor View maps, interfaces that are connected to a neighbor are indicated by little
squares around the background shape of the parent node. Pay special attention to the color of the
lines, which represent connections. For example:

See About Status Colors for more information.

In Layer 3 Neighbor View maps, addresses connected to neighbors within the same IP subnet are
indicated by little hexagons around the background shape of the parent node. The lines indicate the
subnets, so the lines are beige (no status). For example:

1Refers to the Data Link layer of themultilayered communicationmodel, Open Systems
Interconnection (OSI). The Data Link layer moves data across the physical links in the network.
The switches and switch-routers are devices that redirect datamessages at the layer 2 level, using
the destinationMedia Access Control (MAC) address to determine where to direct themessage.
2Refers to the Network layer of themultilayered communicationmodel, Open Systems
Interconnection (OSI). The Network layer is concerned with knowing the address of the neighboring
nodes in the network, selecting routes and quality of service, and recognizing and forwarding
incomingmessages to local host domains. The router and switch-router are the devices that
redirect datamessages at the Layer 3 level. Everything in a subnet is connected at the Layer 3 (IP)
level.
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NNMi Advanced. IPv6 subnets are indicated by this symbol:

NodeGroupMaps show themembers of a NodeGroup (defined by the NNMi administrator). The
map displays the status and connectivity of eachmember. Your NNMi administrator can also
specify a background image (for example, amap of North America). Child NodeGroups display the
hierarchy of nodes in a NodeGroup.

Node Group Maps
NodeGroupMaps enable you to see themembers of a NodeGroup (defined by the NNMi
administrator). Themap displays the status and connectivity of eachmember. Your NNMi
administrator can specify a background image (for example, amap of North America).

Note: If your role permits, you can configure the settings for a NodeGroupmap, including selecting
the background image. If the NodeGroupMap appears in a new window, use the File→
Open Node Group Map Settings option. Administrators can also use theUser Interface
Configuration option from the Configuration workspace. See "Help for Administrators" for
more information.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Becausemembership is based on the NodeGroup, not connectivity, one or more nodes might not
be connected on a NodeGroupMap.

To access a Node Group map:

l Display amap of all NodeGroups and open a specific NodeGroupMap.

a. From theWorkspaces navigation panel, select the Topology Mapsworkspace.

b. Select Node Group Overview.

c. In theNode Group Overviewmap, double-click a  NodeGroup symbol.

l If you know the name of the NodeGroup that has themap you want to display, use the
Troubleshooting workspace to open amap.
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a. From theWorkspaces navigation panel, select the Troubleshooting workspace.

b. Select Node Group Map.

c. In theNode Group field, enter the name of the NodeGroup that has themap you want to
display.

Note: As you start typing the first few letters (case-sensitive) of the name of the node group,
you will view a list that includes all potential node groups with names that match the
letters or numbers as you enter them.

l Select from a table view of all NodeGroups and open themap.

a. From theWorkspaces navigation panel, selectMonitoring or Inventory .

b. Select theNode Groups view.

c. In the NodeGroup view, select the row representing the NodeGroup of interest.

d. Select Actions→Maps→Node Group Map.

l Select any Node, Interface, or IP Address object and open the associated NodeGroupMap:

a. From theWorkspaces navigation panel, selectMonitoring or Inventory .

b. Select the Nodes, Interfaces, or IP Addresses view.

c. Select the row representing the object of interest.

d. Select Actions→Maps→Node Group Map.

l Select an Incident and open the Source Node's associated NodeGroupMap:

a. From theWorkspaces navigation panel, select Incident Management or Incident
Browsing .

b. Select any view.

c. Select the row representing the Incident of interest.

d. Select Actions→Maps→Node Group Map.

When viewing nodes on a NodeGroupMap, keep inmind the following:

l You can view only the NodeGroups that contain one or more nodes to which you have access.

l By default, eachChildNodeGroup is represented by a  NodeGroup symbol that appears
with the other Node objects in theParent NodeGroupMap.

An NNMi administrator can configure themap to display all nodes in aChildNodeGroup as
though its contents are directly in theParent NodeGroup by setting theExpand Child in
Parent Node Group Map attribute. An NNMi administrator must set this option for each Child
NodeGroup that should be expanded. See "NodeGroup Hierarchy (Child NodeGroup) Form
(NNMi Administrators only)" (on page 234) for more information.

l Child  NodeGroup symbols can bemoved and the new location saved with other Node
objects in themap.
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l To display the nodes within aChildNodeGroup, do one of the following:
n Double-click the NodeGroup symbol.

n Select the NodeGroup symbol and click the Open Node Group Map icon.

n Select the NodeGroup symbol and select Actions→ (Child Node Group Name) Map.

l NNMi can enlarge themap symbol of any node associated with aKey Incident1. Use the
Indicate Key Incidents button in themap view toolbar (see Using the View Toolbars: Node
GroupMap Toolbar Icons):

(on) = When the this NodeGroupmap opens, NNMi enlarges any objects on a NodeGroup
map that are Source Objects for aKey Incident2. (For example, when viewing the
NodeGroupmap, NNMi enlarges any node on a NodeGroupmap that has an open root
cause incident associated with it.)

(off) = When the this NodeGroupmap opens, NNMi does not indicate the objects on a
NodeGroupmap that are Source Objects for aKey Incident3.

To view the associated incident for the node, double-click the node symbol. In the Node form,
select the Incidents tab.

l HP Network NodeManager iSPI Performance for Metrics Software only. NNMi automatically
synchronizes Interface Group and NodeGroup configuration changes between NNMi and NNM
iSPI Performance for Metrics. However, in some cases, additional configuration changes that
affect NodeGroup or Interface Groupmembership might take longer to synchronize.

If you do not see one or more nodes in an NNMi Performance for Metrics report that are visible in
NNMi, use theActions→NNM iSPI Performance→ Synch Report Groupswith NNMi
option. This option forces NNMi to synchronize the Interface and NodeGroup information
between NNMi and NNM iSPI Performance for Metrics more quickly than the default time
frame.

NNMi provides the "NodeGroupOverview Map" (on page 248). Your NNMi administrator can
providemore NodeGroupmaps.

Related Topics

"Navigating within a NodeGroupMap" (on page 246)

"Position Nodes on a NodeGroupMap" (on page 248)

Navigating within a Node Group Map
Navigation and accessing node details on a NodeGroupMap are the similar to those for the Layer 2
Neighbor and Layer 3 Neighbor maps with the following exceptions:

1Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
2Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
3Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
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l To display a NodeGroupmap of a Child NodeGroup in the samewindow, double-click the Child
NodeGroup object: 

Tip: Select the node group object and click Open to display the Child NodeGroup form.

l To return to a previous NodeGroupMap, use the breadcrumbs in themap's title bar.

l To display a NodeGroupMap for a Child NodeGroup in a new window, do one of the following:

n UseActions→Maps→Node Group Map.

n Click Show Map in New Window.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Note: The Child NodeGroupmapmust be unique to be displayed in a new window. See Using
Actions to Perform Tasks for more information.

l To open the NodeGroup form for the displayed NodeGroupmap, do one of the following:

Select File→Open Node Group for Map.

l To open the NodeGroupMap Settings form from the displayed NodeGroupmap, select File→
Open Node Group Map Settings.

l You canmanually reposition the nodes on the background image, and, if your role permits, save
themap for later use. See "Position Nodes on a NodeGroupMap" (on page 248) for more
information.

l NNMi can enlarge themap symbol of any node associated with aKey Incident1. Use the
Indicate Key Incidents button in themap view toolbar (see Using the View Toolbars: Node
GroupMap Toolbar Icons):

(on) = When the this NodeGroupmap opens, NNMi enlarges any objects on a NodeGroup
map that are Source Objects for aKey Incident2. (For example, when viewing the
NodeGroupmap, NNMi enlarges any node on a NodeGroupmap that has an open root
cause incident associated with it.)

(off) = When the this NodeGroupmap opens, NNMi does not indicate the objects on a
NodeGroupmap that are Source Objects for aKey Incident3.

To view the associated incident for the node, double-click the node symbol. In the Node form,
select the Incidents tab.

1Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
2Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
3Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
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As in other maps, clicking the Open icon after selecting a node on themap, displays the Node
form. See UseMap Views and Access More Details (Forms and Analysis Pane) for more
information.

Position Nodes on a Node Group Map
You canmanually reposition the nodes on themap, and, if your role permits, save themap. NNMi
users see your change the next time themap is refreshed.

Note: If your role permits, to return to the original layout that NNMi automatically determines, use
File→Clear Layout.

To position and save node locations on a Node Group Map view:

1. Navigate to the NodeGroupMap:

a. From the workspace navigation panel, select the Inventory orMonitoringworkspace.

b. Select Node Groups.

c. Select the row that represents the NodeGroup of interest.

d. Select Actions→Maps→Node Group Map.

Tip: You can right-click any object in a table or map view to access theActions
menu.

2. Manually re-position the node locations by dragging and dropping the nodes to the location you
want.

3. If your role permits, select Save Layout from the toolbar menu to save all node locations on
themap.

Note: Each time you select Save Layout, NNMi deletes any previous node location information
for themap.

Node Group Overview Map
This NodeGroupmap displays all top-level NodeGroups that have been configured for your

network.

Use this view when you want to do any of the following tasks:

l Determine the NodeGroups created for your network.

l Determine the NodeGroup hierarchy for the NodeGroups created for your network.

To display the Node Group Overview map using the Topology Maps workspace:

1. From the workspace navigation panel, select the Topology Mapsworkspace.

2. Select Node Group Overview.

Related Topics

Views Provided by NNMi

NodeGroupMapObjects
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Initial Discovery Progress or Network Overview Map
Initial Discovery Progress displays amap containing themost highly connected nodes (largest
subnets) in the Layer 3 network. Use this map to display the initial discovery progress of the
Routers, Switches, and Switch-Routers, for up to 100 nodes.

Note: NNMi displays this map only if the NNMi administrator has configured the NNMi console's
Initial View to be Installation Default and the network has less than or equal to a total of 100
routers, switches, and switch-routers. After NNMi has discoveredmore than 100 connectors,
this map view changes to the Open Key Incidents table view.

To determine which nodes to display, NNMi uses the following algorithm until it has displayed a
maximum of 100 nodes:

l Display the largest subnets (Layer 3 connectivity) based on discovered routers

l Display themost highly connected switches within the subnets displayed

l Display themost highly connected nodes within the subnets displayed

l Display any remaining nodes up to a total of 100

Note the following:

l NNMi polls only management IP addresses by default. Therefore, the status of IP addresses on
themapmight appear as No Status ( ).

l Because the connections on a Layer 3 represent subnets, which are not monitored in NNMi, the
connections on a the Initial Discovery Progress map appear as No Status ( ).

l The Initial Discovery Progressmap displays amaximum of 100 nodes. This maximum
number cannot be changed.

The Initial Discovery Progressmap periodically updates both topology and status. The update
interval is more frequent when the topology is changing, and less frequent when the topology is not
changing.

Note: Automatic refresh cancels any modifications, such as selecting or zooming, youmake to this
view.

Use this view when you want to do any of the following tasks:

l View a high level overview of your network

l Determine themost highly connected nodes in the Layer 3 network

l Determine discovery progress

The Network Overviewmap is similar to the Initial Discovery Progressmapwith the following
exceptions:

l Network Overview displays amap containing themost highly connected nodes (largest
subnets) in the Layer 3 network for up to 250 nodes.

l The NNMi administrator can change themaximum number of nodes displayed. If you are an
NNMi administrator, see "NNMi Console" in the HP Network NodeManager i Software
Deployment Reference for more information.

l The refresh rate is 5minutes.

HP Network NodeManager i Software (9.21)Page 249 of 454



Online Help: Help for Operators
Chapter 6: ViewingMaps (Network Connectivity)

l The NNMi administrator must have configured the NNMi console's Initial View to beNetwork
Overview

To display the Initial Discovery Progress or Network Overview map using the Topology
Maps workspace:

1. From the workspace navigation panel, select the Topology Mapsworkspace.

2. Select Initial Discovery Progress orNetwork Overview.

Related Topics

Views Provided by NNMi

NodeGroupMapObjects

Networking Infrastructure Devices Map
Tip: Your NNMi administrator can add or delete maps from the Topology Maps workspace. If the

Networking Infrastructure Devices map is not available, your NNMi administrator might have
chosen to remove this map from the Topology Maps workspace. 

The Networking Infrastructure Devicemap provides representative NodeGroups for the Switches
and for the Routers in your network. Each of the following device types, if applicable, are also
included on themap:

l Chassis

l Firewalls

l Voice Gateways

To view the connectivity within each device type (NodeGroup), click the NodeGroup of interest.
See "NodeGroups View (Inventory)" (on page 42) for more information about NodeGroups.

Use this view when you want to do any of the following tasks:

l Determine the types of devices in your network.

l View the connectivity within a group of devices of the same type.

l Determine the number of devices of a specific type.

To display the Networking Infrastructure Devices map using the Topology Maps
workspace:

1. From the workspace navigation panel, select the Topology Mapsworkspace.

2. Select Networking Infrastructure Devices.

Related Topics

Views Provided by NNMi

NodeGroupMapObjects
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Routers Map
Tip: Your NNMi administrator can add or delete maps from the Topology Maps workspace. If the

Routers Map is not available, your NNMi administrator might have chosen to remove this map
from the Topology Maps workspace.

The Routers map shows a graphical representation of the Layer 3 connectivity in your network.
Connector devices on Layer 3maps are routers, switch-routers, and gateways. (See About Map
Symbols for more information.)

Note: If the number of nodes in your network is greater than themaximum number of nodes
configured to be displayed on themap, NNMi filters themap to display routers that have
interfaces with addresses in the largest number of overall subnets in the network. This means
that routers with little or no connectivity are only displayed for smaller networks.

Use this view when you want to do any of the following tasks:

l Understand the router connectivity between your devices.

l Determine the routers that are connected to the largest number of subnets.

To display the Routers map using the Topology Maps workspace:

1. From the workspace navigation panel, select the Topology Mapsworkspace.

2. Select Routers.

Related Topics

Views Provided by NNMi

NodeGroupMapObjects

Switches Map
Tip: Your NNMi administrator can add or delete maps from the Topology Maps workspace. If the

Switches map is not available, your NNMi administrator might have chosen to remove this map
from the Topology Maps workspace.

The Switches map shows a graphical representation of the Layer 2 connectivity in your network.
Connector devices on Layer 2maps are switches, ATM switches, and switch-routers. (See About
Map Symbols for more information.)

Note: If the number of nodes in your network is greater than themaximum number of nodes
configured to be displayed on themap, NNMi filters themap to display switches that are the
most highly connected.

Use this view when you want to do any of the following tasks:

l Understand the switch connectivity between your devices.

l Determine the switches that are connected to the largest number of devices.

To display the Switches map using the Topology Maps workspace:

1. From the workspace navigation panel, select the Topology Mapsworkspace.

2. Select Switches.

Related Topics
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Views Provided by NNMi

NodeGroupMapObjects

Display the Layer 2 Neighbor View
The Layer 21 Neighbor View shows a graphical representation of the selected device and any
connections with other devices within a specified number of hops from the selected
device. Connector devices on Layer 2 are switches and switch-routers. (See About Map Symbols
for more information.)

Use this neighbor view when you want to do any of the following tasks:

l Understand the switch connectivity between your devices.

l Find the cause of a connectivity problem (the device status is not Normal).

l Identify the highly-connected nodes in your environment.

l Determine what elsemight be affected by a problem device, such as an interface.

To display the Layer 2 Neighbor View using the Troubleshooting workspace:
1. From the workspace navigation panel, select the Troubleshooting workspace.

2. Select Layer 2 Neighbor View.

3. In theNode or IP field, type the Name attribute value from the "Node Form" (on page 48) or
any IP Address belonging to a node in your network. (NNMi provides a case-sensitive drop-
down list to help speed up your selection.)

4. A hop is a node representing any network device, such as a workstation, gateway, or switch,
which is connected by a link with no intermediate nodes.

Click theNumber of Hops drop-down list, and select the number of hops to display (1-9). The
default number of hops is 1.

5. All devices connected to the initial object within the specified number of hops are displayed.

The color of the line between the devices indicates the health of the connection ( See "Viewing
Maps (Network Connectivity)" (on page 243)).

A mesh connection represents the location of multiple devices interconnected with each other.
A mesh is represented by the following icon:

To display the Layer 2 Neighbor View using the Actions menu in a table view or in a form:

1. From the workspace navigation panel, select the table view of interest.

For example the Inventoryworkspace, Nodes view.

1Refers to the Data Link layer of themultilayered communicationmodel, Open Systems
Interconnection (OSI). The Data Link layer moves data across the physical links in the network.
The switches and switch-routers are devices that redirect datamessages at the layer 2 level, using
the destinationMedia Access Control (MAC) address to determine where to direct themessage.
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2. Select the row representing the object instance of interest (node, interface, or address).

For example, select the row representing the node of interest from theNodes view.

3. Select Actions→ Layer 2 Neighbor View. The starting node appears with a bold label on a
map.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

4. A hop is node representing any network device, such as a workstation, gateway, or switch,
which is connected by a link with no intermediate nodes.

Click theNumber of Hops drop-down list, and select the number of hops to display (1-9). The
default number of hops is 1.

5. All devices connected to the initial object within the specified number of hops are displayed.

The color of the line between the devices indicates the health of the connection ( See "Viewing
Maps (Network Connectivity)" (on page 243)).

A mesh connection represents the location of multiple devices interconnected with each other.
A mesh is represented by the following icon:

To see more information about a specific connection on the map:

1. Select the line or (mesh connection) icon of interest.

2. Click the  Open icon on themap toolbar.

3. The Layer 2 Connection form displays, showing all information for the connection. See "Layer 2
Connection Form" (on page 179) for information.

To view the addresses for a particular interface:
1. Click to select the interface of interest.

Note: If the interface is difficult to select, use the + (plus) key to zoom in on themap.

2. From themap view toolbar, select the Open icon.

3. In the Interface form, select theAddresses tab.

4. Each address associated with the interface appears in the IP addresses table.

To view the port number for an interface:
Click the interface of interest.

The port number for the interface appears as a new label.
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To view the interface name at each end of a connection:
Click the line representing the connection.

The interface name for each end of the connection appears as a new label.

Tip: Use Ctrl-Click to select mutiple lines and display more interface names.

Related Topics:

UsingMap Views

"Layer 2 Connection Form" (on page 179)

Display the Layer 3 Neighbor View
The Layer 31 Neighbor View is a graphical representation of the subnets in which the starting node
participates, and the health of the routers in those subnets. Connector devices on Layer 3 Neighbor
View maps are nodes that have a Device Category value of either router or switch-router. (See
About Map Symbols for more information.)

Use this neighbor view when you want to do any of the following tasks:

l Determine whether a subnet is down.

l Understand the router connectivity between your devices.

l Assist in finding the root cause of a connectivity problem (see which device along the
communication chain has a status other than normal).

l Identify the highly-connected nodes in your environment.

To display a Layer 3 Neighbor View using the Troubleshooting workpspace:
1. From the workspace navigation panel, select the Troubleshooting workspace.

2. Select Layer 3 Neighbor View.

3. In theNode or IP field, type the Name attribute value from the "Node Form" (on page 48) or
any IP Address belonging to a node in your network. (NNMi provides a case-sensitive drop-
down list to help speed up your selection.)

Note: You can enter aNode or IP attribute value that represents a node of any Device
Category. On the Layer 3 Neighbor View map, NNMi displays only those devices that
have a Device Category of router or switch-router that are connected to it.

4. A hop represents a network device that has a Device Category value of either router or
switch-router and that is connected by a link with no intermediate nodes.

1Refers to the Network layer of themultilayered communicationmodel, Open Systems
Interconnection (OSI). The Network layer is concerned with knowing the address of the neighboring
nodes in the network, selecting routes and quality of service, and recognizing and forwarding
incomingmessages to local host domains. The router and switch-router are the devices that
redirect datamessages at the Layer 3 level. Everything in a subnet is connected at the Layer 3 (IP)
level.
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Click theNumber of Hops drop-down list, and select the number of hops to display (1-9). The
default number of hops is 1.

5. All devices connected to the initial object within the specified number of hops are displayed.

The color of the line between the devices indicates the health of the subnet between the
devices (see "ViewingMaps (Network Connectivity)" (on page 243)).

To display the Layer 3 Neighbor View using the Actions menu in a table view or in a form:

1. From the workspace navigation panel, select the table view of interest.

For example the Inventoryworspace, Nodes view.

2. Select the initial object of interest.

For example, select the row that represents the node of interest from theNodes view.

3. Select Actions→ Layer 3 Neighbor View.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

4. A hop represents a network device that has a Device Category value of either router or switch-
router and that is connected by a link with no intermediate nodes.

Click theNumber of Hops drop-down list, and select the number of hops to display (1-9). The
default number of hops is 1.

5. All devices connected to the initial object within the specified number of hops are displayed.

The color of the line between the devices indicates the health of the connection (see "Viewing
Maps (Network Connectivity)" (on page 243)).

To see more information about a specific subnet on the map:
1. Select the line that represents the subnet of interest.

2. Click the  Open icon on themap toolbar.

The IP Subnet form displays, showing all details of the subnet. See"IP Subnet Form" (on page 160)
for more information.

To view address information for an interface at each end of a connection:
Click the line representing the connection of interest.

The IP address for each interface appears as a new label.

Tip: Use Ctrl-Click to select multiple lines and display more IP addresses.

Related Topics:

UsingMap Views

HP Network NodeManager i Software (9.21)Page 255 of 454



Online Help: Help for Operators
Chapter 6: ViewingMaps (Network Connectivity)

Path Between Two Nodes that Have IPv4 Addresses
Note: If NNMi Advanced is licensed and installed, also see "Enhanced Path View (NNMi

Advanced) " (on page 263).

Path View is a flow diagram rather than a connection diagram. It displays the flow of network traffic
rather than all of the available connections. Path View calculates the route that data flows between
two nodes, and provides amap of that information. The two nodes can be any combination of end
nodes or routers.

To view all possible connections between nodes, use the Layer 2 Neighbor View. See "Display the
Layer 2 Neighbor View" (on page 252) for more information.

Note: End nodes are the primary use case for this view. If you specify routers as the Source or
Destination, the path is a best effort.

Each connection between the two nodes is a line on themap. If more than one route is possible,
NNMi uses a set of rules to choose the displayed route (see "Path Calculation Rules" (on page
258)). NNMi indicates there is more than one possible path under either of the following conditions:

l NNMi Advanced. NNMi finds more than one Active router in a Router Redundancy Group. See
"Router Redundancy Group View (Inventory) (NNMi Advanced)" (on page 41) for more
information about Router Redundancy Groups. See "Path Calculation Rules" (on page 258) for
more information about Active router paths.

l NNMi Advanced. HP Router Analytics Management System (RAMS) determines more than one
equal cost path and, therefore, cannot determine which path is in use. See "Enhanced Path
View (NNMi Advanced) " (on page 263) for more information.

Note: Your NNMi administrator can configure Path View connections using a
PathConnections.xml file. This file enables Path View to traverse undiscovered regions
of your network. Each time NNMi determines a node in the Path View, NNMi checks whether
the node is specified as a Start node in the PathConnections.xml file. If the node is
specified as a Start node, each path segment configured in PathConnections.xml is
inserted in the Path View map.

HP Network NodeManager iSPI Performance for Metrics Software. You can view a report of the
Path Health from the Path View map using theActions > HP NNM iSPI for Performance>
Reporting - Path Healthmenu. Before using themenu option, youmust select the starting and
ending node for which you want to view the health information. The nodes you select must reside in
the NNMi topology database and be configured for performancemeasurement collection. See the
HP Network NodeManager iSPI Performance for Metrics Software online help for more
information.

NNMi Advanced. When RAMS data is used to determine the router paths, NNMi ignores the
PathConnections.xml file. See "Enhanced Path View (NNMi Advanced) " (on page 263) for
more information.

NNMi Advanced. Path View works only with IPv4 addresses. The NNMi Advanced IPv6 address
values are not valid choices for Path View. Any devices in your network that are configured with
IPv6 addresses cannot be displayed on Path View maps.
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Note: Intermediate devices that are physically connectedmight appear in a Path View. For
example, if two end nodes connect to the same switch, but exist in different VLANs, the path
includes the access router where the VLAN and subnet determination is made.

Path View is useful for diagnosing connectivity problems. Path View shows each switch (and the
port on that switch) that participates in the current path. You can quickly identify problematic switch
ports that need to be shut down. Select any map symbol and click the  Open icon to display all
known details about that object. Mouse over any object on themap to access the Tool Tips
information about that object.

Note: You see only those nodes in the Path View that you have permission to view. NNMi ignores
any nodes to which you do not have access and generates the path as if these nodes were not
discovered. If you are an NNMi administrator, see Configuring Security for more information
about configuring security, including node access.

See Path View MapObjects for more information about the symbols that might appear on a Path
View map. See About Status Colors for information about possible Status colors.

Tip: Click the  Swap Nodes icon to switch theSource andDestination values, and then click
the  Compute Path icon. Sometimes NNMi can detect more information from one direction or
the other.

Using Path View from the Troubleshooting workspace:
1. From the workspace navigation panel, select the Troubleshooting workspace.

2. Select Path View.

Note: You can designate any node as Source / Destination, the node does not need to
currently be included in the NNMi database.

3. In theSource field, type a valid fully-qualified hostname, short hostname, or IPv4 address. (If
your entry matches an object currently in the NNMi database, NNMi provides a case-sensitive
drop-down list to help speed up your selection.)

4. Optional. In theDestination field, type a valid fully-qualified hostname, short hostname, or
IPv4 address.

If aDestination value is not provided, NNMi displays the path from theSource node to its
access router. (If your entry matches an object currently in the NNMi database, NNMi provides
a case-sensitive drop-down list to help speed up your selection.)

5. Click the  Compute Path icon.

Using Path View from the Actions menu in a table view or in a form:
1. Access a table view of nodes, interfaces, or IPv4 addresses.

2. Decide which object you want to use as the starting point in the path (Source). Select the row
representing that object.

3. Optional. Decide which object you want to use as the destination point in the path
(Destination). Select the row representing that object.

If a  Destination value is not provided, NNMi displays the path from theSource node to its
access router.

4. In themenu bar, select Actions→Maps→ Path View.
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Tip: You can right-click any object in a table or map view to access theActionsmenu.

5. Click the  Compute Path icon to display themap of the path.

Related Topics:

"Path Calculation Rules" (on page 258)

"Investigate Errors and Performance Issues" (on page 261)

"Access Node Details" (on page 277)

Path Calculation Rules
Note: If NNMi Advanced is licensed and installed, also see "Enhanced Path View (NNMi

Advanced) " (on page 263)

Path View calculates the active flow of data between devices at the time the view is requested. The
active path includes the following devices:

l Source and destination nodes

l Layer 2 devices between the source node and its access router

l Layer 2 devices between the destination node and its access router

l Layer 2 and Layer 3 routing core between the two access routers

Note: The path calculated can include one or more VLANs when applicable.

NNMi starts with the specified source and follows the active path to the specified destination. If no
missing connections are detected, the Path View shows the source node, destination node, and
each router and switch in between.

Note: Your NNMi administrator can configure Path View connections using a
PathConnections.xml file. This file enables Path View to traverse undiscovered regions
of your network. Each time NNMi determines a node in the Path View, NNMi checks whether
the node is specified as a Start node in the PathConnections.xml file. If the nodes is
specified as a Start node, each path segment configured in PathConnections. xml is
inserted in the Path View map.

(NNMi Advanced) Path View works only with IPv4 addresses. The NNMi Advanced IPv6 address
values are not valid choices for Path View. Any devices in your network that are configured with
IPv6 addresses cannot be displayed on Path View maps.

A cloud symbol can represent the following types of information. Themap can include
multiple cloud symbols:

l If a missing connection is detected (no response to SNMP and no entry in
PathConnections.xml), the cloud symbol appears in the routing core between the access
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routers.

l If the port connecting the end node to the first switch is forwardingmore than oneMAC address,
this indicates an intermediate device (such as a hub or one or more undiscovered switches). A
cloud appears at that location in the path.

When interpreting Path View results, note the following:

l In Path View maps, a black arrow or empty black circle that appears at the end of a connection
indicates that NNMi was not able to determine a status value because the connection or
interface is not in the NNMi database. Reasons a connection or interface are not stored in the
NNMi database, include the following:

n NNMi is unable to collect information about a node in the path because it is a non-SNMP
node.

n Not all of the nodes in the path aremanaged by NNMi.

n The discovery information for a node is not up-to-date (for example, interface information is
missing).

l You see only those nodes in the Path View that you have permission to view. NNMi ignores any
nodes to which you do not have access and generates the path as if these nodes were not
discovered. If you are an NNMi administrator, see Configuring Security for more information
about configuring security, including node access.

l The Source and Destination nodes must meet either of the following criteria:

n Support SNMP and be previously discovered by NNMi (recorded in the topology database)

n Have traceroute available

l A switch should not be used as a Source or Destination node in Path View maps. To view
connectivity between switches, use the Layer 2 Neighbor View.

l All access routers and any Layer 2 devices between the Source and Destination nodes must
meet the following criteria:

n Support SNMP

n Be previously discovered by NNMi (recorded in the topology database)

l Optional. Each router is monitored by NNMi.

l The time stamp provided in the final Path View is the time at which the final active path was
determined.

l (NNMi Advanced) If the Router Redundancy Group has more than one Active router, NNMi
selects one Active router for the path. To indicate there is more than one possible path, NNMi
connects any additional Active routers to the chosen router as shown in the following example:
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l (NNMi Advanced) If your network administrator configures NNMi to gather data from Route
Analytics Management Systems (RAMS), the Path View can show multipleOSPF1 Equal Cost
paths through a Layer 3 cloud as shown in the example below:

Note: When RAMS data is used to determine the router paths, NNMi ignores the
PathConnections.xml file. See "Enhanced Path View (NNMi Advanced) " (on page
263) for more information.

l (HP Network NodeManager iSPI Performance for Metrics Software) You can access
performance data from Path Views that contain single or multiple paths. See "Investigate Errors
and Performance Issues" (on page 261)" for more information

Related Topics:

UseMap Views

"Path View Limitations" (on page 260)

Path View Limitations
Path View cannot calculate accurate paths if you have two or more areas of your network which are
separated by undiscovered devices. Your NNMi administrator must use the
PathConnections.xml file to specify areas of your network that are separated by undiscovered
devices. See "Help for Administrators" for more information.

Note: NNMi Advanced. Path View works only with IPv4 addresses. The NNMi Advanced IPv6
address values are not valid choices for Path View. Any devices in your network that are
configured with IPv6 addresses cannot be displayed on Path View maps.

1Open Shortest Path First Protocol
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Path View uses a variety of sources for information to calculate an accurate path. These sources of
information do, however, have limitations:

l SNMP ipRoute tables. If the Source or Destination node represents a device other than a router
and the device does not support SNMP or does not return valid ipRoute table information, NNMi
depends on traceroute to follow the path to find the nodes's access router.

Note: NNMi Advanced. NNMi can use RAMS data to determine router paths. When RAMS data
is used to determine the router paths, NNMi ignores the PathConnections.xml file.
See "Enhanced Path View (NNMi Advanced) " (on page 263) for more information.

Caution: Do not specify a switch as a Source or Destination node in Path View maps. To view
connectivity between switches, use the Layer 2 Neighbor View.

l Open Shortest Path First protocol or Cisco Global Load Balancing protocol. Path View shows
the access router selected by one of these routing protocols. If two or more access routers
communicate with a device, only one access router is shown (usually the one with the shortest
path).

l Cisco Express Forwarding protocol. This protocol bypasses some of the data that Path View
needs. If any routers in the path are using this protocol, Path View might display an incorrect
router path.

l If the NNMI administrator enabledMPLS1, Path view can show multiple OSPF Equal Cost
paths.

Investigate Errors and Performance Issues
The color of the background shape of eachmap symbol conveys themost recent health status.
Select an object on the Path View map that has a status color other than green (see"Watch Status
Colors" (on page 274) for more information about interpreting non-normal status colors). You can
access the following types of information about each node:

l "Access Node Details" (on page 277)

l "Access a Problem Device" (on page 276)

l "Access All Related Incidents" (on page 279)

See "Interpret Root Cause Incidents" (on page 380) for more information about interpreting the
incident information displayed.

(HP Network NodeManager iSPI Performance for Metrics Software) Click here for more
information about additional tools for accessing performance data.

To access performance data from a Path View map:

Select Actions > HP NNM iSPI Performance > Reporting -Path Health.

If the Path View map contains multiple possible paths from the Source to Destination Node, NNMi
alerts and guides you to select a single, unambiguous path for analysis before it can present a Path
Health Report. You can bypass this interaction by pre-selecting enoughmap objects (for example,
connections) to resolve any ambiguities before selectingActions > HP NNM iSPI Performance >
Reporting -Path Health.

1Multiprotocol Label Switching
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Note: NNMi Advanced. Path View works only with IPv4 addresses. The NNMi Advanced IPv6
address values are not valid choices for Path View. Any devices in your network that are
configured with IPv6 addresses cannot be displayed on Path View maps.

MPLS WAN Cloud Map (NNMi Advanced)
TheMPLS WAN CloudMap view displays a graphical representation the Layer 3 connectivity in
your network, as well as any Customer Edge and Provider Edge devices. This map periodically
updates the Customer Edge (CE) status. TheMPLS WAN discovery updates the topology, (see To
discover MPLSWANs in the network). The update interval is more frequent when the topology is
changing and less frequent when the topology is not changing.

To discover MPLS WAN's in the Network:

Note:Startup of jboss discovers all theMPLSWAN's in the network.

1. From the workspace navigation panel, select the Inventoryworkspace.

2. Select theMPLS WAN Clouds (RAMS).

3. From theActionsmenu, select Discover MPLS WANs.
This discovers all theMPLS WAN's in the network.

To display the MPLS WAN Cloud Map view:

1. In theMPLSWANs Cloud table view, select a row.

2. From theActionsmenu, selectMPLS WAN Cloud View.
This displays the selected object's Cloud view.

Use this view when you want to do any of the following tasks:

l View a high-level overview of your MPLS WAN Cloud

l Determine themost highly connected nodes in the Layer 3 network

The symbols used inMPLSWAN Cloud view are described in the following table:

Symbol Description

TheMPLSWAN Cloud. The icon indicates that the status of the devices
in the cloud is unknown.

The IP address of the Provider Edge (PE) device. Status of a PE is
indicated by the color. For example, blue color indicates that the status of
the device is unknown. For more information, see Status Color and
Meaning for Objects.

The CE router that is participating in theMPLSWAN cloud.

The Interface on the CE router that is peering with the PE device. The
color of the icon shows the status of the CE router. For more information,
see Status Color andMeaning for Objects.
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Tip:Select the connector between PE device and CE router to view the IP addresses of the
PE device and the Interface name of CE router.

Related Topics

"MPLSWAN Cloud (RAMS) Form (NNMi Advanced)" (on page 240)

"MPLSWAN Cloud (RAMS) Form: MPLSWAN Connections Tab (NNMi Advanced)" (on page
240)

Enhanced Path View (NNMi Advanced)
NNMi Advanced uses any of the following when calculating a Path View:

l Router Redundancy Protocol groupmembers (for example, HSRP1 orVRRP2)

By default, NNMi monitors current state and priority information for any discovered Router
Redundancy Group objects in the network. If the configured Router Redundancy Protocol allows
virtual addresses, NNMi includes those virtual addresses when calculating the Path View.

l HP Router Analytics Management System (RAMS3) data

If your NNMi Administrator established any RAMS server configurations, NNMi Advanced
calculates the Path View using RAMS data. (RAMS is an IP Route Analytics tool that listens to
routing protocols and builds a real-time routing topology map.)

Note: When using RAMS data in Path View, NNMi ignores the PathConnections.xml file.
See "Help for Administrators" for more information.

RAMS enhances NNMi's ability to trace the route path between the source and destination node
in the following ways:

n NNMi Advanced does not use SNMP to calculate the router path. This means that NNMi
Advanced does not need to wait for SNMP responses and can calculate the Path View more
quickly.

n NNMi Advanced displays equal cost paths when calculating the router path. More than one
path appears if HP Router Analytics Management System (RAMS) determines more than
one equal cost path and, therefore, cannot determine which path is in use.

Note: NNMi Advanced. Path View works only with IPv4 addresses. The NNMi Advanced
IPv6 address values are not valid choices for Path View. Any devices in your network that are
configured with IPv6 addresses cannot be displayed in Path View maps.

1Hot Standby Router Protocol
2Virtual Router Redundancy Protocol
3HP Router Analytics Management System
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Monitoring Devices for Problems
NNMi offers several out-of-the-box views to assist you inmonitoring your network. When using
views, you can choose to do either of the following:

l Monitor views that contain your critical nodes and interfaces.

l Watch an incident view for incidents with status other than normal, such asWarning,Minor,
Major, orCritical.

l Watch amap view for any icons that change color to yellow or red.

Nomatter which way you prefer, you can navigate from amap to a table view or from a table view to
amap.

Related Topics:

"Filter Views by Node or Interface Group" (on page 25)

"Monitor with Table Views" (on page 264)

"Monitor with Map Views" (on page 273)

"Monitor with Line Graphs" (on page 283)

Monitor with Table Views
NNMi provides the following out-of-the-box node and interface views to assist you inmonitoring the
network for problems. These views help you quickly identify the nodes and interfaces that need
your more immediate attention:

Note the following:

l NNMi uses Conclusions to determine an object's Status. Therefore, an object with a non-
Normal Status does not always have an open incident associated with it. See The NMMi Causal
Engine andObject Status for more information about incidents, conclusions, and object Status.

l If NNMi determines that it requires more time to complete its analysis for an object, one of the
following occurs:

n There is a delay between the change in object Status and any associated open incident.

n NNMi determines that the incident does not apply and the incident is not generated.

For example, when an address is not responding to ICMP, the Status of the address is set to
Critical, but the incident is delayed until the NNMi Causal Engine determines whether the
address is in the shadow of a node that is down. If the address is in the shadow of node that is
down, NNMi does not generate an Address Not Responding incident. If the address is not in the
shadow of a node that is down, NNMi generates the Address Not Responding incident. See
Node Down for more information about objects that are in the shadow of a node.

l If Dampening is configured for the incident, one of the following occurs:
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n There is a delay between the change in object Status and any associated open incident.

Tip: To see an incident that has a Lifecycle State of Dampened, in the NNMi console, select
either theCustom Incidents orOpen Custom Incidents view and set the Lifecycle
State Filter toDampened.

n NNMi determines that the incident does not apply and the incident is automatically deleted.

If you are an NNMi administrator, see Dampening Incident Configurations for more information.

l If the Incident Configuration is suppressed, NNMi does not display the incident. If you are an
NNMi administrator, see Suppress Incident Configurations for more information.

Tip: To view the nodes that have an open associated incident from aNodeGroup Topology
Map view, click Indicate Key Incidents. This option enlarges each object on themap that
has an associated open incident. This option is available only with NodeGroupmaps.

"Non-Normal Node Components View" (on page 265)

"Non-Normal Cards View" (on page 266)

"Non-Normal Interfaces View" (on page 266)

"Non-Normal Nodes View" (on page 267)

"Non-Normal SNMP Agents View" (on page 269)

"Not Responding Address View" (on page 268)

"Interface Performance View (HP Network NodeManager iSPI Performance for Metrics Software)"
(on page 269)

"Card Redundancy Groups View (Monitoring)" (on page 270)

"Non-Normal Router Redundancy Group View (NNMi Advanced)" (on page 271)

"NodeGroups View (Monitoring)" (on page 271)

"Custom Node Collections View (Monitoring)" (on page 272)

"Custom Polled Instances View" (on page 272)

Non-Normal Node Components View
The Non-Normal Node Components view in theMonitoring workspace is useful for identifying all of
the Node Components that might need operator attention. Examples of Node Components include
temperature, fan, andmemory.

Possible Statuses for these interfaces include:

l Warning

l Major

l Minor

l Critical

To display the Non-Normal Node Component view:
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1. In theWorkspaces navigation pane, select theMonitoringworkspace.

2. Select theNon-Normal Node Component view.

For each Node Component displayed, you can see its Status, Name, Type, the Node in which it
resides, and the date and time the Status was last modified.

Related Topics

Use Table Views

Export Table Information

Non-Normal Cards View
Tip: See "Card Form" (on page 164) for more details about the attributes that appear in this view's

column headings.

The Non-Normal Cards view in theMonitoring workspace is useful for identifying all of the Cards
that have a status that is other than Normal.

To display the Critical Cards view:

1. In theWorkspaces navigation pane, select theMonitoringworkspace.

2. Select theCritical Cards view.

For each Card displayed, you can see its Administrative State, Operational State, the Node on
which it resides (Hosted on Node), the date and time the Status was last modified, the Card Name,
Model, Type, Serial Number, Firmware Version, Hardware Version, Software Version, Index
number, Physical Index number, the Card on which it is hosted, if any, the Card Redundancy Group
of which it is amember, if any, the date and time the State was last modified, the Card description,
and any notes for the Card.

To see the incidents related to a Card:

1. Double-click the row representing the Card that has the incidents you want to see.

2. Navigate to the Incidents tab to see the incidents associated with the selected Card.

Related Topics

Use Table Views

Export Table Information

Non-Normal Interfaces View
Tip: See "Interface Form" (on page 114) for more details about the interface attributes that appear in

this view's column headings.

The Non-Normal Interfaces view in theMonitoring workspace is useful for identifying all of the
network interfaces that might need operator attention. Possible statuses for these interfaces
include:

l Warning

l Major
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l Minor

l Critical

Note: Interfaces displayed in this table all have the AdministrativeState equal to Up.

To display the Non-Normal Interfaces view:

1. In theWorkspaces navigation pane, select theMonitoringworkspace.

2. Select theNon-Normal Interfaces view.

For each interface displayed in the view, you can identify its status, Operational State, associated
node Name value (Hosted On Node), the interface name, type, speed, a description of the
interface, the ifAlias value, the date and time the status of the interface was last modified, the name
of the Layer 2 Connection associated with the interface, and any notes included for the interface.

By default, this view is sorted by the date the interface status was last modified (Status Last
Modified).

Interface views are useful for quickly identifying items described in the following table.

Use Description

View all network interfaces
per node

Sort the view by Hosted On. This can help you organize your
interfaces per node, so that you can identify the nodes that might
need attention.

Determine the health of each
of themanaged interfaces

Sort the view by theStatus attribute.

Determine the types of
interfaces that are being
managed.

Sort on the ifType (interface type) attribute.

Access amap view of the
network interface and its
surrounding topology.

Select the interface of interest and use theActionsmenu to
select either the Layer 2 or Layer 3 Neighbor View. See Use
Table Views for more information.

Tip: You can right-click any object in a table or map view to
access theActionsmenu.

Related Topics

Use Table Views

Export Table Information

Non-Normal Nodes View
Tip: See "Node Form" (on page 48) for more details about the node attributes that appear in this

view's column headings.

The Non-Normal Nodes view in theMonitoring workspace is useful for identifying all of the nodes
that might need operator attention. Possible statuses for these nodes include:

Warning
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Minor

Major

Critical

For each node displayed, you can identify its status, device category (for example, Switch),
hostname, management address, system location (the current value of the sysLocationMIB
variable), device profile, whether the SNMP Agent is enabled on the node, the date and time its
status was last changed, and any notes included for the node.

The device profile information determines how devices of this type aremanaged and the icon and
background shape displayed onmaps.

By default, this view is sorted by the date the node status was last modified (Status Last
Modified).

Node views are useful for quickly identifying items described in the following table.

Use Description

View all problem nodes Sort the view by Status so that you can be quickly
alerted to existing and potential problems.

Identify whether the problem can be
isolated to a particular area of your
network

Sort the view by System Location. This is the current
value of the sysLocationMIB variable.

View all device types beingmanaged Sort the view by the Device Profile attribute.

View address and subnet information
associated with a selected node to
better determine the scope of the
problem

From the Nodes view, open the Node form. Then
access the Address tab. See "Node Form" (on page 48)
and "IP Subnet Form" (on page 160) for more
information.

Access amap view of a selected node
and its surrounding topology

Select the node of interest and use the Actions menu
from themain toolbar. See Use Table Views for more
information.

Tip: You can right-click any object in a table or map
view to access theActionsmenu.

View the statuses of interfaces
associated with a node

If a node is not completely down, youmight want to see
which interfaces are down for the selected node. To do
so, open the Node form and select the Interfaces tab.

The number of devices that are served
by this node.

Select the node you want and access the Layer 2 or
Layer 3 Neighbor View using the Actions menu.

Not Responding Address View
Tip: See "IP Address Form" (on page 153) for more details about the node attributes that appear in

this view's column headings.
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TheNot Responding Address view in theMonitoringworkspace is useful for identifying all of
the addresses that has a state that is Not Responding (the address is not responding to ICMP
ping).

Note: Because all addresses in this view have a state of Not Responding, theState column is not
displayed in this view.

For each address displayed in the view, you can identify the status, address, associated node
Name value (Hosted On Node), interface, the subnet prefix (In Subnet), the date and time the
State was last modified, the prefix length (PL), and any notes included for the IP address.

Related Topics

Use Table Views

Export Table Information

Non-Normal SNMP Agents View
Tip: See "SNMP Agent Form" (on page 94) for more details about the SNMP Agent attributes that

appear in this view's column headings.

TheNon-Normal SNMP Agents view in theMonitoringworkspace is useful for identifying all of
the SNMP Agents that have a state that is other than Normal.

To display the Non-Normal Node SNMP Agents view:

1. In theWorkspaces navigation pane, select theMonitoringworkspace.

2. Select theNon-Normal SNMP Agents view.

For each SNMP Agent displayed in the view, you can identify the SNMP Agent Status, the Agent
SNMP State, the Agent ICMP State, the associated node Name value (Hosted On Node), the IP
address NNMi uses to communicate with this SNMP agent (Management Address), the date and
time the Status was last modified, the version of the SNMP protocol in use, whether the SNMP
agent is set up for SNMP communication in the network environment (Agent Enabled), the User
Datagram Protocol port configuration for this SNMP agent (UDP Port), the time that NNMi waits for
a response to an SNMP query before reissuing the request, and themaximum number of retries that
NNMi issues for an SNMP query before determining the query result to be "unresponsive", the read
community string, and the SNMP Proxy address.

Note: If you have Administrator Role, the Non-Normal SNMP Agents view also displays the Read
Community String.

Related Topics

Use Table Views

Print Table Information

Interface Performance View (HP Network Node Manager iSPI
Performance for Metrics Software)

(HP Network NodeManager iSPI Performance for Metrics Software) Data appears in this view only
if the HP Network NodeManager iSPI Performance for Metrics Software software is installed and
your NNMi administrator enables performancemonitoring.
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The interface performance view helps you identify the over-used and under-used interfaces within
nodes in your network. Sort this view by Hosted OnNode to help identify which nodes receive the
most traffic. You can proactively monitor your network and check for those interfaces that have an
input or output utilization, error, or discard rate that indicates theremight be a potential problem.

Your network administrator can set up NodeGroups or Interface Groups that identify important
network devices, and those groups can be filters for this view.

Note: If you filter your view usingmultiple filters, NNMi uses the AND operator to combine the
filters you have selected. See Filter a Table View for more information.

For each interface displayed, you can view polling states for its input and output utilization rates,
input and output utilization baselines, input and output error rates, input and output discard rates,
FrameCheck Sequence (FCS) error rates, input and output queue drops, associated node Name
value of the computer on which the interface resides (Hosted On Node), the interface name,
speed, input speed, output speed, and any notes that exist about the interface.

Tip: See "Interface Form" (on page 114) for more details about the interface attributes that appear in
this view's column headings.

Card Redundancy Groups View (Monitoring)
Tip: See "Card Redundancy Group Form" (on page 210) for more details about the Card

Redundancy Group attributes that appear in this view's column headings.

Your network administrator might have set up groups of redundant cards to provide one-to-one
redundancy protection against processor card failure.

To display the Card Redundancy Groups view:

1. In theWorkspaces navigation pane, select theMonitoringworkspace.

2. Select theCard Redundancy Groups View view.

For each Card Redundancy Group displayed in the view, you can identify the Card
Redundancy Group Status, Name, and the time and date the Card Redundancy Group Status
was last modified.

To see the incidents related to a Card Redundancy Group:

1. Double-click the row representing the Card Redundancy Group that has incidents you want to
see.

2. Select the Incidents tab.

A table displays the list of Incidents associated with the selected Card Redundancy Group.

To view the members that belong to this group:

1. Double-click the row representing the Card Redundancy Group that has members you want to
see.

2. Select theRedundant Cards tab.

A table displays the list of Cards that belong to the selected Card Redundancy Group.

HP Network NodeManager i Software (9.21)Page 270 of 454



Online Help: Help for Operators
Chapter 7: Monitoring Devices for Problems

Non-Normal Router Redundancy Group View (NNMi Advanced)
Tip: See "Router Redundancy Group Form (NNMi Advanced)" (on page 214) for more details about

the Router Redundancy Group attributes that appear in this view's column headings.

Your network administrator might have set up groups of redundant routers to help ensure that
information packets reach their intended destination. Whenmonitoring your network, use the Non-
Normal Router Redundancy Group view to see those router groups that have a status that is other
than Normal. This means there is a problem with one or more interfaces or IP addresses on the
routers in the router groups.

To display the Router Redundancy Groups view:

1. In theWorkspaces navigation pane, select theMonitoringworkspace.

2. Select theNon-Normal Router Redundancy Groups view.

For each redundant routers group displayed in the view, you can identify the Router Redundancy
Group status, Router Redundancy Group name, the Router Redundancy Group protocol (for
example, HSRP), and the date the Router Redundancy Group status was last modified.

To see the incidents related to a Router Redundancy Group:

1. Double-click the row representing the Router Redundancy Group that has incidents you want
to see.

2. Select the Incidents tab.

To view the members that belong to this group:

Double-click the row representing the Router Redundancy Group of interest to open the form.

On theRouter Redundancy Members tab, you should see a table view of the nodes and
interfaces that belong to the selected Router Redundancy Group.

Related Topics

Use Table Views

Export Table Information

Node Groups View (Monitoring)
Tip: See "NodeGroup Form" (on page 228) for more details about the NodeGroup attributes that

appear in this view's column headings.

Whenmonitoring your network, youmight be interested in only viewing information for a particular
set of nodes. Your network administrator can group sets of nodes into node groups. An example
node group could be all important Cisco routers, or all routers in a particular building. See About
Node and Interface Groups for more information about how your administrator sets up node groups.
See "Filter Views by Node or Interface Group" (on page 25) for more information about filtering
views using node and interface groups.

To find the definition for a particular NodeGroup filter, navigate to the Inventory workspace, and
select the NodeGroups view.
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For each node group displayed in the view, you can identify the node group status, name, whether
the node group appears in the filter list for node and interface views, whether the node group is
available as a filter in the NNM iSPI Performance software, and any notes about the node group.

Custom Node Collections View (Monitoring)
Tip: Mouse over a column heading for the complete name of a column heading attribute. See

"Custom Node Collections Form" (on page 196) for more details about the attributes that appear
in the view's column headings.

TheCustom Node Collections view in theMonitoringworkspace is useful for identifying the
node objects for which Custom Poller Polices have been created.

For each Custom Node Collection displayed, you can identify a Custom Node Collection's overall
Status, the Name of the associated topology node, the Active State of the Custom Node
Collection's Policy, the name of the Policy that is applied to the current Custom Node Collection,
as well as discovery information regarding theMIB Expression on each node for which you are
collecting data, such as Discovery State, the Discovery State Last Modified, and Discovery State
Information.

Note the following:

l The Custom Node Collection's Status is themost severe State value returned from the Polled
Instances for the Custom Node Collection.

l The Active State for any Custom Node Collection associated with a Not Managed or Out of
Service node that was previously managed, becomes Inactive. NNMi deletes all of the Polled
Instances associated with the Not Managed or Out of Service node.

l You can display a Line Graph for those incidents that have a source node associated with
Custom Node Collections. See "Display a Line Graph from an Incident (Custom Poller Only)"
(on page 295) for more information.

Custom Polled Instances View
Tip: Mouse over a column heading for the complete name of a column heading attribute. See

"Custom Polled Instance Form" (on page 201) for more details about the attributes that appear
in the view's column headings.

The Custom Polled Instances view in theMonitoringworkspace is useful for viewing the polling
results forCustom Node Collection1. A Custom Polled Instance represents the results of aMIB
expression when it is evaluated against a node in the Custom Node Collection. The first time aMIB
Expression is validated with discovery information, the results appear in a Custom Polled Instance
object. The Custom Polled Instance is updated whenever a change in State occurs and includes
themost recent polled value that caused the State to change. For more information, click here.

A node can be associated with multiple Custom Polled Instances when its associatedMIB
expression includes MIBs that havemultiple instances per node. For example, the associatedMIB
expressionmight perform a calculation using the ifInOctets and ifOutOctets MIB values. Using the
MIB Filter andMIB Filter Variable specified, NNMi calculates these values for each interface that
meets the filter criteria and that is associated with a node in the Custom Poller Collection.

1A Custom Node Collection identifies a topology node that has at least one associated Custom
Poller Policy. Because a topology node can be associated with more than one Policy, the same
topology nodemight appear in multiple Custom Node Collections.
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Note: The Active State for any Custom Node Collection associated with a Not Managed or Out of
Service node that was previously managed, becomes Inactive. NNMi deletes all of the Polled
Instances associated with the Not Managed or Out of Service node.

For each Custom Polled Instance displayed, you can identify the following:

l Status of the Custom Polled Instance

l State of the Custom Polled Instance

l Returned value from theMIB Expression that caused the State to change

l MIB Expression name

l MIB Instance value

l Filter Value (The instance of aMIB variable value after theMIB Filter is applied)

l The Display Attribute (The value that results from the Instance Display Configuration. The NNMi
administrator can specify the Instance Display Configuration information when configuring a
MIB expression for Custom Poller.)

l Name of the topology Node on which the Custom Poller Policy information is being collected

l Name of the associatedCustom Node Collection1.

l Active State

l Date and time the Custom Polled Instance State was last modified

(NNMi Advanced - Global Network Management feature) Any Custom Polled Instances are not
sent from aRegional Manager (NNMi management server) to the Global Manager. From theGlobal
Manager, useActions→Open from Regional Manager to see the list of Custom Polled
Instances on the Regional Manager.

Monitor with Map Views
NNMi provides four kinds of map views that show a graphical representation of a selected device
and the devices connected to it (NodeGroupMap views, Layer 2 Neighbor View, Layer 3 Neighbor
View, and Path View).

Map views are useful for the following tasks:

l Identify important connector devices, such as a switch that might be a single connection to a
main office or campus.

l Identify how many devices are served by a node or interface.

l Identify routing issues.

l Identify network issues between two nodes.

Each node on themap is represented by amap symbol. Eachmap symbol has a background shape
and a foreground image. The background shape conveys two pieces of information:

1A Custom Node Collection identifies a topology node that has at least one associated Custom
Poller Policy. Because a topology node can be associated with more than one Policy, the same
topology nodemight appear in multiple Custom Node Collections.
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l The type of device indicated by shape. See About Map Symbols.

l Themost recent health status represented by the background color. See About Status Colors.

The foreground image assists in identifying the devicemodel. NNMi uses first the Family, then
Vendor, and then the Category device profile information to determine the foreground image to be
displayed. If there is no image defined for any of these attributes, NNMi displays *no* icon in the
map node.

Note: SomeNNMi users can delete nodes and other objects from the NNMi database
(depending on the assigned NNMi Role). Any node that has been deleted appears as a
transparent icon to all NNMi users until their map is refreshed using the Refresh icon. After
Refresh, the deleted node is removed from themap. NNMi does not automatically refresh the
connectivity or set of nodes in amap view, except on the Initial Discovery Progress and
Network Overviewmaps.

Tomonitor your network using a network map:

l "Watch Status Colors" (on page 274)

l "Determine Problem Scope" (on page 276)

l "Access Node Details" (on page 277)

Related Topics:

UseMap Views

"NodeGroupMaps" (on page 244)

"Display the Layer 2 Neighbor View" (on page 252)

"Display the Layer 3 Neighbor View" (on page 254)

"Path Between TwoNodes that Have IPv4 Addresses" (on page 256)

Watch Status Colors
Whenmonitoring the network using amap view, watch for nodes that have a Status color of non-
Normal. The background shapes of themap symbols change color based on the current health
status of the represented device.

Note the following:

l NNMi uses Conclusions to determine an object's Status. Therefore, an object with a non-
Normal Status does not always have an open incident associated with it. See The NMMi Causal
Engine andObject Status for more information about incidents, conclusions, and object Status.

l If NNMi determines that it requires more time to complete its analysis for an object, one of the
following occurs:

n There is a delay between the change in object Status and any associated open incident.

n NNMi determines that the incident does not apply and the incident is not generated.

For example, when an address is not responding to ICMP, the Status of the address is set to
Critical, but the incident is delayed until the NNMi Causal Engine determines whether the
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address is in the shadow of a node that is down. If the address is in the shadow of node that is
down, NNMi does not generate an Address Not Responding incident. If the address is not in the
shadow of a node that is down, NNMi generates the Address Not Responding incident. See
Node Down for more information about objects that are in the shadow of a node.

l If Dampening is configured for the incident, one of the following occurs:

n There is a delay between the change in object Status and any associated open incident.

Tip: To see an incident that has a Lifecycle State of Dampened, in the NNMi console, select
either theCustom Incidents orOpen Custom Incidents view and set the Lifecycle
State Filter toDampened.

n NNMi determines that the incident does not apply and the incident is automatically deleted.

If you are an NNMi administrator, see Dampening Incident Configurations for more information.

l If the Incident Configuration is suppressed, NNMi does not display the incident. If you are an
NNMi administrator, see Suppress Incident Configurations for more information.

Tip: To view the nodes that have an open associated incident from aNodeGroup Topology
Map view, click Indicate Key Incidents. This option enlarges each object on themap that
has an associated open incident. This option is available only with NodeGroupmaps.

The following table describes themeaning for each Status color that might appear on amap. The
Status categories are listed in decreasing order of Severity.

Color Meaning Description

Unknown Indicates one of the following:

l The node was just added to the NNMi database, and health status is not
yet calculated.

l The node is unreachable and cannot be polled.

Disabled Indicates the object is administratively "disabled". (For example: for an
interface, the current value of theMIB-II ifAdminStatus is "disabled".)

Critical Indicates NNMi detected problems that require immediate attention.

Major Indicates NNMi detected problems that could precede a critical situation.

Minor Indicates NNMi has detected problems related to the associated object
that require further investigation.

Warning Indicates theremight be a problem related to the associated object.

Normal Indicates there are no known problems related to the associated object.

No Status Indicates that NNMi monitoring configuration specifically excludes this
device. The Status is either not calculated or the device is Not
Managed/Out Of Service.

Status Colors
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Color Meaning Description

In Path View maps, note the following:

l A black arrow or empty black circle that appears at the end of a
connection indicates that NNMi was not able to determine a status
value because the connection or interface is not in the NNMi database.

l Reasons a connection or interface are not stored in the NNMi database,
include the following:

n NNMi is unable to collect information about a node in the path
because it is a non-SNMP node.

n Not all of the nodes in the path aremanaged by NNMi

n The discovery information for a node is not up-to-date (for example,
interface information is missing)

Node Not
Accessible

Indicates a node that you cannot access according to your Security Group
membership. For example in a Path View, NNMi might include information
about all nodes in the path, whether you can access additional information
about each node.

This Status might also indicates that a node has been removed from the
NNMi database since the last Refresh of the data you are viewing.

Status Colors, continued

Determine Problem Scope
Maps are a useful tool for determining the scope of a problem. Scan themap to determine the scope
of the problem. For example, look for large clusters of non-normal color icons to determine if there is
a large-scale outage.

If your naming scheme is based on node location, youmight also be able to determine if the problem
is isolated to a particular site or store.

Access a Problem Device
Using NNMi's Actionsmenu you can access the following commonly used tools to investigate
device access and configuration information:

l Verify that the node can be reached by using ping, see "Test Node Access (Ping)" (on page
443).

l Use telnet to access the device and determinemore information, see "Establish Contact with a
Node (Telnet or Secure Shell)" (on page 445).

l Use traceroute to view traffic paths, see "Find the Route (traceroute)" (on page 444).

Note: Access to these commands depends on theNNMi Role1 andObject Access Privileges to
which you are assigned. If you are unable to access an action, contact your NNMi
administrator.

1Determined by your membership in one of four special NNMi User Groups. This membership
determines what you can see and do within the NNMi console.

HP Network NodeManager i Software (9.21)Page 276 of 454



Online Help: Help for Operators
Chapter 7: Monitoring Devices for Problems

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Access Node Details
Select any node symbol on themap, and display all of the information related to that specified node.
The Node form is useful for troubleshooting purposes:

l List of the conclusions that led to the current status, and information about status calculations
for the node over time.

l Status of each interface contained in the node. For example, if the node is not completely down,
youmight want to see which interfaces are down.

l Status of each address associated with this node.

l System contact information.

l All of the incidents associated with the node.

NNMi also provides an Analysis Pane that displays information about a selected object.

To view all details associated with a map object:
1. In amap view, select the object.

2. Click the  Open icon in themenu bar.

3. The form displays, containing details of all information related to the object.

4. View or edit the details of the selected object.

To access the Analysis Pane from a table view:

1. Select the workspace of interest (for example, Inventory).

2. Select the view that contains the object of interest (for example, theNodes view).

3. Select the row that contains the object of interest.

4. NNMi displays detailed information at the bottom of the view in the Analysis Pane.

To access the Analysis Pane in a map view:

1. Select the workspace of interest (for example, Topology Maps).

2. Select amap view (for example, select Routers).

Note: If themap requires a starting node before it opens, enter the name or
IP Address for the starting node you want to use.

3. Click themap object of interest.

4. NNMi displays detailed information at the bottom of the view in the Analysis Pane.

To access the Analysis Pane in a form:

l Click the form's toolbar Show Analysis icon to display information about the current form's
top-level object in the Analysis Pane.
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Note: Show Analysis always displays the top-level object's information.

l Click a row in a table on one of the form's tabs to display detailed information about the selected
object in the Analysis Pane.

NNMi displays detailed information at the bottom of the form in the Analysis Pane. SeeWorking
with Objects for more information about forms.

Note the following: 

l Look for one of the following at the bottom of the display area:

Open the Analysis Pane if necessary by clicking the expand button.

l Place your mouse cursor over the title bar to display the ↕ symbol, then resize as necessary.

l The Analysis Pane remains blank until an object is selected.

l If you select multiple objects or clear a selection, NNMi retains the Analysis Pane's contents.

l If you change views, NNMi clears the Analysis Pane.

l Click any Refresh icon in the Analysis Pane to update a subset of displayed information.

l NNMi automatically refreshes the entire Analysis Pane's contents when you save a form.

l TheGauges tab shows real-time SNMP gauges to display State Poller and Custom Poller
SNMP data.

n These gauges are displayed for Nodes, Interfaces, Custom Node Collections, and for Node
Components of type CPU, Memory, Buffers, or Backplane.

n NNMi displays a gauge for each significant MIB Object Identifier (OID) that the node or
interface supports, up to the default maximum of 24.

Tip: If you are an NNMi administrator, for information about using the nms-
ui.properties file to change this default, see the "NNMi Console" chapter in theHP
Network NodeManager i Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

n Each gauge displays the current OID value, using the default refresh rate of 15 seconds. (If
you are an NNMi administrator, for information about using the nms-ui.properties file to
change this default, see the "NNMi Console" chapter of theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.)

n The value range displayed indicates the OID minimum andmaximum values that NNMi has
encountered.

n For any gauge that tracks percentage values, NNMi uses a red line to indicate where the OID
value is near 100 percent.

n There is not a one-to-onematch between theOIDs used to analyzemonitoring thresholds and
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those displayed in the Analysis Pane. For example, the Analysis Panemight display aCisco
Memory Pool OID value that does not match the value used to calculate whether the
Memory UtilizationMonitored Attribute threshold is reached or exceeded. This is because
some thresholdmetrics require more complex calculations than a single OID allows. 

Tip: If a gauge label appears to be a duplicate value, mouse over the label to view the
more complete tooltip name that appears. (If you are an NNMi administrator, to change
the gauge title from the NNMi component name to the SNMP MIB variable name, see the
"Maintaining NNMi" chapter of theHP Network NodeManager i Software Deployment
Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.)

n To launch an SNMP LineGraph for the selectedmetric, click the icon that appears at the
bottom of each gauge.

n To select and copy the tooltip information, double-click the gauge. NNMi opens a text window
that enables you to select and copy the tooltip information.

Related Topics:

"Node Form" (on page 48)

"Interface Form" (on page 114)

"IP Address Form" (on page 153)

Access All Related Incidents
If you are using amap view tomonitor your network, there are times when youmight want to switch
to an incident view for more information. Information available from an incident view includes the
first time a notification was received, the description of the problem (for example, Node Down or
Address Not Responding), and the incident category. The incident category helps to identify the
type of problem, such as fault, performance, or security.

To display all incidents related to an object on a map:

1. Click to select the node or interface of interest.

2. Click the  Open icon to open the form.

3. Select the Incidents tab.

4. The incidents table includes all incidents associated with the node or interface. Double-click
the row representing the incident that you want to examine. See "Incident Form" (on page 300).

Related Topics:

Using Views to Display Data

Working with Objects

Use Table Views

Export Maps to Microsoft® Visio (NNM iSPI NET)
NNM iSPI Network Engineering Toolset Software
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If you are using amap view tomonitor your network, there are times when youmight want to export
topology maps displayed in NNMi to Visio documents for later use. NNMi enables you to export the
current map or all NodeGroupmaps that are configured to be exported. See "Help for
Administrators" for more information about how to configure NodeGroup maps.

Note: Vendor-specific icons are not exported.

If you are using Internet Explorer as yourWeb browser, before exporting topology maps to Visio,
make sure the NNMi management server is a trusted site and that File Downloads is enabled. Click
here for more information.

To add the NNMi management server as a trusted site:

1. Select Tools→ Internet Options.

2. Navigate to theSecurity tab.

3. Select Trusted Sites.

4. Click Sites.

5. In theAdd this website to the zone field, enter the url to the NNMi management server and
click Add.

6. Click OK to save your changes and close the Trusted Sites dialog.

To enable File Downloads:

1. Select Tools→ Internet Options.

2. Navigate to theSecurity tab.

3. Select Trusted Sites.

4. Click Custom Level.

5. Navigate to theAutomatic prompting for file downloads.

6. Select Enable.

7. Navigate to File download.

8. Select Enable.

9. Click OK to save your changes and close theSecurity Settings dialog.

10. Click OK to close the Internet Options dialog.

To export the current map to a Visio diagram:

1. Navigate to themap of interest. For example, select Node Group Overview from the
Topology Mapsworkspace.

2. Select Tools→ Visio Export→Current Map.

3. Select Include Node Status Color if you want to export the current Status color for each
node.

4. Select Include connection labels if you want to export all of the connection labels.

Note: Including connection labels increases the file size. If you are concerned about file size,
do not export the connection labels.
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5. Click OK.

6. In the browser dialog, specify whether you want to Open or Save the .vdx file.

NNMi creates a Visio (.vdx) file that contains a single page with the current map view rendered
as a Visio diagram.

To export all Node Group maps configured to be exported:

1. Select Tools→ Visio Export→ Saved Node Group Maps.

Note: Only those NodeGroupmaps that have been properly configured by enabling the
Include in Visio Export check box in the NodeGroupMap Settings form are included in
the Visio Export. If a NodeGroupMap has not been saved usingSave Layout, the
positions of each node in the export will not match any changes youmade in your Map
view. See "Position Nodes on a NodeGroupMap" (on page 248) for more information.

2. Select Include Node Status Color if you want to export the current Status color for each
node.

3. Select Include connection labels if you want to export all of the connection labels. 

Note: Including connection labels increases the file size. If you are concerned about file sizes,
do not export the connection labels

4. Click OK

5. In the browser dialog, specify whether you want to Open or Save the .vdx file. 

NNMi creates a Visio (.vdx) file that contains a separate page for each NodeGroupmap
rendered as a Visio diagram.

Related Topics

"Hide Connections or Connection Labels from an Exported Visio Diagram (NNM iSPI NET)" (on
page 281)

"View the Details for aMapObject on an Exported Visio Diagram (NNM iSPI NET)" (on page 282)

"Print an Exported Visio Diagram (NNM iSPI NET)" (on page 283)

Hide Connections or Connection Labels from an Exported Visio Diagram
(NNM iSPI NET)

NNM iSPI Network Engineering Toolset Software

When viewing an NNMi topology map that was exported to Visio, you can temporarily hide the
Connections or Connection Labels using theViewmenu.

To hide the Connections or Connection Labels from a map that was exported to Visio:

1. Open the Visio diagram of interest.

2. Select View→ Layer Properties.

3. To hide the Connections from the Visio Diagram clear the check box that appears in the
Visible column next to theConnector name as shown in the following example.
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To hide the Connector Labels, clear the check box that appears in theVisible column next to
theConnector Label name.

4. Click Apply to apply the changes.

5. Click OK to close the dialog.

Related Topics

"Export Maps toMicrosoft® Visio (NNM iSPI NET)" (on page 279)

"View the Details for aMapObject on an Exported Visio Diagram (NNM iSPI NET)" (on page 282)

"Print an Exported Visio Diagram (NNM iSPI NET)" (on page 283)

View the Details for a Map Object on an Exported Visio Diagram (NNM iSPI
NET)

NNM iSPI Network Engineering Toolset Software

When viewing an NNMi topology map that was exported to Visio, you can view the details for a
map object that is stored in the NNMi database using theViewmenu.

To view the details for a map object on a map that was exported to Visio:

1. Open the Visio diagram of interest.

2. Select themap object of interest.

3. Select View→ Shape Data Window.

If the object is stored in the NNMi database, NNMi displays the details available for the
selected object. This information is similar to the information displayed when using Quick View
in NNMi.

Related Topics

"Export Maps toMicrosoft® Visio (NNM iSPI NET)" (on page 279)
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"Hide Connections or Connection Labels from an Exported Visio Diagram (NNM iSPI NET)" (on
page 281)

"Print an Exported Visio Diagram (NNM iSPI NET)" (on page 283)

Print an Exported Visio Diagram (NNM iSPI NET)

NNM iSPI Network Engineering Toolset Software

When printing an NNMi topology map that was exported to Visio, use the Visio Filemenu tomake
sure all of your map contents print to one page.

To print a map exported to a Visio diagram:

1. Open the Visio diagram of interest.

2. Select File→ Page Setup.

3. Navigate to thePrint Setup tab.

4. Click Fit to sheet(s) across.

5. Click OK to save your changes and close the Page Setup dialog.

6. Use the File→ Printmenu to print the Viso diagram.

Related Topics

"Export Maps toMicrosoft® Visio (NNM iSPI NET)" (on page 279)

"Hide Connections or Connection Labels from an Exported Visio Diagram (NNM iSPI NET)" (on
page 281)

"View the Details for aMapObject on an Exported Visio Diagram (NNM iSPI NET)" (on page 282)

Monitor with Line Graphs
The NNMi Actions menu enables you to view real-time SNMP data for selected nodes or
interfaces. This feature is useful when you want to use a Line Graph tomonitor a numeric MIB
Expression value for a node or interface over a specified time interval. For example, youmight want
to view a Line Graph of the network traffic using the ifOutOctets (Interface Out Octets) MIB variable
for a specified node. Or youmight want to graph aMIB variable, such as ifInOctets (Interface In
Octets), to verify that a problem has been fixed for a specified interface before closing an incident.

Note: The node for which you want to view informationmust support SNMPv1, SNMPv2c, or
SNMPv3.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi provides a set of Line Graphs for nodes and for interfaces. See "Line Graphs Provided by
NNMi" (on page 294) for more information.

Your NNMi administrator might configure additional Line Graphs.

To access a Line Graph from a table view:
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1. Navigate to the view for that object (for example, Inventoryworkspace, Nodes view).

2. Select the nodes or interfaces of interest by pressing CTRL-Click and selecting the rows
representing the object information.

3. Select Actions→Graphs→<graph_submenu> →<graph_name>

Note: This menu item also is available on any supported object's form.

To access a Line Graph from a map:

1. Navigate to themap of interest (for example, Topology Mapsworkspace, Initial Discovery
Progress orNetwork Overviewmap).

2. Click the object or objects that have the data you want to graph.

Tip: Use CTRL-Click to select multiple objects.

3. Select Actions→Graphs → <graph_submenu> →<graph_name>

Your NNMi client displays the corresponding Line Graph and continues to request new values until
you close the Line Graph window.

Related Topics

"Using Line Graphs" (on page 284)

Using Line Graphs
The NNMi Line Graph enables you to view real-time SNMP data over time for selected nodes or
interfaces.

Each line on a Line Graph represents a numeric value you want to monitor. For example, to enable
you tomonitor network traffic using a Line Graph, your NNMi administrator might configure a graph
so that each line represents the ifOutOctets (Interface Out Octets) MIB variable value for an
interface on a specified node. If more lines than the default number to be displayed on the graph are
available, you can change the set of lines you want to view from the default selection.

Note: If NNMi displays a gap in a line on the graph, this means data was not available during the
points in time indicated by the gap. Any line that discontinues in the Line Graph indicates the
line no longer has available data.

Tip: If a Line Graph displays data as a different type than expected, contact your NNMi
administrator. The NNMi administrator can override aMIB OID Type. If you are an NNMi
administrator seeOverrideMIB OID Types for more information.

Note: When the NNMi administrator overrides aMIB OID Type, youmust restart the Line Graph for
the configuration changes to take effect. After a Line Graphis restarted, the configuration
changes are also displayed on any existing Line Graphs.

From a Line Graph, you perform the following tasks:

l "Change the Lines Displayed on a Line Graph" (on page 285)

l "Emphasize a Line Displayed on a Line Graph" (on page 286)

l "Hide a Line Displayed on a Line Graph" (on page 286)

l "Show and Hide the Line Graph Legend" (on page 287)
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l "Change the Polling Interval for a Graph" (on page 288)

l "Select a Time Segment Using the Timeline Viewer" (on page 289)

l "Unlock the Y-Axis When Viewing a Time Segment" (on page 290)

l "Change the Zoom Value for a Graph" (on page 290)

l "Display Data Values on aGraph" (on page 291)

l "Display Messages on a Line Graph" (on page 291)

l "Determine theMaximum TimeRange for a Graph" (on page 292)

l "Print a Graph" (on page 293)

l "Export Graph Data to a Comma-Separated Values (CSV) File" (on page 293)

Change the Lines Displayed on a Line Graph

When you display a Line Graph, youmust first select the nodes or interfaces for which you want to
graph information. See "Monitor with Line Graphs" (on page 283) for more information about
accessing a Line Graph.

In response, NNMi creates a line for each numeric value defined for the graph. For example, to
monitor network traffic, your NNMi administrator might configure a graph so that each line
represents the ifOutOctets (Interface Out Octets) MIB value for an interface on a specified node.

By default, NNMi displays up to 20 lines of data at one time. If more than 20 instances of data are
available, NNMi uses the notification area to inform you that the number of lines to be displayed
exceeds your default number. See "Display Messages on a Line Graph" (on page 291) for more
information about the notification area.

Note: The NNMi administrator can change the default number of lines to be initially displayed.

See the legend provided with each graph for information about the data represented by each line
color on the graph.

NNMi enables you to change which lines are displayed in a Line Graph. For example, if you select a
graph that displays ifOutOctets (Interface Out Octets) MIB values for all of the interfaces on a node,
you can choose to display only the interfaces with themost traffic.

You can also hide lines displayed on a graph. When a line is hidden, NNMi continues to request
new data for that instance. See"Hide a Line Displayed on a Line Graph" (on page 286) for more
information.

To add a line to the Line Graph:

1. Select File→ Select Lines...

NNMi displays the Select Lines dialog box.

2. In theSelect Lines dialog box, do one of the following:

n To display a line for one or more instances of data that appear in the Select Lines dialog box,
select the check box  in the row representing each instance of data that has a line you
want to display.
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n To display lines for all instances of data that appear in the Select Lines dialog box, select the
check box ( ) that appears above the check box column.

3. Click OK.

The Line Graph displays the new set of lines specified.

To remove a line on the Line Graph:

Note: If a line is removed from the Line Graph, NNMi no longer tracks the SNMP data for that
instance.

1. Select File→ Select Lines...

NNMi displays the Select Lines dialog box.

2. In theSelect Lines dialog box, do one of the following:

n To remove a line for one or more instances of data, deselect the check box ( ) in the row
representing each instance of data that has a line you want to remove.

n To clear all lines for all instances of data that appear in the Select Lines dialog box, deselect
the check box ( ) that appears above the check box column.

Note: If only some instances of data are selected, click the check box above the check box
column twice. The first click selects all instances of data and the second click clears
the check box for all data instances.

3. Click OK.

The Line Graph displays the new set of lines specified.

Emphasize a Line Displayed on a Line Graph

NNMi enables you to emphasize a line displayed in a Line Graph.

To emphasize a line on the Line Graph:

1. Navigate to the Graph Legend.

Note: if the Legend is not displayed, select View→ Legend.

2. Mouse over the legend entry representing the line that you want to emphasize.

The selected legend entry appears bold and all other lines fade.

Hide a Line Displayed on a Line Graph

NNMi enables you to temporarily hide lines displayed in a Line Graph. For example, if you select a
graph that displays ifOutOctets (interface Out Octets) MIB variable values for all of the interfaces
on a node, you can choose to display only the interfaces with themost traffic and hide those
interfaces with the least traffic.

You can also choose to hide a line containing extreme values so that the Y-axis is recalculated to
show more detail for the remaining lines.

Note: NNMi continues to request new data for instances with hidden lines. A line that was hidden
can be added back to the graph at any time and display themost current information.
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To hide a line on the Line Graph:

1. Navigate to the Graph Legend

Note: if the Legend is not displayed, select View→ Legend.

2. Click the entry in the Legend representing the line that you want to hide.

3. Click the popup text to hide the line.

4. The line entry disappears from themap and the Legend link text turns gray.

To display a line that is hidden:

1. Navigate to the Graph Legend.

Note: if the Legend is not displayed, select View→ Legend.

2. Hidden line entries have gray text in the Legend.

Click the entry in the Legend representing the hidden line that you want to display.

3. Click the popup text display the line.

4. The line entry appears on themap and the Legend link text turns black.

You can also remove a line from the Line Graph. When you remove a line from the Line Graph,
NNMi stops requesting new data for that instance. See "Change the Lines Displayed on a Line
Graph" (on page 285) for more information.

Show and Hide the Line Graph Legend

TheGraph Legend identifies each line displayed in the Line Graph. By default, NNMi displays the
name of the node or interface for each line. If the graph displays more than one line per node, the
legend includes the node name followed by the instance identifier specified by the NNMi
administrator who configured the Line Graph. For example, the Interface Index (ifIndex) valuemight
be used to identify each interface per node.
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NNMi enables you to temporarily hide the legend displayed in a Line Graph. For example, if you
needmore than the default number of lines, youmight want to hide the legend to providemore
space to display the graph.

To hide the legend on a Line Graph:

Select View→ Legend.

The check mark no longer appears next to the Legendmenu option.

The legend no longer appears in the Line Graph.

To redisplay a legend that is hidden:

Select View→ Legend.

The check mark re-appears next to the Legendmenu option.

The legend reappears in the Line Graph.

Change the Polling Interval for a Graph

The Polling Interval determines how often NNMi requests for the data point sets displayed in a
graph. When you change the Polling Interval in a graph, you are temporarily changing the Polling
Interval for graphing purposes only.

By default, NNMi uses 15 seconds, or a value specified by the NNMi administrator or HP Network
NodeManager i Software Smart Plug-in.

Note: The NNMi administrator or HP Network NodeManager i Software Smart Plug-in specifies
theMaximum TimeRange in which to retain the graph's data point sets. After theMaximum
TimeRange number is reached, NNMi begins to discard the oldest data point sets so that it
can display themost recent data for the time range specified. For example, if theMaximum
TimeRange is 24 hours, when 24 hours has passed, NNMi removes data starting with the
initial data point set so that it can display data for themost recent 24-hour interval. NNMi
displays aWarningmessage if it is unable to graph the data for theMaximum TimeRange
specified. You can lengthen the Polling Interval to lengthen the time period in which to retain
the data. The time period in which the data is retained will not exceed theMaximum Time
Range configured for the graph. See "Determine theMaximum TimeRange for a Graph" (on
page 292) for more information.

Tip: To pause a graph, set the Polling Interval to 0 (zero).

To change the Polling Interval for a graph:

1. In thePolling Interval (secs) attribute, type the number that represents how often you want
NNMi to request new data point sets.
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2. Press Enter.

Note: The new Polling Interval takes effect after the next data display. For example, if you
change the Polling Interval from 1minute to 15 seconds, the graph waits until the 1-
minute interval is completed, displays the additional data, and then begins waiting 15
seconds between data requests.

Select a Time Segment Using the Timeline Viewer

NNMi enables you to pan to a specified time segment of the graph using the Timeline Viewer that
appears below the graph.

Note: You can also use the Zoom factor to select a time segment. See "Change the Zoom Value for
a Graph" (on page 290) for more information.

For example, youmight want to focus on a particular day or a particular peak period. The following
example uses the Timeline Viewer to select themost recent time segment available on the graph.

If the Timeline Viewer is not displayed, select View→ TImeline Viewer.

Note: As shown in the example above, the Timeline highlights the section of the data that you
chose to display in the graph and continues to display all of the data available.

To select a time segment on agraph:

Note: NNMi displays the timestamp of the time segment end point as you as move the slider.

1. Move the left side of the slider in the Timeline to indicate the beginning of the section you want
to display.

2. Move the right side of the slider in the Timeline to indicate the end of the section you want to
display.

NNMi displays the results of your selection in the graph as shown in the previous example.
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Unlock the Y-Axis When Viewing a Time Segment

By default, NNMi locks the Y-axis so that it remains fixed at theminimum andmaximum values for
the current set of data regardless of the time segment selected. This means NNMi does not
automatically re-adjust the Y-axis to match the data values for the selected time segment.

You can choose to unlock the Y-axis so that NNMi automatically adjusts the increments on the Y-
axis. As the data values change, all of the data points fit on the graph. When using the Timeline
Viewer to focus on a specified time segment, NNMi also automatically re-adjusts the increments on
the Y-axis as new data is received.

For example, suppose theminimum value for the current data set is 0 and themaximum value is 20.
In this case the Y-axis increments would range from 0 to 20. If you select a time segment in which
the data points range from 0 to 5 and you lock the Y-axis, the increments remain fixed at 0 to 20. If
you unlock the Y-axis, NNMi automatically adjusts the Y-axis increments from 0 to 5 and enlarges
the graph accordingly.

This option is useful when you have a wide range of data and you are viewing a series of time
segments.

Note: By default, the Lock Y-Axis option is on.

To unlock the Y-axis when viewing time segments of the graph: 

Select View→ Lock Y-Axis

The check mark no longer appears next to the Lock Y-axis option to indicate the Y-axis is not
locked.

To lock the Y-axis when viewing time segments of the graph:

Select View→ Lock Y-Axis

A check mark appears next to the Lock Y-axis menu option to indicate the Y-axis is locked.

Change the Zoom Value for a Graph

NNMi enables you to change the Zoom number on a graph. For example, youmight want to focus
on a specified time interval that indicates peak traffic for a node or interface.

Note: You can alsomove the slider in the Timeline Viewer that appears below the graph to zoom in
on the area in which you want to focus. See "Select a Time Segment Using the Timeline
Viewer" (on page 289) for more information.

To change the Zoom for a graph:

Select one of the Zoom numbers displayed in the top of the graph.

In the following example the Zoom choices are All, 5 minutes (5m), 3minutes (3m), 2minutes (2m),
and 90 seconds (90s):

Note the following:
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l The All value displays all of the data available.

l The Zoom values might change depending on the Polling Interval specified.

Display Data Values on a Graph

AnNNMi graph enables you to display data values at any point in time represented in the graph.

To display data values at a specified point in time:

Mouse over the location of interest.

NNMi displays the numeric value for each graphed object at the point selected as shown in the
following example:

Display Messages on a Line Graph

AnNNMi Line Graph enables you to display the history of messages generated for a particular
graph. Messages can be either informational or warningmessages that result when NNMi is unable
to display a particular line in the graph. For example, an SNMP timeout might prohibit NNMi from
displaying updated data.

NNMi also displays aWarningmessage if it is unable to graph the data for theMaximum Time
Range specified. See "Determine theMaximum TimeRange for a Graph" (on page 292) for more
information.

You can also control whether NNMi automatically displays theMessage History dialog box in a
pop-up window each time NNMi receives a new Warningmessage.

To display the history of messages:
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1. Select View→Notification History.

NNMi displays the Date, Type (Info orWarning) and Description for all messages that you
have not deleted.

2. Click Delete History to delete the list of messages displayed.

Note: Any messages deleted from the Notification History are no longer available for viewing.

3. Click OK to close the Notification History dialog box.

To control whether the Notification History dialog box is automatically displayed in a pop-
up window each time NNMi receives a new Warning message:

1. Select View→Notification History.

2. Do one of the following:

n Select to clear Show on warning if you do not want NNMi to automatically display
Warningmessages in a Status pop-up window.

n Select to check Show on warning to display Warningmessages in a pop-up window as
they occur.

NNMi displays individual messages in a notification area that appears above the graph when a
message occurs. To clear amessage displayed in the notification area, click theOK button that
appears to the right of themessage. Themessage remains available to be displayed when using
Notification History.

Determine the Maximum Time Range for a Graph

The NNMi administrator specifies theMaximum TimeRange in which the data in a graph should be
retained. After theMaximum TimeRange number is reached, NNMi discards the oldest data point
sets so that it can display themost recent data for the time range specified. For example, if the
Maximum TimeRange is 24 hours, when 24 hours has passed, NNMi removes data starting with
the initial data point set so that it can display data for themost recent 24-hour interval.

To determine theMaximum TimeRange for a graph use the graph status bar. The status bar
displays the following information:

l The start and end time indicating the time interval in which data has been collected for the graph.
NNMi updates this time at each Polling Interval.

Note: Any time NNMi removes older data from the graph, the start time in which data has been
collected for the graph changes to indicate the new start time.

l The total time in which data has been collected for the graph.

l The time remaining before theMaximum TimeRange is reached.

In the following example, the total time in which data has been collected for the graph is 33 seconds
(33s). The time remaining before theMaximum TimeRange is reached is 1 day, 17 hours, 38
minutes, and 30 seconds (1d 17h 38m 30s remaining)
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Note: NNMi displays aWarningmessage if it is unable to graph the data for theMaximum Time
Range specified. You can increase the Polling Interval to lengthen the time period in which the
data remains current. The time period in which the data remains current will not exceed the
Maximum TimeRange configured for the graph.

Print a Graph

NNMi enables you to print a graph using the graphs's File menu. NNMi automatically scales all
information included in the graph window to fit the printed page.

To print a graph:

Select File → Print to access the Print dialog box and send the graph contents to the designated
printer.

Export Graph Data to a Comma-Separated Values (CSV) File

NNMi enables you to export a Line Graph to a Comma-Separated Values (CSV) file. NNMi exports
the data collected only for the lines displayed on the graph. (To change the lines displayed use the
File→ Select Lines option.)

To export a graph to a CSV file:

1. Display the Line Graph that contains the data you want to export. (See "Monitor with Line
Graphs" (on page 283).)

2. Select File → Export to CSV .

NNMi uses the graph Name as the .csv file name.

3. Click Save to save the file.

As shown in the following example, NNMi creates the CSV file using the following format:

l The first column lists each time stamp in which data is collected.

l Each row contains the data per line for the specified time.

l Each column represents a line in the graph.
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Note the following:

l By default, NNMi exports the time as a decimal value. This number represents the number of
days since Jan 1, 1900. To format the time as a date value, in the CSV file, right-click the Time
column, select Format Cells, and select Date.

l Blank or null values indicate that NNMi was unable to collect data from the device.

l A value of 0 (zero) represents a valid value collected from the device for the specified
timestamp.

Line Graphs Provided by NNMi
NNMi provides a set of Line Graph that display real-time SNMP data for specifiedMIB
Expressions. These Line Graphs are available from theActions→Graphs submenu.

Your NNMi administrator might configure additional Line Graphs that also appear under the Actions
menu.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

To display the Line Graphs available for nodes:

1. Navigate to the node view of interest (for example, Inventoryworkspace, Nodes view).

2. Press CTRL-Click and select each row that represents a node you want to graph.

3. Select Actions →Graphs →<graph_submenu> →<graph_name>.

4. Some Line Graphs are specific to a vendor or object type. If the required object or objects are
not selected, the color of that Action is gray to indicate the Action is unavailable.

To display the list of Line Graphs available for interfaces:

1. Navigate to the interface view of interest (for example, Inventory workspace,Interfaces view).

2. Press CTRL-Click and select each row that represents an interface you want to graph.

3. Select Actions →Graphs →<graph_submenu> →<graph_name>.

Some Line Graphs are specific to a vendor or object type. If the required object or objects are
not selected, the color of that Action is gray to indicate the Action is unavailable.

To display the Line Graph available for an incident:

1. Navigate to the incident view of interest (for example, Incident Browsingworkspace, Root
Cause Incidents view).

2. Select the row that represents the incident of interest.

Note: Select only one incident. The Source Node of the incident you select must be associated
with a Custom Poller Collection.

3. Select Actions→Graphs→Graph Custom Poller Results.

NNMi displays a Line Graph for the incident you select. See "Display a Line Graph from an
Incident (Custom Poller Only)" (on page 295) for more information about the Line Graph
displayed.

HP Network NodeManager i Software (9.21)Page 294 of 454



Online Help: Help for Operators
Chapter 7: Monitoring Devices for Problems

To display the Line Graph available for Custom Polled Instances:

1. Navigate to theMonitoringworkspace, Custom Polled Instances view.

2. Press CTRL-Click and select each row that represents a Custom Polled Instance you want to
graph.

3. Select Actions→Graphs→Graph Polled Instance.

NNMi displays a Line Graph that includes the data for each Custom Polled Instance you
select. See "Display a Line Graph for a Custom Polled Instance" (on page 296) for more
information about the Line Graph displayed.

Note: You can also access Line Graphs from an object's form.

See "Monitor with Line Graphs" (on page 283) for more information about accessing Line Graphs.

Display a Line Graph from an Incident (Custom Poller Only)
If you are using incident views tomonitor your network, youmight want to switch to a Line Graph to
determinemore information about an incident that is associated with a Custom Poller Collection.
This means the incident's Source Node is amember of a NodeGroup for which a Custom Poller
Policy is defined.

NNMi graphs MIB expressions from the Custom Poller Collection associated with the incident's
Source Node. See "About Custom Poller" for more information about Custom Poller and Custom
Poller Collections.

You can identify a Custom Poller incident in either of the following ways:

l The incident's Message includes the keywords: for variable.

l The CIAs listed on the Incident form's Custom Attributes tab, include the following Custom
Poller attributes:
n cia.custompoller.collection

n cia.custompoller.instanceDisplayValue

n cia.custompoller.instanceFilterValue

n cia.custompoller.lastValue

n cia.custompoller.mibInstance

n cia.custompoller.policy

n cia.custompoller.state

n cia.custompoller.variable.description

n cia.custompoller.variable.expression

n cia.custompoller.variable.name

n com.hp.ov.nms.apa.symptom

To display an Line Graph from an incident view:

1. Navigate to the incident view of interest (for example, Incident Browsingworkspace, Root
Cause Incidents view).
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2. Select the row that represents the Custom Poller incident of interest.

Note: Select only one incident.

3. Select Actions→Graphs→ Graph Custom Poller Results in themain toolbar.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi displays a Line Graph that contains the data points for theMIB expression configured for
the Custom Poller Collection associated with the incident's Source Node. See "Using Line
Graphs" (on page 284) for more information.

To display an Line Graph from an incident form:

1. Navigate to the incident view of interest (for example, Incident Browsingworkspace, Root
Cause Incidents view).

2. Double-click the row representing the incident that has the Custom Poller results you want to
graph.

3. Select Actions→Graphs→ Graph Custom Poller Results in themain toolbar.

NNMi displays an Line Graph that contains the lines representing the data points for theMIB
expression configured for the Custom Poller Collection associated with the incident's Source
Node. See "Using Line Graphs" (on page 284) for more information.

Display a Line Graph for a Custom Polled Instance
If you are using the Polled Instance view tomonitor your network, youmight want to switch to an
Line Graph to determinemore information about a particular Custom Polled Instance.

NNMi graphs the line representing the Custom Poll results for the selected Custom Polled
Instance. See "About Custom Poller" for more information about Custom Poller

To display an Line Graph from the Custom Polled Instance view:

1. Navigate to theCustom Polled Instances view (Monitoringworkspace, Custom Polled
Instances view).

2. Press CTRL-Click and select each row that represents the Custom Polled Instance of interest.

3. Select Actions→Graph Polled Instance in themain toolbar.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi displays a Line Graph that includes the data for each Custom Polled Instance you
select.

To display an Line Graph from a Custom Polled Instance form:

1. Navigate to theCustom Polled Instances view (Monitoringworkspace, Custom Polled
Instances view).

2. Double-click the row representing the Custom Polled Instance that has data that you want to
graph.

3. Select Actions→ Graph Polled Instancein themain toolbar.
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NNMi displays a Line Graph that includes the data for each Custom Polled Instance you
select.

Related Topics

"Custom Polled Instances View" (on page 272)
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Monitoring Incidents for Problems
Tip: See "Incident Form" (on page 300) for more details about the Incident attributes that appear in

an incident's view column headings.

NNMi actively notifies you when an important event occurs. The event is reflected by a change of
background color of a node in a network map and is reported through incident views.

Note: NNMi enables an NNMi administrator to limit visibility and control to parts of the network for
some or all operators. If your NNMi administrator has configured Security Groups to limit node
access, then as a network operator you can view a node and its associated incidents only if
one of the User Groups to which you belongs is asociated with that node's Security Group.
See "Node and Incident Access" (on page 18) for more information.

Many services (background processes) within NNMi gather information and generate NNMi
incidents. In addition, an SNMP agent might send information to NNMi. For example, an SNMP
agent detects that amanaged critical server is overheating and about to fail. The SNMP agent
forwards a trap to NNMi.

Incidents might also be reporting on information that was requested by NNMi. For example, NNMi
might generate an "Address Not Responding" incident after using ICMP to check whether
communication channels are open to a device (using ping).

For most incident views displayed, you can identify an incident's overall severity, Lifecycle State,
source node, source object, and its message.

Note: Some incidents might have the Source Node or Source Object value set to <none>. This
happens when the NNMi database does not contain any object representing the problem
device. Examples: An incident that is being forwarded from anNNM  6.x or 7.x management
station has a Source Node value of <none>. An incident having a Source Node or Source
Object that is not included in the current NNMi Monitoring Configuration settings might be
displayed as <none>.

The following table describes the severity icons used by NNMi.

Icon Meaning Icon Meaning Icon Meaning Icon Meaning

Normal Minor Critical Disabled

Warning Major Unknown No Status

Incident Severity Icons

Note: NNMi provides management mode attributes that determine whether a node, interface, or
address is discovered andmonitored. Your administrator can set some of thesemanagement
mode attribute values. Any object that has amanagement mode that is set so that it is no
longer discovered andmonitoredmight still have incidents associated with it that existed
before the object was no longer managed. To check whether a node associated with an
incident is beingmanaged, open the form for the incident and then open the form for the
source node associated with the incident. SeeWorking with Objects for more information.
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Incident views are useful for quickly identifying items described in the following table.

Use Description

Identify
potential or
current
problems

Within a view, each incident has a corresponding icon that indicates its severity so
that you are immediately notified of potential or current problems.

You can filter incidents so that you only view incidents that has a severity that is
Critical or you can choose to filter incidents to view all incidents that have a
severity that is greater than Normal.

Identify
problem
nodes

You can sort incidents by node to help you quickly identify the problem nodes.

Determine
the cause
of the
problem

You can sort an incident view by description, to see all incidents reporting a node or
interface that is disabled or otherwise unavailable.

You can also use the child incidents attribute to view all of the incidents that are a
result of the root cause problem reported.

Determine
historical
information

You can sort your incidents by notification date to determine whether a group of
nodes went downwithin a specified time frame.

You can also filter your list of incidents according to notification date to view only
those incidents received within the last hour.

To track historical information for a specific node, sort your incidents by First
Occurrence. Then, filter your view by node Name. This lets you view a
chronological list of the kinds of errors (indicated by Origin) that have occurred for
the current node.

You can then open the Incident form to use the child incidents attribute to view all of
the incidents that are a result of the root cause problem reported.

Identify
only the
incidents
important
to you

You can filter an incident view so that you see only those incidents of interest. For
example, youmight filter incidents so that you only view incidents that have a
status that is Critical or only those incidents assigned to you. You can also view
only those incident associated with a NodeGroup. Your NNMi administrator
creates node groups. For example, your NNMi administrator might choose to group
all of your important Cisco routers into a node group. See "Filter Views by Node or
Interface Group" (on page 25) for more information.

Incident View Uses

Your NNMi administrator can define the format of incident messages so they aremost useful to you
and your team.

Your team can use the Notes attribute of the incident views to notify everyone else about which
issues are being covered.
Note: If a node is deleted, only an NNMi administrator can view the incidents associated with that
node.

Tasks Performed from an Incident View

You can perform the following tasks from an incident view:
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"Organize Your Incidents" (on page 300)

"Own Incidents" (on page 321)

"Assign Incidents" (on page 321)

"Unassign Incidents" (on page 322)

"Keep Your Incidents Up to Date" (on page 323)

"Track an Incident's Progress" (on page 328)

"Display aMap from an Incident" (on page 330)

Related Topics:

"Incident Views Provided by NNMi" (on page 333)

Organize Your Incidents
You can organize your incidents in one of three ways:

1. Sort them according to the column of interest. For example, youmight want to sort your
incidents by status.

2. Filter them according to the values for a particular column or attribute. For example, filtering by
status lets you filter out the status values that are not of interest to you. Filtering by the
Assigned To attribute lets you view only the incidents assigned to you.

3. Filter them according to a NodeGroup. Your network administrator can group sets of nodes
into NodeGroups. An example NodeGroup could be all important Cisco routers, or all routers
in a particular building. See "Filter Views by Node or Interface Group" (on page 25) for more
information about filtering a view by NodeGroup.

Note: See the help topic for each incident view for more details about how youmight want to sort or
filter a specific incident view.

For information about sorting and filtering, see Use Table Views.

Incident Form
Tip: See "Interpret Root Cause Incidents" (on page 380) for additional information about

troubleshooting an incident.

The Incident form provides details for troubleshooting purposes. From this form you can access
more details about the node involved, and the Source Object attribute provides more information
about the interface, IP Address, connection, or SNMP Agent that is contributing to the problem.

If your role permits, you can use this form to update the priority and Lifecycle State of the incident,
assign a teammember to investigate the problem, or add notes to communicate solutions or
workaround information.

For information about each tab:
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Attribute Description

Message A description of the problem that you want NNMi to display.

Severity Seriousness that NNMi calculates for the incident. Possible values are:

No Status

 Normal

 Warning

  Minor

  Major

  Critical

Disabled

Unknown

See About Status Colors for more information about severity values.

Note: The icons are displayed only in table views.

Priority Used to communicate the urgency of resolving the selected incident. You control this
value. NNMi sets this value to null by default. The lower the number the higher the
priority. Possible values are:

  None

  Low

  Medium

  High

  Top

Note: The icons are displayed only in table views.

Lifecycle
State

Identifies where the incident is in the incident lifecycle. You control this value.

Registered – Indicates that an incident arrived in the queue stored in the NNMi
database.  

In Progress – State selected by someone on your team to indicate that they are
taking responsibility for investigating the problem.

Completed – State selected by someone on your team to indicate completion of
the incident investigation and implementation of a solution.

Closed – Indicates that NNMi determined the problem reported by this Incident is
no longer a problem. For example, when you remove an interface from a device,
all incidents related to the interface are automatically Closed.

Basic Attributes
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Attribute Description

Note: NNMi does not automatically Close incidents whose Correlation Nature is
Info. These incidents aremeant to provide information regarding changes in your
network that might be of interest. You will need to Close these incidents if you do
not want them to remain in your incident queue. See "Incident Form: General
Tab" (on page 303) for more information about Correlation Nature

Dampened – Indicates that, within the configured acceptable time period, NNMi
determined the problem reported by this Incident is no longer a problem. NNMi
does not submit the incident to the queue until after the time period (configured by
the NNMi administrator).

In some cases, NNMi updates an incident's Lifecycle State for you. See "About the
Incident Lifecycle" (on page 326) for more information about Lifecycle State.

Note: The icons are displayed only in table views.

Source
Node

The Name attribute value of the node associated with the incident. Click the
 Lookup icon and select  Show Analysis or  Open to display the "Node Form"
(on page 48) for more information about the node.

Note: If the NNMi database does not contain any Node object for this device, the
source node value is <none>. For example, an incident that NNMi receives
from a 6.x or 7.x management station will not have a source node value.

Source
Object

Name used to indicate the configuration item that is malfunctioning on the source
node. Click the  Lookup icon and select  Show Analysis or  Open to display
more information about the interface, IP address, connection, or SNMP agent.

Note: All incidents forwarded to NNMi by a 6.x or 7.x NNM management station
have a Source Object value of none.

Assigned
To

Name of the user to which this incident is assigned. This valuemust be a valid user
name (determined by the NNMi administrator). See "Manage Incident Assignments"
(on page 320) for more information.

Notes (NNMi Advanced - Global Network Management feature) The text you enter here is
not sent from aRegional Manager (NNMi management server) to the Global
Manager. NNMi administrators for the Global Manager can add notes that are stored
in the NNMi database on theGlobal Manager.

Provided for communication among your team (for example, explanations or
workarounds). Informationmight include reasons why the status was changed, what
has been done to troubleshoot the problem, or who worked on resolving the incident.

Type amaximum of 255 characters. Alpha-numeric, spaces, and special characters
(~ ! @ # $ % ̂  & * ( ) _+ -) are permitted.

Note: You can sort your incident table views based on this value. Therefore, you
might want to include keywords for this attribute value.

Basic Attributes, continued

HP Network NodeManager i Software (9.21)Page 302 of 454



Online Help: Help for Operators
Chapter 8: Monitoring Incidents for Problems

Incident Form: General Tab
The "Incident Form" (on page 300) provides details for troubleshooting purposes.

For information about each tab:

Attribute Description

Name Name of the rule used to configure the incident. This name is initially created by
NNMi.

Category Generated by NNMi to indicate the problem category. Possible values include:

Accounting - Used to indicate problems related to usage statistics and
allocation of costs associated with the billing of time and services provided by
devices. This category is not used by NNMi with default configurations, but it is
available for incidents you define.

Application Status - Indicates there is a problem with the health of the NNMi
software. Examples of these kinds of events include license expiration or that a
certain NNMi process lost connection to the Process Status Manager.

Configuration - Indicates there is a problem with the configuration of a
managed device. For example, there is a physical address mismatch.

Fault – Indicates a problem with the network; for example, Node Down.

Performance – Indicates an exceeded threshold. For example, a utility
exceeds 90 percent.

Security – Indicates there is a problem related to authentication; for example,
an SNMP authentication failure.

Status - Often indicates some status change occurred on a device. For
example, when a Cisco device powers up or powers down.

Note: The icons are only in table views.

Family Used to further categorize the types of incidents that might be generated. Possible
values are:

Address – Indicates the incident is related to an address problem.

Aggregated Port – Indicates the incident is related to a Link Aggregation1

General Attributes

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Attribute Description

problem. See "Interface Form: Link Aggregation Tab (NNMi Advanced)" (on
page 122).

BGP - Indicates the incident is related to a problem with BGP (Border Gateway
Protocol). This family is not used by NNMi with default configurations, but it is
available for incidents you define.

Board - Indicates the incident is related to a board problem. This family is not
used by NNMi with default configurations, but it is available for incidents you
define.

Chassis – Indicates the incident is related to an chassis problem. This family is
not used by NNMi with default configurations, but it is available for incidents
you define.

Component Health – Indicates the incident is related to Node Component
metrics collected by NNMi. See "Node Form: Node Component Tab" (on page
66) for more information about the Node Component metrics collected.

Connection – Indicates the incident is related to a problem with one or more
connections.

Correlation – Indicates the incident has additional incidents correlated beneath
it. These incidents are associated with a duplicate count so that you can
determine the number of correlated incidents associated with it.

Custom Poller – Indicates the incident is related to the NNMi Custom Poller
feature. See "About Custom Poller".

HSRP –NNMi Advanced. Indicates the incident is related to a Hot Standby
Router Protocol (HSRP1) problem.

Interface – Indicates the incident is related to a problem with one or more
interfaces.

License - Indicates the incident is related to a licensing problem.

NNMi Health – Indicates the incident is related to NNMi Health. See the Check
NNMi Health for more information.

Node – Indicates the incident is related to a node problem.

OSPF – Indicates the incident is related to anOSPF problem. This family is not
used by NNMi with default configurations, but it is available for incidents you
define.

RAMS –NNMi Advanced. Indicates the incident is related to a Router
Analytics Management System problem.

General Attributes, continued

1Hot Standby Router Protocol
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Attribute Description

RMON – Indicates the incident is related to a RemoteMonitor (IETF standard,
RFC 1757) problem. This family is not used by NNMi with default
configurations, but it is available for incidents you define.

RRP –NNMi Advanced. Indicates the incident is related to a Router
Redundancy Protocol configuration problem.

STP – Indicates the incident is related to Spanning-Tree Protocol problem. This
family is not used by NNMi with default configurations, but it is available for
incidents you define.

Syslog – NNMi does not use this Family with default configurations. It is
available for incidents you define.

Trap Analysis – Indicates the incident is related to an SNMP trap storm.

VLAN – Indicates the incident is related to a problem with a virtual local area
network.

VRRP –NNMi Advanced. Indicates the incident is related to a Virtual Router
Redundancy Protocol (VRRP1) problem.

Note: The icons are only in table views.

Origin Identifies how the incident was generated. Possible values are:

NNMi – Indicates the incident was generated by NNMi processes.

Manually Created – NNMi does not use this Origin with default configurations.
It is available for incidents you define.

NNM 6.x/7.x – Indicates the incident was forwarded from anNNM  6.x or 7.x
management station.

SNMP Trap – Indicates the incident was forwarded from an SNMP Agent.

Syslog – NNMi does not use this Origin with default configurations. It is
available for incidents you define.

Other – Indicates the incident was generated by a source other than the Origin
categories provided.

Note: The icons are only in table views.

Cor-
relation
Nature

This incident's contribution to a root-cause calculation, if any. Possible values are:

Root Cause – Indicates the incident is a root cause of the reported problem. For
example, Node Down is a root cause problem.

General Attributes, continued

1Virtual Router Redundancy Protocol
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Attribute Description

Secondary Root Cause – Indicates the Incident is related to Root Cause, but is
not the primary problem. Secondary Root Cause Incidents are the Child Incidents of
Parent Incidents and often begin as primary Root Cause incidents.Whenever a
primary Root Cause Incident is correlated under another Incident, its Correlation
Nature becomes Secondary Root Cause. Click here for more information.

For example, if an Interface Down incident is followed by aNode Down Incident
on a neighboring device, the Interface Down Incident becomes a Child Incident to
the Parent Node Down incident. Its Correlation Nature becomes Secondary Root
Cause.

Use the All Incidents view to examine both Secondary Root Cause and primary
Root Cause Incidents. Use the Root Cause view to see only the primary Root
Cause Incidents. In the Root Cause Incidents view, any Secondary Root Cause
Incident is correlated under its associated primary Root Cause Incident.

Symptom – Indicates any incidents that were generated from a trap notification
related to the root cause incident. For example, a Link Down incident generated
from a Link Down trap notificationmight appear as aSymptom to an Interface
Down incident in the root cause incidents view.

Service Impact - Indicates a relationship between incidents in which a network
service is affected by other incidents. For example, an Interface Down incident
can affect a Router Redundancy Group that is part of an HSRP service. This
Correlation Nature is available for use by HP Network NodeManager i Software
Smart Plug-ins (iSPIs). See "Help for Administrators" for more information
about NNM iSPIs.

Stream Correlation –Used in NNMi 8.xx only. Stream correlations are created
as NNMi analyzes events and traps to determine the root cause incident for a
problem. Examples of stream correlations include Dedup (duplication of events)
and Rate (occurrence of events by time).

None – Indicates there is no incident correlation for the incident.

Info – Indicates the incident is informational only.

Dedup Stream Correlation – Stream correlations are created as NNMi
analyzes events and traps to determine the root cause incident for a problem.
Dedup Stream Correlation indicates the Incident is a Deduplication Incident.
Click here for more information.

     Deduplication Incident configurations determine what values NNMi shouldmatch
to detect when an Incident is a duplicate. Duplicate Incidents are listed under a
Duplicate Correlation Incident. NNMi tracks the number of duplicates
generated. This value is captured as the Duplicate Count attribute and is
incremented on the Duplicate Correlation Incident.

General Attributes, continued
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Attribute Description

Rate Stream Correlation – Stream correlations are created as NNMi analyzes
events and traps to determine the root cause incident for a problem. Rate
Stream Correlation indicates the Incident is a Rate Incident.Click here for more
information.

     Rate Incidents track incident patterns based on the number of incident
reoccurrences within a specified time period. After the count within the specified
time period is reached, NNMi emits a Rate Correlation Incident and continues to
update the Correlation Notes with the number of occurrences within that rate.

Note: The icons are only in table views.

Duplicate
Count

Lists the number of duplicate incidents that NNMi encountered for the selected
incident. This number increments in the associated deduplication incident that
NNMi generates to inform the operator of incidents needing attention. The incidents
are reoccurring according to the deduplication criteria specified in the incident's
deduplication configuration.

For example, by default, incidents generated from SNMP traps will not have their
deduplication count incremented. If the NNMi administrator defines a deduplication
criteria for the SNMP trap, NNMi generates an incident specifying that the
SNMP trap is reoccurring according to the criteria specified in the incident's
associated deduplication configuration. This incident is the one that increments and
displays theDuplicate Count value.

Note the following:

l By default, NNMi updates theDuplicate Count every 30 seconds. This interval
cannot be changed.

l NNMi continues to update the duplicate count regardless of an incident's
Lifecycle State. For example, if an incident's Lifecycle State is set to
Closed, the duplicate count continues to be incremented. See "About the
Incident Lifecycle" (on page 326) for more information. This behavior helps you
identify situations in which the incident is not yet fixed. Take note if the
Duplicate Count is incremented after a lengthy time period has elapsed; this
might indicate there is a new problem with the node, interface, or address.

l Duplicates are configured by the NNMi administrator using theSNMP Trap
Configuration, Remote NNM 6.x/7.x Event Configuration, orManagement
Event Configuration form available from theConfiguration workspace.

RCA
Active

Used by NNMi to identify whether NNMi considers the incident to be active or
inactive. If set to True, the incident is considered to be active. If set to False, the
incident is considered to be inactive.

NNMi considers an incident to be active when the root cause analysis (RCA)
engine is actively evaluating the problem reported by this incident.

NNMi considers an incident to be inactive when NNMi confirmed that the problem
reported by this incident is no longer a problem. For example, the device is now

General Attributes, continued
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Attribute Description

functioning properly.

NNMi initially sets an incident's RCA Active attribute to True and the incident's
Lifecycle State to Registered. When NNMi sets theRCA Active attribute to
False, it also sets the incident's Lifecycle State to Closed.

Examples of when an incident's RCA Active attribute is set to False include:

l When an interface goes up, NNMi closes the InterfaceDown incident.

l When a node goes up, NNMi closes the NodeDown incident.

Cor-
relation
Notes

Stores notes about the correlation status of the incident.

NNMi provides the following information in theCorrelation Notes field when it sets
an incident's Lifecycle State to Closed:

l The Conclusion information identifying the reason NNMi changed the incident's
Lifecycle State to Closed. For example, NNMi might include an Interface Up
Conclusion as the reason an Interface Down incident was closed.

Click here for more information about possible Conclusions that cause Down
incidents to be closed.

Down Incident
Conclusion Reason for Closing
the Down Incident

AddressNotResponding AddressResponding

BufferOutOfRangeOrMalfunctioning BufferInRangeAndFunctioning

ConnectionDown ConnectionUp

CpuOutOfRangeOrMalfunctioning CpuInRangeAndFunctioning

CustomPollCritical CustomPollNormal

CustomPollMajor CustomPollNormal

CustomPollMinor CustomPollNormal

CustomPollWarning CustomPollNormal

FanOutOfRangeOrMalfunctioning FanInRangeAndFunctioning

InterfaceDisabled InterfaceEnabled

InterfaceDown InterfaceUp

MemoryOutOfRangeOrMalfunctioning MemoryInRangeAndFunctioning

Down Incidents and Conclusion Reasons for Closing the Down
Incidents

General Attributes, continued
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Attribute Description

Down Incident
Conclusion Reason for Closing
the Down Incident

NodeDown NodeUp

NodeOrConnectionDown NodeUp

NonSNMPNodeUnresponsive NodeUp

Pow-
erSupplyOutOfRangeOrMalfunctioning

Pow-
erSupplyInRangeAndFunctioning

VoltageOutOfRangeOrMalfunctioning VoltageInRangeAndFunctioning

Tem-
peratureOutOfRangeOrMalfunctioning

Tem-
peratureInRangeAndFunctioning

Down Incidents and Conclusion Reasons for Closing the Down
Incidents, continued

Click here for additional information if you have NNMi Advanced.

Down Incident Conclusion

AggregatorDegraded AggregatorUp

AggregatorDown AggregatorUp

AggregatorLinkDegraded AggregatorLinkUp

AggregatorLinkDown AggregatorLinkUp

RrgMultiplePrimary RrgOnePrimary

RrgMultipleSecondary RrgOneSecondary

RrgMultipleSecondary RrgManyExpectedSecondary

RrgNoPrimary RrgOnePrimary

RrgNoSecondary RrgOneSecondary

RrgNoSecondary RrgManyExpectedSecondary

Down Incidents and Conclusion Reasons for Closing the Down
Incidents (NNMi Advanced)

Click here for additional information if you have HP Network NodeManager iSPI
Performance for Metrics Software.

General Attributes, continued
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Attribute Description

Down Incident Conclusion

InterfaceInputDiscardRateHigh InterfaceInputDiscardRateNominal

InterfaceInputErrorRateHigh InterfaceInputErrorRateNominal

InterfaceInputUtilizationHigh InterfaceInputUtilizationNominal

InterfaceInputUtilizationLow InterfaceInputUtilizationNormal

InterfaceInputUtilizationNone InterfaceInputUtilizationNominal

InterfaceOutputDiscardRateHigh InterfaceOutputDiscardRateNominal

InterfaceOutputErrorRateHigh InterfaceOutputErrorRateNominal

InterfaceOutputUtilizationHigh InterfaceOutputUtilizationNominal

InterfaceOutputUtilizationLow InterfaceOutputUtilizationNominal

InterfaceOutputUtilizationNone InterfaceOutputUtilizationNominal

InterfacePerformanceCritical InterfacePerformanceClear

InterfacePerformanceWarning InterfacePerformanceClear

Down Incidents and Conclusion Reasons for Closing the Down
Incidents (HP Network Node Manager iSPI Performance for
Metrics Software)

l The timemeasured between when NNMi detected a problem with one or more
network devices to the time the problem was resolved.

l The time when NNMi first detected the problem associated with the incident.

l The time when NNMi determines the problem associated with the incident is
resolved.

NNMi inserts the information in front of any existing information provided.

Note: NNMi provides Correlation Notes information only when the Causal Engine
has analyzed and Closed the incident. Software that is integrated with NNMi
might also provide information identifying the reason an incident was closed.
Any time an incident is closedmanually (for example, by the network
operator), NNMi does not provide Correlation Notes information.

First
Occur-
rence
Time

Used when suppressing duplicate incidents or when specifying an incident rate.
Indicates the time when the duplicate or rate criteria were first met for a set of
duplicate incidents or for a set of incidents that has a rate criteria that was met.

Last
Occur-

Used when suppressing duplicate incidents or specifying an incident rate. Indicates
the time when the duplicate or rate criteria were last met for a set of duplicate

General Attributes, continued
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Attribute Description

rence
Time

incidents or for a set of incidents that has a rate criteria that was met.

If there are no duplicate incidents or incidents that have a rate criteria that weremet,
this date is the same as the First Occurrence Time.

Origin
Occur-
rence
Time

The time at which an event occurred that caused the incident to be created; for
example, the time held in the trap.

General Attributes, continued

Incident Form: Correlated Parents Tab
The "Incident Form" (on page 300) provides details for troubleshooting purposes.

For information about each tab:

Attribute Description

Correlated
Parents

If the current incident is a child incident, any correlated parent incidents of the child
appears in this table view. For example, parent incidents are created when a root
cause problem is detected. A Node Down root cause incident is a parent of an
Interface Down incident. Therefore, on an Interface Down Incident form, a Node
Down incident might appear under the Correlated Parents tab.

Double-click the row representing an incident. The Incident Form displays all details
about the selected incident.

Correlated Parents Table

Incident Form: Correlated Children Tab
The "Incident Form" (on page 300) provides details for troubleshooting purposes.

For information about each tab:

Attribute Description

Correlated
Children

If the current incident is a parent incident, any correlated child incident of the parent
appears in this table view. For example, an Interface Down incident would be
correlated as a child under a Node Down root cause incident. Therefore, on a Node
Down incident form, an Interface Down incident would appear on the Correlated
Children tab.

Double-click the row representing an incident. The Incident Form displays all details
about the selected incident.

Correlated Children Table

Incident Form: Custom Attributes Tab
The "Incident Form" (on page 300) provides details for troubleshooting purposes.

For information about each tab:
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(NNMi Advanced - Global Network Management feature) The NNMi administrator for the Global
Manager can configure Custom Incident Attributes in addition to the ones that appear on the
Regional Manager. If you are an NNMi administrator, see Enrich Incident Configurations for more
information.

Attribute Description

Custom
Incident
Attributes

Used by NNMi to add additional information to the incident that NNMi makes
available for viewing. Each CIA includes a name, type, and value group that can be
populated differently for different types of incidents. Varbind values that accompany
SNMP traps are a common use for this attribute.

Double-click the row representing the Custom Incident Attribute that has the
"Custom Incident Attribute Form" (on page 312) you want to see. For more
information, see "Custom Incident Attributes Provided by NNMi" (on page 313).

Custom Attributes Table

Custom Incident Attribute Form

The Custom Incident Attributes (CIAs) form provides extended information that NNMi gathered
about the incident. For example, if the incident is reporting an SNMP trap, the Varbind values are
stored as CIAs. Each CIA includes a name, type, and value group that can be populated differently
for different types of incidents.

(NNMi Advanced - Global Network Management feature) The NNMi administrator for the Global
Manager can configure Custom Incident Attributes in addition to the ones that appear on the
Regional Manager. If you are an NNMi administrator, see Enrich Incident Configurations for more
information.

To view custom incident attribute information:

1. Navigate to the Incident form.
a. From the workspace navigation panel, select the Incidentsworkspace.

b. Select the incident view that contains the incident of interest; for example, Root Cause
Incidents.

c. To open the Incident form, double-click the row representing an incident. The "Incident
Form" (on page 300) displays all details about the selected incident.

2. In the Incident form, select theCustom Attributes tab.

3. Double-click the row representing the Custom Incident Attribute (CIA) of interest.

See the table below for an explanation of the Name, Type, and Value attributes displayed.

Note: All varbind values are stored as CIAs in NNMi.

Attribute Description

Name Name used to identify the CIA.

The Custom Incident Attribute (CIA) name limit is 80 characters. If this limit is
exceeded, NNMi truncates the value from the left.

Custom Incident Attributes
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Attribute Description

For SNMP traps and events forwarded from NNM 6.x or 7.x management stations,
the name is the object identifier (oid) of the forwarded trap or event.

Note: If different varbinds have the same oid, NNMi appends a number to the original
oid; for example: .1.2.3.4.5.6.2.7.1_1 and .1.2.3.4.5.6.2.7.1_2

Type Describes the type of data that is stored for the CIA. Examples of types include:

Double - Used to describe real numbers; for example 12.3

Integer - Used for integer numeric values; for example 1, 2, or 3

String - Used for character values

Boolean - Used to store true or false values

Note: All SNMP trap and NNM 6.x or 7.x management station events types begin
with asn. If the CIA represents a varbind value, NNMi might provide additional
types, such as Counter.

Value For SNMP traps and events forwarded from anNNM 6.x or 7.x management station,
the CIA value is the varbind value in the forwarded event or trap. For management
events that are generated from NNMi, this value is the CIA value in the incident that
was provided by NNMi.

The Custom Incident Attribute value limit is 2000 characters. If this limit is exceeded,
NNMi truncates the value from the right.

Custom Incident Attributes, continued

Related Topics:

"Custom Incident Attributes Provided by NNMi" (on page 313)

Custom Incident Attributes Provided by NNMi

NNMi uses custom incident attributes to attach additional information to incidents.

A subset of CIAs are available for any particular incident. Any relevant CIAs are displayed on the
"Incident Form" (on page 300), in the Custom Attributes tab. There are two categories of possible
CIAs: 

l SNMP trap varbinds identified by the Abstract Syntax Notation value (ASN.1).Varbinds are
defined inMIB files that the NNMi administrator can load into NNMi.

l Custom incident attributes provided by NNMi.

Some of the potential custom incident attributes provided by NNMi are described in the table below.
If you are an NNMi administrator, also see Custom Incident Attributes Provided by NNMi (for
Administrators).
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Name Description

cia.address SNMP agent address.

cia.eventoid NNM 6.x/7.x object identifier (oid) for the incident.

cia.incidentDurationMs The timemeasured inmilliseconds between when NNMi
detected a problem with one or more network devices to the time
the problem was resolved.

Note: This CIA is used only when NNMi's Causal Engine has
analyzed and Closed the incident. Any time an incident is
closedmanually (for example, by the network operator),
NNMi does not include cia.incidentDurationMs.

cia.reasonClosed The Conclusion information identifying the reason NNMi changed
the incident's Lifecycle State to Closed. For example, NNMi
might include an Interface UpConclusion as the reason an
Interface Down incident was closed.

Note: This CIA is used when NNMi's Causal Engine has
analyzed and Closed the incident. Software that is
integrated with NNMi might also provide values for
cia.reasonClosed. Any time an incident is closedmanually 
(for example, by the network operator), NNMi does not
include cia.reasonClosed.

cia.remotemgr Hostname or IP address of the either of the following:

l NNM 6.x or 7.x management station that is forwarding the
event

l (NNMi Advanced - Global Network Management feature)
NNMi Regional Manager that is forwarding the event

cia.remotetopoid Topology identifier (topoid) of the NNM 6.x or 7.x event

cia.snmpoid SNMP trap object identifier.

cia.timeIncidentDetectedMs The timestamp inmilliseconds when NNMi first detected the
problem on the network device associated with the incident.

Note: This CIA is used only when NNMi's Causal Engine has
analyzed and Closed the incident.. Any time an incident is
closedmanually (for example, by the network operator),
NNMi does not include cia.timeIncidentDetectedMs.

cia.timeIncidentResolvedMs The time when NNMi determines the problem on the network
device associated with the incident is resolved.

Note: This CIA is used only when NNMi's Causal Engine has
analyzed and Closed the incident. Any time an incident is
closedmanually (for example, by the network operator),
NNMi does not include cia.timeIncidentResolvedMs.

Custom Incident Attributes Provided by NNMi
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(HP Network NodeManager iSPI Performance for Metrics Software) For network performance
monitoring, additional custom incident attributes are provided for your use. Click here for more
information.

Name Description

cia.thresholdReason (HP Network NodeManager iSPI Performance for Metrics
Software) Configured thresholds have a value of null.

Unset thresholds have a value of No threshold settings
defined.

cia.thresholdParameter (HP Network NodeManager iSPI Performance for Metrics
Software) Themonitored attribute that is beingmeasured.

Possible performance threshold values for Nodes include:

l CPU 5Sec Utilization

Percentage of CPU usage in relation to the total amount of
CPU available. This percentage is measure at 5-second
intervals.

l CPU 1Min Utilization

Percentage of CPU usage in relation to the total amount of
CPU available. This percentage is measured at 1-minute
intervals.

l CPU 5Min Utilization

Percentage of CPU usage in relation to the total amount of
CPU available. This percentage is measured at 5-minute
intervals.

l Memory Utilization

Percentage of memory usage in relation to the total amount
of memory available.

l Buffer Utilization

Percentage of buffer usage in relation to the total amount of
buffer space available.

l Buffer Miss Rate

Counter indicating that the number of available buffers in
the pool has dropped below theminimum level.

l Buffer Failure Rate

Percentage value based on the number of buffer failures
caused by insufficient memory when trying to create
additional buffers.

Possible performance thresholds for Interfaces include:

Custom Incident Attributes Provided for Thresholding (HP Network Node
Manager iSPI Performance for Metrics Software)
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Name Description

l Input Utilization

The total number of incoming octets traversing the interface
as a percentage of the total possible number of octets
(based on the ifSpeed value). From Interface to Interface,
the exact MIB variables queried vary based on interface
speed and whether the system supports the high speed
counters for interfaces.

Each interface in an Interface Groups has its utilization
calculated by taking the total traffic on all administratively
up interfaces in the group and dividing that by the total
possible bandwidth.

l Output Utilization

The total number of outbound octets traversing the
interface as a percentage of the total possible number of
octets (based on the ifSpeed value). From Interface to
Interface, the exact MIB variables queried vary based on
interface speed and whether the system supports the high
speed counters for interfaces.

Each interface in an Interface Group has its utilization
calculated by taking the total traffic on all administratively
up interfaces in the group and dividing that by the total
possible bandwidth.

l Input Error Rate

Percentage based on the reported change in the number of
input packets on the interface and the packet error count.
What constitutes an error is system specific, but likely
includes such issues as bad packet checksums, incorrect
header information, and runt packets.

l Output Error Rate

Percentage based on the reported change in the number of
incoming packets with errors as a percentage of total
incoming packets. What constitutes an error is system
specific, but likely includes such issues as collisions and
buffer errors.

l Input Discard Rate

Percentage based on the reported change in the number of
input packets on the interface and the discarded packet
count. Packets might be discarded because of a variety of
issues, including receive buffer overflows, congestion, or

Custom Incident Attributes Provided for Thresholding (HP Network Node Manager
iSPI Performance for Metrics Software), continued
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Name Description

system specific issues.

l Output Discard Rate

Percentage based on the reported change in the number of
output packets on the interface and the discarded packet
count. Packets might be discarded because of a variety of
issues, including transmission buffer overflows,
congestion, or system specific issues.

The NNMi administrator selects these values when
configuring performance thresholds.

cia.thresholdLowerBound (HP Network NodeManager iSPI Performance for Metrics
Software) The configured value for the low performance
threshold.

cia.thresholdUpperBound (HP Network NodeManager iSPI Performance for Metrics
Software) The configured value for the high performance
threshold.

cia.thresholdPreviousValue (HP Network NodeManager iSPI Performance for Metrics
Software) Results from the previous Performance Polling
Interval. For example, the performance threshold results for
the Input Error Ratemight change from Nominal toHigh,
based on a change in the thresholdMeasuredValue. See
Interface Form for a complete list of possible values.

cia.thresholdCurrentValue (HP Network NodeManager iSPI Performance for Metrics
Software) Results from themost recent Performance Polling
Interval. For example, High. See Interface Form for a
complete list of possible values.

cia.thresholdMeasuredValue (HP Network NodeManager iSPI Performance for Metrics
Software) Themost recent measurement for the performance
threshold. HP Network NodeManager iSPI Performance for
Metrics Softwaremonitors this measurement for threshold
violations. This measurement is the average of all
measurements taken during the last polling interval
(determined by the NNMi State Poller).

cia.thresholdMeasurementTime (HP Network NodeManager iSPI Performance for Metrics
Software) The time at which the threshold was reached for a
performance threshold. For example, if the threshold for the
Input Error Rate is 6.0, and the thresholdMeasuredValue is
6.0, the time at which the thresholdMeasuredValue become
equal to 6.0 is stored in this custom incident attribute. The time
appears in ISO 8601 format.

Custom Incident Attributes Provided for Thresholding (HP Network Node Manager
iSPI Performance for Metrics Software), continued
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Related Topics

"Custom Incident Attribute Form" (on page 312)

Incident Form: Diagnostics Tab (NNM iSPI NET)
The "Incident Form" (on page 300) provides details for troubleshooting purposes.

For information about each tab:

Attribute Description

List of
Diagnostics

The history of all the HP Network NodeManager iSPI Network Engineering
Toolset Software Diagnostic reports that have been run for the incident's Source
Node. Diagnostics are sets of automated commands specific to one or more
device types, including Cisco routers and switches, Cisco switch/routers, and
Nortel switches.

To generate a new instance of these Diagnostics reports, click Actions→Run
Diagnostics (iSPI NET only).

Tip: You can right-click any object in a table or map view to access the
Actionsmenu.

Double-click the row representing a Diagnostic report. NNMi displays all details
about the selected report. See "Incident Diagnostic Results Form (Flow Run
Result) (NNM iSPI NET)" (on page 318).

Diagnostics Table

Incident Diagnostic Results Form (Flow Run Result) (NNM iSPI NET)

HP Network NodeManager iSPI Network Engineering Toolset Software automatically prepares
diagnostic reports when certain incidents are generated and when usingActions→Run
Diagnostics (iSPI NET only). This form shows details about the currently selected diagnostic
report instance.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Note: Because the values on this form are generated by NNM iSPI NET, these attribute values
cannot bemodified.

See "Incident Form: Diagnostics Tab (NNM iSPI NET)" (on page 318) for more information:

Attribute Description

Start
Time

Date and time NNM iSPI NET created this instance of the Diagnostics report. NNM
iSPI NET uses the locale of the client and the date and time from the NNMi
management server.

Definition The name of the flow as defined in NNM iSPI NET.

 Diagnostic Results Details
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Attribute Description

Status The current status of this NNM iSPI NET Diagnostics report. Possible values
include:

New - The Diagnostic is in the queue, but is not yet running

In Progress -The Diagnostic has been submitted and is not finished running

Completed - The Diagnostic has finished running

Not Submitted - An error condition prevented the Diagnostic from being submitted

Timed Out - NNMi was unable to submit or run the Diagnostic due to a time out
error. The time out limit for submitting a Diagnostic is one hour. The time out limit
for running a Diagnostic is four hours.

Example error conditions include the following:

l The number of Diagnostics in the queuemight prevent NNMI from submitting the
Diagnostic.

l A configuration error, such as an incorrect user name or password, might prevent
NNMi from accessing the required Operations Orchestration server.

Contact your NNMi administrator for Diagnostic log file information.

Report NNM iSPI NET uses this text string to display the selected instance of the
diagnostics report in a browser window.

Click this link to open the actual report.

Note: Youmight be prompted to provide a user name and password to access the
Operations Orchestration software. See theNNM iSPI NET Planning and
Installation Guide for more information.

Lifecycle
State

Incident Lifecycle State of the target Incident.

If the incident's Lifecycle Statematches the value specified here, the Diagnostic
runs.

The Diagnostic automatically runs on each applicable Source Node in the specified
NodeGroup if the incident has the Lifecycle State currently configured in this
attribute of the Diagnostic (Flow Definition - set of automated commands).

Last
Update
Time

Date and time NNM iSPI NET last updated this instance of the Diagnostics report.
NNM iSPI NET uses the locale of the client and the date and time from the NNMi
management server.

 Diagnostic Results Details, continued

Incident Form: Registration Tab
The "Incident Form" (on page 300) provides details for troubleshooting purposes.

For information about each tab:
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Attribute Description

Created Date and time the selected object instance was created. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNMi uses the locale of the
client and the date and time from the NNMi management server.

Registration Attributes

Attribute Description

ID The UniqueObject Identifier, which is unique within the NNMi database.

UUID The Universally UniqueObject Identifier, which is unique across all databases.

Object Identifiers Attributes

Manage Incident Assignments
One of the first things to do with an incident is to assign it to yourself or to another operator. The
following table displays the ways you can assign or un-assign an incident and the NNMi user role
that is required for each.
Note: If a node is deleted, only an NNMi administrator can view the incidents associated with that
node.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Task How
Required Minimum
NNMi User Role

Own an
incident

Select an incident and useActions→Assign→Own
Incident. See "Own Incidents" (on page 321) for more
information.

Level 1 Operator

(with less access
privileges than Level
2 Operators)

Assign an
incident to
someone else

There are two ways to assign an incident to someone
else (see "Assign Incidents" (on page 321) for more
information):

l From any Incident view, select one or more Incidents
and useActions→Assign→Assign Incident.

l From an Incident form, useActions→Assign→
Assign Incident.

Level 1 Operator

Un-assign an
incident

Select an incident and useActions→Assign→
Unassign Incident. See "Unassign Incidents" (on page
322) for more information.

Level 1 Operator

Tasks Related to Assigning Incidents
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Own Incidents
NNMi lets you own incidents. When you specify that you want to own an incident, the incident is
assigned to you.

To own one or more incidents:

1. Navigate to the incident view of interest.

a. From the workspace navigation panel, select the Incident Management or Incident
Browsingworkspace.

b. Select the incident view of interest; for exampleUnassigned Open Key Incidents.

2. Press CTRL-Click and select each row that represents an incident you want to own.

3. Select Actions→Assign→Own Incident.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Your user name appears in theAssigned To column in any incident views that include the incident.

Note: If you are using theUnassigned Open Key Incidents view, the incident is removed from
the view because it is no longer unassigned.

As an operator you are able to view incidents assigned to yourself and to others. If you want to view
only those incidents assigned to or owned by you, use theMy Open Incidents view. See "My
Open Incidents View" (on page 335) for more information.

Assign Incidents
If you are an NNMi user with a Level 1 Operator (with less access privileges than Level 2
Operators), Level 2 Operator, or Administrator role, you can assign an incident to yourself or to
another operator. If the incident is already assigned to another operator, you can change the
assignment or unassign the incident.

Note: Make sure an operator can access the incidents that are assigned to him or her. See "Node
and Incident Access" (on page 18) for more information.

To assign or change assignment for one incident:
1. Navigate to the Incident form of interest.

a. From the workspace navigation panel, select the Incident Management or Incident
Browsingworkspace.

b. Select any Incident view.

c. Select the row representing the incident you want to assign.

2. Select Actions→Assign→Assign Incident.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

3. Select the user name.
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4. Click Save to save your changes or  Save and Close to save your changes and exit
the form..

The user name you entered or selected appears in theAssigned To column in any Incident views
that include that incident.

Note: If you are using theUnassigned Open Key Incidents view, the incident is removed from
the view because it is no longer unassigned. See "UnassignedOpen Key Incidents View" (on
page 338) for more information.

To assign or change assignment for multiple incidents:
1. Navigate to the Incident view of interest.

a. From the workspace navigation panel, select the Incident Management or Incident
Browsingworkspace.

b. Select any Incident view.

2. Press CTRL-Click and select each row that represents an incident you want to assign.

3. Select Actions→Assign→Assign Incident.

4. Select the user name.

The user name you selected appears in theAssigned To column in any Incident views that include
those incidents.

Note: If you are using theUnassigned Open Key Incidents view, the incident is removed from
the view because it is no longer unassigned. See "UnassignedOpen Key Incidents View" (on
page 338) for more information.

Unassign Incidents
If you are an NNMi user with a user role of Level 1 Operator (with less access privileges than Level
2 Operators), Level2 Operator, or Administrator, you can unassign an incident for yourself or for
another user.

To unassign one Incident:
1. Navigate to the incident form of interest.

a. From the workspace navigation panel, select the Incident Management or Incident
Browsingworkspace.

b. Select any incident view.

c. Select the row representing the incident you want to unassign.

2. Select Actions→Assign→Unassign Incident.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

3. Click Save to save your changes or Save and Close to save your changes and exit the
form..

TheAssigned To column is empty in any incident views that include that incident.
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Note: The incident is added to theUnassigned Open Key Incidents view. See "Unassigned
Open Key Incidents View" (on page 338) for more information.

To unassign multiple Incidents:
1. Navigate to the incident view of interest.

a. From the workspace navigation panel, select the Incident Management or Incident
Browsingworkspace.

b. Select any incident view.

2. Press CTRL-Click and select each row that represents an incident you want to unassign.

3. Select Actions→Assign→Unassign Incident.

TheAssigned To column is empty in any incident views that include that incident.

Note: The incident is added to theUnassigned Open Key Incidents view. See "Unassigned
Open Key Incidents View" (on page 338) for more information.

Keep Your Incidents Up to Date
NNMi provides theNotes attribute to help you keep your incident information up-to-date. Use the
Notes field to explain steps that were taken to date to troubleshoot the problem, workarounds,
solutions, and ownership information.

Note: If a node is deleted, only an NNMi administrator can view the incidents associated with that
node.

To update an incident:

1. If you do not have an incident open, from theWorkspace navigation panel, select the incident
view you want to open; for exampleOpen Key Incidents.

2. From the incident view, open the incident you want to update.

3. Type the annotations that you want to be displayed within theNotes field. Type amaximum of
255 characters. Alpha-numeric, spaces, and special characters (~ ! @ # $ % ̂  & * ( ) _+ -) are
permitted.

4. If you needmore space to type in your information, click theNotes label, and type the
information into the window that appears.

5. From themainmenu, click Save to save your changes or Save and Close to save your
changes and exit the form.

You also want to keep your incident Lifecycle State information up-to-date. See "Track an
Incident's Progress" (on page 328) for more information.

NNMi provides the following information in theCorrelation Notes field when it sets an incident's
Lifecycle State to Closed:

l The Conclusion information identifying the reason NNMi changed the incident's Lifecycle State
to Closed. For example, NNMi might include an Interface UpConclusion as the reason an
Interface Down incident was closed.

Click here for more information about possible Conclusions that cause Down incidents to be
closed.
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Down Incident
Conclusion Reason for Closing the Down
Incident

AddressNotResponding AddressResponding

BufferOutOfRangeOrMalfunctioning BufferInRangeAndFunctioning

ConnectionDown ConnectionUp

CpuOutOfRangeOrMalfunctioning CpuInRangeAndFunctioning

CustomPollCritical CustomPollNormal

CustomPollMajor CustomPollNormal

CustomPollMinor CustomPollNormal

CustomPollWarning CustomPollNormal

FanOutOfRangeOrMalfunctioning FanInRangeAndFunctioning

InterfaceDisabled InterfaceEnabled

InterfaceDown InterfaceUp

MemoryOutOfRangeOrMalfunctioning MemoryInRangeAndFunctioning

NodeDown NodeUp

NodeOrConnectionDown NodeUp

NonSNMPNodeUnresponsive NodeUp

PowerSupplyOutOfRangeOrMalfunctioning PowerSupplyInRangeAndFunctioning

VoltageOutOfRangeOrMalfunctioning VoltageInRangeAndFunctioning

TemperatureOutOfRangeOrMalfunctioning TemperatureInRangeAndFunctioning

Down Incidents and Conclusion Reasons for Closing the Down Incidents

Click here for additional information if you have NNMi Advanced.

Down Incident Conclusion

AggregatorDegraded AggregatorUp

AggregatorDown AggregatorUp

AggregatorLinkDegraded AggregatorLinkUp

AggregatorLinkDown AggregatorLinkUp

RrgMultiplePrimary RrgOnePrimary

Down Incidents and Conclusion Reasons for Closing the Down Incidents
(NNMi Advanced)
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Down Incident Conclusion

RrgMultipleSecondary RrgOneSecondary

RrgMultipleSecondary RrgManyExpectedSecondary

RrgNoPrimary RrgOnePrimary

RrgNoSecondary RrgOneSecondary

RrgNoSecondary RrgManyExpectedSecondary

Down Incidents and Conclusion Reasons for Closing the Down Incidents (NNMi
Advanced), continued

Click here for additional information if you have HP Network NodeManager iSPI Performance
for Metrics Software.

Down Incident Conclusion

InterfaceInputDiscardRateHigh InterfaceInputDiscardRateNominal

InterfaceInputErrorRateHigh InterfaceInputErrorRateNominal

InterfaceInputUtilizationHigh InterfaceInputUtilizationNominal

InterfaceInputUtilizationLow InterfaceInputUtilizationNormal

InterfaceInputUtilizationNone InterfaceInputUtilizationNominal

InterfaceOutputDiscardRateHigh InterfaceOutputDiscardRateNominal

InterfaceOutputErrorRateHigh InterfaceOutputErrorRateNominal

InterfaceOutputUtilizationHigh InterfaceOutputUtilizationNominal

InterfaceOutputUtilizationLow InterfaceOutputUtilizationNominal

InterfaceOutputUtilizationNone InterfaceOutputUtilizationNominal

InterfacePerformanceCritical InterfacePerformanceClear

InterfacePerformanceWarning InterfacePerformanceClear

Down Incidents and Conclusion Reasons for Closing the Down Incidents (HP
Network Node Manager iSPI Performance for Metrics Software)

l The timemeasured between when NNMi detected a problem with one or more network devices
to the time the problem was resolved.

l The time when NNMi first detected the problem associated with the incident.

l The time when NNMi determines the problem associated with the incident is resolved.

NNMi inserts the information in front of any existing information provided.

Note: NNMi provides Correlation Notes information only when the Causal Engine has analyzed and
Closed the incident. Software that is integrated with NNMi might also provide information
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identifying the reason an incident was closed. Any time an incident is closedmanually (for
example, by the network operator), NNMi does not provide Correlation Notes information.

About the Incident Lifecycle
NNMi provides the Lifecycle State attribute to help you track an incident's progress (see the
Lifecycle State information for the Incident form for more information). See also "Track an Incident's
Progress" (on page 328).

In some cases, NNMi updates an incident's Lifecycle State for you. For example, NNMi initially
sets an incident's Lifecycle State to Registered. It also sets an incident's Lifecycle State to
Closed. NNMi considers an incident to beClosedwhenNNMi has confirmed that the problem
reported by this incident is no longer a problem. For example, the device is now functioning
properly. Examples of when NNMi sets an incident Lifecycle State toClosed include:

l When an interface goes up, NNMi closes the Interface Down incident.

l When a node goes up, NNMi closes the Node Down incident.

NNMi provides the following information in theCorrelation Notes field when it sets an incident's
Lifecycle State to Closed:

l The Conclusion information identifying the reason NNMi changed the incident's Lifecycle State
to Closed. For example, NNMi might include an Interface UpConclusion as the reason an
Interface Down incident was closed.

Click here for more information about possible Conclusions that cause Down incidents to be
closed.

Down Incident
Conclusion Reason for Closing the Down
Incident

AddressNotResponding AddressResponding

BufferOutOfRangeOrMalfunctioning BufferInRangeAndFunctioning

ConnectionDown ConnectionUp

CpuOutOfRangeOrMalfunctioning CpuInRangeAndFunctioning

CustomPollCritical CustomPollNormal

CustomPollMajor CustomPollNormal

CustomPollMinor CustomPollNormal

CustomPollWarning CustomPollNormal

FanOutOfRangeOrMalfunctioning FanInRangeAndFunctioning

InterfaceDisabled InterfaceEnabled

InterfaceDown InterfaceUp

MemoryOutOfRangeOrMalfunctioning MemoryInRangeAndFunctioning

Down Incidents and Conclusion Reasons for Closing the Down Incidents
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Down Incident
Conclusion Reason for Closing the Down
Incident

NodeDown NodeUp

NodeOrConnectionDown NodeUp

NonSNMPNodeUnresponsive NodeUp

PowerSupplyOutOfRangeOrMalfunctioning PowerSupplyInRangeAndFunctioning

VoltageOutOfRangeOrMalfunctioning VoltageInRangeAndFunctioning

TemperatureOutOfRangeOrMalfunctioning TemperatureInRangeAndFunctioning

Down Incidents and Conclusion Reasons for Closing the Down Incidents, con-
tinued

Click here for additional information if you have NNMi Advanced.

Down Incident Conclusion

AggregatorDegraded AggregatorUp

AggregatorDown AggregatorUp

AggregatorLinkDegraded AggregatorLinkUp

AggregatorLinkDown AggregatorLinkUp

RrgMultiplePrimary RrgOnePrimary

RrgMultipleSecondary RrgOneSecondary

RrgMultipleSecondary RrgManyExpectedSecondary

RrgNoPrimary RrgOnePrimary

RrgNoSecondary RrgOneSecondary

RrgNoSecondary RrgManyExpectedSecondary

Down Incidents and Conclusion Reasons for Closing the Down Incidents
(NNMi Advanced)

Click here for additional information if you have HP Network NodeManager iSPI Performance
for Metrics Software.

Down Incident Conclusion

InterfaceInputDiscardRateHigh InterfaceInputDiscardRateNominal

InterfaceInputErrorRateHigh InterfaceInputErrorRateNominal

Down Incidents and Conclusion Reasons for Closing the Down Incidents (HP
Network Node Manager iSPI Performance for Metrics Software)
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Down Incident Conclusion

InterfaceInputUtilizationHigh InterfaceInputUtilizationNominal

InterfaceInputUtilizationLow InterfaceInputUtilizationNormal

InterfaceInputUtilizationNone InterfaceInputUtilizationNominal

InterfaceOutputDiscardRateHigh InterfaceOutputDiscardRateNominal

InterfaceOutputErrorRateHigh InterfaceOutputErrorRateNominal

InterfaceOutputUtilizationHigh InterfaceOutputUtilizationNominal

InterfaceOutputUtilizationLow InterfaceOutputUtilizationNominal

InterfaceOutputUtilizationNone InterfaceOutputUtilizationNominal

InterfacePerformanceCritical InterfacePerformanceClear

InterfacePerformanceWarning InterfacePerformanceClear

Down Incidents and Conclusion Reasons for Closing the Down Incidents (HP
Network Node Manager iSPI Performance for Metrics Software), continued

l The timemeasured between when NNMi detected a problem with one or more network devices
to the time the problem was resolved.

l The time when NNMi first detected the problem associated with the incident.

l The time when NNMi determines the problem associated with the incident is resolved.

NNMi inserts the information in front of any existing information provided.

Note: NNMi provides Correlation Notes information only when the Causal Engine has analyzed and
Closed the incident. Software that is integrated with NNMi might also provide information
identifying the reason an incident was closed. Any time an incident is closedmanually (for
example, by the network operator), NNMi does not provide Correlation Notes information.

Another way to help you identify those incidents closed by NNMi is by looking at the RCA Active
attribute value. When NNMi considers an incident to beClosed, it sets the RCA Active attribute
value to False. This means NNMi's root cause analysis (RCA) engine is no longer actively
evaluating the problem reported by this incident.

Note: NNMi continues to update the duplicate count regardless of an incident's Lifecycle State. For
example, if an incident's Lifecycle State is set toClosed, the Duplicate Count continues to be
incremented. This behavior helps you identify situations in which the incident is not yet fixed.
Take note if the Duplicate Count is incremented after a lengthy time period has elapsed; this
might indicate there is a new problem with the node, interface, or address.

Track an Incident's Progress
NNMi provides the Lifecycle State attribute to help you track an incident's progress. Your network
administrator might have additional or different guidelines for their use.

Possible Lifecycle State values are as follows:

Registered – Indicates that an incident arrived in the queue stored in the NNMi database.  
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In Progress – State selected by someone on your team to indicate that they are taking
responsibility for investigating the problem.

Completed – State selected by someone on your team to indicate completion of the incident
investigation and implementation of a solution.

Closed – Indicates that NNMi determined the problem reported by this Incident is no longer a
problem. For example, when you remove an interface from a device, all incidents related to the
interface are automatically Closed.

Note: NNMi does not automatically Close incidents whose Correlation Nature is Info. These
incidents aremeant to provide information regarding changes in your network that might be of
interest. You will need to Close these incidents if you do not want them to remain in your
incident queue. See "Incident Form: General Tab" (on page 303) for more information about
Correlation Nature

Dampened – Indicates that, within the configured acceptable time period, NNMi determined
the problem reported by this Incident is no longer a problem. NNMi does not submit the incident
to the queue until after the time period (configured by the NNMi administrator).

In some cases, NNMi updates an incident's Lifecycle State for you. See "About the Incident
Lifecycle" (on page 326) for more information about Lifecycle State.

You should know your guidelines for lifecycle states so that you can keep your incidents updated
accordingly.

To update your Lifecycle State, use theActions→Change Lifecyclemenu or a form.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

To update your Lifecycle State using the Actions menu from a view:

1. If you do not have an incident open, from the workspace navigation panel, select the incident
view you want to open.

2. Select the row representing the incident that has a Lifecycle State you want to change.

3. From themainmenu toolbar, select Actions→Change Lifecycle and then the Lifecycle
State you want, for example, In Progress.

To update your Lifecycle State from a form:

1. If you do not have an incident open, from the workspace navigation panel, select the incident
view you want to open.

2. From the incident view, open the incident you want to update.

Under theBasics pane, select the Lifecycle State you want from the drop-downmenu.

From themainmenu, click Save to save your changes or Save and Close to save your
changes and exit the form.

From the formmenu, select Actions and then the Lifecycle State you want. For example,
select Completed.
The action takes effect immediately. This means you do not have to select Save.
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3. After performing an action on a form that modifies the object being viewed, youmust refresh
the form before you can save any additional changes.

Display a Map from an Incident
If you are using incident views tomonitor your network, there are times when youmight want to
switch to amap view to determinemore information. For example, youmight want to view the
connectivity for a selected node.

To display a map from an incident:

1. In any table of incidents, select the incident of interest by selecting the appropriate row.

2. Select Actions→Maps→ Node Group Map in themain toolbar.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Themap displays based on the source node of the selected incident:

l This action displays the lowest level NodeGroupmap to which the Source Node belongs. For
example, if the node belongs to aChildNodeGroup, theChildNodeGroup displays.

l If the Source Node is amember of more than one NodeGroup at the lowest level, NNMi prompts
you to select the NodeGroupmap you want to display.

l If the incident is associated with an Island NodeGroup, NNMi displays the associated Island
NodeGroupmap. See "Island NodeGroupMap" (on page 331) for more information.

l If the Source Node is not amember of any NodeGroup, NNMi informs you that no NodeGroup
map is available.

Note: Your NNMi administrator sets some of management mode attribute values. The current
values of themanagement mode attributes determine whether NNMi discovers andmonitors
a node, interface, or address. Map symbols with the color set to No Status are not currently
beingmonitored.

Related Topics:

UseMap Views

"Display the Layer 2 Neighbor View" (on page 252)

"Display the Layer 3 Neighbor View" (on page 254)

"Path Between TwoNodes that Have IPv4 Addresses" (on page 256)

"NodeGroupOverview Map" (on page 248)

"Routers Map" (on page 251)

"Switches Map" (on page 251)

"Networking Infrastructure Devices Map" (on page 250)

"Display a Line Graph from an Incident (Custom Poller Only)" (on page 295)
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Island Node Group Map
An IslandGroup is a group of fully-connected nodes discovered by NNMi, and NNMi determines
this group is not connected to the rest of the topology.

An example of an environment with multiple Island NodeGroups is a financial institution or retail
store with many branches or stores. Each branch or storemight be connected to other branches or
stores with aWAN (Wide Area Network) connection. Each branch or store appears as an isolated
island of nodes in the NNMi topology.

The Island NodeGroupmap contains the Island NodeGroup that is the Source Object for the
selected incident.

Note: Incidents that have a Source Object that is an Island NodeGroup includeRemote site in the
incident message.

To display an Island Node Groups Map from an incident:

1. Select an incident view from the Incident Management or Incident Browsingworkspace.

2. Select the row representing an Island NodeGroup incident that has themap you want to
display.

3. Select Actions→Maps→Node Group Map.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Related Topics

NodeGroupMapObjects

Apply an Action to an Incident Source Node or Source
Object

If you are using incident views tomonitor your network, youmight want to apply an action from the
Actions menu to the incident Source Node or Source Object to determinemore information. NNMi
enables you to access the same actions that are available for node, interface, and IP address
objects.

Note: Only the Actions that apply to either the incident's Source Node or Source Object are
available. If the Action does not apply to either the Source Node or Source Object, the color of
that Action turns from black to gray to indicate it is unavailable.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

To access an action from an incident view:

1. Navigate to the incident view of interest (for example, Incident Browsingworkspace, Root
Cause Incidents view).

2. Select the row representing the incident of interest.

Note: Select only one incident.
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3. From the Actions menu in themain toolbar, select one of the followingmenu options:

n Node Actions

n Interface Actions

n IP Address Actions

4. Select an action that is valid for either the incident Source Node or Source Object. See Using
Actions to Perform Tasks for information about the actions available for each object type. Also
see "Investigate and Diagnose Problems" (on page 347).

NNMi performs the selected action on whichever of the following is the valid object for the
action selected:

n Incident's Source Node

n Incident's Source Object

To access an action from an incident form:

1. Navigate to the incident view of interest (for example, Incident Browsingworkspace, Root
Cause Incidents view).

2. Double-click the row representing the incident from which you want to select an action.

3. From the Actions menu in themain toolbar, select one of the following:

n Node Actions

n Interface Actions

n IP Address Actions

4. Select an action that is valid for either the incident Source Node or Source Object. See Using
Actions to Perform Tasks for information about the actions available for each object type.
Also see "Investigate and Diagnose Problems" (on page 347). 

NNMi performs the selected action on whichever of the following is the valid object for the
action selected:

n Incident's Source Node

n Incident's Source Object

Related Topics

"Display a Line Graph from an Incident (Custom Poller Only)" (on page 295)

Monitor Incidents in a Global Network Management
Environment (NNMi Advanced)

The NNMi Global Network Management feature enables multiple NNMi management servers to
work together while managing different geographic areas of your network. Each NNMi management
server discovers andmonitors a portion of the network.

Specific NNMi management servers can be designated as Global Managers and display the
combined Node object data. However, each Regional Manager maintains responsibility for
management of Nodes that were forwarded to aGlobal Manager. TheGlobal Manager generates
andmaintains an independent set of Incidents related to those Nodes. The Incidents on the Global
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Manager are generated within the context of the combined topology and using the Incident
configuration settings on theGlobal Management server.

Regional Manager administrators can intentionally forward copies of two types of incidents to the
Global Manager:

l SNMP Trap Incidents

l Remote NNM 6.x/7.x Event Incidents

On theGlobal Manager, theCustom Incident Attribute tab on the Incident form identifies if the
SNMP trap or NNM 6.x/7.x Event was forwarded and from which Regional Manager.

From any Incident view, to determine the server or servers that forwarded the incident:

1. From the workspace navigation panel, select a workspace containing a view of the incidents of
interest (for example, Incident Managementworkspace).

2. Select a view that contains the specific incident (for exampleOpen Key Incidents view).

3. Double-click the row representing an incident. The Incident Form displays all details about the
selected incident.

4. Navigate to theCustom Attributes tab.

5. In theName column of table view, look for the following value: cia.remotemgr.

n If cia.remotemgr is not listed, this means the incident was not forwarded from aNNM
6.x/7.x management station or Regional Manager.

n If cia.remotemgr appears in the list of Custom Attributes, NNMi displays the hostname
of the NNMi Regional Manager or NNM 6.x/7.x management station in the corresponding
Value column.

Note: If the trap or event has been forwarded throughmultiple servers, cia.remotemgr
includes the hostname or IP address of each forwarding server, separated by commas.
The list of servers provided in cia.remotemgr starts with the server that generated the
original SNMP trap, 6.x/7.x event, or management event incident.

Incident Views Provided by NNMi
You and your team can easily monitor the posted incidents and take appropriate action to preserve
the health of your network. To assist you, NNMi provides the following views for listing incident
information:

Note: NNMi generates informational incidents that do not appear by default in incident views.
These incidents are advisory and have a Correlation Nature of Info. To view these incidents,
create a filter for theAll Incidents view using the Correlation Nature column and select the
value Info from the enumerated list of values. See Filter a Table View for more information
about filtering table views.

l "Open Key Incidents View" (on page 337)

l "UnassignedOpen Key Incidents View" (on page 338)

l "My Open Incidents View" (on page 335)

l "Closed Key Incidents View" (on page 339)

l "Open Root Cause Incidents View"
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l "Service Impact Incidents View" (on page 341)

l "All Incidents View" (on page 342)

l "Custom Open Incidents View" (on page 343)

l "Custom Incidents View" (on page 344)

l "NNM 6.x/7.x Events View " (on page 345)

l "SNMP Traps View" (on page 346)

Themost useful views for proactively monitoring your network for problems are theKey Incident1
views (see "Key Incident Views" (on page 335)). These views include root cause incidents and their
associated symptoms.

NNMi's Causal Engine uses ICMP and SNMP to constantly monitor your network. The Causal
Engine uses the data collected from all the devices on your network to determine the root cause of
known and potential problems.

Note: TheCustom Incidents view lets you use sorting and filtering to customize additional views
while maintaining the out-of-the-box views provided by NNMi. This view includes most of the
attributes available for the incident so that you can decide which aremost important for you to
display. See Use Table Views for more information about sorting, filtering, and hiding
attributes within a view.

For each incident generated, you can view theCorrelated Parents andCorrelated Children tab
information to assist you in understanding how the problem was detected.

NNMi also enables you to access the following 6.x/7.x features by selecting only incidents
generated from 6.x/7.x events: (See "NNM 6.x/7.x Events View " (on page 345) for more
information.) You cannot access these features for any non-6.x/7.x incidents.

l Actions →NNM  6.x/7.x Neighbor View

l Actions →NNM  6.x/7.x Details

l Actions →NNM  6.x/7.x ovw

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Other useful tasks from the incident view, include the following:

l "Display aMap from an Incident" (on page 330)

l "Node Form" (on page 48)

Related Topics:

About Workspaces

About the NNMi Console

1Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
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My Open Incidents View
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in

this view's column headings.

This view is useful for identifying the incidents for which you are responsible.

TheMy Open Incidents view displays all of the open incidents that meet this criterion:

l Assigned to you.

l Lifecycle state matching any of the following:

n Registered

n In Progress

n Completed

As with all incident views, you can filter this view by time period. The default time period is Last
Week.

For each incident displayed, you can view its severity, its priority, its lifecycle state (see the
Lifecycle State information for the Incident form for more information), the date and time the incident
last occurred, the name of its source node, its source object, its category (for example, Fault or
Security), its family (for example, Interface orConnection), its origin (for example, NNMi, NNM
6.x/7.x, orSNMP Trap), its Correlation Nature (for example, Symptom orRoot Cause), the
message used to describe the incident, and any related notes.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.

See "Monitoring Incidents for Problems" (on page 298) for more information about ways to use
incident views.

Key Incident Views
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in a

key incident view's column headings.

TheKey Incident1 views are useful for identifying incidents that aremost important to the network
Operator and that often require more immediate action.

The Key Incident views display incidents that meet the following criterion:

1Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
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l Severity is other thanNormal.

l Correlation Nature is any of the following: 

Incident
Correlation
Nature Description

Root
Cause

Indicates the incident that reports the root cause of a problem.

Service
Impact

Used in NNMi 8.xx only. Indicates a relationship between incidents in which a
network service is effected by other incidents. By default, NNMi generates
Service Impact incidents for Router Redundancy Groups. For example, an
Interface Down incident can effect a Router Redundancy Group that is part of
an HSRP service. The Service Impact incident helps to identify the service that
is affected.

This Correlation Nature is available for use by HP Network NodeManager i
Software Smart Plug-ins (iSPIs). See "Help for Administrators" for more
information about NNM iSPIs.

Stream
Correlation

Used in NNMi 8.xx only. Indicates the correlations that NNMi's event pipeline
establishes as it recognizes patterns in the flow of events through the pipeline.
Correlations are created as NNMi analyzes events and traps to determine the
root cause incident for a problem. Examples of stream correlations include
Dedup (duplication of events) and Rate (occurrence of events by time)
correlations.

Rate
Stream
Correlation

Indicates the incident tracks incident patterns based on the number of incident
reoccurrences within a specified time period. After the count within the
specified time period is reached, NNMi emits a Rate Correlation incident and
continues to update the Correlation Notes with the number of occurrences
within that rate.

Info This Correlation Nature is meant to be informational.

None Indicates there is no incident correlation for this incident.

Some Key Incident views are filtered according to lifecycle state values (see the Lifecycle State
information for the Incident form for more information), which can be set by the user. 

NNMi provides the following Key Incident views filtered to display lifecycle state values of
Registered, In Progress, orCompleted:

l "Open Key Incidents View" (on page 337)

NNMi provides the following Key Incident view filtered to display lifecycle state value of Closed:

l "Open Key Incidents View" (on page 337)"Closed Key Incidents View" (on page 339)

NNMi provides the following Key Incident view filtered to display (1) lifecycle state values of
Registered, In Progress, and Completed plus (2) assigned to value equal to none:

l "UnassignedOpen Key Incidents View" (on page 338)

Related Topics
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Use Table Views

"Organize Your Incidents" (on page 300)

"Monitoring Incidents for Problems" (on page 298)

"Display aMap from an Incident" (on page 330)

Open Key Incidents View

Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in
this view's column headings.

TheOpen Key Incidents view shows the incidents that aremost important to network Operators
and that often require more immediate action. This view displays any Key Incident1 that has a
Lifecycle State value that indicates the incident has not yet been closed. This view is useful for
identifying the Key Incidents that need to be resolved. As with all incident views, you can filter this
view by time period. The default time period is Last Week so that you can view all of the Key
Incidents that have remained open within the last week.

Note: Only incidents that have a Severity other than Normal are included inKey Incident2 views.

For each incident displayed, you can view its severity, its priority, its lifecycle state (see the
Lifecycle State information for the Incident form for more information), the date and time the incident
last occurred, the name of the person to which the incident is assigned, the name of its source
node, its source object, its category (for example, Fault orSecurity), its family (for example,
Interface orConnection), its origin (for example, NNMi, NNM 6.x/7.x, orSNMP Trap), its
Correlation Nature (for example,Root Cause), themessage used to describe the incident, and
any related notes.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.

See "Monitoring Incidents for Problems" (on page 298) for more information about ways to use
incident views.

You can also access additional views from this one using the Actions menu as described in Use
Table Views. One example of an action available from an open root cause incident view is the
ability to access amap view of the nodes related to the incident.

Related Topics

Use Table Views

"Organize Your Incidents" (on page 300)

1Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
2Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
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"Monitoring Incidents for Problems" (on page 298)

"Display aMap from an Incident" (on page 330)

"Key Incident Views" (on page 335)

"UnassignedOpen Key Incidents View" (on page 338)

"Closed Key Incidents View" (on page 339)

Unassigned Open Key Incidents View

Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in
this view's column headings.

TheUnassigned Open Key Incident view displays any Key Incident1 that is open and
unassigned. This view is useful for identifying the Key Incidents that are open andmust still be
assigned to someone. As with all incident views, you can filter this view by time period. The default
time period is Last Day so that you can view all of the incidents that have remained unassigned
with the last day.

Note: Only incidents that have a Severity that is other than Normal are included in Key Incident
views.

For each incident displayed, you can view its severity, its priority, its lifecycle state (see the
Lifecycle State information for the Incident form for more information), the date and time the incident
last occurred, the name of its source node, its source object, its category (for example, Fault or
Security), its family (for example, Interface orConnection), its origin (for example, NNMi, NNM
6.x/7.x, orSNMP Trap), its Correlation Nature (for example, Root Cause), themessage used to
describe the incident, and any related notes.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.

See "Monitoring Incidents for Problems" (on page 298) for more information about ways to use
incident views.

Related Topics

Use Table Views

"Organize Your Incidents" (on page 300)

"Monitoring Incidents for Problems" (on page 298)

"Display aMap from an Incident" (on page 330)

"Key Incident Views" (on page 335)

1Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
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"Open Key Incidents View" (on page 337)

"Closed Key Incidents View" (on page 339)

Closed Key Incidents View

Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in
this view's column headings.

TheClosed Key Incidents view displays any Key Incident1 with a Life Cycle state of Closed
(see the Lifecycle State information for the Incident form for more information). This view is useful
for identifying the Key Incidents that have been resolved. This view might be particularly useful for
reporting on how many incidents were closed within a given time period.

Note: Unlike other Key incident views, the Closed Key Incidents view includes incidents that have
a Correlation Nature of Info. The InfoCorrelation Nature is meant to be informational.

As with all incident views, you can filter this view by time period. The default time period is Last
Day so that you can view all of the incidents that have a Last Occurrence Timewithin the last 24
hours. To select amore specific time range within a time period, you can filter the view using Last
Occurrence Time values.

Note: Only incidents that have a Severity that is other than Normal are included inKey Incident2
views.

For each incident displayed, you can view its severity, the date and time the incident last occurred,
to whom the incident is assigned, the name of its source node, its source object, its category (for
example, Fault orSecurity), its family (for example, Interface orConnection), its origin (for
example, NNMi, NNM 6.x/7.x, orSNMP Trap), themessage used to describe the incident, and
any related notes.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.

See "Monitoring Incidents for Problems" (on page 298) for more information about ways to use
incident views.

Related Topics:

Use Table Views

"Organize Your Incidents" (on page 300)

"Monitoring Incidents for Problems" (on page 298)

1Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
2Incidents with both: (1) Severity = other than Normal. (2) Correlation Nature = equal to Root
Cause, Service Impact, Stream Correlation, Rate Stream Correlation, Info, or None.
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"Display aMap from an Incident" (on page 330)

"Key Incident Views" (on page 335)

"Open Key Incidents View" (on page 337)

"UnassignedOpen Key Incidents View" (on page 338)

Root Cause Incidents
Tip: See "IP Address Form" (on page 153)"Incident Form" (on page 300) for more details about the

incident attributes that appear in a root cause incident view's column headings.

Root Cause Incidents identify the root cause, as well as symptoms associated with the root cause,
as determined by NNMi's Causal Engine.

The Causal Engine uses ICMP and SNMP to constantly monitor your network. NNMi's Causal
Engine uses the data collected from all the devices on your network to determine the root cause of
known and potential problems. For example, NNMi notifies you if it encounters any of the following
situations:

l "Node Down" (on page 397)

l "Interface Down" (on page 394)

l "Address Not Responding" (on page 381)

NNMi provides the "Open Root Cause Incidents View" (on page 340)

When using root cause incident views, note the following:

l Your administrator might choose to configure particular incidents so that they appear as root
cause incidents in your root cause views. To distinguish these incidents from those that NNMi
itself identifies as root cause, theCorrelation Nature value for incidents configured to be root
cause by the NNMi administrator is User Root Cause.

l Any root cause view includes incidents that have aRoot Cause value forCorrelation Nature.

See "Monitoring Incidents for Problems" (on page 298) for more information about ways to use
incident views.

Related Topics:

Use Table Views

"Organize Your Incidents" (on page 300)

"Monitoring Incidents for Problems" (on page 298)

"Display aMap from an Incident" (on page 330)

Open Root Cause Incidents View

Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in
this view's column headings. 

TheOpen Root Cause Incidents view displays the root cause incidents that have a Lifecycle
State other than Closed. This view is useful for identifying the Root Cause Incidents that need to be
resolved. As with all incident views, you can filter this view by time period. The default time period
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is Last Week so that you can view all of the Root CauseIncidents that have remained open within
the last week.

Youmight also choose to narrow your focus by filtering this information according to one or more
attribute values, such as all root cause incidents that have a Status of Critical, or all root cause
incidents that have the descriptionNode Down.

For each incident displayed, you can view its severity, its priority, its lifecycle state (see the
Lifecycle State information for the Incident form for more information), the date and time the incident
last occurred, to whom the incident is assigned, the name of its source node, its source object, its
category (for example, Fault orSecurity), its family (for example, Interface orConnection), its
origin (for example, NNMi, NNM 6.x/7.x, orSNMP Trap), themessage used to describe the
incident, and any related notes.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.

You can also access additional views from this one using the Actions menu as described in Use
Table Views. One example of an action available from an open root cause incident view is the
ability to access amap view of the nodes related to the incident.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Related Topics:

Use Table Views

"Organize Your Incidents" (on page 300)

"Monitoring Incidents for Problems" (on page 298)

"Display aMap from an Incident" (on page 330)

"UnassignedOpen Key Incidents View" (on page 338)

"Closed Key Incidents View" (on page 339)

Service Impact Incidents View
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in

this view's column headings.

TheService Impact Incidents view displays all of the incidents that have a Correlation Nature of
Service Impact. Service Impact incidents indicate a relationship between incidents in which a
network service is effected by other incidents. By default, NNMi generates Service Impact
incidents for Router Redundancy Groups. For example, an Interface Down incident can affect a
Router Redundancy Group that is part of an HSRP service. This view is useful to identify a service
that is affected. 
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Note: TheService ImpactCorrelation Nature is available for use by HP Network NodeManager i
Software Smart Plug-ins (iSPIs). See "Help for Administrators" for more information about
NNM iSPIs.

As with all incident views, you can filter this view by time period. The default time period is Last
Day so that you can view all of the Service Impact incidents that have occurred within the last 24
hours.

For each incident displayed, you can view its severity, its priority, its lifecycle state (see the
Lifecycle State information for the Incident form for more information), the date and time the incident
last occurred, to whom the incident is assigned, the name of its source node, its source object, its
category (for example, Fault orSecurity), its family (for example, Interface orConnection), the
message used to describe the incident, and any related notes.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.

See "Monitoring Incidents for Problems" (on page 298) for more information about ways to use
incident views.

All Incidents View
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in
this view's column headings.

TheAll Incidents view is useful for viewing all of the incidents generated by NNMi within the
specified time period. This view is useful to identify both Open and Closed incidents. As with all
incident views, you can filter this view by time period. The default time period is Last Day so that
you can view all of the incidents that have occurred within the last 24 hours.

For each incident displayed, you can view its severity, its priority, its lifecycle state (see the
Lifecycle State information for the Incident form for more information), the date and time the incident
last occurred, to whom the incident is assigned, the name of its source node, its source object, its
category (for example, Fault orSecurity), its Family (for example, Interface orConnection), its
origin (for example, NNMi, NNM 6.x/7.x, orSNMP Trap), its Correlation Nature (for example,
Symptom orRoot Cause), themessage used to describe the incident, and any related notes.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.
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See "Monitoring Incidents for Problems" (on page 298) for more information about ways to use
incident views.

Custom Open Incidents View
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in

this view's column headings.

TheCustom Open Incidents view lets you choose the columns of incident information for all
Open incidents, to better meet your needs. For example, youmight want to filter the view to display
only the incidents related to a particular set of devices. Youmight also want to filter the view to
display only the incidents assigned to you.

This view includes most of the attributes available for the incident so that you can decide which are
most important for you to display. See Use Table Views for more information about sorting, filtering,
and hiding attributes within a view. As with all incident views, you can filter this view by time period.
The default time period is Last Day so that you can view all of the incidents of interest that have
occurred within the last 24 hours.

For each incident displayed, you can view its severity, its priority, its lifecycle state (see the
Lifecycle State information for the Incident form for more information), the date and time the incident
last occurred, to whom the incident is assigned, the name of its source node, its source object, its
category (for example, Fault orSecurity), its family (for example, Interface orConnection), its
origin (for example, NNMi, NNM 6.x/7.x, orSNMP Trap), its Correlation Nature (for example,
Symptom orRoot Cause), themessage used to describe the incident, and any related notes. You
can also view the duplicate count to indicate any duplicate occurrences of this incident, the name of
the custom incident, an indicator of whether the NNMi root cause analysis (RCA) engine considers
this incident to be active, any Correlation Notes that exist for the incident, the date and time the first
instance of this incident occurred (if suppressing incidents), the date and time the original event that
triggered the incident occurred, the date and time the incident was created, and the date and time
the incident was last modified.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.

See Filter a Table View for more information about how to filter information displayed in a table.

See "Monitoring Incidents for Problems" (on page 298) for more information about ways to use
incident views.

See "Incident Form" (on page 300) for more information about incident attributes.

Related Topics:

Use Table Views

"Organize Your Incidents" (on page 300)

"Display aMap from an Incident" (on page 330)
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Custom Incidents View
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in

this view's column headings.

TheCustom Incidents view lets you choose the columns of incident information, to better meet
your needs. For example, youmight want to filter the view to display only the incidents related to a
particular set of devices. Youmight also want to filter the view to display only the incidents
assigned to you.

This view includes most of the attributes available for the incident so that you can decide which are
most important for you to display. See Use Table Views for more information about sorting, filtering,
and hiding attributes within a view. As with all incident views, you can filter this view by time period.
The default time period is Last Day so that you can view all of the incidents of interest that have
occurred within the last 24 hours.

For each incident displayed, you can view its severity, its priority, its lifecycle state (see the
Lifecycle State information for the Incident form for more information), the date and time the incident
last occurred, to whom the incident is assigned, the name of its source node, its source object, its
category (for example, Fault orSecurity), its family (for example, Interface orConnection), its
origin (for example, NNMi, NNM 6.x/7.x, orSNMP Trap), its Correlation Nature (for example,
Symptom orRoot Cause), themessage used to describe the incident, and any related notes. You
can also view the duplicate count to indicate any duplicate occurrences of this incident, the name of
the custom incident, an indicator of whether the NNMi root cause analysis (RCA) engine considers
this incident to be active, any Correlation Notes that exist for the incident, the date and time the first
instance of this incident occurred (if suppressing incidents), the date and time the original event that
triggered the incident occurred, the date and time the incident was created, and the date and time
the incident was last modified.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.

See Filter a Table View for more information about how to filter information displayed in a table.

See "Monitoring Incidents for Problems" (on page 298) for more information about ways to use
incident views.

See "Incident Form" (on page 300) for more information about incident attributes.

Related Topics:

Use Table Views

"Organize Your Incidents" (on page 300)

"Display aMap from an Incident" (on page 330)
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NNM 6.x/7.x Events View
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in

this view's column headings.

TheNNM  6.x/7.x Events view displays the incidents forwarded from Network NodeManager 6.x
and 7.x management stations in your network environment.

You can use this view tomonitor the health of devices beingmanaged by previous versions of
NNM, including NNM 6.x and NNM 7.x. You can also use this view to access the following 6.x/7.x
features:

l Actions→NNM 6.x/7.x Neighbor View

l Actions→NNM 6.x/7.x Details

l Actions→NNM 6.x/7.x ovw

Tip: You can right-click any object in a table or map view to access theActionsmenu.

See "Accessing NNM 6.x and 7.x Features" (on page 24) for more information.

Note: You can only access 6.x/7.x features by selecting incidents generated from 6.x/7.x events.

For each incident displayed, you can view its severity, its lifecycle state (see the Lifecycle State
information for the Incident form for more information), the date and time the incident last occurred,
the name of its source node, its category (for example, Fault orSecurity), its family (for example,
Interface orConnection), its Correlation Nature (for example, Symptom orRoot Cause), the
message used to describe the incident, and any related notes.

As with all incident views, you can filter this view by time period. The default time period is Last
Day so that you can view all of the incidents of interest that have occurred within the last 24 hours.

Syslog Messages View (HP ArcSight)
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in

this view's column headings.

The HP NNMi–ArcSight integration adds syslogmessage information to NNMi, so that you can
view these syslogmessages and investigate potential problems. After the ArcSight integration is
enabled, NNMi receives ArcSightEvent traps that contain syslogmessage data. NNMi then
maps this syslog information to a SyslogMessage incident configuration and treats it as a syslog
message in NNMi. TheSyslog Messages view in the Incident Browsingworkspace displays
these incidents.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

For each incident displayed, you can view its Severity, its Lifecycle State (see the Lifecycle State
information for the Incident form for more information), the date and time the incident last occurred,
the name of its Source Node and Source Object, its Category (for example, Fault orSecurity), its
Family (for example, Interface orConnection), its Correlation Nature (for example, Symptom or
Root Cause), theMessage used to describe the incident, and any related Notes.

Note the following:
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l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.

As with all incident views, you can filter this view by time period. The default time period is Last
Hour.

SNMP Traps View
Tip: See "Incident Form" (on page 300) for more details about the incident attributes that appear in

this view's column headings.

TheSNMP Traps view is useful for identifying all of the traps that were received from devices in
your network environment. Your NNMi administrator must configure specific traps before they are
displayed within NNMi incident views. As with all incident views, you can filter this view by time
period. The default time period is Last Hour so that you can view themost recent incidents.

For each incident displayed, you can view its severity, its lifecycle state (see the Lifecycle State
information for the Incident form for more information), the date and time the incident last occurred,
the name of its source node, its source object, its category (for example, Fault orSecurity), its
family (for example, Interface orConnection), its Correlation Nature (for example, Symptom or
Root Cause), themessage used to describe the incident, and any related notes.

Note the following:

l If your NNMi Administrator defines at least one Tenant in addition to Default Tenant (provided by
NNMi), the incident view displays the Tenant to which the Source Node belongs. If you are an
NNMi administrator, see Configure Tenants for more information about Tenants.

l Global Network Management only. The Regional ManagerName value that is associated with
the Source Node's NNMi Management Server appears in the incident view on theGlobal
Manager console. If the incident's Source Node no longer exists, theManagement Server value
is blank.
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Investigate and Diagnose Problems
NNMi offers several ways for you to investigate and diagnose network problems.

l The Causal Engine keeps track of changes in your network, and alerts you to the root cause of
problems and potential problems. See "Interpret Root Cause Incidents" (on page 380) for more
information.

For information about a specific Root Cause Incident message:

l Start by accessing the available information for the Source Object and Source Node for the
incident.To access all known information about the Source Object, access the incident's Source
Object form . NNMi monitors the following object types:

n Node and its Node Components, such as fans

n Interface

n IP Address

n Cards

n SNMP Agents

n NodeGroups

n Card Redundancy Groups

n Router Redundancy Groups

l Select an incident. Then, select Actions→ Source Object. NNMi displays the form for the
object associated with the incident.

A wealth of information about that object is available.

n The object's form is displayed in the top half of the display window. Use theConclusions tab
to display a history of any problems that led to the object's current Status.

n The Analysis Pane is displayed in the bottom half of the display window. It provides a quick
summary of available information. For example, theDetails tab also lists the available
Conclusions.

To explore the information about the object, use the browse buttons:

n to display a list of all available tabs. Select any tab name from the list to display that tab.

n to display the next subset of tabs (depending on the current width of your NNMi window).

You will find the object's State, Status (No Status, Normal, Warning, Minor, Major, Critical,
Disabled, or Unknown), Conclusions, and any related incidents.

l If the Source Object is not a node, you can access the form for the node on which the object is
hosted by selectingOpen using the Lookup icon from theHosted on Node attribute.
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Once again, information about the State, Status, and Conclusions can assist yow with
identifying the problem.

l Use theActionsmenu to gather the latest information about multiple aspects of a node (rather
than waiting for the next regularly scheduled collection time).

n "Verify Device Configuration Details " (on page 351)

n "View theMonitoring Settings Report" (on page 352)

n "Verify Current Status of a Device" (on page 377)

l The Actions menu also provides an easy way to use troubleshooting commands to diagnose
node connectivity and access problems:

n "Display End Nodes Attached to a Switch" (on page 441)

n "Test Node Access (Ping)" (on page 443)

n "Find the Route (traceroute)" (on page 444)

n "Establish Contact with a Node (Telnet or Secure Shell)" (on page 445)

n "Check Status Details for a NodeGroup" (on page 447)

n "Accessing NNM 6.x and 7.x Features" (on page 24)

Note: You can also access Line Graphs from theActionsmenu to investigate a problem. See
"Monitor with Line Graphs" (on page 283) for more information.

l Use Tools→ SNMP MIB Browser or select Actions→MIB Information→Browse MIB
from aNode or Incident form to view MIB Information for a node. See "View MIB Information for
a Node (MIB Browser)" (on page 354) for more information.

l If you have NNMi role permits, you can useActions→Open Incident Configuration to
access more information about the incident including its Description, which includes reasons
why the incident is generated.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

l Use the Tools menu to find a problem node. You can also use the Tools menu to verify that
NNMi, itself, is running properly. This includes checking the status of NNMi processes and
services:

n "Find a Node" (on page 437)

n "Find the Attached Switch Port" (on page 439)

n "Checking the Status of NNMi" (on page 449)

Use the Analysis Pane
To begin diagnosing a problem, youmight want to gather current information about the object. 

The Analysis Pane displays related details about the selected object. NNMi performs the
appropriate analysis on the selected object to determine themost important information to display.
Any hyperlink within the Analysis Pane displays more information about the selected detail.
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Examples of the types of related information includes details about an incident's Source Node and
Source Object or information about a node's Interfaces and IP Addresses. See the Examples of
Possible Analysis Pane Information table for more examples of the types of analysis data
displayed.

To access the Analysis Pane from a table view:

1. Select the workspace of interest (for example, Inventory).

2. Select the view that contains the object of interest (for example, theNodes view).

3. Select the row that contains the object of interest.

4. NNMi displays detailed information at the bottom of the view in the Analysis Pane.

To access the Analysis Pane in a map view:

1. Select the workspace of interest (for example, Topology Maps).

2. Select amap view (for example, select Routers).

Note: If themap requires a starting node before it opens, enter the name or
IP Address for the starting node you want to use.

3. Click themap object of interest.

4. NNMi displays detailed information at the bottom of the view in the Analysis Pane.

To access the Analysis Pane in a form:

l Click the form's toolbar Show Analysis icon to display information about the current form's
top-level object in the Analysis Pane.

Note: Show Analysis always displays the top-level object's information.

l Click a row in a table on one of the form's tabs to display detailed information about the selected
object in the Analysis Pane.

NNMi displays detailed information at the bottom of the form in the Analysis Pane. SeeWorking
with Objects for more information about forms.

Note the following: 

l Look for one of the following at the bottom of the display area:

Open the Analysis Pane if necessary by clicking the expand button.

l Place your mouse cursor over the title bar to display the ↕ symbol, then resize as necessary.

l The Analysis Pane remains blank until an object is selected.

l If you select multiple objects or clear a selection, NNMi retains the Analysis Pane's contents.

l If you change views, NNMi clears the Analysis Pane.
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l Click any Refresh icon in the Analysis Pane to update a subset of displayed information.

l NNMi automatically refreshes the entire Analysis Pane's contents when you save a form.

l TheGauges tab shows real-time SNMP gauges to display State Poller and Custom Poller
SNMP data.

n These gauges are displayed for Nodes, Interfaces, Custom Node Collections, and for Node
Components of type CPU, Memory, Buffers, or Backplane.

n NNMi displays a gauge for each significant MIB Object Identifier (OID) that the node or
interface supports, up to the default maximum of 24.

Tip: If you are an NNMi administrator, for information about using the nms-
ui.properties file to change this default, see the "NNMi Console" chapter in theHP
Network NodeManager i Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

n Each gauge displays the current OID value, using the default refresh rate of 15 seconds. (If
you are an NNMi administrator, for information about using the nms-ui.properties file to
change this default, see the "NNMi Console" chapter of theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.)

n The value range displayed indicates the OID minimum andmaximum values that NNMi has
encountered.

n For any gauge that tracks percentage values, NNMi uses a red line to indicate where the OID
value is near 100 percent.

n There is not a one-to-onematch between theOIDs used to analyzemonitoring thresholds and
those displayed in the Analysis Pane. For example, the Analysis Panemight display aCisco
Memory Pool OID value that does not match the value used to calculate whether the
Memory UtilizationMonitored Attribute threshold is reached or exceeded. This is because
some thresholdmetrics require more complex calculations than a single OID allows. 

Tip: If a gauge label appears to be a duplicate value, mouse over the label to view the
more complete tooltip name that appears. (If you are an NNMi administrator, to change
the gauge title from the NNMi component name to the SNMP MIB variable name, see the
"Maintaining NNMi" chapter of theHP Network NodeManager i Software Deployment
Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.)

n To launch an SNMP LineGraph for the selectedmetric, click the icon that appears at the
bottom of each gauge.

n To select and copy the tooltip information, double-click the gauge. NNMi opens a text window
that enables you to select and copy the tooltip information.

Tip: Some views are also accessible from the console's Actions menu. See Using Actions to
Perform Tasks for more information.
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Object Possible Analysis Information

Node l Summary panel

l Interface information and analysis

l IP address information and analysis

l SNMP information

Interface l Summary panel

l IP address information and analysis

Incidents l Summary panel

l Source Node information and analysis

l Source Object information and analysis

Examples of Possible Analysis Pane Information

To access the Analysis Pane, select a workspace, click the view that you want to display, and
select the row that contains the object.

Tip: Some views are also accessible from the console's Actionsmenu. See Using Actions to
Perform Tasks for more information.

Related Topics

Use Table Views

UseMap Views

Verify Device Configuration Details
Before you begin diagnosing a problem, youmight want to gather current information about a node
to update information in views and NNMi maps.

Note: NNMi automatically gathers this information according to the Rediscovery Interval setting
that was set by your administrator. Theminimum allowed Rediscovery Interval setting is 1
hour. The default value set by NNMi is 24 hours.

To update the discovery information for a node:

1. Do one of the following:

Navigate to a table view and select a node
a. From the workspace navigation panel, select the workspace of interest; for example,

Inventory.

b. Click the view that contains the node that has the configuration you want to check; for
exampleNodes.

c. Select the row representing the node that has the configuration you want to check.

Navigate to a map view and select a node:
a. From the workspace navigation panel, select the workspace of interest; for example,
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Topology Maps.

b. Click the view that contains the node that has the configuration you want to check; for
example Initial Discovery Progress orNetwork Overview.

c. From themap view, click the node that has the configuration you want to check.

Navigate to a Node form:
n From a table view, double-click the row representing the node that has the configuration you

want to see.

n From amap view, click themap icon for the node of interest and click the  Open icon.

2. Select Actions→ Polling→Configuration Poll.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Each time you select Actions→ Polling→Configuration Poll, NNMi also applies any
Custom Poller Policy to the selected node. This determines which instances should be polled.
See Configure Custom Polling for more information.

As the node is polled, NNMi displays the status messages for the Layer 3 discovery information. A
Layer 2 connectivity analysis is also started. Information collected includes the node's IP address,
subnet, contact name, location, and description.

View the Monitoring Settings Report
Use theActions→Configuration Details→Monitoring Settingsmenu item to display the
monitoring settings report for a particular object.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi can be configured tomonitor several aspects of each device, and provide a wealth of
information to help you do your job. After fault polling is enabled, several NNMi processes work
together to detect problems and quickly calculate the device status and the root cause of any
problems for you.

(NNMi Advanced) If the Global Network Management feature is enabled and you are signed into a
Global Manager:

l Nodemanaged by the Global Manager = Actions > Configuration Details >Monitoring
Settings opens a report, provided by the Global Manager (NNMi management server).

l Nodemanaged by a Regional Manager = Actions > Configuration Details >Monitoring
Settings accesses that Regional Manager (NNMi management server) and requests the report.

Note: Youmust sign into that Regional Manager unless your network environment enables
Single Sign-On (SSO) to that Regional Manager through theGlobal Manager. For more
information, see the “Configuring Single Sign-On for Global Network Management” section
in theHP Network NodeManager i Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.
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(HP Network NodeManager iSPI Performance for Metrics Software) The HP Network Node
Manager iSPI Performance for Metrics Software software canmonitor performance statistics and
thresholds for each interface.

Attribute Description

NodeGroup The name of any NodeGroups to which this device belongs. See About Node and
Interface Groups for more information.

Fault Polling
(SNMP and
ICMP)

If enabled, State Poller monitors all managed interfaces, IP addresses, and
SNMP agents by issuing ICMP pings and SNMP read-only queries for MIB-II
ifAdminStatus and ifOperStatus. (ifAdminStatus is set by the device
administrator. ifOperStatus indicates the overall health of the device and is
supplied by the SNMP Agent.)

If disabled:

l Devices that were already discovered remain with the last calculated
state/status.

l Newly discovered devices are set to "No Status" with map-symbol
background shape color set to beige.

Fault Polling
Interval

The time that State Poller waits between issuing queries to gather information.

Performance
Polling

(HP Network NodeManager iSPI Performance for Metrics Software)

If enabled, theHP Network NodeManager iSPI Performance for Metrics Software
software is installed. The HP Network NodeManager iSPI Performance for
Metrics Software software is accessed from the Actionmenu within map views
and table views.

If disabled, network performance data is not currently available.

Performance
Polling
Interval

(HP Network NodeManager iSPI Performance for Metrics Software)

The time that theHP Network NodeManager iSPI Performance for Metrics
Software software waits between issuing queries to gather information.

Monitoring Possibilities

To view the monitoring settings report for a Node (SNMP Agent), Interface, IP address, or
Card:
1. Navigate to the view for that object (for example, Inventoryworkspace, Nodes view).

2. Select the row representing the object information.

3. Select Actions→Configuration Details→Monitoring Settings.

Note: This menu item also is available on any object's form.

To view the monitoring configuration for a Router Redundancy Member:
1. Navigate to a Router Redundancy Members view (for example, Inventoryworkspace, Router

Redundancy Members view).

2. Select the row representing the Router Redundancy Member of interest.
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3. Select Actions→Configuration Details→Monitoring Settings.

To view the monitoring configuration for a Tracked Object:
1. Navigate to a Router Redundancy Group view (for example, Inventoryworkspace, Router

Redundancy Groups view.

2. Double-click the row representing the Router Redundancy Group of interest.

3. From the Router Redundancy Members tab, double-click the row representing the Router
Redundancy GroupMember of interest.

4. Select the TrackedObject of interest by selecting the row representing the object information.

5. Select Actions→Configuration Details→Monitoring Settings.

To view the monitoring configuration for a Node Component:
1. Navigate to a Node view (for example, Inventoryworkspace, Nodes view).

2. Double-click the row representing the Node of interest.

3. Select the Node Component tab.

4. Select the Node Component of interest by selecting the row representing the object
information.

5. Select Actions→Configuration Details→Monitoring Settings.

Note: This menu item is also available on any Node Component form.

View MIB Information for a Node (MIB Browser)
When investigating and diagnosing network problems, youmight find it useful to query a node for
SNMP responses to obtain information about the node that is not stored in the NNMi database. You
can use NNMi's MIB Browser to perform the following tasks:

Note: You can view MIB variable information for those nodes to which you have access or for
which you provide a valid community string.

"Determine a Node's SupportedMIBs (MIB Browser)" (on page 355)

"Display aMIB File's Contents (MIB Browser)" (on page 356)

"Determine a Node's MIB Variable Values (MIB Browser)" (on page 357)

"Display aMIB Table (MIB Browser)" (on page 366)

"Display MIB Variable Details " (on page 359)

"Check SNMP Support for a Node (MIB Browser)" (on page 368)

"Find an Entry in theMIB Browser Output" (on page 369)

"Export MIB Browser Output " (on page 371)

"Copy SelectedMIB Browser Output (MIB Browser)" (on page 373)

"Print MIB Browser Output (MIB Browser)" (on page 375)

See "MIB Browser Keyboard Navigation" (on page 355) for a description of the keyboard navigation
you can use in theMIB Browser.
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MIB Browser Keyboard Navigation
The following table describes the keystrokes you can use to navigate the NNMi MIB Browser.

Tip: To incrementally look up values in the first column of a table, type one or more characters that
you want to match.

Keyboard Key Description

UP ARROW Scroll up vertically by one table row.

DOWN ARROW Scroll down vertically by one table row.

HOME Move to the first row of the table.

END Move to the last row of the table.

PAGE UP Move to the first visible table row.

PAGE DOWN Move to the last visible table row.

SHIFT +
RIGHT ARROW

Open a closed node.

SHIFT +
LEFT ARROW

Close an open node.

SPACEBAR Toggle the table column sort order between acsending and descending
order.

MIB Browser Keyboard Navigation

Determine a Node's Supported MIBs (MIB Browser)
To view theMIBs (Management Information Base) supported for a selected Node, use the Tools→
List Supported MIBs option from theMIB Browser. This option is useful when troubleshooting an
Incident so that you can determine the kinds of information available for the problem object that is in
addition to the information provided in the object's form.

Note: You can also view the supportedMIBs for a selected Node using theActions→
MIB Information→ List Supported MIBs from the NNMi console without accessing the
MIB Browser.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

To view the MIBs supported for a Node from the MIB Browser:

1. Do one of the following:

n Select a Node from an Inventory view.

n Select an Incident from an Incident view.

n Open a Node or Incident form.

Note: NNMi uses the incident's Source Node as the selected Node.
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2. Select Actions→MIB Information→Browse MIB.

NNMi displays theMIB Browser.

3. In theNode attribute, NNMi displays the name of the Node you selected.

4. Optional. In theCommunity String attribute, do one of the following:

n Leave this attribute value blank. NNMi uses the Communication parameters currently
configured in the NNMi database for the specified Node (if any).

n Enter a valid read community string for the Node. NNMi uses default SNMP version,
timeout, maximum retries, and port parameters provided by the NNMi administrator within
the nms-ui.properties file.

For more information, see the "Maintaining NNMi" chapter in theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

5. Select Tools→ List Supported MIBs.

NNMi displays the textual representation of the OID (Object Identifier) for eachMIB that is
supported by the Node's SNMP Agent. When displaying the list, NNMi indicates theMIBs that
are supported, but not loaded on the NNMi management server.

To access theMIB form for a supportedMIB, click theMIB name, for example ENTITY-MIB.

To view the MIBs supported for a Node without accessing the MIB Browser:

1. Do one of the following:

n Select a Node from an Inventory view.

n Select an Incident from an Incident view.

n Open a Node or Incident form.

Note: NNMi uses the incident's Source Node as the selected Node.

2. Select Actions→MIB Information→ List Supported MIBs.

NNMi displays the textual representation of the OID (Object Identifier) for eachMIB that is
supported by the Node's SNMP Agent. When displaying the list, NNMi indicates theMIBs that
are supported, but not loaded.

To access theMIB form for a supportedMIB, click theMIB name, for example ENTITY-MIB.

Display a MIB File's Contents (MIB Browser)
To view aMIB (Management Information Base) file's contents, use theActions→Display MIB
Filemenu option. This option is useful for examining the contents of an entire MIB file to determine
all of theMIB variables and associated values contained in aMIB, or to determine the date theMIB
file was last updated.

Note: You can also display aMIB file using Tools→Display MIB File from theMIB Browser.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

To view a MIB file's contents without accessing the MIB Browser:
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1. Select aMIB Variable from the Inventory→MIB Variables view.

Note: You can also access Actions Display MIB File from theMIB Notifcation, Table Index, or
Enumerated Value form.

2. Select Actions→MIB Information→Display MIB File.

NNMi displays theMIB file's contents.

To view a MIB file's contents from the MIB Browser:

1. Select aMIB Variable from the Inventory→MIB Variables view.

2. Select Actions→MIB Information→Browse MIB.

NNMi displays theMIB Browser.

3. Select Tools→Display MIB File.

NNMi displays theMIB file's contents for the selectedMIB.

Determine a Node's MIB Variable Values (MIB Browser)
Tip: See "MIB Browser Keyboard Navigation" (on page 355) for a description of the keyboard

navigation you can use in theMIB Browser.

To view MIB (Management Information Base) variable values for theMIB objects supported by the
SNMP agent on a specified Node use theActions→MIB Information→Browse MIB menu
item. TheMIB variable OID (Object Identifier) value you specify determines the starting point in the
MIB for which variable information is retrieved.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

Determining aMIB variable value can be useful when troubleshooting a problem device. For
example youmight want to view the value of .1.3.6.1.2.1.1.3 sysUpTime to determine
when the last reboot occurred for a device.

To view current MIB variable values for a Node:

1. Do one of the following:

n Select a Node from an Inventory view.

n Select an Incident from an Incident view.

n Open a Node or Incident form.

Note: NNMi uses the incident's Source Node as the selected Node.

2. Select Actions→MIB Information→Browse MIB.

NNMi displays theMIB Browser.

3. In theNode attribute, NNMi displays the name of the Node you selected.

4. Optional. In theCommunity String attribute, do one of the following:
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n Leave this attribute value blank. NNMi uses the Communication parameters currently
configured in the NNMi database for the specified Node (if any).

n Enter a valid read community string for the Node. NNMi uses default SNMP version,
timeout, maximum retries, and port parameters provided by the NNMi administrator within
the nms-ui.properties file.

For more information, see the "Maintaining NNMi" chapter in theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

5. In theOID attribute, NNMi provides mib-2.system (the root of theMIB-2 branch). To
change theOID:

n Type additional numbers or text strings for a specific MIB-2 area.

n Replace the default OID numbers to issue an SNMP getNext request for another area in the
Internet MIB tree.

Note the following:

n To obtain aMIB variable OID value use the Inventory→MIB Variables view. See
"MIB Variables View " (on page 38) for more information.

n TheOID must begin with a dot (.).

n NNMi automatically completes the OID name for you. The name you begin to enter must be
one of the following:

o A valid textual or numeric OID.

o AnOID alias provided by NNMi. To obtain a list of valid OID aliases, use the Tools→
OID Aliases option from the SNMP MIB Browser.

6. Press Enter. NNMi does the following:

If the Node responds to SNMP, NNMi displays all responses toMIB objects from any
designated starting point down though the Internet MIB tree.

If the associatedMIB file is loaded on the NNMi management server, NNMi displays the
textual representation of the OID (Object Identifier) for theMIB variable as well as its
associated value. If the associatedMIB file is not loaded on the NNMi management server,
NNMi displays the numeric representation of the OID.

When displaying the value for theMIB variables of typeOCTET-STRING, NNMi uses the
textual conventions defined in theMIB. If you are an NNMi administrator, seeMIB Textual
Conventions Form for more information.

Note: You can also click the Walk button to display MIB Browser output.

7. To expand aMIB orMIB variable entry, do one of the following:
n Click the Expand icon that precedes the entry you want to expand.

n Click Expand Selected to expand the selected entries.

8. To collapse aMIB orMIB variable entry, do one of the following:
n Click the Collapse icon that precedes the entry you want to collapse.

n Click Collapse Selected to collapse the selected entries.
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9. To stop gathering theMIB variable information before NNMi reaches the end of theMIB tree,
click the Stop button.

When all available MIB variable values are displayed, NNMi disables the Stop button.

Display MIB Variable Details

Tip: See "MIB Browser Keyboard Navigation" (on page 355) for a description of the keyboard
navigation you can use in theMIB Browser.

To view theMIB Variable details for a selectedMIB variable, use theView→Quck Viewmenu
option from theMIB Browser. This option is useful for determining all of the attributes and
associated values for the selectedMIB variable.

To view MIB variable details for a selected MIB variable:

1. Access the SNMP MIB Browser.

Do one of the following:

n

Select Tools→ MIB Browser.
Note: You can view MIB variable information for those nodes to which you have access or
for which you provide a valid community string.

n Open aMIB variable form from the Inventory→MIB Variables view and select Actions→
MIB Information→Browse MIB.

Note: You can also access theMIB Browser from aNode or Incident view or form. See
Determine a Node's MIB Variable Values for more information.

NNMi displays theMIB Browser.

2. In theNode attribute, enter the Node Name or IP address of the Node that has theMIB
variable values you want to view.

3. Optional. In theCommunity String attribute, do one of the following:

n Leave this attribute value blank. NNMi uses the Communication parameters currently
configured in the NNMi database for the specified Node (if any).

n Enter a valid read community string for the Node. NNMi uses default SNMP version,
timeout, maximum retries, and port parameters provided by the NNMi administrator within
the nms-ui.properties file.

For more information, see the "Maintaining NNMi" chapter in theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

4. In theOID attribute, enter the textual or numeric representation of the Object Identifier for the
MIB variable to be used as a starting point for viewing theMIB variable values supported on the
specified Node. Click here for more information.

If you accessed theMIB Browser from aMIB variable form, NNMi provides the OID attribute
value using the selectedMIB variable.

If an OID was not previously selected, NNMi provides mib-2.system (the root of theMIB-2
branch). To change theOID:
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n Type additional numbers or text strings for a specific MIB-2 area.

n Replace the default OID numbers to issue an SNMP getNext request for another area in the
Internet MIB tree.

Note the following:

n To obtain aMIB variable OID value use the Inventory→MIB Variables view. See
"MIB Variables View " (on page 38) for more information.

n TheOID must begin with a dot (.).

n NNMi automatically completes the OID name for you. The name you begin to enter must be
one of the following:

o A valid textual or numeric OID.

o AnOID alias provided by NNMi. To obtain a list of valid OID aliases, use the Tools→
OID Aliases option from the SNMP MIB Browser.

5. Press Enter. NNMi does the following:

If the Node responds to SNMP, NNMi displays all responses toMIB objects from any
designated starting point down though the Internet MIB tree.

If the associatedMIB file is loaded on the NNMi management server, NNMi displays the
textual representation of the OID (Object Identifier) for theMIB variable as well as its
associated value. If the associatedMIB file is not loaded on the NNMi management server,
NNMi displays the numeric representation of the OID.

Note: You can also click the Walk button to display MIB Browser output.

6. To expand aMIB orMIB variable entry, do one of the following:
n Click the Expand icon that precedes the entry you want to expand.

n Click Expand Selected to expand the selected entries.

7. To collapse aMIB orMIB variable entry, do one of the following:
n Click the Collapse icon that precedes the entry you want to collapse.

n Click Collapse Selected to collapse the selected entries.

8. To stop gathering theMIB variable information before NNMi reaches the end of the Internet
MIB tree, click the Stop button.

When all available MIB variable values are displayed, NNMi disables the Stop button.

9. Select theMIB variable of interest.

Note: TheMIB variable must havemultiple instances. For
example: interfaces.ifTable.ifEntry.ifIndex.1

10. Select View→Quick View.

NNMi displays the attribute values for the selectedMIB variable. This information is also
provided in theMIB Variable form. See "MIB Variable Form" (on page 361) for more
information.

You can also double-click theMIB variable of interest to access the Quick View details.
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MIB Variable Form

TheMIB Variable form enables you to view more detailed information about theMIB variables
available from aMIB that is loaded on the NNMi management server.

For information about each tab:

To view MIB variable information for a MIB that is loaded on the NNMi management
server:

1. From the workspace navigation panel, select the Inventoryworkspace.

2. SelectMIB Variables.

3. Double-click the row of interest.

4. View the Basic attributes (see theMIB Variable Basic Attributes table)

Attribute Description

Name The Name value that is stored in theMIB definition for the selectedMIB variable. In
the following example, ifAdminStatus is the Name of theMIB variable :

ifAdminStatus OBJECT-TYPE
SYNTAX INTEGER {                             
up(1), -- ready to pass packets
down(2),
testing(3) -- in some test mode
}

ACCESS read-write
STATUS mandatory
DESCRIPTION

"The desired state of the interface. The testing(3) state
indicates that no operational packets can be passed."
::= { ifEntry 7 }

OID
(Numeric)

The numeric representation of the OID (Object Identification) value for the selected
MIB variable.

OID (Text) The textual representation of the OID for the selectedMIB variable.

Syntax The SYTNAX value for theMIB variable. Valid values for MIB variable that can be
included in aMIB Expression include the following: 

l Agent Capabilities (SNMP v2 only)

l Bits

l Counter

l Counter64

l Display String (SNMP v1 only)

l Enumeration

MIB Variable Basic Attributes
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Attribute Description

l Gauge

l Integer

l IP Address

l MIB Defined (Indicates a custom type defined in theMIB)

l Module Compliance (SNMP v2 only)

l Module Identity (SNMP v2 only)

l Notification Group (SNMP v2 only)

l Notification Type (SNMP v2 only)

l Object Group (SNMP v2 only)

l Object Identifier

l Object Identity (SNMP v2 only)

l Octet String

l Opaque

l Other (Usually indicates the SYNTAX is unset)

l Physical Address (SNMP v1 only)

l Sequence

l Sequence of

l Textual Convention (SNMP v2 only)

l Time_Ticks

l Unsigned32 (Integer)

For more information, click here.

l When evaluatingMIB expressions that includeMIB variables of type Counter,
Counter64 or Time_Ticks, NNMi evaluates theMIB Variable using the
difference in value between themost recent poll and the poll before it. If you
want NNMi to calculate a rate over time in seconds, divide theMIB Expression
by sysUptime. For example: 

(((ifInOctets+ifOutOctets)*8/ifSpeed)*100)/sysUpTime*0.01

Tip: The sysUpTime variable is a value of hundredths of a second. When you
want the rate in seconds, use sysUpTime*0.01 in theMIB expression as
shown in the previous example.

l If you use aMIB variable of type Counter, Counter64 or Time_Ticks in theMIB
Expression, NNMi automatically collects sysUpTime values if sysUpTime is
not already in theMIB Expression. NNMi uses the sysUptime value to detect a
system reboot. Any time a system reboot is detected, NNMi cannot determine

MIB Variable Basic Attributes, continued
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Attribute Description

the difference in values between polls for any Counter MIB variable and
therefore does not calculate theMIB Expression for that poll.

Textual
Convention

Defines the format rules to be used when displaying theMIB value.

MIB The name value that is stored at the beginning of theMIB definitions to identify the
MIB. In the following example, RFC1213-MIB is the name of theMIB:

RFC1213-MIB DEFINITIONS ::= BEGIN

Description The Description that is stored in theMIB for the selectedMIB variable. The
following example includes the description for ifAdminStatus in the RFC1213-
MIB:

ifAdminStatus OBJECT-TYPE
SYNTAX INTEGER {                             
up(1), -- ready to pass packets
down(2),
testing(3) -- in some test mode
}

ACCESS read-write
STATUS mandatory
DESCRIPTION
"The desired state of the interface. The testing(3) state

indicates
that no operational packets can be passed."

::= { ifEntry 7 }

MIB Variable Basic Attributes, continued

Enumerated Values Form

The Enumerated Values form enables you to view each enumerated value pair, if any, for a selected
MIB variable. For example, the ifAdminStatusMIB variable, includes enumerated values for
status as shown in the following example:

ifAdminStatus OBJECT-TYPE
SYNTAX INTEGER {             
1 up
2 down
3 testing(3)
}

ACCESS read-write
STATUS mandatory
DESCRIPTION

"The desired state of the interface. The testing(3) state
indicates that no operational packets can be passed."
::= { ifEntry 7 }

The enumerated values are included in the following table:
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String Value Numeric Value

up 1

down 2

testing 3

Enumerated Values for ifAdminStatus

For information about each tab:

To view the enumerated values for a selected MIB variable:

1. From the workspace navigation panel, select the Inventoryworkspace.

2. Select MIB Variables.

3. Double-click the row of interest.

4. Select theEnumerated Values tab.

NNMi displays the string and numeric value for each enumeration, if any, specified for the
selectedMIB variable.

5. To view more details about an enumerated value pair, double-click the row of interest.

6. View the Basics information for the selected Enumerated Value (see the Enumerated Value
Basic Attributes table).

Attribute Description

String Value The text value that is associated with the Numeric Value for the selectedMIB
variable.

Numeric
Value

The numeric value that is associated with the String Value for the selectedMIB
variable.

MIB Variable The name of the selectedMIB variable that contains enumerated values. For
example, ifAdminStatus is a MIB Variable that contains enumerated values.

MIB The name value that is stored at the beginning of theMIB definitions to identify
theMIB. In the following example, RFC1213-MIB is the name of theMIB:

RFC1213-MIB DEFINITIONS ::= BEGIN

Enumerated Value Basic Attributes

Table Indices Form

The Table Index form enables you to view the index values, if any, for a selectedMIB variable.
Table indices are identified using the INDEX keyword as shown in the following example for the
atEntryMIB variable:

atEntry OBJECT-TYPE
SYNTAX AtEntry
ACCESS not-accessible
STATUS deprecated
DESCRIPTION
"Each entry contains one NetworkAddress to
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`physical' address equivalence."
INDEX { atIfIndex,

atNetAddress }
::= { atTable 1 }

In the example, atIfIndex and atNetAddress are table indices for the atEntryMIB variable.

Table indices are used to storemultiple values for a single MIB variable.

For information about each tab:

To view the table index values for a selected MIB variable:

1. From the workspace navigation panel, select the Inventoryworkspace.

2. Select MIB Variables.

3. Double-click the row of interest.

4. Navigate to the Table Indices tab.

NNMi displays the Position and Name for each of the Table Indices, if any, specified for the
selectedMIB variable.

5. To view more details about a specific Table Index entry, double-click the row of interest.

6. View the Basics information for the selected Table Index (see the Table Index Basic Attributes
table).

Attribute Description

Position The position number of theMIB variable that is used as a Table Index object. In
the following example, atIfIndex and atNetAddress areMIB Variables used
as Table Index objects. atIfIndex is position 0 and atNetAddress is position
1:

INDEX { atIfIndex,
atNetAddress }

MIB Variable The name of the selectedMIB variable that is used as a Table Index object. Table
indices are used for storingmultiple values for aMIB variable.

Table
Definition

The name of theMIB variable used to define theMIB table. In the following
example, atEntry is theMIB variable that defines theMIB table:

atEntry OBJECT-TYPE
SYNTAX AtEntry
ACCESS not-accessible
STATUS deprecated
DESCRIPTION
"Each entry contains one NetworkAddress to
`physical' address equivalence."
INDEX { atIfIndex,
atNetAddress }
::= { atTable 1 }

Table Index Basic Attributes
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Attribute Description

MIB Name The name value that is stored at the beginning of theMIB definitions to identify
theMIB. In the following example, RFC1213-MIB is the name of theMIB:

RFC1213-MIB DEFINITIONS ::= BEGIN

Table Index Basic Attributes, continued

Display a MIB Table (MIB Browser)

Tip: See "MIB Browser Keyboard Navigation" (on page 355) for a description of the keyboard
navigation you can use in theMIB Browser.

To view theMIB table for a selectedMIB variable, use theView→MIB Tablemenu option from
theMIB Browser. This option is useful for determining all of the attributes and associated values for
each instance of theMIB variable in aMIB table.

To view MIB table information for a selected MIB variable:

1. Access theMIB Browser.

Do one of the following:

n

Select Tools→ MIB Browser.
Note: You can view MIB variable information for those nodes to which you have access or
for which you provide a valid community string.

n Open aMIB variable form from the Inventory→MIB Variables view and select Actions→
MIB Information→Browse MIB.

Note: You can also access theMIB Browser from a node or incident view or form. See
Determine a Node's MIB Variable Values for more information.

NNMi displays theMIB Browser.

2. In theNode attribute, enter the node name or IP address of the node that has theMIB variable
values you want to view.

3. Optional. In theCommunity String attribute, do one of the following:

n Leave this attribute value blank. NNMi uses the Communication parameters currently
configured in the NNMi database for the specified Node (if any).

n Enter a valid read community string for the Node. NNMi uses default SNMP version,
timeout, maximum retries, and port parameters provided by the NNMi administrator within
the nms-ui.properties file.

For more information, see the "Maintaining NNMi" chapter in theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

4. In theOID attribute, enter the textual or numeric representation of the Object Identifier for the
MIB variable to be used as a starting point for viewing theMIB variable values supported on the
specified node. Click here for more information.

If you accessed theMIB Browser from aMIB variable form, NNMi provides the OID attribute
value using the selectedMIB variable.
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If an OID was not previously selected, NNMi provides mib-2.system (the root of theMIB-2
branch). To change theOID:

n Type additional numbers or text strings for a specific MIB-2 area.

n Replace the default OID numbers to issue an SNMP getNext request for another area in the
Internet MIB tree.

Note the following:

n To obtain aMIB variable OID value use the Inventory→MIB Variables view. See
"MIB Variables View " (on page 38) for more information.

n TheOID must begin with a dot (.).

n NNMi automatically completes the OID name for you. The name you begin to enter must be
one of the following:

o A valid textual or numeric OID.

o AnOID alias provided by NNMi. To obtain a list of valid OID aliases, use the Tools→
OID Aliases option from the SNMP MIB Browser.

5. Press Enter. NNMi does the following:

If the Node responds to SNMP, NNMi displays all responses toMIB objects from any
designated starting point down though the Internet MIB tree.

If the associatedMIB file is loaded on the NNMi management server, NNMi displays the
textual representation of the OID (Object Identifier) for theMIB variable as well as its
associated value. If the associatedMIB file is not loaded on the NNMi management server,
NNMi displays the numeric representation of the OID.

Note: You can also click the Start SNMPWalk button to display MIB Browser output.

6. To expand aMIB orMIB variable entry, do one of the following:
n Click the Expand icon that precedes the entry you want to expand.

n Click Expand Selected to expand the selected entries.

7. To collapse aMIB orMIB variable entry, do one of the following:
n Click the Collapse icon that precedes the entry you want to collapse.

n Click Collapse Selected to collapse the selected entries.

8. To stop gathering theMIB variable information before NNMi reaches the end of the Internet
MIB tree, click the Stop SNMP Walk button.

When all available MIB variable values are displayed, NNMi disables the Stop SNMP Walk
button.

9. Select theMIB variable of interest.

Note the following:

n TheMIB Variable must havemultiple instances. For
example: interfaces.ifTable.ifEntry.ifIndex.1

n NNMi uses the View MIB Table button to indicateMIB Variables that havemultiple
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instances.

n

10. To view theMIB table of multiple instances, click the View MIB Table button or select a row
that contains a View MIB Table button and click View→MIB Table.

NNMi displays theMIB table that is associated with the selectedMIB Variable. TheMIB table
includes all of the attributes and associated values for each instance in theMIB table.

Check SNMP Support for a Node (MIB Browser)
Tip: See "MIB Browser Keyboard Navigation" (on page 355) for a description of the keyboard

navigation you can use in theMIB Browser.

In addition to determining theMIBs andMIB variables supported for a node, you can use theMIB
Browser to check the following:

l Whether a node supports SNMP

l Valid SNMP community strings

To check SNMP support for a selected node:

1. Do one of the following:

n Select a Node from an Inventory view.

n Select an Incident from an Incident view.

n Open a Node or Incident form.

Note: NNMi uses the incident's Source Node as the selected Node.

2. Select Actions→MIB Information→Browse MIB.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi displays theMIB Browser.

3. In theOID attribute, NNMi provides mib-2.system (the root of theMIB-2 branch). To change
theOID:
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n Type additional numbers or text strings for a specific MIB-2 area.

n Replace the default OID numbers to issue an SNMP getNext request for another area in the
Internet MIB tree.

Click here for more information. Note the following:

n To obtain aMIB variable OID value use the Inventory→MIB Variables view. See
"MIB Variables View " (on page 38) for more information.

n TheOID must begin with a dot (.).

n NNMi automatically completes the OID name for you. The name you begin to enter must be
one of the following:

o A valid textual or numeric OID.

o AnOID alias provided by NNMi. To obtain a list of valid OID aliases, use the Tools→
OID Aliases option from the SNMP MIB Browser.

4. Optional. In theCommunity String attribute, do one of the following:

n Leave this attribute value blank. NNMi uses the Communication parameters currently
configured in the NNMi database for the specified Node (if any).

n Enter a valid read community string for the Node. NNMi uses default SNMP version,
timeout, maximum retries, and port parameters provided by the NNMi administrator within
the nms-ui.properties file.

For more information, see the "Maintaining NNMi" chapter in theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

5. Press Enter. NNMi does the following:

n If the Node responds to SNMP, NNMi displays all responses toMIB objects from any
designated starting point down though the Internet MIB tree.

n If the associatedMIB file is loaded on the NNMi management server, NNMi displays the
textual representation of the OID (Object Identifier) for theMIB variable as well as its
associated value. If the associatedMIB file is not loaded on the NNMi management server,
NNMi displays the numeric representation of the OID.

Note: You can also click the Walk button to display MIB Browser output.

Find an Entry in the MIB Browser Output
Tip: See "MIB Browser Keyboard Navigation" (on page 355) for a description of the keyboard

navigation you can use in theMIB Browser.

When using theMIB Browser to determineMIBs andMIB variables supported for a node, use the
MIB Browser Find button to search for a particular text string within the output. For example, you
might want to search for a specific MIB variable without examining all of theMIB Browser output.

To find a text string in the MIB Browser output:

1. Access theMIB Browser.

Do one of the following:
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n

Select Tools→MIB Browser.
Note: You can view MIB variable information for those nodes to which you have access or
for which you provide a valid community string.

n Open aMIB variable form from the Inventory→MIB Variables view and select Actions→
MIB Information→Browse MIB.

Note: You can also access theMIB Browser from a node or incident view or form. See
Determine a Node's MIB Variable Values for more information.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi displays theMIB Browser.

2. In theOID attribute, enter the textual or numeric representation of the Object Identifier for the
MIB variable to be used as a starting point for viewing theMIB variable values supported on the
specified node. Click here for more information.

If you accessed theMIB Browser from aMIB variable form, NNMi provides the OID attribute
value using the selectedMIB variable.

If an OID was not previously selected, NNMi provides mib-2.system (the root of theMIB-2
branch). To change theOID:

n Type additional numbers or text strings for a specific MIB-2 area.

n Replace the default OID numbers to issue an SNMP getNext request for another area in the
Internet MIB tree.

Note the following:

n To obtain aMIB variable OID value use the Inventory→MIB Variables view. See
"MIB Variables View " (on page 38) for more information.

n TheOID must begin with a dot (.).

n NNMi automatically completes the OID name for you. The name you begin to enter must be
one of the following:

o A valid textual or numeric OID.

o AnOID alias provided by NNMi. To obtain a list of valid OID aliases, use the Tools→
OID Aliases option from the SNMP MIB Browser.

3. Optional. In theCommunity String attribute, do one of the following:

n Leave this attribute value blank. NNMi uses the Communication parameters currently
configured in the NNMi database for the specified Node (if any).

n Enter a valid read community string for the Node. NNMi uses default SNMP version,
timeout, maximum retries, and port parameters provided by the NNMi administrator within
the nms-ui.properties file.

For more information, see the "Maintaining NNMi" chapter in theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

4. Press Enter. NNMi does the following:
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If the node responds to SNMP, NNMi displays all responses toMIB objects from any
designated starting point down though the Internet MIB tree.

If the associatedMIB file is loaded on the NNMi management server, NNMi displays the
textual representation of the OID (Object Identifier) for theMIB variable as well as its
associated value. If the associatedMIB file is not loaded on the NNMi management server,
NNMi displays the numeric representation of the OID.

Note: You can also click the Walk button to display MIB Browser output.

5. Expand theMIB or MIB variable entries in which you want search:
n Click the Expand icon that precedes the entry you want to expand.

n Click Expand Selected to expand the selected entries listed.

6. To collapse aMIB orMIB variable entry, do one of the following:

n Click the Collapse icon that precedes the entry you want to collapse.

n Click Collapse Selected to collapse the selected entries listed.

7. To stop gathering theMIB variable information before NNMi reaches the end of the Internet
MIB tree, click the Stop button.

When all available MIB variable values are displayed, NNMi disables the Stop button.

8. To find a text string, enter the text string value in the field next to the Find button and click
Find.

NNMi searches all of the expandedOID column entries and highlights the first occurrence of
the text string you enter.

Each time you click Find, NNMi advances to the next occurrence of the text string you
entered.

Export MIB Browser Output
In addition to determining theMIBs andMIB variables supported for a node, you can use theMIB
Browser to export the SNMP query results to another application. For example, youmight want to
place the contents in a spreadsheet.

NNMi exports your SNMP query results in a comma-delimited format to the Clipboard. You can
then paste the output to any application that accepts the comma-delimited format.

If you do not need a comma-delimited format, useEdit→Copywhen you want to select output for
printing or pasting to another application. See "Copy SelectedMIB Browser Output (MIB Browser)"
(on page 373) for more information.

Use File→ Print Visiblewhen you want to generate a printout of the output without using it in
another application. See "Print MIB Browser Output (MIB Browser)" (on page 375) for more
information.

To export the MIB Browser output :

1. Access theMIB Browser.

Do one of the following:

n

Select Tools→MIB Browser.
Note: You can view MIB variable information for those nodes to which you have access or
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for which you provide a valid community string.

n Open aMIB variable form from the Inventory→MIB Variables view and select Actions→
MIB Information→Browse MIB.

Note: You can also access theMIB Browser from a node or incident view or form. See
Determine a Node's MIB Variable Values for more information.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi displays theMIB Browser.

2. In theNode attribute, NNMi displays the name of the node you selected.

3. Optional. In theCommunity String attribute, do one of the following:

n Leave this attribute value blank. NNMi uses the Communication parameters currently
configured in the NNMi database for the specified Node (if any).

n Enter a valid read community string for the Node. NNMi uses default SNMP version,
timeout, maximum retries, and port parameters provided by the NNMi administrator within
the nms-ui.properties file.

For more information, see the "Maintaining NNMi" chapter in theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

4. In theOID attribute, enter the textual or numeric representation of the Object Identifier for the
MIB variable to be used as a starting point for viewing theMIB variable values supported on the
specified node. Click here for more information.

If you accessed theMIB Browser from aMIB variable form, NNMi provides the OID attribute
value using the selectedMIB variable.

If an OID was not previously selected, NNMi provides mib-2.system (the root of theMIB-2
branch). To change theOID:

n Type additional numbers or text strings for a specific MIB-2 area.

n Replace the default OID numbers to issue an SNMP getNext request for another area in the
Internet MIB tree.

Note the following:

n To obtain aMIB variable OID value use the Inventory→MIB Variables view. See
"MIB Variables View " (on page 38) for more information.

n TheOID must begin with a dot (.).

n NNMi automatically completes the OID name for you. The name you begin to enter must be
one of the following:

o A valid textual or numeric OID.

o AnOID alias provided by NNMi. To obtain a list of valid OID aliases, use the Tools→
OID Aliases option from the SNMP MIB Browser.

5. Press Enter. NNMi does the following:
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If the node responds to SNMP, NNMi displays all responses toMIB objects from any
designated starting point down though the Internet MIB tree.

If the associatedMIB file is loaded on the NNMi management server, NNMi displays the
textual representation of the OID (Object Identifier) for theMIB variable as well as its
associated value. If the associatedMIB file is not loaded on the NNMi management server,
NNMi displays the numeric representation of the OID.

Note: You can also click the Walk button to display MIB Browser output.

6. Select File→ Export to Clipboard.

NNMi exports your SNMP query results in a comma-delimited format to the Clipboard. You can
then paste the output to any application that accepts the comma-delimited format.

Note: All data that is available from the query is exported.

Copy Selected MIB Browser Output (MIB Browser)
Tip: See "MIB Browser Keyboard Navigation" (on page 355) for a description of the keyboard

navigation you can use in theMIB Browser.

In addition to determining theMIBs andMIB variables supported for a node, you can use theMIB
Browser to copy the output to another application. For example, youmight want to send the
contents to a coworker or save it for later comparison.

When you need a comma-delimited format, use the File→ Export to Clipboard option.

To copy the MIB Browser output for a selected node:

1. Access theMIB Browser.

Do one of the following:

n

Select Tools→MIB Browser.
Note: You can view MIB variable information for those nodes to which you have access or
for which you provide a valid community string.

n Open aMIB variable form from the Inventory→MIB Variables view and select Actions→
MIB Information→Browse MIB.

Note: You can also access theMIB Browser from a node or incident view or form. See
Determine a Node's MIB Variable Values for more information.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi displays theMIB Browser.

2. In theNode attribute, NNMi displays the name of the node you selected.

3. Optional. In theCommunity String attribute, do one of the following:

n Leave this attribute value blank. NNMi uses the Communication parameters currently
configured in the NNMi database for the specified Node (if any).
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n Enter a valid read community string for the Node. NNMi uses default SNMP version,
timeout, maximum retries, and port parameters provided by the NNMi administrator within
the nms-ui.properties file.

For more information, see the "Maintaining NNMi" chapter in theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

4. In theOID attribute, enter the textual or numeric representation of the Object Identifier for the
MIB variable to be used as a starting point for viewing theMIB variable values supported on the
specified node. Click here for more information.

If you accessed theMIB Browser from aMIB variable form, NNMi provides the OID attribute
value using the selectedMIB variable.

If an OID was not previously selected, NNMi provides mib-2.system (the root of theMIB-2
branch). To change theOID:

n Type additional numbers or text strings for a specific MIB-2 area.

n Replace the default OID numbers to issue an SNMP getNext request for another area in the
Internet MIB tree.

Note the following:

n To obtain aMIB variable OID value use the Inventory→MIB Variables view. See
"MIB Variables View " (on page 38) for more information.

n TheOID must begin with a dot (.).

n NNMi automatically completes the OID name for you. The name you begin to enter must be
one of the following:

o A valid textual or numeric OID.

o AnOID alias provided by NNMi. To obtain a list of valid OID aliases, use the Tools→
OID Aliases option from the SNMP MIB Browser.

5. Press Enter. NNMi does the following:

If the Node responds to SNMP, NNMi displays all responses toMIB objects from any
designated starting point down though the Internet MIB tree.

If the associatedMIB file is loaded on the NNMi management server, NNMi displays the
textual representation of the OID (Object Identifier) for theMIB variable as well as its
associated value. If the associatedMIB file is not loaded on the NNMi management server,
NNMi displays the numeric representation of the OID.

Note: You can also click the Walk button to display MIB Browser output.

6. To expand aMIB orMIB variable entry, do one of the following:
n Click the Expand icon that precedes the entry you want to expand.

n Click Expand Selected to expand the selected entries.

7. To collapse aMIB orMIB variable entry, do one of the following:
n Click the Collapse icon that precedes the entry you want to collapse.

n Click Collapse Selected to collapse the selected entries.
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8. To stop gathering theMIB variable information before NNMi reaches the end of the Internet
MIB tree, click the Stop button.

When all available MIB variable values are displayed, NNMi disables the Stop button.

9. Select the text you want to copy.

10. Select Edit→Copy.

NNMi copies the selected output to the Clipboard. You can then paste the output to any
application that accepts the text output.

Print MIB Browser Output (MIB Browser)
Tip: See "MIB Browser Keyboard Navigation" (on page 355) for a description of the keyboard

navigation you can use in theMIB Browser.

You can print MIB Browser output using theMIB Browser's Filemenu. NNMi enables you to print
either the entire output contents or only the visible content.

To print MIB Browser output for a selected node:

1. Access theMIB Browser.

Do one of the following:

n

Select Tools→MIB Browser.
Note: You can view MIB variable information for those nodes to which you have access or
for which you provide a valid community string.

n Open aMIB variable form from the Inventory→MIB Variables view and select Actions→
MIB Information→Browse MIB.

Note: You can also access theMIB Browser from a node or incident view or form. See
Determine a Node's MIB Variable Values for more information.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi displays theMIB Browser.

2. In theNode attribute, NNMi displays the name of the node you selected.

3. Optional. In theCommunity String attribute, do one of the following:

n Leave this attribute value blank. NNMi uses the Communication parameters currently
configured in the NNMi database for the specified Node (if any).

n Enter a valid read community string for the Node. NNMi uses default SNMP version,
timeout, maximum retries, and port parameters provided by the NNMi administrator within
the nms-ui.properties file.

For more information, see the "Maintaining NNMi" chapter in theHP Network NodeManager i
Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

4. In theOID attribute, enter the textual or numeric representation of the Object Identifier for the
MIB variable to be used as a starting point for viewing theMIB variable values supported on the
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specified node. Click here for more information.

If you accessed theMIB Browser from aMIB variable form, NNMi provides the OID attribute
value using the selectedMIB variable.

If an OID was not previously selected, NNMi provides mib-2.system (the root of theMIB-2
branch). To change theOID:

n Type additional numbers or text strings for a specific MIB-2 area.

n Replace the default OID numbers to issue an SNMP getNext request for another area in the
Internet MIB tree.

Note the following:

n To obtain aMIB variable OID value use the Inventory→MIB Variables view. See
"MIB Variables View " (on page 38) for more information.

n TheOID must begin with a dot (.).

n NNMi automatically completes the OID name for you. The name you begin to enter must be
one of the following:

o A valid textual or numeric OID.

o AnOID alias provided by NNMi. To obtain a list of valid OID aliases, use the Tools→
OID Aliases option from the SNMP MIB Browser.

5. Press Enter. NNMi does the following:

If the node responds to SNMP, NNMi displays all responses toMIB objects from any
designated starting point down though the Internet MIB tree.

If the associatedMIB file is loaded on the NNMi management server, NNMi displays the
textual representation of the OID (Object Identifier) for theMIB variable as well as its
associated value. If the associatedMIB file is not loaded on the NNMi management server,
NNMi displays the numeric representation of the OID.

Note: You can also click the Walk button to display MIB Browser output.

6. To expand aMIB orMIB variable entry, do one of the following:
n Click the Expand icon that precedes the entry you want to expand.

n Click Expand Selected to expand the selected entries.

7. To collapse aMIB orMIB variable entry, do one of the following:

n Click the Collapse icon that precedes the entry you want to collapse.

n Click Collapse Selected to collapse the selected entries.

8. To stop gathering theMIB variable information before NNMi reaches the end of the Internet
MIB tree, click the Stop button.

When all available MIB variable values are displayed, NNMi disables the Stop button.

9. To print only the visible content, select File→ Print Visible.

NNMi prints the output to the printer you specify.

HP Network NodeManager i Software (9.21)Page 376 of 454



Online Help: Help for Operators
Chapter 9: Investigate and Diagnose Problems

Verify Current Status of a Device
NNMi calculates the status of devices each time additional information is gathered. You can
instruct NNMi to gather real-time data for all the information that NNMi uses to calculate Status for
each selected Node or selected Incident's Source Node (up tomaximum 10).

Note: UsingActions→ Polling→ Status Poll does not affect the timing of the Polling interval
configured for the device.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

To update node status information:

1. Navigate to the view of interest and select each node that has the status information you want
to update. Do one of the following:

Navigate to a table view and select up to 10 nodes:
a. From the workspace navigation panel, select the workspace of interest; for example,

Inventory.

b. Click the view that contains the nodes that has the status you want to update; for example
Nodes.

c. From the table view, press CTRL-Click and select each row that represents a node that
has a status you want to update (maximum 10).

Navigate to a map view and select up to 10 nodes:
a. Navigate to the Topology Mapsworkspace.

b. Open themap view.

c. CTRL-click each node that has a status you want to update (maximum 10).

Navigate to an incident view and select up to 10 incidents:
a. Navigate to the Incident Management or Incident Browsingworkspace.

b. From a table view, press CTRL-Click and select each row that represents an incident that
has the Source Node status you want to update (maximum 10).

2. Select Actions→ Polling→ Status Poll.

3. A window for each Node displays with a report about which information was gathered. Your
NNMi administrator determines the list of information gathered by establishingMonitoring
Configuration settings.

Item Description

Policy Describes the item being gathered.

Target Identifies where the information is being gathered.

Poller The name of the Polling Policy that NNMi State Poller uses to control what is
gathered. The following additional information displays:

Status Poll Data Returned

HP Network NodeManager i Software (9.21)Page 377 of 454



Online Help: Help for Operators
Chapter 9: Investigate and Diagnose Problems

Item Description

n If the target is responding.

n If the poll was successful.

n How long it took to get an answer.

Resulting
Data

Shows the results for this item.

Status Poll Data Returned, continued

To see the resulting Node status after the real-time update:

Do one of the following:

l Open the appropriate Node form, see "Accessing Device Details" (on page 45). Check the
information displayed on the "Node Form: Status Tab" (on page 85) and the "Node Form: Node
Component Tab" (on page 66).

l Check the Node icon status colors onmaps ("Watch Status Colors" (on page 274)).

l In a Node view, locate the row representing the node and check the icon in the Status column.

l From the Incident form, open the Source Node's form, see "Incident Form" (on page 300) for
instructions about using the Source Node attribute to open the appropriate Node form.

Exceeding SNMP Trap and Queue Size Limits
Tip: Also see "Investigate and Diagnose Problems" (on page 347) for more information about
troubleshooting tools that NNMi provides.

NNMi generates SNMP Trap Incidents to inform you that the following limits are reached: 

"Number of SNMP Traps Persisted in the Database has Reached or Exceeded Trap Limit" (on page
378)

"$queueNameQueue Size Exceeded Limit" (on page 379)

Note: If you are an NNMi administrator, see Control which Incoming Traps Are Visible in Incident
Views for a list of the SNMP Trap Incidents that NNMi enables by default.

Number of SNMP Traps Persisted in the Database has Reached or
Exceeded Trap Limit

A Number of SNMP Traps Persisted in the Database has Reached or Exceeded Trap Limit
incident indicates the number of SNMP traps has reached or exceeded themaximum limit. The
SNMP trap limit is 100,000.

Note: When themaximum limit is reached, NNMi no longer accepts traps from the Event system.
The NNMi administrator can reduce the number of traps in the NNMi database. If you are an
NNMi administrator, see "Configuring the Auto-Trim Oldest SNMP Trap Incidents Feature" in
the HP Network NodeManager i Software Deployment Reference for more information.
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A Number of SNMP Traps Persisted in the Database has Reached or Exceeded Trap Limit
incident is generated with Severity set to eitherWarning,Major, orCritical.

When the number of traps reaches 90 percent of themaximum limit, NNMi generates the following:

l A Number of SNMP Traps Persisted in the Database has Reached or Exceeded Trap
Limitwith a Severity set toWarning.

l A health conclusionSnmpTrapLimitExceeded with theSeverity set toWarning.

When the number of traps reaches 95 percent of this maximum limit, NNMi generates the following:

l A Number of SNMP Traps Persisted in the Database has Reached or Exceeded Trap
Limitwith a Severity set toMajor.

l A health conclusionSnmpTrapLimitExceeded with theSeverity set toMajor.

When the number of traps reaches themaximum limit, NNMi generates the following:

l A Number of SNMP Traps Persisted in the Database has Reached or Exceeded Trap
Limitwith a Severity set toCritical.

l A health conclusionSnmpTrapLimitExceeded with theSeverity set toCritical.

Tip: To view the associated conclusion information, check the health of the NNMi management
server using theHealth tab from Help→ System Information.

$queueName Queue Size Exceeded Limit
A $queueName Queue Size Exceeded Limit incident indicates one of the queues connecting the
stages for the Event Pipeline is above the configured limits. NNMi determines queue size limits
based onmemory size. Click here for more information about the Event Pipeline.

Any incident information that appears in your incident views first travels through the Event Pipeline.
The Event Pipeline guarantees that the incident data is analyzed in chronological order.

Note: Not all information that travels through the pipeline results in an incident.

If at any time an incident does not meet the criteria for a stage in the Event Pipeline, it is ignored and
passed to the next stage in the pipeline or it is dropped. For information about each of the stages in
the Event Pipeline, see Help for Administrators.

When the lower queue size limit is reached, NNMi generates the following:

l A $queueName Queue Size Exceeded Limit incident with the Severity set toMajor.

l A PipelineQueueSizeLowerLimitExceeded health conclusion with the Severity set toMajor.

Tip: To view the conclusion information that generated this incident, check the health of the
Regional Manager using theHealth tab from Help→ System Information.

When the upper limit is reached, NNMi does the following:

l Generates a $queueName Queue Size Exceeded Limit incident with the Severity set to
Critical.

l Generates aPipelineQueueSizeHigherLimitExceeded health conclusion with the Severity
set toMajor.
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Tip: To view the associated conclusion information, check the health of the Regional Manager
using theHealth tab from Help→ System Information.

l Drops incidents created from SNMP traps or Remote NNM 6.x/7.x Events, but continues to
generate incidents created fromManagement Events. 

To reduce the number of incidents in the queue, ask your NNMi administrator to disable any SNMP
Trap or Remote NNM 6.x/7.x Event configurations that are not essential.

Interpret Root Cause Incidents
Tip: Also see "Investigate and Diagnose Problems" (on page 347) for more information about

troubleshooting tools that NNMi provides.

The Causal Engine keeps track of changes in your network, and alerts you to the root cause of
problems and potential problems.The Causal Engine sets an object's status using an object's
outstanding conclusions. Every outstanding conclusion has a status, such as Normal orCritical.
The highest status for an object's outstanding conclusions becomes the object's status. The order
of status from lowest to highest is listed below:

  No Status

  Normal

  Warning

  Minor

  Major

Critical

  Disabled 

  Unknown

Incident form explains the situation. Click here for examples of the type of information you can
obtain from incidents. The information in the Incident helps you solve the problem quickly and
efficiently:

l A router, switch, server, or other monitored device is down (see "Node Down" (on page 397) )

l A node or connectionmight be down and need your attention (see "Node or Connection Down"
(on page 399))

l An interface is operationally down (see "Interface Down" (on page 394))

l An address is no longer responding (see "Address Not Responding" (on page 381)).

l The connection between two important devices is down (see "Connection Down" (on page 390))

For more information about a specific root cause incident:

To access an incident form from the Incident Management or Incident Browsingworkspace,
click the Open icon in the row representing an incident. The "Incident Form" (on page 300)
displays all details about the selected incident.
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TheSNMP Trap Configuration, Remote NNM 6.x/7.x Event Configuration, orManagement
Event Configuration form provides a way to view an incident configuration's Description. The
Incident Description attribute includes information about the reasons the incident occurred. The
Incident configuration form also includes any additional configurations specified for the incident. For
example, the NNMi administrator might have specified an Enrichment configuration to customize
incident attributes, such as an incident's Message Format or Severity. After selecting or opening an
incident, useActions→Open Incident configuration to display an incident's configuration.

Map views provide a quick way to view status. Click here for more information. As problems are
detected for specific devices, the Causal Engine changes the status color of that device's icon on
themaps. See "Watch Status Colors" (on page 274) for more information about status color.

The sequence of color changes indicates increasing levels of trouble. Red, themost severe,
indicates that a network element is not functioning. You generally want to intervene and solve
problems before they cause a complete node failure.

Address Not Responding
NNMi periodically uses an ICMP ping command to check each address. If there is no response and
the node is not completely unreachable, NNMi's Causal Engine determines that the address is not
responding.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theAddressNotResponding Conclusion.

Incident Adds theAddress Not Responding incident.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Addresses Changes the State and Status of the address toCritical.

Status Adds the Minor Status.

Conclusion SomeUnresponsiveAddressesInNode

Note: If you view anAllUnresponsiveAddressesInNodeConclusion, see "Node
Down" (on page 397) for more information.

Source Node Updates

On themaps, the icon for the Source Node is set to yellow.

When the IP Address starts responding to ICMP and NNMi can reach the node, NNMi updates the
following attributes:
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l The IP Address Status is changed toNormal.

l The IP Address Conclusion is changed to AddressResponding.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Node Status is changed toNormal. The Conclusion on the Node is
ResponsiveAddressInNode.

Aggregator Interface Degraded (NNMi Advanced)
Link Aggregation1: NNMi generates anAggregator Interface Degraded incident when the
Status of at least one of the AggregationMember Interfaces is set toCritical. See Layer 2 Neighbor
View MapObjects for more information about Aggregator Interfaces.

An Aggregator Interface Degraded incident has a Severity set toMinor.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theAggregatorDegraded Conclusion.

Incident Adds theAggregator Interface Degraded incident.

TheCorrelated Children tab has an Interface Down incident for themember
interfaces that have a Status of Critical.

Status Adds theMinor Status.

Overall
Status

Changes toMinor.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Interfaces Changes the State and Status of all member interfaces that have anOperational
State of Down toCritical.

Status Adds the Minor Status.

Conclusions InterfacesDownInNode

Source Node Updates

See "Interface Down" (on page 394) for more information about Interface Down incidents.

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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On Layer 2 Neighbor View maps, the icon for the Aggregator Interface is yellow:

When an Interface Up occurs for all of the AggregationMember Interfaces that have a Status of
Critical, NNMi updates the following attributes:

l Each Aggregator Interface Status is changed toNormal.

l Each Aggregator Interface Conclusion is changed to AggregatorUp.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Aggregator Interface Down (NNMi Advanced)
Link Aggregation1: NNMi generates anAggregator Interface Downwhen the Status of all
AggregationMember Interfaces are set toCritical.

An Aggregator Interfacemight becomeCritical when NNMi determines either of the following:

l The Aggregator Interface exists in the interface table and its MIB II ifOperStatus is Down.

l All of the participating AggregationMember Interfaces have aMIB-II ifOperStatus of Down.

See Layer 2 Neighbor View MapObjects for more information about Aggregator Interfaces.

An Aggregator Interface Down incident has Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theAggregatorDown Conclusion.

Incident Adds theAggregator Interface Down incident.

TheCorrelated Children tab has an Interface Down incident for themember
interfaces that have a Status of Critical.

Status Adds theCritical Status.

Overall
Status

Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Tab Description

Interfaces Changes the State and Status of all member interfaces that have anOperational
State of Down toCritical.

Status Adds the Minor Status.

Conclusions InterfacesDownInNode

Source Node Updates

See "Interface Down" (on page 394) for more information about Interface Down incidents.

On Layer 2 Neighbor View maps, the icon for the Aggregator Interface is red:

When an Interface Up occurs for the Aggregation Interfaces that have a Status of Critical, NNMi
updates the following attributes:

l The Aggregator Interface Status is changed toNormal.

l The Aggregator Interface Conclusion is changed to AggregatorUp.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Aggregator Connection Degraded (NNMi Advanced)
Link Aggregation1: NNMi generates anAggregator Connection Degraded incident when the
Status of at least one of the Aggregator Interfaces (at either end of the connection) is set toMinor.
See Layer 2 Neighbor View MapObjects for more information about Aggregator Interfaces and
Aggregator Layer 2 Connections. Also see "Aggregator Interface Degraded (NNMi Advanced)" (on
page 382).

An Aggregator Connection Degraded incident has a Severity set toMinor.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theAggregatorLinkDegraded Conclusion.

Incident Adds theAggregator Connection Degraded incident.

Source Object Updates

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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Tab Description

TheCorrelated Children tab has anAggregator Degraded incident for each
Aggregator Interface.

Status Adds theMinor Status.

Overall
Status

Changes toMinor.

Source Object Updates, continued

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Interfaces Changes the State and Status of all AggregationMember Interfaces that have an
Operational State of Down toCritical.

Status Adds the Minor Status.

Conclusions InterfacesDownInNode

Source Node Updates

See "Interface Down" (on page 394) for more information about Interface Down incidents.

On Layer 2 Neighbor View maps, the icon for the Aggregator Layer 2 Connection is yellow:

When NNMi determines that all Aggregator Interfaces in an Aggregator Connection are up, NNMi
updates the following attributes:

l The Aggregator Connection Status is changed toNormal.

l The Aggregator Connection Conclusion is changed to AggregatorLinkUp.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Aggregator Connection Down (NNMi Advanced)
Link Aggregation1: NNMi generates anAggregator Connection Down incident when the
Status of at least one of the Aggregator Interfaces is set toCritical. See Layer 2 Neighbor View

1Protocols used on Switches to configuremultiple Interfaces (AggregationMember Interfaces) to
function as if they were one (an Aggregator Interface). When two Aggregator Interfaces establish a
connection, that connection is an Aggregator Layer 2 Connection. The Aggregator Layer 2
Connection appears on Layer 2 Neighbor View maps as a thick line with an Interface icon at each
end (representing the Aggregator Interface). When you double-click the thick line, it converts into
multiple thin lines representing the participating AggregationMember Layer 2 Connections with their
AggregationMember Interfaces at each end of the lines.
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MapObjects for more information about Aggregator Interfaces and Aggregator Layer 2
Connections. Also see "Aggregator Interface Down (NNMi Advanced)" (on page 383).

An Aggregator Connection Down incident has Severity set toCritical.

On the Source Object form NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theAggregatorLinkDown Conclusion.

Incident Adds theAggregator Connection Down incident.

TheCorrelated Children tab includes theAggregator Down incidents under
this incident.

Status Adds theCritical Status.

Overall
Status

Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Interfaces Changes the State and Status of all member interfaces that have anOperational
State of Down toCritical.

Status Adds the Minor Status.

Conclusions InterfacesDownInNode

Source Node Updates

See "Interface Down" (on page 394) for more information about Interface Down incidents.

On Layer 2 Neighbor View maps, the icon for the Aggregator Connection is red:

When NNMi determines that all Aggregator Interfaces in an Aggregator Connection are up, NNMi
updates the following attributes:

l The Aggregator Connection Status is changed toNormal.

l The Aggregator Connection Conclusion is changed to AggregatorLinkUp.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Buffer has Insufficient Capacity or is Malfunctioning
A Buffer has Insufficient Capacity or is Malfunctioning incident indicates the buffer pool for the
Source Node is either exhausted or cannot meet the demand for use.
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A Buffer has Insufficient Capacity or is Malfunctioning incident is generated with Severity set
toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theBufferOutOfRangeOrMalfunctioning Conclusion.

Incident Adds theBuffer has Insufficient Capacity or is Malfunctioning incident.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

The Source Nodemap icon does not change color because this incident does not affect Node
Status.

When NNMi determines that the buffer is functioning properly, NNMi updates the following
attributes:

l The Node Status is changed toNormal.

l The Node Conclusion is changed to BufferInRangeAndFunctioning.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Card Disabled
Note: Card Disabled incidents are disabled by default. If you are an NNMi administrator, see

Generate Card Disabled Incidents for information about how to enable this incident.

NNMi periodically uses SNMP to check each card. If an SNMP agent reports that a card has an
Administrative State of Down, NNMi's Causal Engine takes the following actions.

A Card Disabled Incident incident is generated with Severity set toMinor.

Note: If the current card is a parent card, NNMi generates aCard Disabled incident on all daughter
cards.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theCardDisabled Conclusion.

Note: If the SNMP Agent reports the card has anOperational State of Down, then
NNMi also adds aCardDown conclusion. TheCard Down incident is not
generated.

Incident Adds theCard Disabled incident.

TheCorrelated Children tab includes any associated traps.

Source Object Updates
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Tab Description

Status Adds theDisabled Status.

Overall
Status

Changes toDisabled

Source Object Updates, continued

The Source Nodemap icon does not change color because this incident does not affect Node
Status.

When NNMi determines that the card has an Administrative State of Up, NNMi updates Information
in theCorrelation Notes attribute and closes the incident. See "Incident Form: General Tab" (on
page 303) for more information.

See "Card Form" (on page 164) for more information about card States and Status.

Card Down
You receive aCard Down incident when NNMi analyzed the situation and determined any of the
following:

l The card's Operational State is Down.

l The Daughter card's Operational State is Down.

A Card Down incident is generated with Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theCardDownConclusion.

Incident Adds theCard Down incident.

TheCorrelated Children tab includes the following:

l All ConnectionDown and InterfaceDown incidents that are associated with
this card under this incident.

l Any associated traps.

Status Adds theCritical Status.

Overall
Status

Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Cards Changes the State and Status of the cards hosted on the node that have an
Operational State of Down toCritical.

Source Node Updates
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Tab Description

Interfaces Changes the State and Status of interfaces hosted on the card that have an
Operational State of Down toCritical.

Status Adds the Minor Status.

Conclusions CardsDownInNode

Source Node Updates, continued

On themaps, the icon for the Source Node is set to yellow.

When NNMi determines that the Card has anOperational State of Up, the Node can be reached,
and all of the Node's IP addresses respond to ICMP, NNMi updates the following attributes:

l The Card Status is changed toNormal.

l The Card Conclusion is changed to CardUp.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Node Status is changed toNormal. The Conclusion on the Node is CardsUpInNode.

See "Card Form" (on page 164) for more information about card states and status.

Card Undetermined State
Note: TheCard Undetermined State incident is disabled by default. If you are an NNMi

administrator, seeGenerate Card Undetermined State Incidents for information about how to
enable this incident.

You receive aCard Undetermined State incident when NNMi cannot determine the Card's State
for one of the following reasons:

l The SNMP agent responded with a value for the card's Operational Status of Unavailable

l The SNMP agent returned a value outside the range of possible values or returned a null value

A Card Undetermined State incident is generated with Severity set toMinor.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theCardUndeterminedStateConclusion.

Incident Adds theCard Undetermined State incident.

Status Adds theMinor Status.

Overall Status Changes toMinor.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:
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Tab Description

Cards Changes the State and Status of the cards hosted on the node that have a Status
of Minor toMinor.

Status Adds the Minor Status.

Conclusions CardsUndeterminedStateInNode

Source Node Updates

On themaps, the icon for the Source Node is set to yellow.

When NNMi determines that the card has anOperational State of Up, NNMi updates the following
attributes:

l The Card Status changes toNormal.

l The Card Conclusion changes to CardUp.

l NNMi updates Information in the Correlation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

See "Card Form" (on page 164) for more information about card States and Status.

Connection Down
NNMi periodically uses SNMP to check the interface on each end of a connection. NNMi's Causal
Engine uses this information to determine the Status of the connection. If both ends of the
connection are down, the Causal Engine determines that the connection is down.

A Connection Down incident is generated with Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theConnectionDown Conclusion.

Incident Adds theConnection Down incident.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Interfaces Changes the State and Status of interfaces hosted on the node that have an
Operational State of Down toCritical.

Status Adds the Minor Status.

Conclusions InterfacesDownInNode

Source Node Updates
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On themaps, the Causal Engine sets the color of the line between the devices according to the
following criteria (the line indicates the connection):

l Red: neither interface is responding.

l Green: Both interfaces are responding.

l Yellow: the interface on one end is not responding. The interface on the other end is
responding.

l Blue: due to other network problems, the status of one interface cannot be determined at
this time.

When NNMi determines that the Connection is Up, NNMi updates the following attributes:

l The Connection Status is changed toNormal.

l The Connection Conclusion is changed to ConnectionUp.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

CPU Utilization is too High
 A CPU Utilization is too High incident indicates any of the following utilization averages is too
high:

l 5 second

l 1minute

l 5minute

A CPU Utilization is too High incident is generated with Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theCpuOutOfRangeOrMalfunctioning Conclusion.

Incident Adds theCPU Utilization is too High incident.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

WhenNNMi determines that the CPU utilization is nominal, NNMi updates the following attributes:
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l The Source Object Status is changed toNormal.

l The Source Object Conclusion is changed to CpuInRangeAndFunctioning.

l NNMi updates Information in theCorrelation Noteattribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Custom Polled Instance in Collection is Out of Range
Note: The NNMi administrator determines whether NNMi generates Custom Polled Instance1

incidents. If you are an NNMi administrator, seeConfigure Basic Settings for a Custom
Poller Collection for more information.

 A Custom Polled Instance in Collection is Out of Range incident indicates a Custom Polled
Instance has reached or exceeded a ComparisonMap value or Threshold configured for the
associatedCustom Node Collection2.

A Custom Polled Instance in Collection is Out of Range incident is generated with the
Severity equal to the Status of the Custom Polled Instance. For example, if the Status of the
Custom Polled Instance is Critical, NNMi generates the associated incident with a Severity of
Critical.

If the Status of the Custom Polled Instance is Normal, NNMi does not generate an incident.

The Name of the Source Object for a Custom Polled Instance Incident is the display value that is
determined using the Instance Display Configuration for the associatedMIB Expression.

If the Instance Display Configuration is not set, NNMi identifies the Source Object using the
topology Node Name followed by theMIB Instance value in the format: <node_name> -.<MIB_
instance_value>.

Note: The Name that NNMi uses to identify the Custom Polled Instance Incident’s Source Object
is not stored in the NNMi database as the Custom Polled Instance object Name.

On the Custom Polled Instance form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds one of the following Conclusions:

CustomPolledInstanceCritical

CustomPolledInstanceMajor

Source Object Updates

1A Custom Polled Instance represents the results of aMIB expression when it is evaluated against
a node. The first time aMIB Expression is validated with discovery information, the results appear
in theMonitoring workspace's Custom Polled Instances view. The Custom Polled Instance is
updated whenever a change in State occurs and includes themost recent polled value that caused
the State to change. These results are then used to determine the Status of the associated Custom
Node Collection.
2A Custom Node Collection identifies a topology node that has at least one associated Custom
Poller Policy. Because a topology node can be associated with more than one Policy, the same
topology nodemight appear in multiple Custom Node Collections.
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Tab Description

CustomPolledInstanceMinor

CustomPolledInstanceWarning

Incident Adds theCustom Polled Instance in Collection is Out of Range incident.

Status Adds the Status of the Custom Polled Instance object.

Overall Status Changes to the Status of the Custom Polled Instance object.

Source Object Updates, continued

WhenNNMi determines that the Custom Polled Instance is Normal, NNMi updates the following
attributes:

l The Custom Polled Instance Status is changed toNormal.

l The Custom Polled Conclusion is changed to CustomPolledInstanceNormal.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Fan is Out of Range or Malfunctioning
A Fan is Out of Range or Malfunctioning incident indicates the identified fan on the Source
Node is not operating correctly.

A Fan is Out of Range or Malfunctioning incident is generated with Severity set toCritical.

Note: Only the health of the Fan and Power Supply Node Components are propagated to the Node
level.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds the FanOutOfRangeOrMalfunctioning Conclusion.

Incident Adds the Fan is Out of Range or Malfunctioning incident.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Node
Components

The State and Status of malfunctioning fans that are hosted on the node are
changed toCritical.

Status Adds the Major Status.

Source Node Updates
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Tab Description

Conclusions NodeWithBadFan

Source Node Updates, continued

On themap, the Causal Engine sets the color of the Source Node to orange.

When NNMi determines that the fan is functioning properly, NNMi udpates the following attributes:

l The Node Component Status changes toNormal.

l The Node Component Conclusion changes to FanInRangeAndFunctioning.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Conclusion on the Node is NodeWithGoodFans.

Interface Down
NNMi periodically uses SNMP to check each interface. If an SNMP agent reports that an interface
is down (MIB-II ifOperStatus), NNMi's Causal Engine takes the following actions.

An Interface Down incident is generated with Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds the InterfaceDown Conclusion.

Incident Adds the Interface Down incident.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Interfaces Changes the State and Status of the interface toCritical.

Note: Youmight find relevant traps on theCorrelated Children tab.

Addresses If the interface has one or more addresses, the State and Status is Critical if the
address is no longer reachable.

Status Adds the Minor Status.

Conclusions InterfacesDownInNode

Source Node Updates

On themaps, the icons for the Source Node and its interfaces are updated:
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When the Interface is operationally up, the Node can be reached, and all of the Node's IP
Addresses respond to ping, NNMi updates the following attributes:

l The Interface Status is changed toNormal.

l The Interface Conclusion is changed to InterfaceUp.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Node Status is changed toNormal. The Conclusion on the Node is
InterfaceUpInNode.

Interface Disabled
NNMi periodically uses SNMP to check each interface. If an SNMP agent reports that an interface
is administratively down (MIB-II ifAdminStatus), NNMi's Causal Engine takes the following
actions.

Note: Interface Disabled incidents are not generated by default. If you are an NNMi administrator,
seeGenerate Interface Disabled Incidents for information about how to enable this incident.

An Interface Disabled incident is generated with Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds the InterfaceDisabled Conclusion.

Incident Adds the Interface Disabled incident.

Note: If the SNMP agent reports that the Operational State of the interface is
Down, an InterfaceDown Conclusion is also added. The Interface Down
incident is not generated.

TheCorrelated Children tab includes any associated link down traps.

Status Adds theDisabled Status.

Overall
Status

Changes toDisabled.

Associated
IP Addresses

Adds the AddressDisabled Conclusion.

Source Object Updates

On themaps, the icons for any of the Source Node's disabled interfaces are updated, the color of
the interface icon changes to gray (disabled):
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When the Interface is administratively up, the node's SNMP Agent is up, and the IP Address
associated with the Interface responds to ICMP, NNMi updates the following attributes:

l The Interface Status is changed toNormal.

l The Interface Conclusion is changed to InterfaceEnabled.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Interface's IP Addresses Status is changed toEnabled. The Conclusion on the IP Address
is AddressEnabled.

IP Subnet Contains IP with New MAC Address
NNMi generates an IP Subnet Contains IP with New MAC Addresswhen it detects that the
MAC Address corresponding to a particular IP Address has changed. This situationmight occur
when NNMi performs a configuration poll on certain devices (for example, routers) and indicates
that a possible duplicate IP Address exists on this subnet.

Note: NNMi can detect a change in theMAC address even if the particular IP Address is not
discovered.

An IP Subnet Contains IP with New MAC Address incident is generated with Severity set to
Major.

The Source Nodemap icon does not change color because this incident does not affect Node
Status.

After 24 hours, NNMi automatically closes the incident.

Memory has Insufficient Capacity or is Malfunctioning
AMemory has Insufficient Capacity or is Malfunctioning incident indicates thememory pool
for the Source Node is exhausted or cannot meet the demand for use.

AMemory has Insufficient Capacity or is Malfunctioning incident is generated with Severity
set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theMemoryOutOfRangeOrMalfunctioning Conclusion.

Incident Adds theMemory has Insufficient Capacity or is Malfunctioning incident.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates
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On the Source Node form, NNMi updates information on the following tabs:

Tab Description

NodeComponents Changes the State and Status of themalfunctioningmemory toCritical.

Status Adds theMajor Status.

Conclusions NodeWithBadMemory

Source Node Updates

On themap, the Causal Engine sets the color of the Source Node to yellow.

When NNMi determines that thememory pool is functioning properly, NNMi updates the following
attributes:

l The Source Object Status is changed toNormal.

l The Source Object Conclusion is changed toMemoryInRangeAndFunctioning.

l NNMi updates Information in the Correlation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Source Node Conclusion is changed to NodeWithGoodMemory.

Node Down
An unresponsive device within your network can cause a variety of problems. If the troubled device
is a router, switch, or server, many devices could be unreachable. You receive aNode Down
incident when NNMi analyzed the situation and determined any of the following:

l A node with two or more connections is truly down.

l A node that has no discovered connections is unreachable. (No connections have been
discovered for the node.)

l A node belongs to the Important Nodes Group and has become unreachable. Your NNMi
administrator assigns devices to this NodeGroup (these devices can have any number of
connections).

l A node's neighbor is up and the node is unresponsive.

Reasons NNMi might not successfully ping all of the addresses for a node include one or more
devices between the non-SNMP node and its neighbor device are down.

Note: If a node does not have an SNMP agent, NNMi gathers only the address information for
the node.

A Node Down incident is generated with Severity set toCritical, and themap icon is set to red (see
MapDisplays).

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theNodeDownConclusion.

Source Object Updates
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Tab Description

Incident Adds theNode Down incident.

On theCorrelated Children tab, any Interface Down incident on neighbors that
are one hop from the node are correlated under theNode Down incident.

Status Adds theCritical Status.

Overall
Status

Changes toCritical.

Source Object Updates, continued

Note: When NNMi cannot determine whether the node or connection is down, it generates aNode
or Connection Down incident. See "Node or Connection Down" (on page 399) for more
information.

NNMi does not generate a Node Down incident for node under the following conditions:

l If the node is in the shadow of another node that causes the node to be unreachable.

l If the node is in an ATM or FrameRelay cloud that causes the node to be unreachable.

Map Displays

The Status of the Node Down device for a Source Node changes toCritical and the device's map
icon color changes to red (Router 3 in the illustration below). The status of each unreachable
interface changes toUnknown and the interfacemap icon color changes to blue.

Any other devices that are unreachable because of this problem are in the "shadow" of the problem:

l The unreachable shadow devices' map icons change to blue.

l Nodes that aremembers of the Important Nodes group's map icons change to red (Switch_56 in
the illustration below).

HP Network NodeManager i Software (9.21)Page 398 of 454



Online Help: Help for Operators
Chapter 9: Investigate and Diagnose Problems

WhenNNMi determines that the Node is Up, NNMi updates the following attributes:

l The Node Status is changed toNormal.

Note: If all of the access switches to any Nodes in the shadow are reachable, the Status of
any Nodes in the shadow is also changed toNormal.

l The Node Conclusion is changed to NodeUp.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Node or Connection Down
If a non-SNMP node is not responding to ICMP or an SNMP node is not responding to ICMP and
SNMP queries, and only one neighbor is down, the Causal Engine cannot determine whether the
node itself is down or whether the connection to the node is down.

A Node or Connection Down incident is generated with Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:
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Tab Description

Conclusion Adds theNodeOrConnectionDown Conclusion.

Incident Adds theNode or Connection Down incident.

On theCorrelated Children tab, the Interface Down incident on neighbor that is
one hop from the node is correlated under theNode or Connection Down
incident.

Status Adds theCritical Status.

Overall
Status

Changes toCritical.

Source Object Updates

Map Displays

The Status of the Node or Connection Down device for a Source Node changes toCritical and the
device's map icon color changes to red .

The status of each unreachable interface changes toUnknown and the interfacemap icon color
changes to blue.

Any other devices that are unreachable because of this problem are in the "shadow" of the problem:

l The unreachable shadow devices' map icons change to blue.

l Nodes that aremembers of the Important Nodes group's map icons change to red.

Tip: See "MapDisplays" in "Node Down" (on page 397) for more information.

When NNMi determines that the Source Node in the Connection is Up, NNMi updates the following
attributes:

l The Node Status is changed toNormal.

l The Connection Status is changed toNormal.

l The Node Conclusion is changed to NodeUp.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Power Supply is Out of Range or Malfunctioning
A Power Supply is Malfunctioning incident indicates the Source Node's specified power supply
is not operating correctly.

A Power Supply is Malfunctioning incident is generated with Severity set toCritical.

Note: Only the health of the Power Supply and Fan Node Components are propagated to the Node
level.

On the Source Object form NNMi updates information on the following tabs:
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Tab Description

Conclusion Adds thePowerSupplyOutOfRangeOrMalfunctioning Conclusion.

Incident Adds thePower Supply is Malfunctioning incident.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

NodeComponents Changes the State and Status of themalfunctioning fan toCritical.

Status Adds the Major Status.

Conclusions NodeWithBadPowerSupply

Source Node Updates

On themap, the Causal Engine sets the color of the Source Node to orange.

When NNMi determines that the power supply is functioning properly, NNMi updates the following
attributes:

l The Source Object Status is changed toNormal.

l The Source Object Conclusion is changed to PowerSupplyInRangeAndFunctioning.

l NNMi updates Information in the Correlation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Source Node Conclusion is NodeWithGoodPowerSupply.

Island Group Down
A Island Group Down incident is generated when all of the nodes in an Island do not respond to
ICMP or SNMP queries.

An IslandGroup is a group of fully-connected nodes discovered by NNMi, and NNMi determines
this group is not connected to the rest of the topology.

Note: Islands must have at least two nodes, are created by NNMi, and cannot bemodified.

An example of an environment with multiple Islands is a financial institution or retail store with many
branches or stores. Each branch or storemight be connected to other branches or stores with a
WAN (Wide Area Network) connection. Each branch or store appears as an isolated island of
nodes in the NNMi topology.

NNMi checks for Islands and, when applicable, automatically creates them whenever it detects
changes in Layer 2 Connections.

NNMi selects a representative node in each Island as the Source Node associated with the Island
Group Down incident. The Source Object for this incident is the IslandGroup.
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WhenNNMi determines that a node in the Island is reachable, NNMi updates the information in the
Correlation Notes attribute and closes the incident. See "Incident Form: General Tab" (on page
303) for more information.

SNMP Agent Not Responding
NNMi periodically uses SNMP to check the availability of each SNMP Agent in your network
environment. Possible reasons an SNMP Agent is not responding include the following:

l The SNMPv1 or SNMPv2c read community string for this agent changed

l The SNMPv3User Name for this agent changed and the NNMi communication configuration
settings have not yet been updated

A SNMP Agent Not Responding incident is generated with Severity set toMinor.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theSNMPAgentNotResponding Conclusion.

Incident Adds theSNMP Agent Not Responding incident.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Interfaces The Status of polled interfaces is set toUnknown.

Status Adds the Minor Status.

Conclusions UnresponsiveAgentInNode

Source Node Updates

On themaps, the icons for themonitored Source Node (status = Minor) and its interfaces (status =
Unknown) are updated:

When NNMi determines that the agent is responding, NNMi updates Information in theCorrelation
Notes attribute and closes the incident. See "Incident Form: General Tab" (on page 303) for more
information.

When NNMi determines that SNMP Agent for the Source Node is responding, NNMi updates the
following attributes:
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l The SNMP Agent Status is changed toNormal.

l The SNMP Agent Conclusion is changed to SNMPAgentResponding.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Node Status is changed toNormal. The Conclusion on the Node is
ResponsiveAgentInNode.

l The Node's Interfaces return to their previous Status and the InterfaceUnmanageable
Conclusion is cleared from the Node's polled Interfaces.

l The Node's Cards return to their previous Status and the CardUnmanageable Conclusion is
cleared from the Node's polled Cards.

SNMP Agent Ping Not Responding
NNMi periodically performs ICMP requests to the SNMP Agent IP Address. If there is no response
and the node is not completely unreachable, NNMi's Causal Engine determines that the SNMP
Agent IP Address on the device is not responding.

On the Source Object form NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theSNMPAgentPingNotResponding Conclusion.

Incident No incident is generated.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Status Adds the Minor Status.

Conclusions SNMPAgentPingUnresponsiveInNode

Source Node Updates

On themaps, the icon for the Source Node is set to yellow.

When the SNMP Agent IP Address starts responding to ICMP requests, NNMi updates the
following attributes:

l The SNMP Agent IP Address Status is changed toNormal.

l The SNMP Agent IP Address Conclusion is changed to SNMPAgentPingResponding.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Source Node Conclusion is SNMPAgentPingResponsiveInNode.
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Temperature Sensor is Out of Range
A Temperature Sensor is Out of Range incident indicates the Source Node's temperature sensor
is either too hot or too cold.

A Temperature Sensor is Out of Range incident is generated with Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds the TemperatureOutOfRangeOrMalfunctioning Conclusion.

Incident Adds the Temperature Sensor is Out of Range incident.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

The Source Nodemap icon does not change color because this incident does not affect Node
Status.

When NNMi determines that the temperature sensor is within the normal range (nominal), NNMi
udpates the following attributes:

l The Node Status changes toNormal.

l The Node Conclusion changes to TemperatureInRangeAndFunctioning.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Voltage is Out of Range
A Voltage is Out of Range incident indicates the specified voltage on one of the Source Node's
power supplies is out of range.

A Voltage is Out of Range incident is generated with Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theVoltageOutOfRangeOrMalfunctioning Conclusion.

Incident Adds theVoltage is Out of Range incident.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall Status Changes toCritical

Source Object Updates
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The Source Nodemap icon does not change color because this incident does not affect Node
Status.

When NNMi determines that the voltage is within the normal range (nominal), NNMi updates the
following attributes:

l The Node Component Status changes toNormal.

l The Node Component Conclusion changes to VoltageInRangeAndFunctioning.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Interpret Incidents Related to SNMP Traps
Tip: Also see "Investigate and Diagnose Problems" (on page 347) for more information about

troubleshooting tools that NNMi provides.

In addition to tracking Root Cause Incidents, NNMi accepts traps and (if there is a corresponding
incident configuration that is enabled) generates a corresponding incidents to inform you of a
potential problem.

The following Incidents are generated only in a Global Network Management Environment: 

"Forwarded Incident Rate Exceeded Limit (NNMi Advanced)" (on page 405)

"$hostNameMessageQueue Size Exceeded Limit (NNMi Advanced)" (on page 406)

The following incidents are generated as a result of exceeding trap threshold limits.

"Hosted Object Trap Storm" (on page 407)

"Trap Storm" (on page 408)

Note: If you are an NNMi administrator, see Control which Incoming Traps Are Visible in Incident
Views for a list of the SNMP Trap Incidents that NNMi enables by default.

Forwarded Incident Rate Exceeded Limit (NNMi Advanced)
(NNMi Advanced) When theGlobal Network Management feature is enabled, a queue is
established on each Regional Manager. This queue holds information to be forwarded to Global
Managers. See "NNMi's Global Network Management Feature (NNMi Advanced)" (on page 20) for
more information about this feature.

A Forwarded Incident Rate Exceeded Limit incident indicates that the volume of messages
entering a Regional Manager's Global Network Management message queue has exceeded
configured rate limits. The default rate is 20 incidents per second within a 5minute period (6,000
incidents within 5minutes).

Note: If a sudden burst of incident forwarding occurs, for example 6,000 incidents within 2minutes,
the threshold rate is reached.

When themessage queue's incident rate lower limit is exceeded, NNMi does the following:

l Generates a Forwarded Incident Rate Exceeded Limit incident with the Severity set to
Critical.
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l Generates aGlobalNetworkManagementIncidentRateLimitExceeded health conclusion with
the Severity set toMajor.

l Stops forwarding to Global Managers any incidents generated from SNMP Traps and NNM
6.x/7.x Remote Events.

Note: The NNMi administrator must specifically configure SNMP Traps and NNM 6.x/7.x Remote
Events to be forwarded from this Regional Manager to Global Managers. 

Tip: To view the associated conclusion information, check the health of the Regional Manager
using theHealth tab from Help→ System Information.

NNMi closes the incident when the incident rate falls below 90 percent of the threshold and the next
incident has been successfully forwarded.

$hostName Message Queue Size Exceeded Limit (NNMi Advanced)
(NNMi Advanced) When theGlobal Network Management feature is enabled, a queue is
established on each Regional Manager. This queue holds information to be forwarded to Global
Managers. See "NNMi's Global Network Management Feature (NNMi Advanced)" (on page 20) for
more information about this feature.

A $hostName Message Queue Size Exceeded Limit incident indicates that a Regional
Manager's Global Network Management message queue has exceeded configured limits:

l Default lower limit is 200,000messages.

l Default upper limit is 250,000messages.

When themessage queue size's lower limit is reached, NNMi generates the following:

l A $hostName Message Queue Size Exceeded Limit incident with the Severity set to
Warning.

l A GlobalNetworkManagementIncidentQueueSizeLimitExceeded health conclusion with the
Severity set toWarning.

When themessage queue size's upper limit is reached, NNMi generates the following:

l A $hostName Message Queue Size Exceeded Limit incident with the Severity set to
Critical.

l A GlobalNetworkManagementIncidentQueueSizeLimitExceeded health conclusion with the
Severity set toMajor.

l Stops forwarding to Global Managers any incidents generated from SNMP Traps and NNM
6.x/7.x Remote Events.

Note: The NNMi administrator must specifically configure SNMP Traps and NNM 6.x/7.x
Remote Events to be forwarded from this Regional Manager to Global Managers. 

Tip: To view the conclusion information that generated this incident, check the health of the
Regional Manager using theHealth tab from Help→ System Information.

This incident indicates a connection problem with a Global Manager. Click Help→ System
Information and select theGlobal Network Management tab to identify which Global Manager is
not currently connected.

To resolve this issue, communication with that Global Manager must be reestablished.
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Hosted Object Trap Storm
A Hosted Object Trap Storm incident indicates that the trap rate for an object on the specified
node has exceeded a configured threshold.

Tip: Tomodify the thresholds for trap storm detection and suppression, see nnmtrapconfig.ovpl.

Use this incident to determine the following:

CIA Description

trapSource The IP address of the SNMP agent from which the SNMP traps originated.

totalTrapRate The total trap rate for the Node identified as the Source Node.

Suppressed
Hosted
Objects

A report containing all of the Source Objects on the specified Node that have
exceeded a trap rate threshold. All SNMP traps are suppressed for the specified
Object when the trap rate threshold is exceeded.

Note the following:

l The report tracks the average trap rate over time.

Tip: If a trap storm spike was the source of the problem, this report
might show a lower than expected trap rate, because NNMi gathers the
report data after the initial incident.

l If the report exceeds the 2000 character limit, NNMi continues to log the
information using subsequent files numbered consecutively; for
example: suppressedHosteObjects.1,
suppressedHostedObjects.2, and so on.

Unsuppressed
Hosted
Objects

A report containing all of the Source Objects on the specified Node that have
traps that are not currently suppressed. This means the trap rate threshold has
not been exceeded for these objects.

Note the following:

l The report tracks the average trap rate over time.

Tip: If a trap storm spike was the source of the problem, this report
might show a lower than expected trap rate, because NNMi gathers the
report data after the initial incident.

l If the report exceeds the 2000 character limit, NNMi continues to log the
information using subsequent CIAs numbered consecutively; for
example: unsuppressedHosteObjects.1,
unsuppressedHostedObjects.2, and so on.

Trap Information Source

Note the following: 
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l NNMi determines threshold rates every 2minutes. This means a trap ratemust be below the
threshold for at least the 2minute interval before the incident is canceled.

l If multiple objects are exceeding the specified threshold, NNMi generates the incident as soon
as one object exceeds the configured threshold. The Source Object for the incident is the first
object that exceeds the trap storm threshold.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theHosted Object Trap Storm Conclusion.

Incident Adds theHosted Object Trap Storm incident.

Status Adds theWarning Status.

Overall Status Changes toWarning.

Source Object Updates

On themaps, the icon for the Source Node is set to teal.

When the trap rate returns to below the configured threshold, NNMi cancels the incident.
See"Incident Form: General Tab" (on page 303) for more information.

Trap Storm
A Trap Storm incident indicates one of the following:

l The overall trap rate in your network management domain exceeds a set threshold. Use the
overallThresholdRate argument to the nnmtrapconfig.ovpl command to set this threshold.

Note:The incident's blockedSources and blockedTraps CIA values are set to all.

l The trap rate on an IP address in a Node exceeds a set threshold. Use the thresholdRate
argument to the nnmtrapconfig.ovpl command to set this threshold.

Note:The incident's blockedSources CIA value contains the IP address of the node that is
the source of the trap storm. The blockedTraps CIA is set to all.

l The overall trap rate for a specific trap (Object Identifier) exceeds a threshold. Use the
thresholdRate argument to the nnmtrapconfig.ovpl command to set set this threshold.

Note:The incident's blockedSources CIA value is set to all. The incident's
blockedTraps CIA contains the Object Identifier (OID) of the trap that has exceeded the
specified threshold value.

Tip: Tomodify the thresholds for trap storm detection and suppression, see nnmtrapconfig.ovpl.

Note the following: 

l NNMi determines threshold rates every 5minutes. This means a trap ratemust be below the
threshold for at least the 5minute interval before the incident is canceled.

l If multiple nodes are exceeding the specified threshold, NNMi tracks information for only the first
node that has exceeded the trap storm threshold until it can cancel the incident.

Use this incident to determine the following:
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CIA Description

trapRate The trap rate for the first trap that has exceeded the threshold limit.

blocked
Sources

The IP address for the Node, if any, that has suppressed traps.

Note: This CIA vaue is all if the overall trap rate is exceeded or if the overall
trap rate for a specific trap OID is exceeded.

blockedTraps A report containing all of the nodes that have traps that are currently suppressed.

Note: This CIA vaue is all if the overall trap rate is exceeded or if the overall
trap rate for a specific node is exceeded.

Trap Information Source

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds the Trap Storm Conclusion.

Incident Adds the Trap Storm incident.

Status Adds theWarning Status.

Overall Status Changes toWarning.

Source Object Updates

On themaps, the icon for the Source Node is set to teal.

When the trap rate returns to below the configured threshold, NNMi cancels the incident.
See"Incident Form: General Tab" (on page 303) for more information.

Interpret Informational Incidents
Tip: Also see "Investigate and Diagnose Problems" (on page 347) for more information about

troubleshooting tools that NNMi provides.

In addition to tracking Root Cause Incidents, NNMi's Causal Engine tracks changes in your
network and generates incidents to inform you of changes to your network devices that might be of
interest. These incidents are informational and have a Correlation Nature of Info. To view these
incidents, create a filter for theAll Incidents view, using the Correlation Nature column, and select
the value Info from the enumerated list of values . See Filter a Table Views for more information
about using filters in table views.

Examples of incidents generated to inform you of network changes include the following: 

l "Card Removed" (on page 409)

l "Card Inserted" (on page 410)

Card Removed
Tip: Also see "Investigate and Diagnose Problems" (on page 347) for more information about

troubleshooting tools that NNMi provides.

A Card Removed incident indicates a card has been removed from the Source Node.
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A Card Removed Incident is generated with the Severity set toWarning.

On the Source Object (which is a node) form, NNMi updates information on the following tab:

Tab Description

Incident Adds theCard Removed incident.

The Correlated Children tab includes any associated traps.

Source Node Updates

Note: NNMi does not automatically closeCard Removed incidents.

See "Card Form" (on page 164) for more information about card States and Status.

Card Inserted
Tip: Also see "Investigate and Diagnose Problems" (on page 347) for more information about

troubleshooting tools that NNMi provides.

A Card Inserted incident indicates a Card has been inserted into the Source Node.

A Card Inserted Incident is generated with the Severity set toNormal.

On the Source Object (which is a node) form, NNMi updates information on the following tab:

Tab Description

Incident Adds theCard Inserted incident.

The Correlated Children tab includes any associated traps.

Source Node Updates

Note: NNMi does not automatically closeCard Inserted incidents.

Node Deleted
Tip: Also see "Investigate and Diagnose Problems" (on page 347) for more information about

troubleshooting tools that NNMi provides.

A Node Deleted incident indicates a Node was deleted from the NNMi topology.

A Node Deleted Incident is generated with the Severity set toNormal.

Note: NNMi does not automatically closeNode Deleted incidents.

Interpret Service Impact Incidents
Service Impact incidents indicate a relationship between incidents in which a network service is
affected by other incidents. The Service Impact incident helps to identify the service that is
affected.

A Service Impact incident is indicated using the incident Correlation Nature attribute.

Note: NNMi determines the Correlation Nature for an incident.

NNMi Advanced. As an example of a Service Impact incident and its relationship between
additional incidents: an Interface Down incident on an interface that is part of a Router Redundancy
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Group can effect the integrity of a Router Redundancy Group that is part of an HSRP service. To
continue the example, A Router Redundancy Group Degraded incident might be the Service Impact
incident used to indicate there is a problem with your HSRP service. The Interface Down incident
would appear under the Conclusions tab for the Router Redundancy Degraded incident to indicate
that it is part of the reason the Router Redundancy Group (and subsequent HSRP service) has
become degraded.

NNMi provides the following incidents that have a Correlation Nature of Service Impact:

l "Muliple Primary Cards in Card Redundancy Group" (on page 411)

l "Multiple Primary Devices in Router Redundancy Group (NNMi Advanced)" (on page 412)

l "Multiple Secondary Devices in Router Redundancy Group (NNMi Advanced)" (on page 413)

l "No Primary Card in Card Redundancy Group" (on page 413)

l "No Primary Device in Router Redundancy Group (NNMi Advanced)" (on page 414)

l "No Secondary Card in Card Redundancy Group" (on page 415)

l "No Secondary Device in Router Redundancy Group (NNMi Advanced)" (on page 416)

l "Primary Device in Router Redundancy Group Switched (NNMi Advanced)" (on page 417)

l "Router Redundancy Group Degraded (NNMi Advanced)" (on page 417)

Note: NNMi determines the Correlation Nature for an incident.

See "Router Redundancy Group View (Inventory) (NNMi Advanced)" (on page 41) for more
information about Router Redundancy Groups.

Muliple Primary Cards in Card Redundancy Group
AMuliple Primary Cards in Card Redundancy Group incident means NNMi determined
multiple primary cards (for example, Card Active) are identified in a Card Redundancy Group.

This incident typically indicates that communication between cards in the group is malfunctioning.

AMuliple Primary Cards in Card Redundancy Group incident has Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theCrgMultiplePrimaryConclusion.

Incident Adds theMuliple Primary Cards in Card Redundancy Group incident.

TheCorrelated Children tab includes any associated traps.

Note: If any cards in the group have anOperational State of Down, theCard Down
incidents are correlated under the new incident

Status Adds theCritical Status.

Overall
Status

Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:
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Tab Description

Status Adds the Warning Status.

Conclusions CrgMalfunctionInNode

Source Node Updates

On themaps, the icon for the Source Node is set to teal.

When NNMi determines that the group contains one primary card, NNMi udpates the following
attributes:

l The Card Redundancy Group Status changes toNormal.

l The Card Redundancy Group Conclusion changes to CrgNormal.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Node Conclusion is CrgNormalInNode.

Multiple Primary Devices in Router Redundancy Group (NNMi
Advanced)

AMultiple Primary Devices in Router Redundancy Group incident means NNMi detected
multiple primary devices in a Router Redundancy Group (for example, HSRP Active or VRRP
Master).

This incident typically indicates that protocol-specific communication between routers in the group
is malfunctioning.

AMultiple Primary Devices in Router Redundancy Group incident has Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theRrgMultiplePrimaryConclusion.

Incident Adds theMultiple Primary Devices in Router Redundancy Group incident.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall Status Changes toCritical.

Source Object Updates

WhenNNMi detects that the group has one primary member, NNMi updates Information in the
Correlation Notes attribute and closes the incident. See "Incident Form: General Tab" (on page
303) for more information.

When NNMi determines that the group has one primary member, NNMi udpates the following
attributes:

l The Router Redundancy Group Status changes toNormal.

l The Router Redundancy Group Conclusion changes to RrgOnePrimary.
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l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

Multiple Secondary Devices in Router Redundancy Group (NNMi
Advanced)

AMultiple Secondary Devices in Router Redundancy Group incident means NNMi detected
more than one secondary router in a Router Redundancy Group using a Router Redundancy
Protocol that does not allow more than one router in a secondary role. That Router Redundancy
Protocol has a third designator to indicate routers that are available, but not currently serving as
primary or secondary (for example, HSRP Listen).

This incident typically indicates that protocol-specific communication between routers in the group
is malfunctioning.

AMultiple Secondary Devices in Router Redundancy Group incident has Severity set to
Critical.

On the Source Object form NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theRrgMultipleSecondaryConclusion.

Incident Adds theMultiple Secondary Devices in Router Redundancy Group
incident.

TheCorrelated Children tab includes any associated traps.

Status Adds theCritical Status.

Overall
Status

Changes toCritical.

Source Object Updates

WhenNNMi determines that the group has has one secondary member, NNMi closes the incident
and changes the Router Redundancy Group Status toNormal. No Conclusion is added.

No Primary Card in Card Redundancy Group
A No Primary Card in Card Redundancy Group incident means NNMi determined no primary
card (for example, Card Active) is identified in a Card Redundancy Group.

This typically indicates one of the following: 

l One card, or both cards have anOperational State of Down

l NNMi has identified only secondary cards (for example Card Standby) in the Card Redundancy
Group

l Communication between cards in the Card Redundancy Group is malfunctioning

A No Primary Card in Card Redundancy Group incident has Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:
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Tab Description

Conclusion Adds theCrgNoPrimaryConclusion.

Incident Adds theNo Primary Card in Card Redundancy Group incident.

TheCorrelated Children tab includes any associated traps

Note: If there are cards down in the group, theCard Down incidents is correlated
under the new incident

Status Adds theCritical Status.

Overall
Status

Changes toCritical.

Source Object Updates

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Status Adds the Warning Status.

Conclusions CrgMalfunctionInNode

Source Node Updates

On themaps, the icon for the Source Node is set to teal.

When NNMi determines that the group contains a primary card, NNMi udpates the following
attributes:

l The Card Redundancy Group Status changes toNormal.

l The Card Redundancy Group Conclusion changes to CrgNormal.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Node Conclusion is CrgNormalInNode.

l

No Primary Device in Router Redundancy Group (NNMi Advanced)
A No Primary Device in Router Redundancy Group incident means NNMi detected zero
primary devices in a Router Redundancy group (for example, zero HSRP Active or VRRP Master).

This typically indicates one of the following:

l Toomany routers are down.

l Protocol specific communication between routers in the group is malfunctioning.

A No Primary Device in Router Redundancy Group incident has Severity set toCritical.

On the Source Object form, NNMi updates information on the following tabs:
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Tab Description

Conclusion Adds theRrgNoPrimaryConclusion.

Incident Adds theNo Primary Device in Router Redundancy Group incident.

TheCorrelated Children tab includes any associated traps.

Note: If an interface in the group has anOperational State of Down, its Interface
Down incident is correlated under this incident.

Status Adds theCritical Status.

Overall
Status

Changes toCritical.

Source Object Updates

WhenNNMi determines that the group NNMi updates Information in theCorrelation Notes
attribute and closes the incident. See "Incident Form: General Tab" (on page 303) for more
information.

When NNMi determines that the group has a Primary member, NNMi udpates the following
attributes:

l The Router Redundancy Group Status changes toNormal.

l The Router Redundancy Group Conclusion changes to RrgOnePrimary.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

No Secondary Card in Card Redundancy Group
A No Secondary Card in Card Redundancy Group incident means NNMi determined no
secondary card (for example, Card Standby) is identified in a Card Redundancy Group.

This typically indicates the following:

l One of the two cards in the group has anOperational State of Down.

l The other card has been identified as primary (for example, Card Active).

l The Card Redundancy Group is functioning properly.

A No Primary Card in Card Redundancy Group incident has Severity set toMinor.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theCrgNoSecondaryConclusion.

Incident Adds theNo Secondary Card in Card Redundancy Group incident.

TheCorrelated Children tab includes any associated traps

Note: If there are cards down in the group, theCardDown incidents is correlated

Source Object Updates
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Tab Description

under the new incident

Status Adds theMinor Status.

Overall
Status

Changes toMinor.

Source Object Updates, continued

On the Source Node form, NNMi updates information on the following tabs:

Tab Description

Status Adds the Warning Status.

Conclusions CrgMalfunctionInNode

Source Node Updates

On themaps, the icon for the Source Node is set to teal.

When NNMi determines that the group contains a secondary card, NNMi udpates the following
attributes:

l The Card Redundancy Group Status changes toNormal.

l The Card Redundancy Group Conclusion changes to CrgNormal.

l NNMi updates Information in theCorrelation Notes attribute and closes the incident. See
"Incident Form: General Tab" (on page 303) for more information.

l The Node Conclusion is CrgNormalInNode.

No Secondary Device in Router Redundancy Group (NNMi
Advanced)

A No Secondary Device in Router Redundancy Group incident means NNMi detected zero
secondary devices in a Router Redundancy Group (for example, zero HSRP Standby or VRRP
Backup).

This incident typically indicates the following:

l Protocol-specific communication between routers in the group is malfunctioning.

l The group is routing packets properly because NNMi detected a primary device.

A No Secondary Device in Router Redundancy Group incident has Severity set toWarning.

On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds theRrgNoSecondaryConclusion.

Incident Adds theNo Secondary Device in Router Redundancy Group incident.

Source Object Updates
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Tab Description

TheCorrelated Children tab includes any associated traps.

Note: If an interface in the group has anOperational State of Down, its Interface
Down incident is correlated under this incident.

Status Adds theWarning Status.

Overall
Status

Changes toWarning.

Source Object Updates, continued

WhenNNMi determines that the group has a secondary member, NNMi closes the incident and
changes the Router Redundancy Group Status toNormal. No Conclusion is added.

Primary Device in Router Redundancy Group Switched (NNMi
Advanced)

A Primary Device in Router Redundancy Group Switched incident means NNMi detected that
the Primary role moved from one device to another in a Router Redundancy Group.

Note: The group is routing packets properly.

Reasons for this incident include one or more of the following:

l A router or interface in the Router Redundancy Group has gone down.

l A tracked object (interface or IP address) in the Router Redundancy Group has gone down.

When aPrimary Device in Router Redundancy Group Switched incident is generated, the
Router Redundancy Groupmaintains its current status.

A Primary Device in Router Redundancy Group Switched incident has Severity set toCritical

On the Source Object form, NNMi updates information on the following tab:.

Tab Description

Incident Adds thePrimary Device in Router Redundancy Group Switched incident.

TheCorrelated Children tab includes any associated traps.

Source Object Updates

Router Redundancy Group Degraded (NNMi Advanced)
This incident occurs only in Router Redundancy Groups with more than two routers.

A Router Redundancy Group Degraded incident means NNMi determined the following:

l The Router Redundancy Group still has a primary and secondary device.

l The remaining devices in the group are down or in an unexpected protocol-specific state. For
example, in HSRP other member routers should be in Listen state.

Typically, the protocol-specific communication between routers is malfunctioning. However, the
group is routing packets properly.

A Router Redundancy Group Degraded incident has Severity set toWarning.
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On the Source Object form, NNMi updates information on the following tabs:

Tab Description

Conclusion Adds the Conclusion RrgDegraded.

Incident Adds theRouter Redundancy Group Degraded incident.

TheCorrelated Children tab includes any associated traps.

Note: If an interface in the group has anOperational State of Down, the Interface
Down incidents are correlated under this incident.

Status Adds theWarning Status.

Overall
Status

Changes toWarning.

Source Object Updates

WhenNNMi determines that the group has a active, standby and listenmembers, NNMi closes the
incident and changes the Router Redundancy Group Status toNormal. No Conclusion is added.

Interpret Threshold Incidents (HP Network Node Manager
iSPI Performance for Metrics Software)

(HP Network NodeManager iSPI Performance for Metrics Software) If the NNMi administrator
configures performancemeasurement thresholds, NNMi monitors interfaces for acceptable
operations ranges or threshold violations. NNMi can be configured to create incidents when
performance outside the acceptable range is detected. When the performance returns to within an
acceptable range, NNMi closes the incident. The HP Network NodeManager iSPI Performance for
Metrics Software software provides exceptions reports to track the frequency of threshold
violations.

The following table describes possible threshold incidents.

Note: Performance thresholds can affect the status of an interface, connection, or node. For
example, if an interface error rate is high, the interface status becomes Critical. NNMi's
Causal Engine returns the node status ofWarning for any nodes that have interfaces outside
one or more threshold boundaries.

Tip: See "Interface Form: Performance Tab (HP Network NodeManager iSPI Performance for
Metrics Software)" (on page 135) for more information about each performancemeasurement.
See also "Interface Performance View (HP Network NodeManager iSPI Performance for
Metrics Software)" (on page 269).

Performance Measurement

Interface
Performance
State Message

Incident
Severity

Backplane Utilization

See "Backplane Incidents (HP Network Node
Manager iSPI Performance for Metrics Software)" (on

Abnormal
Range

Backplane
Abnormal

Warning

Threshold Incidents
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Performance Measurement

Interface
Performance
State Message

Incident
Severity

page 421) High BackplaneOut
of Range

Critical

Low BackplaneOut
of Range

Critical

Buffer Utilization

See "Buffer Incidents (HP Network NodeManager
iSPI Performance for Metrics Software)" (on page
422)

Abnormal
Range

Buffer
Abnormal

Warning

High Buffer Out of
Range or
Malfunctioning

Critical

Low Buffer Out of
Range or
Malfunctioning

Critical

CPU Utilization

"CPU Incidents (HP Network NodeManager iSPI
Performance for Metrics Software)" (on page 423)

Abnormal
Range

CPU Abnormal Warning

High CPU Out of
Range or
Malfunctioning

Critical

Low CPU Out of
Range or
Malfunctioning

Critical

Disk Space Utilization

"Disk Incidents (HP Network NodeManager iSPI
Performance for Metrics Software)" (on page 424)

Abnormal
Range

Disk Abnormal Warning

High Disk Out of
Range

Critical

Low Disk Out of
Range

Critical

FCS LAN Error Rate

See "Interface FrameCheck Sequence (FCS) Error
Rate Incidents (HP Network NodeManager iSPI
Performance for Metrics Software)" (on page 425)

Abnormal
Range

Interface FCS
LAN Error Rate
Abnormal

Warning

High Interface FCS
LAN Error Rate
High

Critical

FCSWLAN Error Rate

See "Interface FrameCheck Sequence (FCS) Error
Rate Incidents (HP Network NodeManager iSPI
Performance for Metrics Software)" (on page 425)

Abnormal
Range

High

Interface FCS
LAN Error Rate
Abnormal

Interface FCS
LAN Error Rate
High

Warning

Critical

Input Utilization

See "Interface Input andOutput Utilization Incidents
(HP Network NodeManager iSPI Performance for

Abnormal
Range

Interface Input
Abnormal

Warning

Threshold Incidents, continued
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Performance Measurement

Interface
Performance
State Message

Incident
Severity

Metrics Software)" (on page 427). High Interface Input
High

Critical

Low Interface Input
Low

Minor

None Interface Input
None

Major

Output Utilization

See "Interface Input andOutput Utilization Incidents
(HP Network NodeManager iSPI Performance for
Metrics Software)" (on page 427).

Abnormal
Range

Interface
Output
Abnormal

Warning

High Interface
Output High

Critical

Low Interface
Output Low

Minor

None Interface
Output None

Major

Input Error Rate

See "Interface Input andOutput Error Rate Incidents
(HP Network NodeManager iSPI Performance for
Metrics Software)" (on page 429).

Abnormal
Range

Input Error
Rate Abnormal

Warning

High Input Error
Rate High

Critical

Output Error Rate

See "Interface Input andOutput Error Rate Incidents
(HP Network NodeManager iSPI Performance for
Metrics Software)" (on page 429).

Abnormal
Range

Output Error
Rate Abnormal

Warning

High Output Error
Rate High

Critical

Input Discard Rate

See "Interface Input andOutput Discard Rate
Incidents (HP Network NodeManager iSPI
Performance for Metrics Software)" (on page 431).

Abnormal
Range

Input Discard
Rate Abnormal

Warning

High Input Discard
Rate High

Critical

Output Discard Rate

See "Interface Input andOutput Discard Rate
Incidents (HP Network NodeManager iSPI
Performance for Metrics Software)" (on page 431).

Abnormal
Range

Output Discard
Rate Abnormal

Warning

High Output Discard
Rate High

Critical

Input Queue Drops

See "Input andOutput Queue Drop Incidents (HP
Network NodeManager iSPI Performance for Metrics
Software)" (on page 433).

Abnormal
Range

Input Queue
Drops
Abnormal

Warning

High Input Queue
Drops High

Critical

Threshold Incidents, continued
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Performance Measurement

Interface
Performance
State Message

Incident
Severity

Output Queue Drops

See "Input andOutput Queue Drop Incidents (HP
Network NodeManager iSPI Performance for Metrics
Software)" (on page 433).

Abnormal
Range

Output Queue
Drops
Abnormal

Warning

High Output Queue
Drops High

Critical

Threshold Incidents, continued

Backplane Incidents (HP Network Node Manager iSPI Performance
for Metrics Software)

Backplane incidents are available if the HP Network NodeManager iSPI Performance for Metrics
Software software is installed and your administrator configured performancemeasurement
thresholds.

Backplane incidents identify backplanes that are over-used or under-used.

You receive backplane incidents when performance is not within the allowable range set by your
administrator. Reasons for setting backplane thresholds include:

l Monitor for under-utilization which wastes money

l Monitor for over-utilization, whichmight result in performance bottlenecks or service provider
surcharges (over a pre-specified percentage)

The status of backplane incidents depends on whether themeasured value is over or under the
allowable range. The following table describes themeaning of Abnormal Range, Low, Nominal, and
High.

State
Value Description Incident Status

Abnormal
Range

Themeasured value is abnormal based on the
computed baseline.

Backplane
Abnormal

Warning

Low/None Themeasured value is less than the allowable
range.

BackplaneOut of
Range or
Malfunctioning

Minor

Nominal Themeasured value is within the allowable range.
This incident cancels any related High, Low, or
None incidents.

No incident is
generated

Not
applicable

High Themeasured value is greater than the allowable
range

BackplaneOut of
Range or
Malfunctioning

Critical

Information under the following Incident tabs is updated:

l Correlated Parents

l Correlated Children
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l Custom Attributes

The following table describes a combination of Conclusions leading to Backplane errors. These
appear in the Conclusions lists on the associated Node Component form.

Conclusion Status

BackplaneAbnormal Warning

BackplaneOutOfRangeOrMalfunctioning Critical

Possible Conclusions for Backplane Incidents (Node Component Form)

WhenNNMi determines that the Node Component is within the allowable range, NNMi updates the
following attributes:

The Node Component Status is changed toNormal.

The Node Component Conclusion is changed to one of the following:

Incident Conclusion Conclusion to Close the Incident

BackplaneAbnormal BackplaneNormal

BackplaneOutOfRangeOrMalfunctioning BackPlaneInRangeAndFunctioning

Conclusions Used to Close Backplane Incidents

Buffer Incidents (HP Network Node Manager iSPI Performance for
Metrics Software)

Buffer incidents are available if the HP Network NodeManager iSPI Performance for Metrics
Software software is installed and your administrator configured performancemeasurement
thresholds.

Buffer incidents identify nodes that are over-used or under-used.

You receive buffer incidents when performance is not within the allowable range set by your
administrator. Reasons for setting buffer thresholds include:

l Monitor for under-utilization which wastes money

l Monitor for over-utilization, whichmight result in performance bottlenecks or service provider
surcharges (over a pre-specified percentage)

The status of buffer incidents depends on whether themeasured value is over or under the
allowable range. The following table describes themeaning of Abnormal Range, Low, Nominal, and
High.

State
Value Description Incident Status

Abnormal
Range

Themeasured value is abnormal based on the
computed baseline.

Buffer Abnormal Warning

Low/None Themeasured value is less than the allowable
range.

Buffer Out of
Range or

Minor
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State
Value Description Incident Status

Malfunctioning

Nominal Themeasured value is within the allowable range.
This incident cancels any related High, Low, or
None incidents.

No incident is
generated

Not
applicable

High Themeasured value is greater than the allowable
range

Buffer Out of
Range or
Malfunctioning

Critical

Information under the following Incident tabs is updated:

l Correlated Parents

l Correlated Children

l Custom Attributes

The following table describes a combination of Conclusions leading to Buffer errors. These appear
in the Conclusions lists on the associated Node Component form.

Conclusion Status

BufferAbnormal Warning

BufferOutOfRangeOrMalfunctioning Critical

Possible Conclusions for Buffer Incidents (Node Component Form)

WhenNNMi determines that the Node Component is within the allowable range, NNMi updates the
following attributes:

The Node Component Status is changed toNormal

The Node Component Conclusion is changed to one of the following:

Incident Conclusion Conclusion to Close the Incident

BufferAbnormal BufferNormal

BufferOutOfRangeOrMalfunctioning BufferInRangeAndFunctioning

Conclusions Used to Close Buffer Incidents

CPU Incidents (HP Network Node Manager iSPI Performance for
Metrics Software)

CPU incidents are available if the HP Network NodeManager iSPI Performance for Metrics
Software software is installed and your administrator configured performancemeasurement
thresholds.

CPU incidents identify nodes that are over-used or under-used.

You receive CPU incidents when performance is not within the allowable range set by your
administrator. Reasons for setting CPU thresholds include:
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l Monitor for under-utilization which wastes money

l Monitor for over-utilization, whichmight result in performance bottlenecks or service provider
surcharges (over a pre-specified percentage)

Information under the following Incident tabs is updated:

l Correlated Parents

l Correlated Children

l Custom Attributes

The following table describes a combination of conclusions leading to CPU errors. These appear in
the Conclusions lists on the associated node form.

Conclusion Status

CPUAbnormal Warning

CPUOutOfRangeOrMalfunctioning Critical

Possible Conclusions for Utilization Incidents (Node form)

WhenNNMi determines that the Node Component is within the allowable range, NNMi updates the
following attributes:

The Node Component Status is changed toNormal

The Node Component Conclusion is changed to one of the following:

Incident Conclusion Conclusion to Close the Incident

CPUAbnormal CPUNormal

CPUOutOfRangeOrMalfunctioning CPUInRangeAndFunctioning

Conclusions Used to Close CPU Incidents

Disk Incidents (HP Network Node Manager iSPI Performance for
Metrics Software)

Disk incidents are available if the HP Network NodeManager iSPI Performance for Metrics
Software software is installed and your administrator configured performancemeasurement
thresholds.

Disk incidents identify nodes that are over-used or under-used.

You receive disk incidents when performance is not within the allowable range set by your
administrator. Reasons for setting disk thresholds include:

l Monitor for under-utilization which wastes money

l Monitor for over-utilization, whichmight result in performance bottlenecks or service provider
surcharges (over a pre-specified percentage)

The status of disk incidents depends on whether themeasured value is over or under the allowable
range. The following table describes themeaning of Abnormal Range, Low, Nominal, and High.
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State
Value Description Incident Status

Abnormal
Range

Themeasured value is abnormal based on the
computed baseline.

Disk Abnormal Warning

Low/None Themeasured value is less than the allowable range. Disk Out of
Range or
Malfunctioning

Minor

Nominal Themeasured value is within the allowable range.
This incident cancels any related High, Low, or
None incidents.

No incident is
generated

Not
applicable

High Themeasured value is greater than the allowable
range

Disk Out of
Range or
Malfunctioning

Critical

Information under the following Incident tabs is updated:

l Correlated Parents

l Correlated Children

l Custom Attributes

The following table describes a combination of Conclusions leading to Disk errors. These appear in
the Conclusions lists on the associated Node Component form.

Conclusion Status

DiskAbnormal Warning

DiskOutOfRangeOrMalfunctioning Critical

Possible Conclusions for Disk Incidents (Node Component Form)

WhenNNMi determines that the Node Component is within the allowable range, NNMi updates the
following attributes:

The Node Component Status is changed toNormal

The Node Component Conclusion is changed to one of the following:

Incident Conclusion Conclusion to Close the Incident

DiskAbnormal DiskNormal

DiskOutOfRangeOrMalfunctioning DiskInRangeAndFunctioning

Conclusions Used to Close Disk Incidents

Interface Frame Check Sequence (FCS) Error Rate Incidents (HP
Network Node Manager iSPI Performance for Metrics Software)

Interface FrameCheck Sequence (FCS) error rate incidents are available if the HP Network Node
Manager iSPI Performance for Metrics Software software is installed and your administrator
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configured performancemeasurement thresholds.

FCS error rate incidents identify interfaces that are dropping data.

You receive FCS error rate incidents when error rate threshold is not within the allowable range set
by your administrator. Reasons for setting FCS error rate thresholds include:

l Check for corrupted data packets

l Detect configurationmismatches

l Detect faulty hardware

The status of FCS error rate incidents depends on whether themeasured value is over or under the
allowable range. The following table describes themeaning of Abnormal, Nominal and High.

State
Value Description Incident Status

Nominal Themeasured value is within the allowable range.
This incident cancels any related High, Low, or
None incidents.

No incident is
generated

Not
applicable

High Themeasured value is greater than the allowable
range

Interface FCS
LAN Error Rate
High

Interface FCS
WLAN Error
Rate High

Major

Information under the following Incident tabs is updated:

l Correlated Parents

l Correlated Children

l Custom Attributes

The following table describes a combination of Conclusions leading to FCS LAN errors. These
appear in the Conclusions lists on the associated Interface form.

Conclusion Status

InterfaceFCSLANErrorRateHigh Major

InterfaceFCSWLANErrorRateHigh Major

Possible Conclusions for Interface FCS Error Rate Incidents (Interface form)

WhenNNMi determines that the FCS LAN Interface Error Rate is within the allowable range, NNMi
updates the following attributes:

The Interface Status is changed toNormal.

The Interface Conclusion is changed as shown in the following table:
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Incident Conclusion Conclusion to Close the Incident

InterfaceFCSLANErrorRateHigh InterfaceFCSLANErrorRateInRange

InterfaceFCSWLANErrorRateHigh InterfaceFCSLANErrorRateInRange

Conclusions Used to Close FCS Error Rate Incidents

Interface Input and Output Utilization Incidents (HP Network Node
Manager iSPI Performance for Metrics Software)

Input and output utilization incidents are available if the HP Network NodeManager iSPI
Performance for Metrics Software software is installed and your administrator configured
performancemeasurement thresholds.

Input and output utilization incidents identify interfaces that are over-used or under-used.

You receive input and output utilization incidents when performance is not within the allowable
range set by your administrator. Reasons for setting utilization thresholds include:

l Monitor for under-utilization which wastes money

l Monitor for over-utilization, whichmight result in performance bottlenecks or service provider
surcharges (over a pre-specified percentage)

The status of input and output utilization incidents depends on whether themeasured value is over
or under the allowable range. The following table describes themeaning of Abnormal Range, None,
Low, Nominal, and High.

State
Value Description Incident Status

Abnormal
Range

Themeasured value is abnormal based on the
computed baseline.

Interface Input
Utilization
Abnormal

Interface Output
Utilization
Abnormal

Warning

None Themeasured value is zero. Interface Input
Utilization None

Interface Output
Utilization None

Minor

Low Themeasured value is less than the allowable range. Interface Input
Utilization Low

Major

Nominal Themeasured value is within the allowable range.
This incident cancels any related High, Low, or
None incidents.

No incident is
generated

Not
applicable

High Themeasured value is greater than the allowable
range

Interface Output
Utilization High

Major

Information under the following Incident tabs is updated:
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l Correlated Parents

l Correlated Children

l Custom Attributes

The following tables describes a combination of conclusions leading to input and output utilization
errors. These appear in the Conclusions lists on the associated Interface and Connection or Node
forms.

Form Conclusion Status

Interface InterfaceInputUtilizationAbnormal Warning

Interface InterfaceInputUtilizationNone Minor

Interface InterfaceInputUtilizationLow Major

Interface InterfaceOutputUtilizationAbnormal Warning

Interface InterfaceOutputUtilizationNone Minor

Interface InterfaceOutputUtilizationHigh Major

Connection SomeConnectionThresholdValuesHigh Minor

Connection AllConnectionThresholdValuesHigh Critical

Connection SomeOrAllConnectionThresholdValuesLow Minor

Node SomeInterfacesOutsideThresholdBoundariesInNode Minor

Possible Conclusion Combinations for Input Utilization Incidents (Interface,
Connection, and Node)

WhenNNMi determines that the Interface Input or Output Utilization Rate is within the allowable
range, NNMi updates the following attributes:

The Interface Status is changed toNormal.

The Interface Conclusion is changed to one of the following:

Incident Conclusion Conclusion to Close the Incident

InterfaceInputUtilizationAbnormal InterfaceInputUtilizationNominal

InterfaceInputUtilizationNone InterfaceInputUtilizationNominal

InterfaceInputUtilizationLow InterfaceInputUtilizationNominal

InterfaceOutputUtilizationAbnormal InterfaceOutputUtilizationNormal

InterfaceOutpuUtilizationNone InterfaceOutputUtilizationNominal

InterfaceOutputUtilizationHigh InterfaceOutputUtilizationNominal

Conclusions Used to Close Interface Input and Output Utilization Incidents
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Incident Conclusion Conclusion to Close the Incident

SomeConnectionThresholdValuesHigh ConnectionWithinThresholdBoundaries

AllConnectionThresholdValuesHigh ConnectionWithinThresholdBoundaries

SomeOrAllConnectionThresholdValuesLow ConnectionWithinThresholdBoundaries

SomeIn-
terfacesOutsideThresholdBoundariesInNode

All-
Inter-
facesWithinThresholdBoundariesInNode

Conclusions Used to Close Interface Input and Output Utilization Incidents, con-
tinued

Interface Input and Output Error Rate Incidents (HP Network Node
Manager iSPI Performance for Metrics Software)

Interface input and output error rate incidents are available if the HP Network NodeManager iSPI
Performance for Metrics Software software is installed and your administrator configured
performancemeasurement thresholds.

Interface input and output error rate incidents identify interfaces that are dropping data.

You receive interface input and output error rate incidents when an error rate threshold is not within
the allowable range set by your administrator. For example, the error rate must not exceed 10
percent. Reasons for setting error rate thresholds include:

l Check for corrupted data packets

l Detect configurationmismatches

l Detect faulty hardware

Only error rates that exceed the allowable range generate an incident.

State
Value Description Incident Status

None Themeasured value is zero. Interface Input
Error Rate
None

Interface
Output Error
Rate None

Normal

Low Themeasured value is less than the allowable range. Interface Input
Error Rate Low

Interface
Output Error
Rate Low

Normal

Nominal Themeasured value is within the allowable range. This
incident cancels any related High, Low, or

No incident is
generated

Not
applicable
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State
Value Description Incident Status

None incidents.

High Themeasured value is greater than the allowable range Interface Input
Error Rate High

Interface
Output Error
Rate High

Major

Information on the following Incident tabs is updated:

l Correlated Parents

l Correlated Children

l Custom Attributes

The following table describes a combination of conclusions leading to interface input error rate
incidents. These appear in the Conclusions lists on the associated interface and connection or node
forms.

Form Conclusion Status

Interface InterfaceInputErrorRateNone Normal

Interface InterfaceInputErrorRateLow Normal

Interface InterfaceInputErrorRateHigh Major

Interface InterfaceOutputErrorRateNone Normal

Interface InterfaceOutputErrorRateLow Normal

Interface InterfaceOutputErrorRateHigh Major

Connection SomeConnectionThresholdValuesHigh Minor

Connection AllConnectionThresholdVauesHigh Critical

Node SomeInterfacesOutsideThresholdBoundariesInNode Minor

Possible Conclusion Combinations for Input Error Rate Incidents (Interface,
Connection and Node forms)

WhenNNMi determines that the Interface Input or Output Error Rate is within the allowable range,
NNMi updates the following attributes:

The Interface Status is changed toNormal.

The Interface Conclusion is changed to one of the following:
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Incident Conclusion Conclusion to Close the Incident

InterfaceInputErrorRateNone InterfaceInputErrorRateNominal

InterfaceInputErrorRateLow InterfaceInputErrorRateNominal

InterfaceInputErrorRateHigh InterfaceInputErrorRateNominal

InterfaceOutputErrorRateNone InterfaceOutputErrorRateNominal

InterfaceOutputErrorRateLow InterfaceOutputErrorRateNominal

InterfaceOutputErrorRateHigh InterfaceOutputErrorRateNominal

SomeConnectionThresholdValuesHigh ConnectionWithinThresholdBoundaries

AllConnectionThresholdValuesHigh ConnectionsWithinThresholdBoundaries

SomeIn-
terfacesOutsideThresholdBoundariesInNode

All-
Inter-
facesWithinThresholdBoundariesInNode

Conclusions Used to Close Interface Input and Output Error Rate Incidents

Interface Input and Output Discard Rate Incidents (HP Network Node
Manager iSPI Performance for Metrics Software)

(HP Network NodeManager iSPI Performance for Metrics Software) Prerequisite, your NNMi
administrator configured performancemeasurement thresholds.

Interface input and output discard rate incidents enable you to identify interfaces that have
transmission buffer overflows or are bottlenecks.

You receive interface input and output discard rate incidents when a discard rate is not within the
allowable range set by your administrator. For example, the discard ratemust not exceed 10
percent. Reasons for setting discard rate thresholds include:

l Check for large data packets

l Monitor bottlenecks

l Detect faulty hardware

Only discard rates that exceed the allowable range generate an incident.

State
Value Description Incident Status

None Themeasured value is zero. Interface Input
Discard Rate
None

Interface Output
Discard Rate
None

Normal

Low Themeasured value is less than the allowable range. Interface Input Normal
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State
Value Description Incident Status

Discard Rate
Low

Interface Output
Discard Rate
Low

Nominal Themeasured value is within the allowable range. This
incident cancels any related High, Low, or
None incidents.

No incident is
generated

Not
applicable

High Themeasured value is greater than the allowable
range

Interface Input
Discard Rate
High

Interface Output
Discard Rate
High

Major

Information on the following Incident tabs is updated:

l Correlated Parents

l Correlated Children

l Custom Attributes

The following table describes a combination of conclusions leading to input and output discard rate
incidents. These appear in the Conclusions lists on the associated interface and connection or node
forms.

Form Conclusion Status

Interface InterfaceInputDiscardRateNone Normal

Interface InterfaceInputDiscardRateLow Normal

Interface InterfaceInputDiscardRateHigh Major

Interface InterfaceOutputDiscardRateNone Normal

Interface InterfaceOutputDiscardRateLow Normal

Interface InterfaceOutputDiscardRateHigh Major

Connection SomeConnectionThresholdValuesHigh Minor

Connection AllConnectionThresholdValuesHigh Critical

Connection SomeOrAllConnectionThresholdValuesLow Minor

Possible Conclusion Combinations for Input Discard Rate Incidents (Interface,
Connection and Node forms)
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Form Conclusion Status

Connection SomeOrAllConnectionThresholdValuesNone Minor

Node SomeInterfacesOutsideThresholdBoundariesInNode Minor

Possible Conclusion Combinations for Input Discard Rate Incidents (Interface,
Connection and Node forms), continued

WhenNNMi determines that the Interface Input or Output Discard Rate is within the allowable
range, NNMi updates the following attributes:

The Interface Status is changed toNormal.

The Interface, Connection, or Node Conclusion is changed as shown in the following table:

Incident Conclusion Conclusion to Close the Incident

InterfaceInputDiscardRateNone InterfaceInputDiscardRateNominal

InterfaceInputDiscardRateLow InterfaceInputDiscardRateNominal

InterfaceInputDiscardRateHigh InterfaceInputDiscardRateNominal

InterfaceOutputDiscardRateNone InterfaceOutputDiscardRateNominal

InterfaceOutputDiscardRateLow InterfaceOutputDiscardRateNominal

InterfaceOutputDiscardRateHigh InterfaceOutputDiscardRateNominal

SomeConnectionThresholdValuesHigh ConnectionWithinThresholdBoundaries

AllConnectionThresholdValuesHigh ConnectionWithinThresholdBoundaries

SomeOrAllConnectionThresholdValuesLow ConnectionWithinThresholdBoundaries

SomeOrAllConnectionThresholdValuesNone ConnectionWithinThresholdBoundaries

SomeIn-
terfacesOutsideThresholdBoundariesInNode

All-
Inter-
facesWithinThresholdBoundariesInNode

Conclusions Used to Close Interface Input and Output Discard Rate Incidents

Input and Output Queue Drop Incidents (HP Network Node Manager
iSPI Performance for Metrics Software)

(HP Network NodeManager iSPI Performance for Metrics Software) Prerequisite, your NNMi
administrator configured performancemeasurement thresholds.

Interface input and output queue drop incidents enable you to identify interfaces that have
transmission buffer overflows or are bottlenecks.

You receive input and output queue drop incidents when a discard rate is not within the allowable
range set by your administrator. For example, the queue drop ratemust not exceed 10 percent.
Reasons for setting queue drop rate thresholds include:
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l Check for large data packets

l Monitor bottlenecks

l Detect faulty hardware

The status of input and output queue drop incidents depends on whether themeasured value is over
the allowable range. The following table describes themeaning of Nominal and High.

State
Value Description Incident Status

Nominal Themeasured value is within the allowable range. This
incident cancels any related High, Low, or
None incidents.

No incident is
generated

Not
applicable

High Themeasured value is greater than the allowable range Interface Input
Queue Drops
High

Interface Output
Queue Drops
High

Major

Information on the following Incident tabs is updated:

l Correlated Parents

l Correlated Children

l Custom Attributes

The following table describes a combination of conclusions leading to input and output queue drop
rate incidents. These appear in the Conclusions lists on the associated interface form.

Form Conclusion Status

Interface InterfaceInputQueueDropsHigh Major

Interface InterfaceOutputQueueDropsHigh Major

Connection SomeConnectionThresholdValuesHigh Minor

Connection AllConnectionThresholdValuesHigh Critical

Node SomeInterfacesOutsideThresholdBoundariesInNode Minor

Possible Conclusions for Input Queue Drop Incidents (Interface, Connection and
Node forms)

WhenNNMi determines that the Queue Drops are within the allowable range, NNMi updates the
following attributes:

The Interface Status is changed toNormal.

The Interface, Connection, or Node Conclusion is changed as shown in the following table:
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Incident Conclusion Conclusion to Close the Incident

InterfaceInputQueueDropsHigh InterfaceInputQueueDropsRateInRange

InterfaceOutputQueueDropsHigh InterfaceOutputQueueDropsRateInRange

SomeConnectionThresholdValuesHigh ConnectionWithinThresholdBoundaries

AllConnectionThresholdValuesHigh ConnectionWithinThresholdBoundaries

SomeIn-
terfacesOutsideThresholdBoundariesInNode

All-
Inter-
facesWithinThresholdBoundariesInNode

Conclusions Used to Close Input and Output Queue Drops Incidents

Management Address ICMP Response Time Incidents
Management address Internet Control Message Protocol (ICMP) response time incidents enable
you to identify high or abnormal ICMP response time from the NNMi management server to the
selected node.

You receive response time incidents when the ICMP response time for the selectedmanagement
address is not within the allowable range set by your administrator. Reasons for setting
ICMP response time rate thresholds include identifying changes in network performance from the
management station to the selected node.

The State value returned for the node depends on whether themeasured value is over the allowable
range or outside of the configured baseline settings. The following table describes themeaning of
High andAbnormal.

State
Value Description Incident Status

Abnormal Themeasured value is abnormal
based on the computed baseline.

Management Address ICMP
Response Time Abnormal

Warning

High Themeasured value is greater than the
allowable range.

Management Address ICMP
Response TimeHigh

Warning

Information on the following Incident tabs is updated:

l Correlated Parents

l Correlated Children

l Custom Attributes

The following table describes a combination of conclusions leading toManagement Address
ICMP response time incidents. These appear in the Conclusions lists on the associated interface
form.
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Conclusion Status

ManagementAddressICMPResponseTimeAbnormal Warning

ManagementAddressICMPResponseTimeHigh Warning

Possible Conclusions for Management Address ICMP Response Time Incidents
(SNMP Agent form)

WhenNNMi determines that theManagement Address ICMP Response Time is within the
allowable range, NNMi updates the following attributes:

The SNMP Agent Status is changed toNormal.

The SNMP Agent Conclusion is changed to one of the following:

Incident Conclusion Conclusion to Close the Incident

Man-
age-
mentAddressICMPResponseTimeAbnormal

Man-
agementAddressICMPResponseTimeNormal

ManagementAddressICMPResponseTimeHigh Man-
age-
mentAddressICMPResponseTimeNominal

Conclusions Used to Close Management Address ICMP Response Time Incidents

Memory Incidents (HP Network Node Manager iSPI Performance for
Metrics Software)

Memory incidents are available if the HP Network NodeManager iSPI Performance for Metrics
Software software is installed and your administrator configured performancemeasurement
thresholds.

Memory incidents identify nodes that are over-used or under-used.

You receivememory incidents when performance is not within the allowable range set by your
administrator.

The status of memory incidents depends on whether themeasured value is over or under the
allowable range. The following table describes themeaning of Abnormal Range, Low, Nominal, and
High.

State
Value Description Incident Status

Abnormal
Range

Themeasured value is abnormal based on the
computed baseline.

Memory
Abnormal

Warning

Nominal Themeasured value is within the allowable range.
This incident cancels any related High, Low, or
None incidents.

No incident is
generated

Not
applicable

High Themeasured value is greater than the allowable
range

Memory Out of
RangeOr
Malfunctioning

Critical
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Information under the following Incident tabs is updated:

l Correlated Parents

l Correlated Children

l Custom Attributes

The following table describes a combination of Conclusions leading toMemory incidents. These
appear in the Conclusions lists on the associated Node Component form.

Conclusion Status

MemoryAbnormal Warning

MemoryOutOfRangeOrMalfunctioning Critical

Possible Conclusions for Memory Incidents (Node Component form)

WhenNNMi determines that the Node Component is within the allowable range, NNMi updates the
following attributes:

The Node Component Status is changed toNormal.

The Node Component Conclusion is changed to one of the following:

Incident Conclusion Conclusion to Close the Incident

MemoryAbnormal MemoryDiskNormal

MemoryOutOfRangeOrMalfunctioning MemoryInRangeAndFunctioning

Conclusions Used to Close Memory Incidents

Find a Node
As part of the investigation and diagnosis process, youmight want to search the NNMi database for
details about a specific node. One way is to use the Tools→ Find Node option. This option is
particularly useful when you want to search for a node by any of its IP addresses.

See "Access Node Details" (on page 277) and Access More Details (Forms and Analysis Pane) for
a description of additional ways to access node details.

To find information about a node:

1. From the console, select Tools→ Find Node.

2. In the Find Node dialog, enter one of the following case-sensitive known values for the node of
interest:

Possible
Values Description

Hostname The current value of the fully-qualified, case-sensitiveHostname attribute as it
appears on the Node form.

"Find Node" Options
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Possible
Values Description

NNMi follows a set of rules to dynamically generate the value stored in the
NNMi database for each Node's Hostname. Click here for details.

Note: If DNS is the source of the Node's Hostname, the actual Hostname
might be converted to all uppercase or all lowercase before it is added to
the NNMi database (depending on how the NNMi administrator configured
settings in the nms-topology.properties file). See the "Modifying
NNMi Normalization Properties" section of theHP Network NodeManager
i Software Deployment Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

n If the Node supports SNMP, NNMi requests the Hostname using the IP
Address of the associated SNMP agent (theManagement Address attribute
value on the Node form).

When the NNMi administrator chooses Enable SNMP Address
Rediscovery in the Communication Configuration:

o If the SNMP Agent does not respond, NNMi checks for another
Management Address to request the Hostname, and the Hostname could
change.

o If the SNMP Agent associated with the node changes, theManagement
Address and Hostname could change.

When the NNMi administrator disables Enable SNMP Address
Rediscovery in the Communication Configuration:

o If the SNMP Agent does not respond, NNMi uses the previously gathered
Management Address attribute value to request the Hostname.

o If the SNMP Agent associated with the node changes, NNMi uses the
previously gatheredManagement Address attribute value to request the
Hostname.

n If the Node does not support SNMP, noManagement Address is available.
NNMi requests a Hostname starting with the lowest IP Address associated
with the node (a Discovery Seed value or an IP address value gathered from
a neighboring device). NNMi uses the first Hostname provided. The
Hostnamemight change during a future discovery cycle.

IP
address of
any
interface

The IP address of any interface in the node.

System
Name

The current value of theMIB-II sysName that is obtained from the node's
SNMP agent (case-sensitive) as it appears in the System Name attribute on

"Find Node" Options, continued
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Possible
Values Description

Node form. For example cisco5500.abc.example.com

Name The current value of the Name attribute as it appears on the Node form.

The NNMi administrator configures how NNMi populates this attribute through
two configuration settings: (1) TheNode Name Resolution attributes in
Discovery Configuration (full or short DNS name, full or short sysName,
IP address). (2) The Namemight be converted to all uppercase or all lowercase
(depending on how the NNMi administrator configured settings in the nms-
topology.properties file). See the "Modifying NNMi Normalization
Properties" section of theHP Network NodeManager i Software Deployment
Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

"Find Node" Options, continued

3. Click Find.

NNMi searches the database to find amatching value in any of the attributes listed in the
preceding table.

NNMi displays the Node form of the firstmatch. If nomatch is found, NNMi displays an error
message.

Find the Attached Switch Port
Tools→ Find Attached Switch Port helps you investigate and diagnose problems when you
need to quickly determine which switch a problem EndNode uses. For example, if an End Node in
your network has a potential virus, you can identify the switch through which that End Node
connects to your network. Then, you can prevent the virus frommoving to other nodes in your
network.

(NNMi Advanced - Global Network Management feature) TheGlobal Manager and the Regional
Manager maintain separate sets of data. Conclusions about each Node are derived from the
available data and can sometimes be different. Regional Managers forward the results of each
Spiral Discovery cycle to the Global Manager. The Regional Manager can have a NodeGroup filter
configured to limit the amount of data that is forwarded to the Global Manager. Filters are usually
unnecessary for Global Network Management. Do not filter out nodes that are important for
connectivity in your network environment to ensure NNMi has the data needed for accurate root
cause analysis.

l TheGlobal Manager might know information about why a connection from one site to another is
down, but the Regional Manager just knows that the router connected to that remote site has an
interface that is down. UseActions→Regional Manager Console to see the other
perspective.

l When troubleshooting a Node on theGlobal Manager, you can useActions→Open from
Regional Manager to see the latest Node information on the Regional Manager.

Tip: You can also use the nnmfindattachedswport.ovpl command to find which Switch an End
Node uses to reach your network.
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To find which Switch an End Node uses to reach your network: 

1. From the console, select Tools→ Find Attached Switch Port.

2. Navigate to theEnd Node field, and enter one of the following case-sensitive known values for
the end Node.

Possible
Values Description

Hostname The End Node's fully-qualified, case-sensitiveHostname value.

The End Node can be either of the following:

n A device in your network environment that has not been discovered by NNMi
(no corresponding Node object in the NNMi database).

n A Node previously discovered by NNMi. The Hostname you providemust
match the current case-sensitive value of the end Node's Hostname
attribute on the "Node Form" (on page 48). See "Access Node Details" (on
page 277) and Access More Details (Forms and Analysis Pane) for methods
of looking up the current Hostname value.

NNMi follows a set of rules to dynamically generate the value stored in the
NNMi database for each Node's Hostname. Click here for details.

Note: If DNS is the source of the Node's Hostname, the actual
Hostnamemight be converted to all uppercase or all lowercase before it
is added to the NNMi database (depending on how the NNMi
administrator configured settings in the nms-topology.properties
file). See the "Modifying NNMi Normalization Properties" section of the
HP Network NodeManager i Software Deployment Reference, which is
available at:
http://h20230.www2.hp.com/selfsolve/manuals.

o If the Node supports SNMP, NNMi requests the Hostname using the IP
Address of the associated SNMP agent (theManagement Address
attribute value on the Node form).

When the NNMi administrator chooses Enable SNMP Address
Rediscovery in the Communication Configuration:

o If the SNMP Agent does not respond, NNMi checks for another
Management Address to request the Hostname, and the Hostname
could change.

o If the SNMP Agent associated with the node changes, the
Management Address and Hostname could change.

When the NNMi administrator disables Enable SNMP Address
Rediscovery in the Communication Configuration:

o If the SNMP Agent does not respond, NNMi uses the previously

"Find Attached Switch Port" Options
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Possible
Values Description

gatheredManagement Address attribute value to request the
Hostname.

o If the SNMP Agent associated with the node changes, NNMi uses the
previously gatheredManagement Address attribute value to request
the Hostname.

o If the Node does not support SNMP, noManagement Address is
available. NNMi requests a Hostname starting with the lowest IP
Address associated with the node (a Discovery Seed value or an IP
address value gathered from a neighboring device). NNMi uses the first
Hostname provided. The Hostnamemight change during a future
discovery cycle.

IP
address of
any
interface

The current value of any IP address associated with the End Node.

NNMi Advanced. Either IPv4 or IPv6 allowed.

MAC
address

The current value of theMAC (Media Access Control) address of any interface
in the End Node.

"Find Attached Switch Port" Options, continued

3. Click Find. NNMi searches existing data in the NNMi database for amatch, searching through
all known Layer 2 information previously gathered from switch forwarding tables in your
network environment. NNMi does not generate SNMP traffic to gather additional data for this
search.

NNMi displays a report about the Switch attached to the specified End Node:

n Hostname of the Switch (click the Hostname link to open the switch's Node form).

n Interface Name value (click the Interface link to open the switch's relevant Interface form).

n VLAN Id andGlobal VLAN Name, if any.

Display End Nodes Attached to a Switch
This action helps you investigation and diagnosis problems. Youmight need to determine the end
nodes attached to a switch. For example, to upgrade a switch, youmight need to check which
servers are attached to the switch so that you can fill out the change request properly.

(NNMi Advanced - Global Network Management feature) TheGlobal Manager and the Regional
Manager maintain separate sets of data. Conclusions about each Node are derived from the
available data and can sometimes be different. Regional Managers forward the results of each
Spiral Discovery cycle to the Global Manager. The Regional Manager can have a NodeGroup filter
configured to limit the amount of data that is forwarded to the Global Manager. Filters are usually
unnecessary for Global Network Management. Do not filter out nodes that are important for
connectivity in your network environment to ensure NNMi has the data needed for accurate root
cause analysis.
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l TheGlobal Manager might know information about why a connection from one site to another is
down, but the Regional Manager just knows that the router connected to that remote site has an
interface that is down. UseActions→Regional Manager Console to see the other
perspective.

l When troubleshooting a Node on theGlobal Manager, you can useActions→Open from
Regional Manager to see the latest Node information on the Regional Manager.

To display the end nodes attached to a switch using the NNMi console Actions menu, do
one of the following:

1. Navigate to the view or form of interest and select the switch that has attached end nodes you
want to display.

n Navigate to a table view and select a switch:
i. From the workspace navigation panel, select the workspace of interest; for example,

Inventory.

ii. Click the view that contains the switch that has attached end nodes you want to
display; for exampleNodes.

iii. From the table view, select the row that represents the switch of interest.

n Navigate to a map view and select a switch:
i. Navigate to the table view.

ii. From the table view, select the row that represents the switch of interest.

iii. Select Actions→Maps→ Layer 2 Neighbor View, Layer 3 Neighbor View, Node
Group Map, orPath View.

Tip: You can right-click any object in a table or map view to access theActions
menu.

iv. In themap, click themap symbol representing the switch of interest.

n Navigate to a form:
i. From a table view, double-click the row that represents the switch of interest.

ii. From amap view, click the switch of interest on themap and click the  Open icon.

2. Select Actions→ Show Attached End Nodes.

NNMi displays the following for each end node that it determines is attached to the switch:

n The Name of the Interface to which the Node is attached

n The identification number of the VLAN (VLAN ID) to which the Node belongs

n The name of the VLAN to which the Node belongs

n DNS-resolvable hostname

n MAC address of the connected interface

n IP address

Note the following:
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n If the end node does not have a DNS-resolvable hostname, NNMi uses the node's
IP address for both the Hostname value and the IP Address value.

n If NNMi is unable to locate any information about end nodes attached to the selected
switch, NNMi displays amessage that no end nodes were found.

3. Click any object name link to open the form for the selected object.

Note: If the object name appears without a link, this indicates NNMi has not discovered the
node or interface.

Related Topics

"Find the Attached Switch Port" (on page 439)

Test Node Access (Ping)
You can verify that a node or IP address is reachable using the ping command from the NNMi
consoleActionsmenu.

Note: NNMi uses the packet size used by the current operating system. NNMi displays the ping
results, including reply times and ping statistics.

From an incident view:

1. Select the row representing an incident that has a source node you want to ping.

2. Select Actions→Node Access→ Ping (from server).

Tip: You can right-click any object in a table or map view to access theActionsmenu.

NNMi pings theSource Node of the incident. It does not ping the source object. For example, if
the incident is related to an interface, NNMi pings the node in which the interface resides, not
the interface itself.

(NNMi Advanced) If the Global Network Management feature is enabled and you are signed
into a Global Manager:

n Nodemanaged by the Global Manager = Actions →Ping issues an ICMP request from the
Global Manager (NNMi management server).

n Nodemanaged by a Regional Manager = Actions →Ping accesses that Regional Manager
(NNMi management server) and issues the ICMP request.

Note: Youmust sign into that Regional Manager unless your network environment
enables Single Sign-On (SSO) to that Regional Manager through theGlobal Manager.
For more information, see the “Configuring Single Sign-On for Global Network
Management” section in theHP Network NodeManager i Software Deployment
Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

From other views or forms:
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1. Navigate to the view or form of interest and select the node or IP address you want to ping.

To navigate to a table view and select a node:
a. From the workspace navigation panel, select the workspace of interest; for example,

Inventory.

b. Click the view that contains the node or IP address that you want to verify is reachable; for
exampleNodes.

c. From the table view, select the row that represents the node or IP address.

To navigate to a map view and select a node:
a. Navigate to the table view.

b. From the table view, select the row that represents the node or IP address.

c. Select Actions→Maps→ Layer 2 Neighbor View, Layer 3 Neighbor View orPath
View.

d. In themap, click themap symbol representing the node of interest.

To navigate to a form:
a. From a table view, double-click the row that represents the node or IP address of interest.

b. From amap view, click the node of interest on themap and click the  Open icon.

2. Select Actions→Node Access→ Ping (from server)

(NNMi Advanced) If the Global Network Management feature is enabled and you are signed
into a Global Manager:

n Nodemanaged by the Global Manager = Actions →Ping issues an ICMP request from the
Global Manager (NNMi management server).

n Nodemanaged by a Regional Manager = Actions →Ping accesses that Regional Manager
(NNMi management server) and issues the ICMP request.

Note: Youmust sign into that Regional Manager unless your network environment
enables Single Sign-On (SSO) to that Regional Manager through theGlobal Manager.
For more information, see the “Configuring Single Sign-On for Global Network
Management” section in theHP Network NodeManager i Software Deployment
Reference, which is available at:
http://h20230.www2.hp.com/selfsolve/manuals.

Find the Route (traceroute)
When investigating and diagnosing network problems, youmight want to trace the route path using
the traceroute command. Using traceroute also lets you identify bottlenecks along the destination
path provided. You can access the traceroute command from the NNMi console Actions menu.

Note the following:

l You can also use Path View to display the routing path between two nodes that have IPv4
addresses. See "Path Between TwoNodes that Have IPv4 Addresses" (on page 256) for more
information.
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l The starting node is the NNMi management server on which you are running the traceroute
command.

Tip: You can right-click any object in a table or map view to access theActionsmenu.

To access the traceroute command:

1. Do one of the following:

Navigate to an Incidents view and select the incident that has the source node's route
you want to trace:
a. From the workspace navigation panel, select the workspace of interest; for example,

Incident Management.

b. Click the view that contains the incident that has the source node's route you want to trace;
for exampleMy Open Incidents.

c. From the table view, select the row representing the incident that has a source node's
route you want to trace.

Navigate to a table view and select a node:
a. From the workspace navigation panel, select the workspace of interest; for example,

Inventory.

b. Click the view that contains the node that has the route you want to trace; for example
Nodes.

c. From the table view, select the row representing the node that has the route you want to
trace.

Navigate to a map view and select a node:
a. From the workspace navigation panel, select the workspace of interest; for example,

Topology Maps.

b. Click the view that contains the node that has the route you want to trace; for example
Initial Discovery Progress orNetwork Overview.

c. From themap view, click the node that has the route you want to trace.

Navigate to a Node form:
n From a table view, double-click the row representing the object that has the route you want

to trace.

n From amap view, click the node of interest on themap and click the  Open icon.

2. Select Actions→Node Access→ Trace Route (from server).

NNMi displays the output from traceroute, including the lists of routers that are traversed to
reach the destination node.

Establish Contact with a Node (Telnet or Secure Shell)
When investigating and diagnosing network problems, youmight need to establish a connection to
a node to view or change configuration information. You can establish a connection to a node using
the Telnet or Secure Shell (ssh) command from the NNMi console Actions menu.
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Note: If you cannot access Telnet or ssh from yourWeb browser, your operating system or
Web browser might not enable Telnet or Secure Shell by default. If you are an NNMi
administrator, see the "Configuring the Telnet and SSH Protocols for Use by NNMi chapter of
theHP Network NodeManager i Software Deployment Reference for more information.

To establish contact with a node using Telnet:

1. Do one of the following:

Navigate to an incident view:
a. Select the row representing the incident that has the source node you want to access using

Telnet. 

b. Select Actions→Node Access→ Telnet (from client).

Note: NNMi uses Telnet to access the source node of the incident. It does not use
Telnet on the source object. For example, if the incident is related to an interface,
NNMi uses Telnet to access the node in which the interface resides, not to the
interface itself.

Tip: You can right-click any object in a table or map view to access theActions
menu.

Navigate to a table view and select a node:
a. From the workspace navigation panel, select the workspace of interest; for example,

Inventory.

b. Click the view that contains the node you want to access using Telnet; for example
Nodes.

c. From the table view, select the row representing the node you want to access using Telnet.

Navigate to a map view and select a node:
a. From the workspace navigation panel, select the workspace of interest; for example,

Topology Maps.

b. Click the view that contains the node you want to access using Telnet; for example Initial
Discovery Progress orNetwork Overview.

c. From themap view, click the node you want to access using Telnet.

To navigate to a Node form:
n From a table view, double-click the row representing the node of interest.

n From amap view, click the node of interest on themap and click the  Open icon.

2. Select Actions→Node Access→ Telnet (from client).

To establish contact with a node using Secure Shell:
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1. Do one of the following:

Navigate to an incident view:
a. Select the row representing the incident that has the source node you want to access using

Secure Shell. 

b. Select Actions→Node Access→ Secure Shell (from client).

Note: NNMi uses Secure Shell to access the source node of the incident. It does not
use Secure Shell on the source object. For example, if the incident is related to an
interface, NNMi uses Secure Shell to access the node in which the interface resides,
not to the interface itself.

Navigate to a table view and select a node:
a. From the workspace navigation panel, select the workspace of interest; for example,

Inventory.

b. Click the view that contains the node you want to access using Secure Shell; for example
Nodes.

c. From the table view, select the row representing the node you want to access using Secure
Shell.

Navigate to a map view and select a node:
a. From the workspace navigation panel, select the workspace of interest; for example,

Topology Maps.

b. Click the view that contains the node you want to access using Secure Shell; for example
Initial Discovery Progress orNetwork Overview.

c. From themap view, click the node you want to access using Secure Shell.

To navigate to a Node form:
n From a table view, double-click the row representing the node of interest.

n From amap view, click the node of interest on themap and click the  Open icon.

2. Select Actions→Node Access→ Secure Shell (from client).

NNMi displays a browser window and a Secure Shell window.

Check Status Details for a Node Group
NNMi can generate a Status Details report about the a particular NodeGroup showing how many
nodes are currently within each possible status (see Status Color andMeaning for Objects). The
Status Details window automatically refreshes Status Detail information every 5minutes:

l Using a table view, check the status details for a NodeGroup.

a. Navigate to the NodeGroups view of interest (see "NodeGroups View (Inventory)" (on page
42) or "NodeGroups View (Monitoring)" (on page 271)).

b. Select the row representing the NodeGroup of interest.

c. Select Actions→ Status Details.

HP Network NodeManager i Software (9.21)Page 447 of 454



Online Help: Help for Operators
Chapter 9: Investigate and Diagnose Problems

Tip: You can right-click any object in a table or map view to access theActionsmenu.

d. For the NodeGroup selected, NNMi shows the following information:

o NodeGroup name

o Overall NodeGroup status

o Number of nodes in the group with each possible status

o Percentage of nodes in the group with each possible status

l Using amap view, to check the status details for a NodeGroup.

a. From the workspace navigation panel, select the Topologyworkspace.

b. Select Node Group Overview.

c. Select the  NodeGroup symbol of interest.

d. Select Actions→ Status Details.

e. For the NodeGroup selected, NNMi shows the following information:

o NodeGroup name

o Overall NodeGroup status

o Number of nodes in the group with each possible status

o Percentage of nodes in the group with each possible status

When diagnosing and troubleshooting problems, youmight want to check the status for only a
particular set of nodes. Your network administrator can group sets of nodes into NodeGroups. For
example, all important Cisco routers or all routers in a particular building. See About Node and
Interface Groups for more information about how your NNMi administrator sets up NodeGroups.
See "Filter Views by Node or Interface Group" (on page 25) for more information about filtering
views using NodeGroups.
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Chapter 10

Checking the Status of NNMi
To confirm that NNMi is running properly, check NNMi status. If one or more of the NNMi
processes or services are not running, contact your NNMi administrator to have the process or
service restarted.

To check the health of NNMi:

1. From the NNMi console, select Tools→NNMi Status.

NNMi displays a list showing the status of each process and service.

Each process and service should be running. If one is not, contact your NNMi administrator.

To check the health of the State Poller and Custom Poller:

1.  From the NNMi console, select Help→ System Information. For more information, see
Displaying NNMi System Information.

2. Navigate to theState Poller tab.

NNMi displays the status of the State Poller, including details about collections, queues, and
currently managed objects.

3. Navigate to theCustom Poller tab.

NNMi displays the status of the Custom Poller, including details about collections, queues,
and currently managed objects.
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Glossary

A

AES

Advanced Encryption Standard

Anycast Rendezvous Point IP Address

Rendezvous Point addresses are
loopback addresses used for routers in
multi-cast network configurations.

B

BGP

Border Gateway Protocol

C

Causal Engine

The NNMi Causal Engine analyzes the
health of your network and provides the
ongoing health status reading for each
device. The Causal Engine also
extensively evaluates problems and
determines the root cause for you,
whenever possible, sending incidents to
notify you of problems. Any incident
generated from aCausal Engine
management event has anOrigin of
NNMi in your incident views.

CBC

Cipher Block Chaining

CE

Customer Edge router. The router in your
network that sends data to an Internet
Service Provider's router (the Provider
Edge) on the path to the data's final
desination.

Custom Node Collection

A Custom Node Collection identifies a
topology node that has at least one
associated Custom Poller Policy.
Because a topology node can be
associated with more than one Policy,
the same topology nodemight appear in
multiple Custom Node Collections.

Custom Polled Instance

A Custom Polled Instance represents the
results of aMIB expression when it is
evaluated against a node. The first time a
MIB Expression is validated with
discovery information, the results appear
in theMonitoring workspace's Custom
Polled Instances view. The Custom
Polled Instance is updated whenever a
change in State occurs and includes the
most recent polled value that caused the
State to change. These results are then
used to determine the Status of the
associated Custom Node Collection.

Custom User Groups

Custom User Groups are the User
Groups that you create. These User
Groups are additional to the NNMi User
Groups, which are those User Groups
that NNMi provides.

D

DES

Data Encryption Standard

E

EIGRP

Enhanced Interior Gateway Routing
Protocol
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EVPN

Ethernet Virtual Private Network.

G

global unicast address

(2000:: to 3fff:ffff:ffff:ffff:ffff:ffff:ffff:ffff) A
publically routable IPv6 unicast address,
used for communication between nodes
anywhere on the internet. The first part of
the address is a global routing prefix in
the 2000::/3 address space for your
organization (assigned by the Internet
Service Providers). The complete host
address can either bemanually
configured or automatically assigned
using IPv6 auto-configuration and
neighbor discovery.

H

HMAC

Hash-basedMessage Authentication
Code

hops

A hop is a node representing any network
device, such as a workstation, gateway,
or switch, which is connected by a link
with no intermediate nodes.

HSRP

Hot Standby Router Protocol

I

ISIS

Intermediate System to Intermediate
System Protocol

K

Key Incident

Incidents with both: (1) Severity = other
than Normal. (2) Correlation Nature =
equal to Root Cause, Service Impact,

Stream Correlation, Rate Stream
Correlation, Info, or None.

L

Layer 2

Refers to the Data Link layer of the
multilayered communicationmodel, Open
Systems Interconnection (OSI). The
Data Link layer moves data across the
physical links in the network. The
switches and switch-routers are devices
that redirect datamessages at the layer 2
level, using the destinationMedia Access
Control (MAC) address to determine
where to direct themessage.

Layer 3

Refers to the Network layer of the
multilayered communicationmodel, Open
Systems Interconnection (OSI). The
Network layer is concerned with knowing
the address of the neighboring nodes in
the network, selecting routes and quality
of service, and recognizing and
forwarding incomingmessages to local
host domains. The router and switch-
router are the devices that redirect data
messages at the Layer 3 level.
Everything in a subnet is connected at
the Layer 3 (IP) level.

Link Aggregation

Protocols used on Switches to configure
multiple Interfaces (AggregationMember
Interfaces) to function as if they were one
(an Aggregator Interface). When two
Aggregator Interfaces establish a
connection, that connection is an
Aggregator Layer 2 Connection. The
Aggregator Layer 2 Connection appears
on Layer 2 Neighbor View maps as a
thick line with an Interface icon at each
end (representing the Aggregator
Interface). When you double-click the
thick line, it converts into multiple thin
lines representing the participating
AggregationMember Layer 2
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Connections with their Aggregation
Member Interfaces at each end of the
lines.

link-local address

A non-routable IPv6 unicast address only
used for communication with other nodes
on the same link (LAN or VLAN). Link
local addresses cannot be used for
communication that must be forwarded
through a router. IPv6 auto-configuration
automatically assigns a unique link local
address in the fe80::/10 address space to
each IPv6-enabled interface on a system.

loopback address

The address associated with the
loopback interface. The loopback
interface is a virtual interface on a device
that provides a route for internal
communication. Many vendors provide a
specially configured loopback for
management purposes. Exact details of
how loopbacks are configured varies by
vendor andmodel. See each device's
documentation for details. NNMi
identifies these loopback addresses by
using ifType Number 24,
softwareloopback from the IANA ifType-
MIB.

M

MAC address

TheMedia Access Control address
(hardware address or physical address)
that the factory burns into a network
adapter or device with built-in networking
capability. A MAC address has six pairs
of hexadecimal digits, separated by
colons or dashes. For example
02:1F:33:16:BC:55

MAC addresses

TheMedia Access Control address
(hardware address or physical address)
that the factory burns into a network
adapter or device with built-in networking

capability. A MAC address has six pairs
of hexadecimal digits, separated by
colons or dashes. For example
02:1F:33:16:BC:55

MD5

Message-Digest algorithm 5

MPLS

Multiprotocol Label Switching

multicast address

Used to identify a group of hosts joined
into a group. IPv4multicast addresses
are in the range 224.0.0.0 to
239.255.255.255 and IPv6multicast
addresses have the prefix ff00::/8.

multiconnection

A multiconnection is a thick line on amap
view between two Node icons, two Node
Group icons, or between a Node icon and
a NodeGroup icon (with no Interface icon
or IP Address icon at either end of the
line). This thick line represents a set of
multiple connections that have been
combined to preserve space and simplify
themap. Your NNMi administrator
specifies the number of connections that
must exist before NNMi condenses them
into amulticonnection line (User Interface
Configuration's Multiconnection
Threshold attribute). Double-click the
thick line to convert it into the original set
of connections with Interface icons or IP
Address icons at either end of the lines.

N

NAT

Network Address Translation. NNMi
supports the following protocols: Static
Network Address Translation, Dynamic
Network Address Translation, Dynamic
Port Address Translation.
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NNMi Role

Determined by your membership in one of
four special NNMi User Groups. This
membership determines what you can
see and do within the NNMi console.

NNMi User Group

NNMi User Groups are those User
Groups provided by NNMi. Users cannot
access the NNMi console until their User
Account is mapped to at least one of the
following NNMi User Groups: NNMi
Administrators, NNMi Level 2 Operators,
NNMi Level 1 Operators (with less
access privileges than Level 2
Operators), and NNMi Guest Users

O

OSPF

Open Shortest Path First Protocol

P

PE

Provider Edge router. The Internet
Service Provider's router that receives
your data on the path to your data's final
desination. The Customer Edge (CE)
router in your network connects to this
PE.

private IP addresses

These are IPv4 addresses that can be
reused in home and office local area
networks (LANs). Following the
standards set by RFC 1918 and RFC
4193 (10.*.*.*, 169.254.*.*, 172.16-31.*.*,
and 192.168.*.*)

R

RAMS

HP Router Analytics Management
System

routing prefixes

A network protocol technique used to
shorten or filter the amount of required
routing information in each packet by
declaring a prefix for an entire group of
packets. This prefix also indicated the
number of bits in the address.

S

SHA

Secure Hash Algorithm

U

unique local address

(fd00:: to fdff:ffff:ffff:ffff:ffff:ffff:ffff:ffff) A
privately routable IPv6 unicast address
used only for communication between
nodes within your organization. The
unique local addresses cannot be routed
to the public internet. The address
consists of a routing prefix in the fd00:/8
address spaces, assigned locally by your
organization. And the full host address
might bemanually configured or
automatically assigned using IPv6 auto-
configuration and neighbor discovery.

Unmanaged

Indicates theManagement Mode is "Not
Managed" or "Out of Service".

UUID

Universally UniqueObject Identifier,
which is unique across all databases.

V

VRRP

Virtual Router Redundancy Protocol
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